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Revision History

Rev. 1.5.2:

* VAST now supports Video Servers VS8801 & VS8401, and NVR servers NR8201 &
NR8301.

* Automatically saves the last layout when the management session is closed (for both
LiveClient and Playback).

* Added Playback as one of user's previlege options.

* A web session with an individual camera can be launched by a double-click on a camera's
icon.

Rev. 1.6.1:
* Added description for Adaptive Frame Rate Adjustment with the new SVC codec cameras.

* Added description for Auto Stream Size functionality.

* Added functionalities related to FE8171V fisheye camera.

* Added description for fisheye-specific screen control and playback functions.

* Replaced some description for the changes/improvements made on the user interface.
* Modified the graphic size limitation of E-map upload from 5MB to 2MB.

Rev. 1.6.18:

* Corrected editorial errors and added a conceptual drawing for the SVC-T (Temporal) func-
tion.

Rev. 1.6.1.11:
* Changed the maximum number of channel number in trial mode to 256.

Rev. 1.7.7:
* Added description for the Bookmark function.

* Added functional description related to the Panoramic PTZ feature in Appendix A.

* Added description for the Instant Replay function.

* Reflected changes on the new display and layout design.

* Added Hot key combinations.

* Removed the 1P3R fisheye display mode, which was removed from specifications later.

Rev. 1.8:
* Added individual Motion detection window options in the Event Management configuration
(see page 112).
* Added description for new Export video clips function.
* Added support for user accounts from Windows AD (Active Directory) service. (see page
103).
* Added G.726 audio codec support.
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* Added digital input options in the Recording Schedule settings. (see page 148)
* Added contents for the support of ONVIF rev. 2.2 in Appendix D (see page 294).

* Added new PTZ control options (speed and continuous move) for speed dome cameras. (see
page 37).

* Added description for the Seamless Recording function. (see page 49).
* User management: increased the number of configurable users to 1,024.
* Added the Device Pack update option (see page 33).

Rev. 1.9:
* Renamed and re-organized the Event Management window into the Alarm Management
windows. The Filter function is added. (see page 112).

* Added description for the vertical layouts. (see page 82).

* Added description for the Video mode option (see page 68).

* Added description for the common user name and password for multiple cameras (see page
67.

* Added the Sort devices by name option (see page 191).

* Added Storage lost as a system log type.

* Added description for the Alarm search function (see page 232).

* Added Appendix D for the 1/0 box support (Digital /O Modbus TCP Modules). (see page
307).

* Added the Auto tracking button (see page 36).

* Added description of the new implementation for multiple event screens on video alarms (see
page 117).

Rev. 1.10:

* Added the ONVIF Batch Insert feature (see page 63).

* Added the show VCA rules setting in View settings (see page 188). Note that VCA rules are
not displayed on the Matrix view.

* Added information for the Logical Tree configuration (see page 217).

* Added the video clip information - resolution/codec/fps/model name/IP/throughput.

* Added the feature for enabling/disabling Server GUID while importing VAST configuration.
(see page 272).

* Moved Appendix D ONVIF support to page 294. Moved Appendix E Digital /O Modbus TCP
Modules to page 307.

* Added Line Crossing and Field Detection as the triggering conditions in Recording Schedule

setting.
* Added the Output Camera List function on a right-click menu (see page 78).
* Removed the Video settings from the Batch Insert function window.
* Modified the Activity Adaptive streaming (Recording Settings) on page 47.



Rev. 1.11:

1.Described the application rules for the new software license. The new software license
replaces the use of hardware dongle. The same software licenses apply to both VIVOTEK
cameras and ONVIF cameras. See page 21 for details.

2.Added enhancement details for the Alarm state function group. See page 41.

3.Added H.265 codec support for the latest H.265 models.

4.Added description for the new device pack update function. The older Linux-based NVRs
(NR8201/NR8301/NR8401) and ND8301/ND8401 do not support this function.

5.Added joystick related configuration options, such as keypad quick switch, channel
mapping, and zoom control direction. See page 200.

6.Added description for the improved Instant Replay. See page 43.

7.Added information about the support for VIVOTEK’s managed switches. See page 132.

8.Added the options for Disable Background Decode (see Appendix E on page 318), DI/DO
status detection, and storage directory reserved space (10%).

9. Added Email with snapshot in the Alarm Management window. See page 115.

Rev. 1.12:

1. Improved displays of alarm windows with better display layout. The Alarm notification
windows can display the dewarped regional views for fisheye cameras. Also, the Alarm
search results can be exported to csv files. See page 120.

2. Added support for SSL management session with HTTPS login. See page 30.

3. Supports Multiple Stream Recording for recording redundancy. Different recording
schedules apply to different recording streams. See page 138.

4. Supports Seamless Recording of VCA counting data.

5. Supports configurable user access time and login time limitations (Expiration). See page
108.

6. Supports multicast streaming for Virtual Matrix. See page 130.

7 Added the description for VCA People Counting Report utility in Appendix D. See page 296.

8. Supports SQLite since rev. 1.12. The related information will display when updating the
VAST software.

9. Added description for the Database Merge function in Appendix F for migration of recording
files across systems. See page 312.

Rev. 1.13:

1. Added Failover server configuration as the Appendix A. See page 275.
2. Supports bad block/life expectancy event notification from SONY's Smart SD card. See
page 114.

3. Supports Alarm configuration using the DI/DO triggers from VIVOTEK's sub-station
cameras and NVR systems. See page 111. NVR DI/DO on page 56.

4. Added the description for pop-up alarm windows on E-maps. See page 191.

5. Added the description for adding cameras using the URL command. See page 55.

6. Added the description for overlay camera name and time on snapshots. See page 179.

7. Added the description for VIVOTEK joystick function integration. See page 201.

8. Added the description for the Scheduled Backup enhancement. See page 161.

9. Added the description for the User List Export function. See page 108.
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10. Added the description for the Scheduled Layout Rotation function. See page 86.
11. Added description for the Seamless Recording status. See page 49.
This revision also supports Auto Stream Size for Matirx.

Technology License Notice

HE HEVC-\dvance™

‘: Covered by Patents at patentlist.hevcadvance.com

Notices from HEVC Advance:

THIS PRODUCT IS SOLD WITH A LIMITED LICENSE AND IS AUTHORIZED TO BE USED ONLY
IN CONNECTION WITH HEVC CONTENT THAT MEETS EACH OF THE THREE FOLLOWING
QUALIFICATIONS: (1) HEVC CONTENT ONLY FOR PERSONAL USE; (2) HEVC CONTENT THAT
IS NOT OFFERED FOR SALE; AND (3) HEVC CONTENT THAT IS CREATED BY THE OWNER OF
THE PRODUCT. THIS PRODUCT MAY NOT BE USED IN CONNECTION WITH HEVC ENCODED
CONTENT CREATED BY A THIRD PARTY, WHICH THE USER HAS ORDERED OR PURCHASED
FROM A THIRD PARTY, UNLESS THE USER IS SEPARATELY GRANTED RIGHTS TO USE THE
PRODUCT WITH SUCH CONTENT BY A LICENSED SELLER OF THE CONTENT. YOUR USE OF
THIS PRODUCT IN CONNECTION WITH HEVC ENCODED CONTENT IS DEEMED ACCEPTANCE
OF THE LIMITED AUTHORITY TO USE AS NOTED ABOVE.
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Getting Started
Introducing VAST

VIVOTEK VAST is the professional video / central management software designed for managing
all VIVOTEK IP surveillance products with intuitive functions and numerous features. It supports
hundreds of cameras and stations in a hierarchical structure of system for monitoring, recording,
playback and event trigger management with ease-of-use and efficient control. Moreover, VAST
also offers the video wall solution, VAST Matrix, for hundreds of cameras live view monitoring.

VAST integrates VIVOTEK network cameras to provide diverse solutions and applications, such
as seamless recording with the cameras for uninterrupted video recording and Panoramic PTZ
for 360° seamless surveillance solution. VAST performs remote management with full range of
the server & client structure and constitutes a robust system for various applications, such as
stores, banking and the public space.

New Features

e H.265 compression support

e Multiple Stream Recording

e VCA Counting Report

e HTTP Secure Connection Support
e Multicast Support (Matrix Only)

e User Management Enhancement

Key Features

» 128-channel Live Video Monitoring with Dual Monitors

* 16-channel Synchronous Playback

* Video Wall Solution “VAST Matrix” for Unlimited Live Views

* Auto Stream Size for Reducing Display Loading

* Instant Replay & Playback on Live Client

* Intelligent Alarm Management and Acknowledgement
 Overall Device Management through Intuitive E-map Feature
* Multiple Fisheye Dewarp Support

* Web Access via Internet Explorer

* Logical Tree Management

* Windows Active Directory Integration

* VIVOTEK Exclusive Feature: Panoramic PTZ, Seamless Recording and VCA Counting Solution

* The number of linked devices will depend on the license on the key dongle.
* The ability to extend devices is also subject to the network bandwidth and computer performance.
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VAST Server and Client Components

There are four components in VAST: one server component--VAST Server, three client
components--VAST LiveClient, VAST Playback, and VAST Matrix.

VAST Server provides a centralized management site for video recording. VAST LiveClient
is a client program for the user to login and modify the server's configuration, edit the server's
recording storage, schedules and many other functions on the server; VAST Playback is
another client program for the user to log in and browse the recorded video database and video
clips related to specific events on the server.

Usage Scenario

The powerful management scalability of VAST makes it suitable for managing small- to large-
scale structures.

For users that manage only a few cameras, we recommend installing the client and server
components on the same computer. A host with all of the three components installed is recognized
as a stand-alone site. All the functions can be simultaneously performed on one single site.

Local Server Structure

— Stand-alone site
{2./| VAST Server

“4id] | VAST LiveClient
| VAST Playback

Network Cameras

! !
e & ....... 1 ‘:?;‘

For users who manage large-scale surveillance deployments, please plan the hierarchical
structure first. Then you can start to add cameras to each station and connect these sub-stations
to the root station. The whole hierarchical management system is thus constructed.

Remote Server Structure

Please refer to page 217 for
Logical Tree configuration, which
allows for a flexible and use-
N\, togn oriented privilege control.

Login VAST CMS Server
(Root station)

“» ~»
VAST LiveClient  VAST Playback Web Console
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Version
General

Max. Number of
Cameras*

Max. Number of Servers*

Max. Number of Clients
Support OS

Support Web Browser
Mobile Support
Virtual Matrix Support*

Devices Pack

Technical Specifications

1.12

Unlimited

Unlimited
Unlimited

Windows 8, 7, Vista, XP
Windows Server 2012, 2008, 2003, 2000

Internet Explorer 11/10/9
iViewer (i0OS/Android)
VAST Matrix

.vdp File Update

*Please refer to System Requirements Page
(http://www.vivotek.com/vast/#system)

LiveView (Local Display)

Max. Channel

Layout

Stream Application

View Application

Fisheye Dewarp Mode

Playback

Max. Channel

Layout

Playback Mode

Playback Control

Search Mode

Video
Video Format

Video Resolution

Video Enhancement

Audio
Audio Format

Audio Capability

- User's Manual

128-Channel (with Dual Monitors)

Multi Layout Display: 1x1, 2x2, 1+5, 3x3,
1+12, 4x4, 5x5, 1+31, 8x8, 1P+2, 1P+6,
1P+8, 2V, 3V, 4V, 2V+3

Single Layout Display, Full Screen Display,
Sequential Display

Stream Selection & Auto Stream Size

Drag & Drop

Remote 1/0 Control

PiP (Digital Zoom)

Instant Replay

De-interlace

Video Display Mode (Aspect Ratio, Hide
Borders, Keep Top/Down Borders)

Fisheye Display Mode:

Regular: 10, 1P, 1R, T03R, 4R

Wall Mount: 1P2R, 1P3R

Ceiling/Floor Mount: 2P, 4R Pro, 108R

16 Channels

Multi Layout Display: 1x1, 2x2, 1+5, 3x3,
1412, 4x4, 2V, 3V, 4V, 2V+3

Single Layout Display, Full Screen Display,
Sequential Display

Asynchronous & Synchronous

Play, Rewind, Pause, Stop, Next/Previous
Video Start, Next/Previous Frame, 1/8X ~
64X Speed Control, Bookmark

Browsing, Date & Time (Fast), Event,

Bookmark, Alarm, Log, Timeline, Timeline
Scale

MJPEG, MPEG4, H.264 AVC, H.264 SVC,
H.265

Up to 9 Megapixels
Basic Mode: Brightness, Contrast,
Saturation, Hue

Intelligent Mode: Defog, Rain, Snow, Fire/
Smoke

G.711, G.726, AMR, AAC

Two-way Audio

Audio Control

Record

Recording Time (sec.)
Recording Stream Type

Recording Stream
Recording Mode

Recording Setting
Recording File Format

External Storage
Recording

Alarm Management
Alarm Period (sec.)

Alarm Filter

Alarm Setting

Schedule Type

Camera Event

Camera Status
Substation

Storage Status

Station Status

External Devices Event
Action

Alarm State for
Management
Alarm Result Export

eMap

Source
Marked

Event Notification
PTZ

PTZ/ePTZ Control
PTZ/ePTZ Operation

PTZ Operation Mode
Export

Print

Snapshot

Export File

Mute, Broadcasting & Sound Play

Pre-Record: 3-15, Post-Record: 10-60
Unicast
Single/Multiple

Continuous, Schedule, Manual, Event,
Activity Adaptive Streaming

Recycle (Unit: Size or Day)

3GP

NAS (SMB & CIFS)

Max. 30

Name, Time, Source, Event Type, State
LiveView Alarm Notification: Fixed &
Popup

Alert Sound

Continuous, Schedule, Manual

Motion, DI/O, Video Lost/Restore, PIR,
Tampering, Temperature, IR, PPTZ, Line
Crossing Detection, Loitering Detection,
Field Detection

Connection Status, Recording Status,
Recording Error

Substation Connection Status

Storage Connection Status, Storage
Capacity Status

License Status, Network Status, Virtual
Memory Status

DI/O (With 1/0 Box)

Email, Start Recording, Move to preset
location, Set DO, GSM Short Message,
HTTP & Client notification

New, Assigned, In Progress, Resolved,
Closed, Later, Reject, Ignore

.csv File

Import Picture

Add, Remove, Direction Control, PTZ
Control & Indicator LiveView

Event Icon Light Flash

Panel Control & Mouse Click Control
Direction Control, Home, Zoom, Focus,
Iris, Preset, Patrol (Group), Pan, Stop,
Speed

Click to Move & Continuous Move

Selection Windows & All Windows
BMP & JPEG

AVI, 3GP & EXE




Technical Specifications

Backup
Schedule
User Management

Authentication

User Level

User Control

User Login Time
Limitation

User Login Schedule
System

Date & Time
Network

Multicast

Language

Device Integration

Joystick

Switch

1/0 Box

Camera Integration

Camera Insert

Basic Setting

NAS (SMB & CIFS)

Basic Account/Windows AD Account

Administrator, Power User, User, Operator
& Guest

Permission, Accessible Cameras &
Substations

By Time & By Day

Weekly Setting

Sync PC

DDNS, SMTP, UPnP, Proxy, HTTPS
Matrix Only

Czech, English, French, German, Italian,
Japanese, Persian, Portuguese, Russian,

Spanish, Simplified Chinese, Traditional
Chinese

VIVOTEK USB Joystick
All Windows® Compatible USB Joystick

VIVOTEK AW-GEV Series (VivoCam PoE
Switch)

Advantech ADAM-6000 Series

Manual & Search

User Name, Password & Camera Model
Detection

Connection Setting

Video Setting
Audio Setting

Remote Focus

NTP Setting
ONVIF Core Spec

ONVIF Stream

ONVIF Control

ONVIF Discovery

VCA Solution
VCA for Surveillance

VCA for Business
Intelligence

VCA Event

Configuration Protocol: HTTP, HTTPS
Streaming Protocol: TCP, UDP, HTTP,
HTTPS

Video Stream, Compression, Resolution,
FPS, Video Quality

Compression & Bitrate

Manual Focus Adjustment & Full Range
Scan

IP Address (NTP Server or VAST Server) &
Updating Interval

Version 2.2 or above (By Project)

Video (H.264, MPEG4 & MJPEC) & Audio
(G.711, One Way)

PTZ Control (Up, Down, Left, Right &
Zoom In/Out)

Discover the other brand camera through

Insert Camera & Batch Insert

Motion Detection, Line Crossing

People Counting

Line Crossing Detection, Loitering
Detection, Field Detection

*Only Support VIVOTEK Cameras.

Advanced Features

VIVOTEK Exclusives

Panoramic PTZ

Seamless Recording

Standard VCA Integration (Line Crossing &
Loitering & Field Detection)

VCA Counting Solution

are subject to change witho

© VIVOTEK INC. All rights
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VAST Server Functionality

Centralized management site for all the logged in clients
Maintain the configuration of the hierarchical management list
Hundreds of video recording channels

Store recorded data onto multiple networked or local hard disks
Live video for the local/remote LiveClient users

Retrieval of recorded video for the local/remote Playback users
Zero latency database recovery

Multiple stream recording

LiveClient is the management interface to your VAST server. The server-related settings are
made via the VAST LiveClient utility. The convenient and intuitive user interface on VAST
LiveClient provides access to camera, live monitoring, and recording configurations.
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VAST LiveClient Functionality

Server function control

B Hierarchical station management

User account management

Recording storage management

Recording schedule management

Recorded data backup

Event trigger management

Flexible video live view layout

B Dual screens for a maximum of 64 or more channels for simultaneous monitoring

B 1x1, 2V, 1P+2, 3V, 2x2, 4V, 2V+3, 1+5, 1P+6, 3x3, 1P+8, 1+12, 4x4, 5x5, 8x8, 1+31 moni-
toring layouts (V stands for vertical layout)

m 1P+2, 1P+6, and 1P+8 Panoramic PTZ layouts
B Multiple video viewing pages

Virtual Matrix for video wall display

Intelligent PiP function

E-map for overall management

Network storage for recorded video

Convenient switching among multiple monitors
PTZ / E-PTZ operation panel for camera control
Supports two way audio

Instant playback for event recording

Instant replay for immediate playback

Supports joystick control

Remote configuration for network cameras

qsv Insterk Asvbock  Eorce Tma TrmeZoe  Troe Desiption
: s
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VAST Playback Functionality

B Browse the database of recorded video from the server
B Flexible video playback layout
B Maximum 16 channels with simultaneous playback
B 1x1, 2V, 3V, 2x2, 4V, 2V+3, 1+5, 3x3, 1+12, 4x4 video playback layouts
B Supports powerful playback functions
W 1/8x, 1/4x, 1/2x slow-down playback
B 2x, 4x, 8x, 16X, 32x, 64x video playback speed
B Intelligent PiP function
B Supports convenient evidence and data exporting
B Export media files of recorded video
B Supports snapshot and print out
B Supports convenient switch among multiple monitors
B Search engine:
B Time search
B Event search
B Bookmark search
B Alarm and Log search B Alarm search result export
B Playback while recording
B Support synchronous/ asynchronous playback

8 Bk — -_——— S]] e <

T =R o] e

Irchs  Camara Start End Cescrprion
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Minimum System Requirements

Before installing the VAST software, please make sure your system meets the following
recommended minimum system requirements.
If you would like to install ST7501 Server only, please follow the requirements as below:

Windows Server 2000, 2003, 2008, 2012 / Windows XP Professional, Windows
7, Windows 8

up to 64 CH (256Mbps throughput) Up to 128CH (512Mbps throughput)

3rd Generation Intel® Core™ i5 3rd Generation Intel® Core™ i7
Processors or above Processors or above

RAM 4GB or above - 64CH; 8GB or above - 128CH
Network Interface Card Ethernet, 1 Gbit recommended
Graphics Adapter ~ DirectX 9 compatible 1GB graphics card

Single recording group w/ one HDD Two recording group w/ two HDDs*
SATA, SCSI, SAS (7200 rpm or faster) in NTFS format

* Each recording group can receive recordings for 60 channels.

If you would like to install both the server and client programs, please follow the requirements as
below:

Windows Server 2000, 2003, 2008, 2012 / Windows XP Professional, Windows
Vista, Windows 7, Windows 8

8CH 16CH 32CH

4CH 10CH 18 CH

2CH 5CH 9CH

3rd Generation Intel®  3rd Generation Intel® 3rd Generation Intel® Core™
Core™ i3 Processors Core™ i5 Processors i7 Processors

RAM 2 GBorabove 4GB or above 4GB or above

Ethernet, 1Gbit recommended

DirectX 9 compatible 1GB graphics card

* Display requirements of the 3MP fisheye camera is equal to a 720P camera.
** Display requirements of the 5MP fisheye camera is equal to a 1080P camera.

If installing Server and Client on the same PC, the overall loading on the PC is to be evaluated.
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&
® Only users with Administrator privileges can install or use VAST on a Windows Vista system.
® The required hard disk space will depend on the video settings, the number of network cameras and recording
group settings. Please add more hard disks if you want to extend the system.
Below are approximate numbers for a week-long recording. The actual storage space required also depends on
imaging parameters, e.g., a complex retail environment that involves many moving objects requires more pixel
dala to be transmitted over network than a simple environment such as a parking lot.
32-CH, VGA, about 1 week recording. 750 GB
64-CH, VGA, about 1 week recording: 1TB x 2
32-CH, 2-megapixel, about 1 week recording: 2TB x 2
64-CH, 2-megapixel, about 1 week recording: 2TB x 4
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VAST Software License

To activate the software, refer to the flow chart below:

Scenario

Action

Dongle license users Need more CHs

New users preferring
more than 32 CHs

1. Help > License > export license.

2. Send license file to VIVOTEK to
purchase more dongle license.

Need more than

New users fine with
32 CHs

1. Install the 256 CH trial VAST.

2. Help > License > Generate license
update request.

3. Send request file to VIVOTEK to
purchase software license.

Fine with less than

1. Install the 32 CH free VAST.

The VAST software provides 32 free channels. Since revision 1.11, the VAST software is
activated using a software license instead of the original hardware dongle.

For users running the previous dongle version, there is no need to upgrade their original license.
If they need the license for more channels, They can export their license file, and purchase more

dongle licenses.

For users who require more than 32 channels, they can install the 256 channel trial version first,
and go to Help > License page, and click on Generate License Update Request. Send the
request back to VIVOTEK to purchase more channel licenses.

System [Lacal |

e,  ~ ..
= . = A

Purchased WIVOTEK Used
Systemn 320 0 (Free: 17/32)

Unused
319

Purchased WIVOTEK Used
* W TK_Stationl 20 0 (Free: 4/32)
WWTE 300 0 (Free: 13/32)

Unused
20
299

*

Import License: | | Generate License Update Request | | Close |

When you purchased and received the
official software license, use the Import
License function to activate the official
license.

When importing purchased licenses, you
can manally select which station/license
file to update, or click the Auto Dispatch
button and let system decide the
distribution of license updates especially
when there are substations under a
managing VAST server.

Before the Auto Dispatch function is
available, license has to be individually
updated on every substations.
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Reminders for VAST Software License

H Limitations:

1.The Batch import/export function applies when a managing VAST server needs to collect and
update the licensing information from subordinate VAST substations and itself. An enterprise
may have a central management server and several VAST instances running in branch offic-
es. In that case, the substations will be listed on the device list, and may not be displayed on a
hierarchical structure.

The Batch import/export function is accessed through the Help > License menu on LiveCli-
ent.

W Import License @
— —
Mame IP address Wersion Type Path
= WA TK_Stationl 5
roww 08 KevDonok
= 111 182, e .08 Trial
|l noo 182.168.40.37
< 1 J »
]

2.The batch download/import function only takes effect on a VAST instance running on server,
not on the Linux-based NVR.

3.The trial channels on VAST substations will not be available for use on a managing VAST
server (one that manages multiple substations).

4.1f you access a VAST deployment via a web console, the license related information will not
be available.

5.1n this revision, an identical software license applies to both VIVOTEK and other-brand cam-
eras (ONVIF). You do not need to activate two different kinds of software licenses.

6. The Batch export update of the current license profile is supported.

7.The licensing mechanism does not apply to machines running Virtualized OSes (VMWare,
VirtualBox, Hyper-V, Parallels), either through an upgrade or generating software license on
a new installation.

8.1f VAST is removed and then re-installed, the number of licensed channels remains intact.

9. If users plan to integrate the software licenses from previous dongle licenses, problems may
occur if users changed the exported license file name.
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10.The VAST rev. 1.11 supports 32 free channels, and trial licenses for up to 256 channels.
Note that the unused trial licenses in a VAST substation will not be available for a managing
VAST server. The 32 free licenses will be available for a stand-alone VAST server only.

11. The software license verifies its availability on a machine by checking the computer’s main
components, e.g., GPU or memory. If a VAST server has several of its main components re-
placed, the software license may become invalid. Note that users can only change 2 compo-
nents on a substation (server components - CPU/Memory/Graphics card/Network card/Main
board).

12.For an older VAST installation containing a VAST substation licensed through the dongle, the
32 free channels will be automatically added to the total number of licensed channels. One
substation comes with 32 free channels. The added number of licensed channels will be-
come available for the managing VAST server.

User's Manual - 23




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

VAST Installation

Installing the VAST Software

1. Run VAST_Setup.exe on your computer. Select the displayed language. Click | ACCEPT the License
Agreement and specify a location to install the program.

Installer Language ﬁ Q VIVOTEK WVAST Setup: License Agreement EI&E

@ Please select the language of the installer @ Please read this license agreement carefully before installing.

.

End-User License Agreement a

v"] PLEASE READ CAREFULLY: This End-User License Agreement
("EULA"™) is a legal agreement betwreen VIVOTEK Ine. ("VIVOTEE")
as lcensor, and wou, as licensee, for the VIVOTEK software that
accompanies this EULA, which includes the wideo management
software VAST W1 and other applicable software (the “3oftware™).
TOU AGREE TO BE BEOUND EY THE TERMSE OF THIZ EULA BY
INETALLING, COPYING, OR OTHERWISE USING THE S0FTWARE
OF CLICKING THE BUTTON MARKED “I AGREE™ OR “YES™ -

§
&4 VIVOTEK VAST Setup: Installation Folder [P

Setup wil install YIWOTEK WAST in the following folder. To installin a L )
different folder, click Browse and select another falder, Click Mext to
cankinue,

|English

Destination Folder

VIVOTEK INcyvasT || rowse...

Space required: 525,3ME
Space available: 560.8GE

WAST v1.11.0.1 [ <Back |[ mext> |

W J

2. Select the items you want to install, then click Next to continue.

m |f you want to install both VAST Server component and Client components, please follow the steps
below to install the database.

&4 VIVOTEK VAST Setup: Installation Options E=E)

@ Check the components wou want ta install and uncheck the components

wou don't want ko inskall, Click Mest bo continue,

Select components ko install: '-.-'ﬂ.'E.T LiveClient Server Component
AT Playback — .
[ vast server Client components

Space reguired: 523, 3ME

WAST w1.11.0.1 <Back || Mext=
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3. You can install the free 32 CH version, or, select the Trial 256 CH version, then click Next to continue.

® The trial version will expire after 60 days. You can then contact VIVOTEK's sales representatives to
purchase the official software license to continue using the software.

&4 VIVOTEK VAST Setup : Server Configuration E‘éﬁ

In the LiveClient window, you can go to Help
> License, and click on Generate License
Update Request. You can send the request file to
©) Trial version: 256 channels (60 davs) VIVOTEK's sales representatives to facilitate the
purchase process.

@ Free version: 32 channels (YIWYOTEK only)

VAST ¥1.11,0,1 [ <Back || Mexts |

(S -

4. Assign a username and password for the VAST Server and click Next to continue. A strong password
is recommended using a minimum of 8 characters, in upper/lower case, and special characters.
Resetting passwords regularly is also recommended.

&4 VIVOTEK VAST Setup - Server Configuration [ [ e [t

WAST Server User Mame: adrmin

YAST Server Password: (LI LT L)

Corfirm Password: LTTTLTTY |

VAST v1.9.0.2 <Back || Mext> |

" J

=Y
Please record the user name and password for login later.
Once you have created a user account for a VAST station, you can login to VAST Server from any computer over
the network through the LiveClient and Playback utilities.
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5. An SQL Lite database is automatically installed on your server. In order to avoid conflicts among
different databases, we suggest you remove the original database from your computer.

Usually, you do not need to change the Station Listen Port and RTSP port for streaming video. If
necessary, e.g., when the port has been occupied by other applications, change the port number.

Specify a file recording path on your server. Multiple recording groups can be created, and if you have
more than 32 channels, it is recommended to assign a recording path on a different hard drive or RAID
volume disk other than your system drive. Click Install to continue the process.

at

&4 VIVOTEK VAST Setup : Server Canfiguration = 2
Station Mame: "F"‘."TK_Statil:lnl
Station Lisken Park: 3454
RTSP Port: 4543
Default Recording Path: E:\recording |:|
| Cancel | | < Back | | Install |

L8

The installation process should be completed within several minutes. Shortcuts will be created on your
desktop. Double-click on the shortcut to start using the software.

&4 VIVOTEK WAST Setup: Installing | =u| J

44 Instaling the WAST Server...
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If you installed the trial version, you will be prompted to activate the trial license. Click Yes to start
using the trial version.

&4 Information

6 The software is running trial mode. Would you like to activate the software?

Loes J[ me |

|
&4 Information

o '_I"he software is activated.
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VAST Server

Activating the VAST Server

VAST Server is a service program that will run automatically when your VAST station starts.
Users can also deselect the Auto launch option at windows startup on the VAST Service Control
program tray. The program tray icon can be located on Windows tool bar.

How to Configure the Server

Please follow the steps below to configure the VAST Server:
1. Find a local/remote computer that has installed VAST LiveClient.
2. Activate VAST LiveClient and login to the target VAST Server.

3. Configure the server using the VAST LiveClient user interface.

How to Stop/Reboot the Server

Please follow the steps below to stop/reboot the server:
1. Click on the VAST Service Control program tray icon in the toolbar.

2. There are 3 options: Start Service, Stop Service, and Restart Service. It's selectable by a right-click on
the Service Control program tray icon.

Open VAST Service Control

Start Service
Stop Service
Restart Service

Exit
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VAST LiveClient Configuration

Activating the VAST LiveClient and Logging in to a VAST Server

VAST LiveClient allows you to monitor live video from cameras managed by the VAST Server; it
is also the main user interface for server function control.

After installing the VAST LiveClient program, please follow the steps below to activate VAST
LiveClient:

1. Run the VAST LiveClient program.
2. A Login window will pop up. Enter the information as shown below:

® |f you want to login to a remote VAST Server, enter the IP Address, User Name, Password and the
Communication Port of the target server correctly. Click Login to log in to the target server.
= [f you want to login to a local host that is running VAST Server, check the Login local station check-

box, then the local IP Address will be displayed automatically. Enter the User Name, Password,
and Communication Port of the local server for login. Click Login to login to the target server.

4 VAST LiveClient (==

N VASTY
[Log in local station mlslation = Please refer to page 103 for
N how to enable and configure
Address: 192.168.6.117 ~ Address: | 127.0.0.1 -] Windows AD accounts.
Authentication: |Basic Account || | Authentication: [Basic Account -
User Name: admin User Name: adrmin
Password: ssses | Password: LXITT]
Part: 343 2] Wlusess Port: 3443 2] Mlusessi
[ Log in ][ Cancel ][Hidec{ ] I Log in I[ Cancel ]’Hide({ ]

3. The VAST LiveClient monitoring window will prompt.

ge

m /f your network environment needs to set up proxy, click More >> to extend the login window, then click Proxy
Settings to open the dialog. Then enter related information to link to your proxy server.

&4 VAST LiveClient = @ < p‘mx} ﬁgﬂings
Log in local station

|| [T1Enable Proxy
Address: 192.168.6.117 -

| Address: | |
Authentication: |Basic Account - _“

e |

User Name: admin " m [
Password: . | User Mame: | |
Port: 3443 5] [@usesst | Password: | |
[‘Proxy Settings | : | ok || cancel |

I J
l Log in ] ’ Cancel ] [ Hide << ]

m Available functions of the VAST LiveClient program will be enabled according to the role of your login account.
For more details about the privileges of the user account, please refer to How to Manage User Accounts on
page 100.
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If you use LiveClient to access a remote VAST server, you can use the SSL login for secure
connection.

To prevent network layer attack, the management session between a VAST LiveClient and

server can be encrypted using the HTTPS connection. HTTPS (Hypertext Transfer Protocol over
Secure Socket Layer) encrypts the traffic between web browsers and servers.

When starting the LiveClient, click the More button, and select the Use SSL checkbox.

WAST Li ient
Log in local station Log in local station
Address: 192.168.6.117 - Address: 192.168.6.117 -
Authentication: |Basic Account "] Authentication: |Basic Account -
User Narme: admin User Mame: admin
Password: . Passwaord: O
|_login | [ cancel | [ more>> | Port: 3443 [ [@usessL
Proxy Settings
[Lngil][{mcﬂllkﬂea:{]
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VAST LiveClient User Interface

A. Menu bar B. Quick access bar C. Hierarchical management tree
D. Camera control panel (PTZ / Two way audio / Instant Playback control panel)
E. Live view window F. Matrix view window  G. Status panel H. Alarm window

Menu Bar
cﬁ_ystem | Edit | View | Configuration | Layout | Help_j'

Menu Item Drop-down Options

Lock / Enable Click On Image (Disable Click On Image) / Language / Second View / E-map /

S Launch Playback / Logout / Exit

Edit Manually Begin Recording (Stop Manual Recording) / Snapshot / Print / Record to EXE (3GP,
AVI) / Snapshot Zoomed Image / Print Zoomed Image / Find

View Logical Tree view/ Device Tree view/ PTZ Panel / Two Way Audio Panel / Instant Playback

Panel / Alarm Window / Full Screen / Minimize / Matrix View

Camera Management (Insert Camera / Update Camera / Delete Cameras / Batch Insert
Cameras / Camera Configuration) / Station Management / Logical Tree View management
/ 10 Box Management / User Management / Association Management / Alarm Management
/ Virtual Matrix Management (Matrix Management / Matrix View Settings) / Station Settings
(General Settings / Network Settings / Recording Storage Settings / Recording Schedule
Settings / Scheduled Backup Settings / Server Settings / Relay Settings) / Client Settings
(Snapshot Settings / Recording Settings / View Settings / General Settings / Joystick Settings /
Proxy Settings / PiP Settings) / Video Enhancement (Basic Image Adjustment / Defog)

Configuration

Layout Start Rotating (Stop Rotating) / Save to / Delete / Choose
Help About / License
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Status Panel

32 - User's Manual

User Name

Station Name (IP Address)

Login Time (yyyy-mm-dd hh:mm:ss)
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Help Panel

The Help panel provides software revision information and the access to the associated iViewer
software in either the iOS or Android version. You can also click on the License button to review
the number of cameras and manageable substations.

If necessary, you may also use the Import License button to activate the functionality you
separately purchased or generate a license request.

N oL vellien k

&  VASTLiveClient 1,9.0.2

Trial wersion (Rermaining time: 52 days)

Al vights reserved. Copyright @ 2009-2014 VIVOTEK INC,

Marne Walue Description
bt f e vivortelk . com Camera number 256 Maxirmum number of the total camera channels,
S Other brand camera number - 10 Mayirnurmn number of the other brand camera.
Device Pack Version: 2.0.1 Update... Substation nurmber i} Maxirnum nurmber of substations for this icense.

WIVOTEK iWiewer

Please click QR code to purchase it. ] i k

Product Inforrmation Impart License Generate License Update Request Close

Available on the

App Store

Device Pack Update

A Device Pack consists of information of new VIVOTEK cameras or the updated information
for previous models, such as various configurations including resolutions, FPS, DI/DO, etc. For
example, some panels, such as the PTZ panel, may not be available for a new PTZ camera.
Your VAST server might not recognize the features of the latest VIVOTEK cameras. With the
Device Pack, you can configure and implement the latest VIVOTEK models without the need
to upgrade the entire VAST software to acquire the associated information. Please visit: http://
www.vivotek.com/web/product/productdetail.aspx?Model=VAST. For configurations not specified
in the device pack, you can still open a web console with individual cameras to change their
configuration.

You can consult VIVOTEK's technical support for the latest Device Pack [CSV files (*.csv)],
and use the Update... button in the Help window to replenish camera information. The update
information will be displayed, and the update process is completed almost immediately.

Device Pack Update
Old version: 1.0.2
New version: 1.0.3

Ready for update.

| Update || _



http://www.vivotek.com/web/product/productdetail.aspx?Model=VAST
http://www.vivotek.com/web/product/productdetail.aspx?Model=VAST
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Quick Access Bar

Icon

2l
(]
[©]
o]
=
[o]

-

] [E] & & @

¥
Ay

(] [w] (]|

Function

Exit

Logout

Lock

Volume
Snapshot

Print

Record to Media
Alert Sound
Switch Screen
Adjust SVC Level
Remove All Connections
Layout

Full Screen

Page Up

Page Down

Start / Stop Rotating

Description

Exit the system

Log out from the current station

Click to Lock the system for security concerns ( Unlock the system)
Adjust the audio volume of the current video ( Mute)

Capture pictures from the focus live video cell

Print out the pictures of focus live view window or all live video cells
Record media in EXE/3GP/AVI format ( Recording Media)

Play sound when an event triggers

Switch the current window to another screen

Dynamically adjust the SVC control over frame rates

Remove all live videos from the live view window

Change the layout of the live view window

Maximize the live video cell

Switch to the previous live view page

Switch to the next live view page

Start or stop live view layout rotating

Some buttons will be disabled if the selected devices do not support the corresponding functions.

Live Video Monitoring Window

The "VIVOTEK" logo is displayed where no camera has been assigned to a video cell.
The red frame ( |:| ) represents the current selection.
I

Video Cell
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Hierarchical Management Tree

_Station1(127.0.0.1) Root Station Name (IP address)
= FE camera
= @M 1_IP7139(192,168.5.120) | Connected devices listed under the root station
_— i o Camera name (IP Address)
e “ Do-1
= P& Recording Storage
= P DefaultGroup | Connected devices that have been assigned to
the default recording storage
o (M 1_IP7139
........ P Layout Layout list
= 8] wwTK_Station2(172.16.4.23) —— Sub-station Name (IP address)
- [ Carmera

#- [ Recording Group

=8
By default, the 1/O device connection status display is disabled. You can turn up the display by visiting
Configuration > Client settings > General settings > Keep detecting camera DI/DO status.

Icon Description

! A station (The host that’s installed with VAST Server)

A station (The host that’s installed with ST7501 Server)

VIVOTEK fixed network camera (or ONVIF cameras)
Red dot signifies that the camera is recording.

VIVOTEK PTZ network camera
Red dot signifies that the camera is recording.

w / T VIVOTEK dome network camera
Red dot signifies that the camera is recording.

VIVOTEK fisheye network camera
Red dot indicates that the camera is recording.

VIVOTEK video server
Red dot signifies that the video server is recording.

. / l Digital input on / off
- / i Digital output on / off

A layout of the live monitoring window

by A station that’s not able to be connected currently.

A device that’s not able to be connected currently.
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Camera Control Panel

Pan/Tilt/Zoom (PTZ) Control Panel
Up
Activated mode: | Digital -
Click: to rmove -

PTZ operation mode: |

Top left Top right
' Return to home position
Bottom left / Bottom right
! Down
—— — - Auto focus
Zoom out ——— & e - Eoom IP
Focus near———— £ il ocus far
Close — & Alaimml) 3 Open
— Auto iris
Start to auto pan —————— P ) Pairl ) i Auto Tracking
[_Stop
Stop auto pan/ = = Start to auto patrol
patrol 7 _an_;ﬁée_dh Speed control
Foom spaE:d':
Facus speed; o -

iy

Panaramic speed:
Rotate speed:
 Preset Lacation:

o

g;

Drop-down list of preset positions

m There are two types of PTZ control: Digital (E-PTZ for megapixel cameras) and Mechanical (PTZ cameras or
fixed cameras with camera control via RS-485). If the connected cameras support PTZ/E-PTZ function, the
PTZ option(s) will appear on the drop-down list. For detailed camera control settings, please refer to the user's

manual that came with VIVOTEK network camera .

m Click System > Enable Click On Image to use the mouse for the control of the PTZ and E-PTZ functions in the
video cells for linked cameras. An icon @ will appear in the video cell as shown below.

_ System | Edit | View | C

Lock Crl+L
{ Enable Click On [mage |

Langnage

Second View
E-Map
Lanmnch Plavhack

Logont
Exit

1_FD&161

2010408/03 AM 11:

25:23

® You can control the PTZ function through joystick as well. For more information regarding to the joystick

configuration, please refer to instructions on page 195.
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VIVOTEK's latest SD8xxx speed dome series supports the Continuous Move control. The
"Click to move" enables one movement by every mouse click on the PTZ buttons.

When Continuous Move is enabled from the PTZ panel, you can click and hold down the
mouse button on an arrow key to command the camera to continue moving to that direction.
The move will stop when you release the mouse button. Also, if the pan/tilt/zoom/focus speed
is configurable for a PTZ camera, you can use the Speed button to display the speed options:
pan, tilt, zoom, focus, panoramic, and rotate speeds.

For fisheye cameras, two more options will be available: Panoramic speed and Rotate speed.
These two options apply to the onscreen control for the Panoramic and Regional views.

ée

In addition to the PTZ panel, the following hot key combinations are also available:

Ctrl + NumPad (PTZ control)

Up Ctrl + 8

Left Ctrl +4

Home Ctrl +5

Right Ctrl + 6

Down Ctrl + 2

Focus (Far - Near) Ctrl+1 |[Ctrl+3
Zoom (Out - In) Ctrl+7 [Ctrl+9
Pan Ctrl +/

Stop Ctrl +*

Patrol Ctrl + -

Preset locations (pre- Ctrl + 0~9 (number keys above the alphabetic keys)
configured by users)

Full screen Ctrl + F

Single view Ctrl +V

Previous layout page Alt + PageUP
Next layout page Alt + PageDown
First layout page Alt + Home

Last layout page Alt + End
Snapshot Ctrl + S

Stop alarm Ctrl + A

Mute audio from current |Ctrl + M

stream

Start/ Stop rotation Ctrl + O
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Two Way Audio Control Panel

The two way audio function allows the user to remotely communicate with people nearby the
network camera.

PTZ | Two Way Audio | Instant Playback

z Selected device that
1_PZi131 can use the two way
B audio function

Click to play sound from the camera
Remove all cameras

Click to talk from the Talk Panel

alk Play Sound Clear Al

Select sound from the
file list

C:Program FilesVivotek InciS1 b Click to play the selected
sound on the client's side
NRRNRERRNRRRREN

g¢ Click to adjust volume

® For detailed information about How to Use the Talk Panel, please refer to page 166.
® Only cameras that come with the two way audio function can be added to the Talk Panel.

Language Selection

VAST currently supports multi-lingual user interfaces including: English, Cesky, Deutsch, Espa-
fiol, Farsi, Francais, Italiano, HZAEE, Portugués, Pycckun, fifAdsz, %4+ < | If you want to select
another language for the interface, please click System > Language on the menu bar to select
the desired language. Please note that if you want to change the language option, a message
will prompt to remind you to restart the system.

Neten
! System | Edit | View | Configuration | Layout | Help |. ge
Lack Ctrl+L
Enable Click On Image . = ||H
Lemage o If you want fo use "User Defined" language, please prepare images and
e 7] oo language strings, and upload the files to the following folders:
stirichs Playhack: Fs'.”."”'_
Rt RR ;:’ ...\VASTIClient|LiveClientllanguage\zz_UD (language string)
= taiare ...\VASTIClient|LiveClientlimage (images)
it EE=
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Alarm Window

£¢

* Only the alarm-related messages will be displayed in this window. An Alarm is a configuration
consisting of triggers and reactions set to activate during a specific period of time. The
Alarm-related settings is configured in Configuration > Alarm management. See page 111

for more information.

« For the event messages of the overall system operation, please refer to the Playback > Log

viewer.

» If a VAST server is reset, the Alarms will disappear from the Alarm window. You can go to the
Playback utility and use the Alarm search function to retrieve the past events.

Click View > Alarm Window to open a window showing the real-time information for event
triggers. If you want to hide this window, deselect this option on the menu bar.

View | lCUnﬁgUfaﬁﬂﬂ | Layout |I nstarit Playback Mame Y Dascrption souce T Eveirt Type T vilug Time Y State
Panel 0 [PA1SEHF mo...  mation detachon Mega-Fiel Network Camera Moton - wWindow 2 =% 2014-09-25 13:42:37.384 New
[+ i de e Mation - Wirdaw. 1 ; Hew
¥ TwoWay Audio Panel [+ PSSR ma...  mation detection Maga-Pieel Matwark Camira Mation - Window 2 =
Instant Playback Panel ADMENS2 sl ADaM-E0sE O3 (=} Trigoer 20140225 13141132178 Mew
sOaMEDSZ stel ADEMECER D1 o Trooer 20140925 13:20:39.118 Mew
v Alarm Window
Full Screen Ctrl+F
Minimize
v Matrix View
el Tire [Fiter |
Event Window I General settings ==
System Settings

The default Alarm window is set to be fixed on the
bottom of the LiveClient. If you want to change
the Alarm window as a popup page, please open
the Configuration > Client Settings > General
Settings window to switch the display modes.

Camera Management L
Station Managerment...

Logical Tree View Management...

/O Box Management 3
User Management...

Association Management...

Alarm Management..

Wirtual Matrix Management 2
Failover Management 3

Search YivoCam Switches...

Station Settings
Client Settings

Wideo Enhancement

Proxy Settings
PiP Settings

[] automaticall log in after logging in to operating system

[=] Automaticall display in full screen after login

[¥] Auto add newly-inserted camera to video cell

Retrieve RTSP stream on specified port: E
|| connect substation streaming vis refay

Keep detecting DI/DO status

[ Sort camera by name

Alarm Settings

Enable lve alarm notification

Enable alert sound(s)

Enable E-Map popup window
Alarm window mode: @ Fixed

) Popup

Rotation Settings
Enable rotation after login
Rotate the page every 10 E second(s) (3 ~999)

Display Settings
Maximum number of view cells
Enable auto stream size:

Enable de-interlace function
Enable Instant Replay on video cel

Default replay length:

Local streaming buffer time: 0 E milisecond(s) (0 ~ 10000)
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® The Event Type field in the Alarm window shows the event category and another field Value displays
the percentage of motion in the detection window. You can go to the Configuration setting page of the
connected device to set the percentage.

Enable motion detection

Video(TCP-AV)

Window MName

[1

Sensitivity

—_— | |_ g0%
Percentage

_I— 10%

Mewy | Sawe |

Alarm Filter

On the Alarm panel, a list of alarms will be displayed. Click on the attributes with a funnel icon.

Instant Playback  Mame W Description Sowrce W Event Type W Walue Time T State T
a 5D DI SDe161 DI-2 DI Trigger  2015-07-31 11:50:36.426  MNew
a S0 DI SDE161 DI-2 DI Trigger  2015-07-31 1150024722 New
a S0 DI SDE161 DI-2 DI Trigger  2015-07-31 11:50013.750  New

The Alarm Filter window will prompt. Use the Name, Time selector, and the State checkboxes in
the Source and Event Type panes to specify what kinds of alarms will be displayed.

General Source Event Type

Name: |l = Category

- Camera Events

[T Camera Status

gtate ) Substation Connection St
ey Assigned Storage Status

[Tin Progress [ |Resolved [T Station Status
.g (- External Device Events
Closed Later

Reject Ignore

Time
| [Clstart Time:
2015/ 731 - [1msaE2 |

[T1End Time:

2015/ 731 - [1usaE2 |

[ Apply ][ Cancel
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For example, you can set up a filter to display the alarms with a name associated with a specific
camera, such as "bullet on the corridor." The name of the alarm is configured in Configuration
> Alarm management on page 111.

General .. Trigger .. Action .. Schedue .. @ Detal

[¥]Enable this alarm

[¥] Enable live notification

Marne: :.

Description: -

-

Ttigger Period: 3 (sec) O '—07 30

| Back | [ mext || Frsn | [ cancel ]m

Use the Filter tab at the bottom of the Alarm window to display a different sorted result.

'ﬂ' IP2155HP mo...  motion detection

Q IPE152Y-3 dddddd

Real Time  Filter |

Alarm State

Left-click to select an alarm, and then right-click to display the Update Alarm button.

Source W Event Type W Value Time W State W
SDe161 DI-2 D1 Trigger  2015-07-31 11:50:36.426  Mew

SDE161 DI-2 ) Trigger  2015-07-31 11:5 2
SDe161 DI-2 D1 Trigger  2015-07-31 11:50013.750  Mew

Update Alarm...

You can change the alarm state from the pull-down menu. For example, if someone has already
been sent to check out the situation, for example, an intruder broke in through a window, you
can select the Assigned status. A 1024 bytes decription can be added into the alarm Note for

future reference.

Alarm Information Alarm Handling

Mame: @ State; | Mew
*5DOI

If an alarm is proved as a
false alarm, the alarm can
be designated as Ignore or

Resolved, and so on.

Description:
"

Source:
* 508161 DI-2

Event Type:
*DI

Value:
* Trigger

The different alarm states can
RPN also be used as the filtering
conditions in the Alarm filter.
Single or multiple states can
be selected in the filter. For
example, to display the Resolved
alarms only, use the Resolved
state as the filter.

Tirne:
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Instant Playback

Check View > Instant Playback to open the window on the panel. The entries listed in the
Event panel are the short recordings made from triggered events.

View | I]onﬁguration | Layout | H

anel

Two Way Audic Panel

I e P —— Deselect this item if you want to hide this window.

v Alarm Window

Full Screen Crl+F

Minirize

¥ Matrix View

Descrption Souce T Evert Type T
... mation detection Mega-Fiel Network Camera Moton - Window 2

Tme T

New
MeagaFiae] Netwiork Camera MoHon - Window 1 S51% 201409-25 793 Mew
Maga-Pivel Metwork Camera Totion - Window 2 Mew
ADAMLE0EE D2 2] 20140525 134132170
sttel ADEM-EOSE DI-1 ol Trooer 20140975 13:20:39.118 Mew

New

Rzal Time |FIIB |

Instant Playback Window with a slide bar, play, pause, and stop function

The recorded media that was triggered by an event will be indicated with a playable ﬁ icon.

You can double-click an event on the list to playback the recorded video. Each event contains
a video clip of 20 seconds in length. (The default recording data of an event is 20 seconds. For
more information about event recording, please refer to page 137.)
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Instant Replay

n If a camera is currently recording to the VAST server, then a Replay button will be
available at the lower left corner of its view cell. This allows you to immediately retrieve the video
recording in the past few seconds or minutes.

The Instant Replay function enables you to quickly retrieve videos of what has just happened (20
seconds to 15 minutes ago), without the need to open the Playback utility for the past videos.

Prerequisites for Instant Replay:

1. The function is enabled by default, only available on a LiveClient installed on a PC.

2. There must be recorded videos of the immediate past. If the video streams from a camera
were not recorded, you can not retrieve videos using the Instant Replay function.

J NOTE:

1. When using the Instant Replay function and you change the stream number on a video cell,
the Instant Replay will be interrupted.

2. The Instant Replay will also be interrupted when the time comes for a rotation of Live View
pages. For example, if you have multiple Live View pages and you set up a rotation of these
pages by every 10 seconds, page swap (rotation) still has a higher priority even if you are
viewing the Instant Replay.

How to Use:

1. On a selected view cell, mouse over to the lower left corner. A Replay icon u will appear.
2. Click on it to display the Replay control bar. Click on the play button.

M 10:19:30

20130704

3. The default queue length is 30 seconds. You can click on the number on the right to change
the queue length.

The Playback option allows you to directly open the Playback utility. A
maximized single view window will open. In this single view, previous
recording will be played, but, unlike the smaller Instant playback pane, the
Seeonds playback will continue until manually stopped.

1 minute

5 minutes This playback mode is not memorized as the norm the next time you use

the Instant Replay function.

15 minutes

The queue length configuration stays with the view cell, and it will not go unless you remove
and insert the camera again.
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4. To stop the Replay and return to the Live View, click on the Return to Live button. -

5. On a Replay view cell, you can apply the same Snapshot, Print, Single view and Full screen
control as those on a normal view cell. You can also right-click to display the Display Mode
and Video Enhancement functions.

Click and drag the playhead to skip or move to a different point in time on the playback.

An active Replay view cell is indicated by the Replay text indicator and the time of occurrence
of the current playback. ([

To change the default Replay settings, open the Configuration > Client Settings > General
Settings menu.

I Display Settings

Maximum number of view cells |

[¥| Enable auto stream size: [Quaity first. vl

[TEnable de-interface function
Enable Instant Replay on video cell

Default replay length: |30 seconds | +

Local streaming buffer time: 0 E milisecond(s}) (0 ~ 10000}

| ok || cancel |

Audio Control

The audio function will be enabled if the device is equipped with an internal or external
microphone. For detailed audio control settings, please refer to page 138.
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How to Manage Devices

Please follow the steps below to open the Camera Management window:
a. Select the station from the hierarchical management tree.

b. Click Configuration > Camera Management on the menu bar (or right-click the station, then select
Camera Management).

c. Then you can choose to insert, update, delete, or batch insert cameras.

(System Edit | View | Configuration Layout Help:\

Camera Management v
1
O &
Logical Tree View Management..
@ = B vk staton1 (12 g0 Management ,
_ B h (‘Z_a_Tera User Management...
e MEgEE R
Association Management...
(&M MegaF| : <
o @M egap  AlamManagement
S M Recording St Virtual Matrix Management »
Lo Layout Failover Management 3
= P 10 Box Search VivaCam Switches.
g ¥
& ADAMC Station Settings »
Client Settings b
Video Enhancement »

= [ Hon(107 168 A I mr——
@ e E cami Camera Management b Insert Camera... |
B E Recd Station Management... Update Camera..
E Layo! Logical Tree View Management... Delete Cameras...
E ol 1/O Box Management 3 Batch Insert Cameras...
User Management... Camera Configuration.
Association Management...
Alarm Management
Virtual Matrix Management 13

Search VivoCam Switches
Station Settings 3

Find..
Output Streaming URL

Insert Cameras T

Get PublicIP

Please follow the steps below to add devices to a station:

a. Click Configuration > Camera Management > Insert Camera on the menu bar (or right-click the
device/station, then select Camera Management > Insert Camera).

b. The Camera Management - Insert window will pop up. The device tree managed by the station will
be displayed in the left Camera List window.

c. Enter the Camera Name, IP address (or you can enter an IP address and check Auto to get a
camera name automatically) and configure the Connection Settings.

m |f the camera is on the LAN, you can click Search Camera to detect all VIVOTEK network
cameras on the LAN. A Camera List window will pop up and show a list of detected cameras on
the LAN. On the top of Camera List window, you can select "List the cameras which are not
inserted" or "List all cameras". The items listed below will then change accordingly. You can click
Mac, IP Address, Model, HTTP port to sort the items. Then select a camera from the list to insert
to the station.

®m The streaming protocol determines how the live video stream is sent from the camera to the local
computer. Please refer to the note on the next page for a detailed description of each transmission
protocol. Specify the recommended live monitoring stream for the device. If you want to change the
live viewing stream, please refer to the next page to update the camera settings. Or you can right-
click the desired cell, then select a desired stream. Please refer to Dual / Multiple Streams on page
73 for a detailed illustration.

m Click Detect Model to detect the device. The Model Name and MAC Address of the device will
automatically be displayed in the respective fields if the connection is successful.

d. If you want to make sure you are connected to the target device, click Connection Test to preview the
live video from the device.



Brand: WIVOTEK

Module:

@ Camera Mame:

Address:

il

1021666175 [QE)[)

PE162

Model Marne:

MAC Address:  |000201157840

Connection Settings | Recording Settings |

User Mame: Passwoard;:

Configuration Protocal: Configuration Port: 80 -
Streaming Protocal: TCR - Channel: 1

Tnitial @ Stream: 1 =

| [¥] sutomatically add camera into recording storage 'DefauItGroup IZI H

() List the cameras which are not inserted

@ List all cameras Refresh |
Camera List
A Address Mode! HTTF Paort
| 00-02-01-15-7B-40 192.168.6.175 IPE162 a0 |
00-02-D1-81-73-03 192.168.6.101 FE2173 a0

m /f you want to use "HTTPS Port", please enable the HTTPs settings on the configuration page of the Network
Camera first.
m The characteristics of each protocol are shown in the following table:

Protocol

UDP

TCP

HTTP

HTTPS

Description

UDP uses a simple transmission model without implicit hand-shaking dialogues for guaranteeing
reliability, ordering, or data integrity. Thus, UDP provides an unreliable service and data grams may
arrive out of order, appear duplicated, or go missing without notice. This protocol allows for almost
real-time audio and video streams. However, network packets may be lost due to network burst
traffic and images may be obscured. Activate UDP connection when occasions require time-sensitive
responses and video quality is less important.

TCP provides the service of exchanging data reliably directly between two network hosts, whereas IP
handles addressing and routing message across one or more networks. In particular, TCP provides
reliable, ordered delivery of a stream of bytes from a program on one computer to another program
on another computer. This protocol guarantees the delivery of streaming data and thus provides
better video quality. The downside with this protocol is that the real-time effect is worse than that with
UDP for a narrower bandwidth.

HTTP is a networking protocol for distributed, collaborative, hypermedia information systems. It’'s the
foundation of data communication for the World Wide Web. This protocol allows for the same quality
as TCP and the users need not open a specific port for streaming under some network environment.
Users inside a firewall can utilize this protocol to allow streaming data through.

This protocol enables authentication and encrypted communication over SSL (Secure Socket Layer),
which protects streaming data transmission over the Internet on higer security level.
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e. Configure Recording Settings:

Connection Settings | Recarding Settings

Basic Settings

Recording Stream: 1 E [ClEnahle seamless recording

Pre-event Time: 10 E seconds(3-15)

Post-event Time: 10 E seconds(10-60)

Activity Adaptive Stream
Active

m Recording Stream: By default, the stream source of the recording stream is stream 1, if you want to
change it later on, please refer to the previous page to update the camera settings (Update Camera).

m Pre-event time: Enter a number to decide how much time to record before an event is triggered.
m Post-event time: Enter a number to decide the duration of recording after an event is triggered.

Caonnection Settingl Recarding Settings | ] e
J

Basic Settings

; Pre-event time : — Post-event time :
Recording Strearn: 1 E pre- ? post-
10 sec. 10 sec.

Pre-event Time: [L1] E seconds(3-15)

Post-event Time: 10 E seconds(10-60)

Trigger Activation

Activity Adaptive Stream
Active

For example: If both the Pre-event time and Post-event time are set to 10 seconds, a total of 20
seconds of video will be recorded if an event is triggered. This function is supported by the buffer area
on a VAST server.

Note the following with the associated configuration: 1) [2) # [3) )
® The Pre-/Post-event time configuration only applies to %- t‘ 7 j 4
event re.cc.)rdlng. | | S ﬁ = " S
m The Activity Adaptive Stream (a.k.a., AAS) only applies to £ HL g i m Iﬁ'\L
the ContinUOUS Recording_ | frame ---> Full frame rate ---> |frame
Bandwidth

™ Activity Adaptive Streaming

m Activity Adaptive Stream (active if possible): Check this for Dynamic Frame Rate Control
item to enable activity adaptive stream recording. For
cameras that come with multiple streams features, users
can make use of activity adaptive streaming for dynamic
frame control.

If you check Activate Activity Adaptive Stream, the VAST Continuous recording Time
server will record full-frame-rate video only when an

event is triggered on the camera; otherwise, it will only

request the | frame data during normal monitoring, thus

effectively save lots of bandwidths and storage.

Vv
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Camera List 0 Brand: WTWOTEK |E| [02: 422-@@ _,'i

-8l Tk Station1(127.0.0.1)

h Module: . - -

@ Camera Mame: AL e
Address: 102.168.6.175 E]

Model Mame: | [PE162

MAC Address;  |000201157B40

Connection Test

Connection Settings |M|
IJzer Mame: Pazsward:
Configuration Protocal; Configuration Port; 80 =
| Streaming Protocol: TCP - Channel: 1
Initial Yiewing Stream:; 1 =
ﬁ' [¥] automatically add camera into recording storage | DefaultGroup |;| j

[m | Insert ]| Close |

., A

f. The device will automatically be assigned to the default recording group. Deselect the item if you want
to cancel this setting.

g. You can deselect the "Auto" checkbox behind the Camera Name entry, and manually enter a name
of your choice, such as "East alley bullet." This name will be used as the folder name for the recorded
video files. An index number will still be appended to the folder name. Note that if this name is changed
when the recording is taking place, the configuration change will not take effect until the next day.

h. When all settings are completed, click Insert to add the device to the station. The device will be
displayed under the Camera List on the left.

i. To insert additional devices to the station, repeat the above steps.
j. When completed, click Close to exit the camera management window.

k. Back to the main window, you will find the newly-inserted devices displayed under the station and the
live video in the video cell.

= WYTK_Station1(127.0.0.1) | 19 Live view ﬁr'-flatri}{ Wiy
& hCamera =
[+ @ 1 FD2161{192,

- [ Recording Storage

P Lavout

1_FD8&161 _ 2010408/03 AM 11:25:23

——
S
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Seamless Recording

Seamless Recording safeguards critical videos in the occurences of network disconnection.
In the event of temporary disconnection, video is stored in individual cameras' SD/SDHC/
SDXC card; and once the connection is restored, a VAST server can automatically resumes the
recording. More remarkable is that, a VAST server can simultaneously retrieve the time-tagged
videos that were temporarily stored on SD/SDHC/SDXC cards. For information about the latest
firmware/software revisions that support this feature, please contact your sales representatives
or technical support.

Seamless Recording
Disconnect Restored

14:30 14:50

VAST

Server Station Server Station

— -
Normal recording SD/SDHC/SDXC

—
Retrieval

The video data retrieved from SD/SDHC/SDXC card also include event-triggered recordings
such as pre- or post-event footages, if events were detected during the network outage.

The Seamless Recording feature is enabled when inserting, updating, or batch inserting
cameras in the Camera Management window. The firmware/hadware compatibility of this
feature is automatically detected, i.e., this feature is not available when a non-compliant camera
is attached. If a compatible camera is attached, a checkbox will be available as shown below.

[V]Enable seamless recording :@" Tips:

[Gemn

Camera List
| Camera Name: | [“]auto

TE Stationl - Insert

3l
Try out the Detect model

= B WiksusriizooD ‘ button on the Insert Camera
s [ 5y page if the Seamless
el [ Recording checkbox does not
MAC Address: | | appear.
s ot ]
| Connection Settings | Recarding Settings | . _
e Address: 192.168.6.207
I oy | e
Preevent Tme: |10 (& seconds(3-15) A Al
Post-event Time: |10 3] seconds(10-60)
- Activity Adaptive Stream
OActive if possible  Min, Pre-event Time: \ ‘ seconds(2-5)
[¥] automatically add camera into recording storage {DefaJtGrmp [:]

Ot ] o ]
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é&

*  When the SD/SDHC/SDXC card storage space is full, cameras will stop recording. When
the network conneciton between VAST server and cameras is restored, videos in the SD
card will be transmitted back to the VAST server. Note that the videos that were not recorded
during the time when the network was disconnected will not be transmitted.

+ If the videos on the cameras belong to those that are about to be erased within 24 hours (e.g.,
for the lack of storage space on a VAST server), those videos will not be retrieved.

Limitations:

* Retrieving video fragments from a camera can momentarily double the throughput of normal
video streaming.

* Video streams recorded using the MJPEG codec is not supported by Seamless recording.
+ Seamless recording can only take place from a camera with 1 video stream recorded to a
maximum of 3 VAST servers. .

Onscreen Elements for Seamless Recording:

* The associated icons will appear in the Liveview, popup window on e-Map, and the Matrix
view. The status icon appears on the upper right of the view cell.

» Below is the description of the Seamless recording statuses and the indicative icons.
Normally the video fragments will be retrieved first, and then the event log:

@ Currently not recording video from camera, but is retrieving data from camera due to
previous disconnection.

@ Currently not recording video from camera, but is retrieving event log.

@ Currently recording video to system as well as retrieving data.

@ Currently recording video to system as well as retrieving event log.

After a period of time, the gaps of recording (those blue lines or blocks representing network
interruptions during the recording) should be gradually stitched up. It is, however, system
integrators' responsibility to build a reliable network. Additional bandwidth should also be
available for retrieving fragmented recordings from the camera side.

The VAST checks for the need for retrieving fragmented videos by every one minute. If the
retrieval failed due to some network faults, the server will re-try the retrieval tasks later on.

m
¥
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In the Playback utility, you can select the tabbed window on top of the device tree to select
"Seamless Recording Status." If, after a cable disconnection, you can select to check if the
Seamless recording has duly performed a recovery.

% Playbnck:

{ Sysiem | Edit | Miew | Configeraticn | Layoal

Time Zone: | GMT+OE:00 Beprg, Changong. Hon x|
2 start Teves
2047/ % 7 o~ 125428 <
4 End Time:

185428 2

2017 % T ¥

Search

End Time Zong Descrpton Stane Fraquency of Reconery  Last Recowery

Export & Logs |

Note that when a cable is disconnected, the Seamless Recording Status may not immediately
display a disconnection event. The timeout for a disconnection is 1 minute, and the VAST server

and camera will take
the disconnection on

some time handling the disconnection and re-connection. Even you notice
live view, the Seamless Recording Status may take longer than 1 minute

to display the current status.

Status Description

Camera is Disconnected|The connection between server and camera has not been restored.
Standby Standing by for recovery.

Recovering Recovering recording data from camera.

Revover failed

Recovery errors occurred, and recovery failed.

Recover successfully

Recovery success.

No Need to Recover

No Need to Recover.

Ul Elements

ltem Description

Start time Beginning of a disconnection.

End time The end of a disconnection.

Time Zone Time zone of the disconnection event.
Description Length of the disconnection.

Status The handling status for the disconnection event.

Frequency of Recovery

The attempts made to recover data.

Last Recovery

The time the last attempt was made to recover.
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Enable SVC

If the camera to-be-added supports the latest SVC (Scalable Video Coding) feature, select the
SVC checkbox to enable the related control. The SVC feature enables streaming of videos for
multiple clients from one single set of layered IP packets. Designed for saving bandwidth and
CPU load on client stations, the frame rate of a video stream appearing through a view cell
can be individually adjusted. This feature applies when an administrator experiences unstable
video streaming due to the lack of network bandwidth, less-than-ideal hardware, or during an
occurence of network problems.

30fps

VAST Server Client PC

Notebook

Network Camera

b5fps

S
QO 3G Cell Phone

60fps
NVR Storage

The VAST server (rev. 1.6.1 and later) automatically negotiates with a camera and determines
whether a network camera comes with the SVC feature.

To configure the SVC-related feature:

1. When inserting a new camera into your configuration, select the streaming option, usually the
stream #1.

i ‘:" Camera Config

Camera List ; — — -
Video | Audio | Remote Focus | NTP Settings | Pamoramic FTZ |
= ! WYTK_Station1{127.0. | poy [Feheye mode (MAX 1505) .
b TR Mega-Pixel Netw - = .
- Bl Mega-Pixel Netwe
Yideo stream: =
= Mega-Piel Netw Stream 1 ~|
- BB 26w Zoom Speed| | | Codec type: IH 264 il
- & Metwork Cameral = — J MPEG-4 :
Lo 2P Mega-Pixel Netwe rame size: H.=64
Maxirnum frame rate: JPES |
Fusl =] J
Wideo quality: [ggnsj;ant.b_it rate '] l.;.‘.L{”lbp_ 23 b ]
i " | Copy settings to l Save. I [ Close

.
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2. Right-click on the view cell of an SVC-enabled camera. Select SVC fps adjust bar.

Mega-Pixel Network Camera. 201107127 EF 111707

|7| Single View

Full Screen
Others
Fisheye Settings

SVC fps adjust bar

3. A slide bar will appear above the view cell. Click and drag the slide bar. A numeric indicator
will display the current selection. See below for the frame rates represented by the numeric
indicator.

Indicator Frames per second (fps)
Maximum 30
7 26
(] 22
5 18
4 12
3 8
2 4
1 1
Minimum 1/4

& NOTE:

The SVC feature only applies to H.264 and MJPEG streams. It is not applicable to MPEG-4 streams.
Please refer to Configuration -> Media -> Video for individaul stream settings.
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If you have multiple SVC-enabled cameras, you can enable a collective setting via the Adjust
SVC level button on the tool bar. The frame rate selected here will then apply to all view cells on
the VAST LiveClient console.

(_System | Edit | View | Configuration | Layout | Help]

ll!@ﬂﬂlﬁ@ﬂlhl'@@@\ﬂ BE

= Bl Eric_vWTK Station(192.166.4.104)
E| h Camera

Please note that the SVC related setting can not take effect while the LiveClient station is
running the Layout Rotation. Stop the layout rotation before configuring the SVC function.

&
While you save your bandwidth for live viewing, you can still record full-frame-rate video by changing the

recording setting. For example, you can enable resource-saving SVC on stream #1 and configure stream
#2 to be recorded with full details, in terms of frame size, frame rate, and video quality.

)

N [ —
\ Camera Management for EricV

o canearime [ | e
Address: 192.168.4.134
Model Mame: |E\
MAC Address: | 000201117430 |

Connection Settings | Recording Settings
Basic

Recording Stream: 2

Pre-avent Time: 10 E seconds(3-15)

Post-event Time: 10 E seconds(10-60)

Activity Adaptive Stream
—_— . : : =] =
[Tl Active if possible — 1Mir, Pre-event Time: | 3 = seconds(2-5)

Automatically add camera into recording storage | DefaultGroup El

£ i | ¢ [ mnsert | [ Cose |
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Streaming URL

You can enter a camera's IP address to add a camera's RTSP streaming for live view and
recording, and playback.

To insert a camera using the URL-like command,
1. Select the camera Brand as "URL."

Camera List

B vus_swton(127.0.0.1)

Camera Name: I:I [¥] Auto
Address: 192.168.4.124
st ||

MAC Address:  0002D13D3882

URL: live.sdp

Connection Settings ‘Re(ﬂfdﬂg SetM@‘
User Name: Password:
Configuration Protocok  |HTTP - Configuration Port: 554 H
Streaming Protocol: TCP - Channel: E
‘Automatically add camera into recording storage | DefaultGroup

2. Enter the camera's IP address.

3. Enter the camera's MAC address as printed on the camera label, or one found by the
Shepherd utility.

4. Enter "554" in the Configuration port.

5. Enter "live.sdp" in the URL field, as this is part of the original RTSP streaming command:
"rtsp://172.18.204.58:554/live.sdp". If streaming stream #2, enter live2.sdp.

Note that the free 32 channel licenses does not apply when inserting a camera using the
URL command. Only the live view, recording, and playback functions are supported if thus
connected. All other functions are not supported, such as auto streaming size or changing to
another video stream. Camera DI/DO is also not supported.
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Insert NVR (Network Video Recorder)

1. Before you can include an NVR system into your current configuration, you should enable
the corresponding configuration on a web management console with the NVR system. In
Configuration > System > VAST, click on the Enabled checkbox and enter a password for
authentication.

HTTP Port: 80

HTTPS Port: 443

RTSP port: 554

CMS & iViewer: Allow access

o This password is only for CMS connection. iViewer login account is
the same as NVR

Port: 3454
CMS password:

Confirm password:
DDNS

Service

Apply

2. Return to your VAST management screen. Left-click to select your VAST station on the navigation
panel, and then right-click to display and select "Station Management..."

L e

(System | Edit | View | Configuration | Layout | Help )

O g Y[ @) @D'

(= vk station1(157.168.4. 182 I

B camera | Camera Management 4
EM Network Camemt ( Station Management... )
& Mega-prixel Net'.Jg User Management...

&M Network Camera| Association Management...

= video Server(197 Event Management...

& Mega-Picel MNetw Wirtual Matrix Management 3
& Network Cameral

& [N Network Cameral Sisfionsettings 4
B Recording Storage End
B Layout Output Streaming URL
P! g
= - NVR(60.251.25.60) Get Public TP

[y E Camera L
e Stomge—H_
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3. The Station Management window will prompt. Enter the Address, Password, and check if the
Communication Port match that you set for the NVR. Click on the List Sub-Station Hierarchy
button.

Station Tree for VVTK_Stationl Adtiress: ( 60.251.25.60 )
......... B Tk _station1(192.168.4.105) e ( (e D
Communication Port: ( 3454 )

I Update | ’ Close ]
After a brief delay, the NVR server will be listed in the column. You may also use the Search
button to locate similar devices if they are reacheable in your local area network.

4. You can then click the Insert button to add the NVR server to your configuration. When
done, click the Close button.

Station Tree for VVTK_Stationl

Address: 60.251.25.60
B WWTK_Station1(192.168.4.105)

Passwaord: sse

Communication Port: 3454
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5. The NVR will appear in the navigation panel along with its subordinate cameras.

| System | Edit | View | Configuration |

QEEEEERE

= B yvTK_Station1(192.168.4.105)
' Camera

& [ Network Camera(192.168.4.133
=@ Mega-Pixel Network Camera(192
- @M Network Camera(192.168.4.104
o () Video Server(192.168.4.115)
= F&¥ Recording Storage

& PM DefaultGroup

=B Y vR(60.251.
& B Comere
- [ Recording Storage

To enable the detection of NVR DI/DO signales,
1. Enter Configuration > Client Settings > General Settings. Select "Keep detecting DI/DO status."

Note that you should restart the VAST console for the configuration to take effect.

e ™
System Settings
[} Automatically log in after logging in to operating system
[T] Automatically display in full screen after login

Auto add newly-inserted camera to video cell

Retrieve RTSP stream on specified port: E

Connect substation streaming via relay
Keep detecting DI/DO status
Sort camera by name
Alarm Settings
Enable five alarm notification
Enable alert sound(s)
Enable E-Map popup window
Alarm window mode: @) Fixed
() Popup
Rotation Settings
Enable rotation after login
Rotate the page every 10 E second(s) (3 ~ 999)

Display Settings
Maximum number of view cells
Enable auto stream size:

Enable de-interlace function
Enable Instant Replay on video cel

Default replay length:

Local streaming buffer time: 0 E millisecond(s) (0 ~ 10000)

(o ][ el |
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The NVR's DIs and DOs will be listed on the device tree. Note that the DI/DO status is not supported by
NVRs running an embedded VAST software.

System | Edit | View | Configuration | L

VMS_Station(127.0.0.1)
- Camera
P Recording Storage
B Yo Box
A Layout

=

Insert a Video Server

1. Left-click on your VAST station, and then right-click to display the Camera Management
command. Let your cursor stay on the command for a second and then move to the Insert
Camera command. Click on the command to open its configuration window.

System | Edit | View | Configuration | Layout | Help
Oz @ 1| 2E+a| EBIIES >l
- B @- = | CameraManagement ) (P Insert Camera...

Station Management... u pdatEE&n'tera_

Logical Tree View Management... Delete Cameras...

/O Box Management * Batch Insert Cameras...
User Management... Camera Configuration...
Association Management...

Alarm Management...
Virtual Matrix Management *
Search VivoCam Switches...

Station Settings »
Find...

Output Streaming URL

Output Camera List

Get PublicIP
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2. See below for the steps to insert a Video Server along with its subordinate cameras.

Camera List

Camera Name: gj [¥] Auto

@M Network Camera(192.16¢§  Address: 152.168.4.115
i Mega-Pixel Metwork Came

Model Name: | V58401

oo (M Network Camera(192.16§

MAC Address: | 0OABCDABCDEF

Connection Settings | Recording Settings|

User Name: root G Password: PTTTTY |

Configuration Port: 80

iy
Channel: ilA":

Configuration Protocol: |HTTP

Streaming Protocol: TCP

Initial Viewing Stream: |1 |-

2-1. You can deselect the Auto checkbox to enter a name for the Video Server. If set to Auto and your
video server already has a name, that name will be displayed in your device list.

2-2. Enter the Address of the video server - or - use the Search | .| button to open a Search window.

2-3. If you enter its address and it is found after you click on the Detect Model [%]button, its Model
Name and MAC Address will be listed.

2-4. Before you click the Detect button, you should enter the User Name and Password for access
to the video server. You should also confirm the Configuration Protocol, Configuration Port,
Streaming Protocol, and the rest of the networking parameters.

2-5. You may select or deselect the checkbox in front of the recording storage option - or - use the pull-
down menu to select the default group or a pre-configured storage group.

You might use the Connection Test button to verify if the stream comes from the device you prefer.

2-6. Click Insert to include the video server to your configuration.

The Video Server should now be listed on the Camera List.
You can also use the Search button to poll the local area network for VIVOTEK's devices. You can
select to list all cameras or list those that have not been included in your current configuration.
Click on a device, and its detailed information will immediately appear in the Camera Management
window on the left. For recording settings, please refer to page 47 as previously described.

@ List the cemeras which are not inserted
) List all cameras Refresh

Camera List

MAC Address & Model HTTP Port
00-AB-CD-AB-CD-EF 102.168.4.122
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Update Devices

Please follow the steps below to update a device via Camera Management window:
a. Click Configuration > Camera Management > Update Camera on the menu bar (or right-click the

device/station, then select Camera Management > Update Camera).

b. The Camera Management - Update window will pop up. The device tree managed by the station will
be displayed in the left Camera List window.

c. Select a device from the list you want to update. Its related information will automatically be displayed
in the corresponding fields in the Camera Management window. Then you can modify Connection
Settings and Recording Settings of the device.

d. After modifying the settings, you can click Connection Test to preview the live video from the device.

e. When all settings are completed, click Update to enable the settings.

s Bl WK Station1(127.0.0.1)

(= Zamera
20% Z
H I [

Camera List

= Bl vk Station1(127.0.0.1)

G 20x Zoom Mega-Pixel Spe

E0a-Hixel Metwork Came
i (M Mega-Pixel Metwork Came

Delete

Refresh

Camera Settings
Carmera Ma nag:;ément .

Qutput Streaming URL
Send to Talk Panel

Camera Configuration...

ete L.ameras...

Brand:

VIVOTEK |+
20 Zoom Mega-f
102.166.6.142
Model Mame:  |SDE363E

MAC Address: 00020 121S0FE

Module:

Camera Mame:

Address:

455430 J:':}LF- 11:3

Connection Settings Recording Settings

zer Mame:

Configuration Protocal:

Streaming Protocol:

Initial Wienwing Stream:

Passwiord:

Configuration Port: 80

Channel:
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Delete Devices from the VAST Server

m Delete a device:

Right-click the device on the device tree, then select Delete. A dialog box will pop up. Click Yes to
delete the device along with the recorded data; click No to delete the device but retain the recorded
data; click Cancel to cancel the delete action.

B FS Camera

B w 20 Zoom Mega=-Te

Camera Settings [ ves | [ Mo ] [ Cancel ]

Camera Management 3

Cutput Streaming URL
Send to Talk Panel

m Delete more than one device at a time:

a. Click Configuration > Camera Management > Delete Cameras on the menu bar (or right-click the
device/station, then select Camera Management > Delete Cameras).

b. The Delete Cameras window will pop up.
c. Select the devices you want to delete from the list, then click Delete.

d. A dialog box will pop up. Click Yes to delete the device along with the recorded data; click No to delete
the device but retain the recorded data; click Cancel to cancel the delete action.

e. When completed, click Close to exit the Delete Cameras window and return to the main window. The
deleted device will disappear from the station.

= B Tk _Station1(127.0.0.1)
= By Camnera

|_:_| ...... w 20x 7

Delete

Refresh

Camera Settings
Camera Ma naéén\em 3

Insert Camera...

Update Camera...
Delete Cameras...
amera Lonfiguration...

Output Streaming URL
Send to Talk Panel

Address Mochel Marme

192.168.6.143 SDa363E 20x Zoom Mega-Pixel ...
192, 162 g MMega-Pixel Network Ca...
192.168.6.219 1PE332 Mega-Pixel Metwork Ca...

Select all

é Are you sure you want to delete this camera along with recorded data?

i Yes i [ a] ] [ Cancel
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Batch Insert Devices

Batch insert is a very useful function that allows user to search, filter, and import a row of
devices that are in the same LAN to a VAST station. The basic settings can also be applied to
those inserted devices simultaneously, e.g., a common user name and password.

Please follow the steps below to batch insert devices to a station:

a. Click Configuration > Camera Management > Batch Insert Cameras on the menu bar (or right-
click the station, then select Camera Management > Batch Insert Camera).

b. The Batch Insert Cameras window will pop up. Then click Search to open the Search Camera
window.

c. On top of the Camera List window, you can select "List the cameras which are not inserted" or "List
all cameras". The items listed below will then change accordingly. You may select ONVIF-compliant
cameras as well using the Brand selector.

d. Use the 4 Filters to narrow down the range of the wanted cameras from the list.

m [P Range: Type in a range of IP address to narrow down the list; the filter automatically applies after
you fill in a correct IP range.

Instruction

Search button Edit Connection Settings

Specify Address button ->  Import into List ->  Edit Recording Settings - Insert button

Irnport From File button Edit Video Settings
# Marne Address Part Model  MAC Status Search...

[ Specify Address... ]

[ Irnpart Fram File. .. I

-

R e —— - D -
. .
d Brand: |VIVOTEK =~

@ List the cameras which are not inserted

() List all camaras

Camera Name: @ Set following filters to narrow down the range of searched cameras,

Connection Setting [ [ address Range: . '
Uzer Mame:
[ address with prefix: :

Configuration Prot
? [CImModel with prefic: :
[ImMac with prefic :

-

Streaming Protocd

Initial Wiewing Strd

# Address Port Brand Model Recording Storage
1 102,166.6.142 £0 SDE3E3E 00-02-D1-21-50-FE f‘t%?ag;e, cameras to the recording
O o2 192.188.6.101 &0 FEB173 00-02-D1-81-73-03 '
2 192.168.6,219 &0 PEgaz 00-02-D1-15-20-02 DefauitGroup (3/256 CH) -
| ’ Insert ][ Close ]
I J
N
[Iselect &l [ QK ] [ Cancel ]:
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= |P with prefix: Type in the prefix of the IP address to narrow down the list.

¥ Bearch Cameras |z|

O List the cameras which are not inserted

() List all cameras

Filters

Set folowing filters to narrow down the range of searched cameras,

[[] address Range: | | 6o |

[ Address with prefix: |192.168.5.132I l

[(Iraodel with prefix:
[CIMac with prefie I:I

# Addrass Port Model A
r 1 192,168.5,132 20 FD2161 00-02-D1-FD-21-15

m Model with prefix: The user can type in the prefix of the model name or the complete model name of
the cameras to narrow down the list.

¥ Search Cameras |X|

O List the cameras which are nat inserted

(@ List all cameras

Filters

Set following filters to narrow down the range of searched cameras,

[ address Range: | | - |

[ address with prefix:
[ Maodel with prefix: Foe161| ‘
[CIMaC with prefi:

# Address Port todel A
o1 192,168.5,132 a0 FD2151 00-02-D1-FD-81-15

= MAC with prefix: You can type in the prefix of the MAC address of the cameras to narrow down the
list.

¥ Search Cameras |z|

O List the cameras which are not inserted

@ List all carneras

Filters

Set following filkers to narrow down the range of searched carmeras.

[ address Range: | | - |

[l address with prefie | 102.168.5. 132
CModel with prefie. [FOE1E1
[ MAC with prefis 00-02-01-FD

# Address Port Maodel A
o1 192,168.5.132 =] FO2161 00-02-D1-FD-81-15
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e. When the list is filtered, you can select the cameras one by one or check Select All to add them to the
batch insert list. Then click OK to finish searching.

¥ Search Cameras | X |

O List the cameras which are not insertad

@ List all cameras

Filters

Set folowing fitters to narrow down the range of searched cameras.

[7] Address Range: 192.168.5 |~ [192.168.5

[ address with prefic I:l
[CImadel with prefiz: I:I
[CIMac with prefic l:|

. #  Address CPort Model | MAC |
V1 192.168.5.131 &0 FDB133 00-02-D1-08-95-3B
| 2] 192.168.5.132 20 FDE161 00-02-D1-FD-21-15
¥ 3 192.168.5.119 20 Pa132 00-02-D1-32-C3-53
[¥]5elect &t K, Cancel

f. The selected cameras will be shown on the batch insert camera list with the camera information and
the connection status. When you click on a camera, a live view will show up on the right side for you to
identify the cameras on the list. If you want to remove a camera from the list, click the trash can icon to
delete it.

Instruction
Search button Edit Connection Settings

Specify Address button -»  Import into List -»  Edit Recording Settings -»  Insert button

f Irnpiort From File button Edit Wideo Settings
I
# Narne Addrass Port Model  MaC Status [ Search...
& 1 20% Zoom... 192,168.6.143 80 SDE3.. 00-02D1-21-50FB OK [ _
® = Mega-Pie.. 192.168.6.101 80 FES173 00-02-D1-81-73-03 OK st oove
® =

Mega-Pixe... 192.168.6.219 a0 IPa332  00-02-D1-19-20-02  OK [

1 | »

Imnport From File...

%

w
Camera Mame:  Mega-Pixel Network Camnera

Connection Settings -RECUFdiOQ&SBtUngS*I

Llzer Mame: Passwoard:

- :
Configuration Port: 80

Channel: EI

Configuration Protocol:

Streaming Protocol:

Initial Yiewing Stream: 1 =
Recording Storage

Add the cameras to the recording
storage:
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g. At the bottom of the window, there is a field for you to alter the camera settings including Connection
Settings and Recording Settings. You can apply the new settings to each camera on the list, or
click Apply to All to apply the same configurations to all the cameras. For more information about
Connection Settings and Recording Settings, please refer to Insert Device on page 45 for detailed

information. ;
h. Specify host: If you want to add a camera to the list, click Specify
Address to directly add a wanted camera. Click Add after filling in | , ... 192 1685 151
the correct information. The camera will be added to the list of the SeAEE
Batch Insert Camera window. Corfiguration Protocol:

i. By default, all inserted devices will be applied to the default | coniguration Part: I
recording group. Deselect the Add checkbox if you do not want to
assign the selected devices to the default recording group. User Mame:

j. Click Insert when all the settings are done. Cameras will be added. Password:

II;

[ Add ][ Close ]

&
When you modify the camera settings, and when the connection information (User Name, Password, Configuration

Protocol, Configuration Port, and Streaming Protocol) does not match the current network environment, the camera
will be disconnected and the status of the camera will become “Camera cannot be found” as shown below.

Egy =

Instruction

Search button Edit Connection Settings

Specify Address button  -=  Impott into List -»=  Edit Recording Settings ->  Insert button
Import From File button Edit Video Settings

# Marng Address Part Model  MaC Ctatle ’ Search... ]

'E’T?,‘g 1 Mega-Pixe... 192.168.5.132 443 FD2161 00-02-D1-FD-,.  Camera cannot be found, ’ Specify Address... ]

@ 3 Mega-Pixe... 192.168.5.119 443 PE132 00-02-D1-32-,.  Camera cannot be found. [ Import From File ]

Camera Mame:

Connection Settinds | Recording Settings

Uzer MName: Password:

Configuration Port: 80 E

Configuration Protocal;
Streaming Protocal: TCP - Channel: E'
Iritial Wigwing Stream: |_7:

Recording Storage

Add the cameras to the recording
storage:

epplyto Al | | [DefadltGroup (3/256 CH) -

[ Insert H (Close ]
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You can enter a User name and Password and use the Apply to All button to apply this combination
to all selected cameras. This way, you do not need to change the user name and password for every
individual cameras.
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Camera Configuration

The Camera Configuration function group provides immediate access to the video streaming
and other settings without the need to open a web console. The function group is accessed by
selecting a camera on the device tree, and right-click to select Camera Management > Camera
Configuration. If you have new VIVOTEK cameras and the VAST server can not recognize
their features, see page 33 for how to update camera information using the Device Pack update.

- Bl Tk Station1(127.0.0.1) ‘

Refresh
Camera Settings
b [ Layout ‘ :-Canmra"M}ana_ﬁ_gment ' 3 Insert Camera...
Update Camera...
Delete Cameras...
[ Camera Configuration. .. ]

...... nME

Output Streaming URL
Send to Talk Panel

= FOV (Field of View)

The FOV configuration is available for 5 megapixel cameras (such as IP8372 and IP8172P),
which allows you to crop a portion of the image captured by the sensor. The FOV setting ap-
plies in the scenario where you do not need all of the video a camera can capture. For example,
when shooting a parking lot where the upper half of the image is the sky. Cropping a field of
view can help save bandwidth and reduce the requirements for storage space.

= Bl wvTK_Station1(127.0. Fov:
o [ Mega-Pixel Netwe SR p— e
- ¥EE Maga-Pixel Mot ] 1080P Full HD (MAX 30fps)
YWideo stream: -
- B Mega-Pixel Metw [EEES
- (A cam test test{19) | Codec type: [g\,rc
LGP Mega-Pinel Netwr
Frame size: [?68){?68
Maximum frame rate: [15 fos
Viden quality: [Constant bit rate v] [6 Mbps
J U D Copy settings to: v| [ Save ] [ Close
= Video mode
For cameras having resource limitations such as hav- [(soe | [ cose |

ing a lower frame rate when supporting dual streams, or
lower frame rate when using the Rotation mode, its vid-
eo mode is automatically displayed in the Video window.
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= \/ideo

This tabbed window privides access to the selection of the live view stream, its compression co-
dec, frame size, max. frame rate, and video quality. Note that the Constant Bit Rate methodol-
ogy can be used to ensure that the size of video stream does not exceed a preferred threshold,
regardless of the complexity or the changes of pixels in the image. You should use a maximum
of 1080P as frame size and 6Mbps as constant bit rate for video streams managed by this

system.

i —p—| '

Video | pudio | Remote Focus | NTP Settings || Panaramic PT?

Video stream: [stream 1 ]

Codec type: [se )

P s [ 1056x1056 =

Maximum frame rate: {_ls.fm ._,_,:]

Mdsa satiy; Constantbitrate | [4Mbps <]
Copy ssttngs tor | s [ see ][ oo |

If your camera supports the Smart Stream function, the related options will be available with the
Video quality. Note that only the Auto mode option will be available.

Auto: When set to Auto, only the moving objects and the areas around them will be displayed
with the Foreground quality. The rest of the screen will be displayed with the Background (lower)

quality.

[ merst

w Mega-Pixel Metw
- @ Mega-Pixel Metw
- M Mega-Pixel Metw
s Mega-Pixel Metw

video | audia | Remate Focus | NTP Settings | Panaramic PTZ |

videno stream:
Codec type:

Frame size:

Maxirnurn frame rate:

Yideo quality:

| Stream 1

|H.264

|1920x1080

30 s

Smart stream (autor| v

Constant bit rate
Fixed qualit
Smiart stream (auto mode)

Background quality: H |
Maxirnurn bit rate: 40Mbps :l
Copy settings to: |Z|

| save I[ Close: ]
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= Audio
If audio feed is preferred, configure the audio codec type, sampling bit rate, and operating mode
in here.

" Camera List =
EL..- WK _Station1(127.0.0.1) | (7| nable audin

Audio codec type: m -|
lpom_

J’I

Mode:

K R T s— =
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m Remote Focus

For cameras supporting the remote focus feature, such as the FD8362E that comes with a motorized
lens, this window provides finetune buttons and full-range scan fucntion to help reach the best image fo-
cus.

(=28 . VVTK_Station 1{127.0.0. 1
- [N Mega-Picel Network
-G MegaPixel Netwark,

panoramic 1.«

ras o] O

L —— M| copysettngsto: | [ sve ][ che

m NTP Settings

If cameras’ real time clocks are set to be synchronized with a time server, enter the NTP server’s ad-
dress or domain name and specify an Updating interval. If you select the “Synchronize camera time with
system automatically” checkbox during the initial setup, the NTP server IP will be the VAST server’s IP.

~
4 Camera Configuration
Camera List
EETE | video | Audio | Remote Focus | NTP Settings | Panoramic PTZ
- B v station1(127.0. [¥]Enable MTP Server
i Mega-Pixel Netwi
- (A Mega-Pixel Met] TP server: 192168.6:135
M Mega-Fixel Netw) Updating interval; One day >
Q| —TT— Y| Copy settings to: El

Always remember to Save your configuration before leaving this window. You can also use the “Copy
settings to” button below to duplicate your current settings to adjacent cameras.
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m Panoramic PTZ

Please refer to Appendix B Panoramic PTZ configuration on page 288 or the Panoramic PTZ
Installation Guide for more information.

| viden | Audio | Remote Facus | NTP Settings | Panaramic PTZ

[¥]Enable panoramic PTZ
i (DA Metweork Camerai
- G RSNG| [FEnable auto tracking
T P | Copy settings tor [ save ] [ Close
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View Live Videos

The server will automatically add a newly-inserted device to the video cell for live viewing.
You also can double-click the target device or drag-and-drop the target device from the
hierarchical management tree to the video cell.

= WWTK_Station1(127.0.0.1)

r: ESr camera
= & Il

- [ Recording Storage

E Layout

Dual / Multiple Streams

I3 Live View ﬁ Matrix Wigw

1_FD8161

For dual-stream devices, you can right-click on the focused cell to select stream 1 or stream 2. For
multiple-stream devices, you can select from stream 1 ~ stream 4.

= WYTK_Station1(127.0.0.1)
= b Camera
N =R | -0cici102,163,5.132)
- [ Recording Storage

B Lavout

Fisheye Display Modes

‘ I3 Live View

1_FD8161

ﬁ Matrix Wiew

2010408{03 AM 11:25:23
Remeve

Ctrl+v
Ctrl+F
Ctrl+1
Cirl+H

Single View

Full Sereen
Enable PiP

Hide Global View

FrshleTnstant Renlay

Strearm 1 (1280720)

Stream 2 (1280720
Stream 3 (176144}
Strearm 4 (19201080

Set DO 3
Others 3
Wideo Enhancement 2

By default, a circular view is displayed when a fisheye camera is successfully connected. To
display Regional, Panoramic, or the combination of different views, right-click on a fisheye
camera's live view to display the associated commands. The display modes available are: 10
(Original), 1P (Panoramic), 1R (Regional), 2P (2 Panoramic), 103R (1 Original & 3 Regional),
4R (Quad Regional), 108R (1 Original & 8 Regional), and 4R Pro (4 Proactive) modes.

03 Live View

Mega-Pixel Network Camera

= A N ¢ A — = —. W/ W F
g W ey
Remove a1 J -
'S -
Single View Ctrl+4 TR |
Full Screen Ctrl+F

EnableInstant Replay

Strearn 1 (768x76E)
Strearn 2 (788x76E)
Stream 3 (15381536)
Send to Talk Panel
Set DO

Others

Video Enhancement

Video Display Mode

Fisheye Display Mode
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Fisheye Display Modes: below are conceptual drawings for different display modes.

10 (Single Original) Display mode: 1R (Single Regional) Display mode:

An Original oval view covers the A Regional view crops a portion of the hemisphere

hemisphere taken by the fisheye lens. as a region of interest. You can zoom in or out or
move the view area elsewhere from on the regional
view.

10 View (Original View)
ﬂ ©-_ 1R View (Single Regional View)
)

180° Hemispheric

Zoom in/out
&
all-direction
navigation control

A Regional view is dewarped, by correcting images
from the distorted oval view to a rectangular and
visually proportional image.

1P (Single Panoramic) Display mode:

With image correction algorithms in firmware, the hemispheric image is transformed into a
rectilinear stripe in the 1P display mode. Viewers can use the PTZ panel or simply use mouse
control to quickly move through the 360° panoramic view.

Note that the 1P view is apt for an overview, the Zoom in/out function does not apply in this
mode.

1P (Panoramic) Mode Screen Control

0 Live View

Mega-Pixel Network Camera
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2P (2 Panoramic) Display mode:

Two dewarped rectangular views are placed one on top of another each showing 180 degree of
panoramic view. The 2P view looks like the upper view shows the front of hemisphere, and the
lower view the rear half of the hemisphere.

2P (Panoramic) Mode Screen Control

B Live View

Mega-Pixel Network Camera

103R (One Original & 3 Regional) Display mode:

Fisheye cameras also support the display of multiple regional views taken from within the same
hemisphere, and they can be displayed with or without an Original view in its view cell.

3R View (Regional View)

Zoom in/out
&
all-direction
navigation control

* Only two regional views are shown for simplicity reason
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PTZ Mouse Control

The "Mount type" setting also determines the display modes available to your display modes.
Please refer to fisheye camera's User Manual for more information.

A highly versatile mouse control is implemented with fisheye cameras. The same control takes
effect on a browser management session, on the LiveClient utility, and even on a video playback
screen. See the drawing below for how it works.

You can click and hold down the left mouse button to quickly swipe through the field of view,
change the view angle, or use the mouse wheel to zoom in/out on a region of interest. However,
the PTZ mouse control is only available in the "R" (Regional) mode. In the Panoramic mode,
you can only scroll horizontally across the 180° or 360° panoramic view.

103R (Original & Regional) Mode Screen Control

3 Live View

Mega-Pixel Network Camera

> Interactive

ZoomIn  ZoomOut regional FOV indicators

<z _

— Current screen selection

@ Pan or tilt

Click to bring into ﬁ _

center of view <4 —>Click and hold down
<:ﬂ the button

=
The various display modes require the support of D3D technologies by your display card on the
LiveClient or Playback station. Most off-the-shelf display cards today support this feature.

The onscreen mouse control is very agile. Therefore, use the PTZ panel for more delicate
moves in a field of view. Pan and Patrol moves are also supported if you have configured
preset PTZ positions in the camera's firmware. Note that the Pan move takes place in the
Panoramic and Regional views, while the Patrol function through preset positions applies only in
the Regional views.
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Below are the conceptual drawings for other display modes. The available display modes can
different with different mount types:

Regular: 10, 1P, 1R, 103R, 4R.

Wall mount: 1P2R, 1P3R.

For more information, you can refer to fisheye camera's user documents.

4R (Quad Regional) Display mode: 4RPro (4 Regional Proactive) Display mode:

01 Live View 0 Live View

Mega-Pixel Network Camera Mega-Pixel Network Camera

( Regional View #2

Regional View #2 Regional View #1 Regional View #1

v

( Regional View #4

Regional View #3 Regional View #4 ( Regional View #3

108R (One Original & 8 Regional) Display mode:

20110901 05:41:35

Mega-Pixel Network Camera

Regional View #3 Regional View #2 Regional View #1

Regional View #4 Original View Regional View #8

Regional View #5 Regional View #6 Regional View #7
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Refresh

Right-click the device, then click Refresh, the camera information will be refreshed from the server.

= B Camera

| @ @ 20 Zooptens Pl cnacd o
&) Mega-i Delete

- @M Mega-Fi Refresh

[ Recarding Sto amera Settings

o [ Layout Camera Management 3

| Output Streaming URL
Send to Talk Panel

Streaming Server

Right-click the station or the device and click Output Streaming URL. A .txt file with streaming URL will
pop up. Then you can use this URL to link to the live streaming through QuickTime Player.

L

Camera Management 3 ‘
Delete

Refresh

Camera Settings

[ AUTK

Station Management._.

Logical Tree View Management...
I/O Box Management 3

User Management...
Association Management...

'?‘"i" -

& = — =

Alarm Management...
Virtual Matrix Management ,

Camera Management 4
Failover Management 3

Search VivoCam Switches... | Qutput Streaming URL
Station Settings [ Send to Talk Panel
Find..

( Output Streaming URL )

=

Get PublicIP

Output Camera List

This command produces a text file containing cameras' brand name, IP address, and HTTP port
information. The camera list file can later be used for Batch Insert function, Import from File.

Get Public IP
If your access to Internet is via PPPoE, this function will display the public IP provided by your service

provider. If your access to Internet is via a router, please consult your network administrator or consult
your ISP for a valid public IP.

E| B camera Camera Management »
iooe.. RN Me Station Management...

E| B Recordin Logical Tree View Management...

E & ' De’ 1/O Box Management »
e User Management...

o [ Layout Association Management...

Alarm Management...

Virtual Matrix Management »
Failover Management »

Search VivoCam Switches. .
Station Settings 3

Find...

Output Streaming URL
Output Camera List
Get PublicIP
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Camera Settings

Left-click to select a camera, Right-click, and then click Camera Settings to open a brower's session
to the camera.

= B wTK station1(127.0.0.1) —— Corfguraton
=B F=r camera
w 20 FOOpstnns Niunl Pemed 0 — System
o Mega-Pi Delete Host name: Wireless Network Camera
- Mega-Fi [~ Tum offthe LED indicator
P Rrecording Sto Camera Settings  System Time
o - Layout Camera Management 3

" Keep current date and time
| QOutput Streaming URL Audio and " Synchronize with computer time
© Manual
Send to Talk Panel

Motion det

 Autamatic

Camer:

— Dland DO

Maintenance
Digital input: The active state is |Low _» | the current state detected is High

Digital output: The active state is | Grounded | : the current state detected is Open

[ Advanced mode ]

Save

You must have an IE browser rev. 7.0
or above for opening a management
session.
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Remove Live Video from the Video Monitoring Window

There are two ways to remove a live video from the video cell:
Method 1. Right-click the video cell and select Remove.

= WyTK_Station1({127.0.0.1)
= BS Camera

B =R F0cie1(102,168.5.132)

@ [ Recording Storage

B - Layaut

I3 Live View ﬁ Matrix Wiewy

1_FD8161

Ctrl+4
Ctrl+F
Enable PiP Ctrl+I
Hide Global View Ctrl+H
v Enablelnstant Replay

@ Stream 1 (19201080
Stream 2 (1280x720)
Stream 3 (176x144%

Method 2. Drag-and-drop the live view from the video cell to the hierarchical management tree window.

-8 WWTK Station1(127.0.0.1)
= B camera

E} PM recording Storage

B - Layaout

08 Live View | [ Matrix View

1_FD8161 2010{08/03 AM 11:25:23

- Ly
; a

If you want to remove all live videos from the video cells, please click on the menu bar.

BNEERD

=

[
- —_—
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How to Change the VAST LiveClient Layout

Changing the Layout of the Live Video Monitoring Window

VIVOTEK VAST LiveClient supports up to 32-CH simultaneous video viewing on a single
monitor and allows you to change the layout of the live video monitoring window based on the
number of inserted devices.

Switch Video Channels

To move a video channel to another empty video cell, drag-and-drop the view to the target video cell.

To switch two different channels, drag-and-drop one view to the other, then the two different channels
will be switched to the opposite.
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Configure Layout Mode

Click the Layout button [E] on the quick access bar. Select a desired layout mode, and the layout
window will be changed accordingly. Below we illustrate 15 types of layout modes and the corresponding
page numbers:

oz a][o o]  [@[e) (]l Ee]>))

Layout mode Description No. of Video page
1x1
2V
s 1P+2
3v
2x2
4V
2V+3
1+5
s 1P+6
3x3
— 1P+8
1+12
4x4
5x5
1+ 31

More than 1 video page;

P-PTZ modes — — rotation function is enabled

Only 1 video page;
— rotation function is disabled

BEEREEELEEEEBE0

= 2 NN OO W oo A~ N 0o

Configure Layout Mode

Click the Layout button [E] on the quick access bar. Select a desired layout mode, and the layout
window will be changed accordingly. Below we illustrate 11 types of layout modes and the corresponding
page numbers:
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The 1P+2, 1P+6, and 1P+8 layouts apply exclusively to the Panoramic PTZ configurations. Please refer
to page 274, Appendix B Panoramic PTZ Configuration, for details.

Normally, a Panoramic PTZ layout will consist of 1 fisheye Original view, 1 speed dome field of view, and
1 fisheye Panoramic view as shown below. Note that the interactive click-on-image control only takes
place on the Original and the Panoramic views.

2013M3128 F7F 04:40:59
|

| Speed dome
view window

Instant Mayback  Source Tma TmaZore  Twe Descriotan =

20 Zoom 1080p Spoad. .. 20120220 15:34:50.576  +02:00 Rocording Status Start

20c Zoam 10600 Speed...  2013-08-23 153447015 +09:00 Recarding Status S

20¢ Toom 10800 Speed... 20120320 1531:35.602  +[8:00 Rocording Status Start

20c Zoam 10600 Speed. . 2013-03-23 153123516 +09:00 Reconding Status S '
20« Zoom 1080p Speed...  2012-03-20 1535:40.676  +[8:00 Aocording Status Start T -

20¢ Zpam 10800 Speed...  2013-03-23 15:25:26.597  +06:00 Recanding Status St

Moo Piscl Network Came.. 20120220 1621:20.400  +02:00 Aecarding Status. Start

Mega-Finsl Netwoik Camy,, 2013-08-23 16:31:19.334  +[9:00 Recardng Status St

Pl Dbl Mibsornrle S AT 458 ET ORD Lr0eT Derrebiren b e Shark

Some layout modes (1x1, 2V, 3V, 2x2, 4V, 2V+3, 1+5, 3x3, 1+12, 4x4) will spread all video channels
into several pages. Some cameras support the video Rotation function for scenarios such as a tall, long
corridor or the inside of a vehicle. The Rotation configuration is made through a web console with such
cameras.

% viversk

e, i T L T Home  Client settings QeLulIFieii-lM Language
Media > Image

Systom General settings | Image settings Exposure Privacy mask

Media - Video Settings

Image Video fitle
Video [7] Show timestamp and video title in video and snapshots

Position of imestamp and video fitle on image: | Top E'Y]

Network Timestamp and video fitle font-size: Small [E]
. Color: () B/W @ Color

Security
Power line frequency: (50 Hz @ 60 Hz

PTZ
Video orientation: [ Flip [] Mirror

Event [

ven e Rotale | gp [=] Degrees

Applications

Recording

Local storage
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For example, under the 3x3 layout mode, you can switch among the pages by clicking [ﬂ and on
the quick access bar. To arrange the content of each page, manually drag-and-drop cameras from the
hierarchical management tree to the video cells on each page.

Page 1 Page 2 Page 3

19 20 24
2923 2l
25150 o7

Rotating Video Pages

[ 53 = = I8 o o 2 B

For layout modes that contain more than one page, the LiveClient provides the rotating function for
displaying all video pages in turn.

® To enable this function, click on the Quick Access Bar, which will become Stop Rotating, and
the video pages will start to rotate so that the user does not have to click || to move to the next page.

® To disable this function, click |8 Stop Rotating, which will become || on the Quick Access Bar.

You can also click Layout > Start to Rotate/Stop Rotating to enable/disable this function.

Layout | Help |

lSta.‘rt Eotation Ctl+O '

Edit r
iZhooss

The default rotating time interval is 6 seconds. If you want to edit rotation settings, please refer to
Rotation Settings on page 190.

Edit Layout

Please follow the steps below to save a layout:
a. Arrange a layout mode and drag devices to their desired video cells.
b. Click Layout > Edit > Save to > New on the menu bar. A Layout Name dialog box will pop up.

I Layout Help | ¥ Save Layout |g|

atart Eotation Ctl4O Layout Mame:

|Iaw:uut 1 |

i (04 i [ Cancel J

c. Enter a name for the the layout, then click OK to enable the setting.
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d. Back to the monitoring window, the new layout will be displayed under the hierarchical management
tree as shown below. You can save up to 10 layouts.

e. To change to another layout, double-click the layout options on the hierarchical management tree, or
click Layout > Choose on the menu bar to select a desired layout.

= Bl vMs_station(127.0.0.1) %M W TS

& [ Start Rotating Crl+0
G [ Recording Storage
- I/O Box i ’
Delete 4
= BEy Layout '
Choose 4
3

Multi-Layout

Office4

m |f you want to edit an existing layout, arrange a layout mode and drag devices to the desired video
cells, then click Layout > Edit > Save to > New to save as a new layout or an existing layout to

Save To 3

Delete 3 Officel

@ g Office2

Multi-Layout » Office3
Officed

m |f you want to delete an existing layout, right-click the layout item on the hierarchical management
tree or click Layout > Edit > Delete on the menu bar to delete it.

E|! WMS_Station(127.0.0.1)
[ - Camera

[ - Recording Storage
- [M /0 Box Save To 8

Layout | Help )

Start Rotating Ctrl+0O

= By Layout Delete »
[ » Office2
Multi-Layout Office3

- ! VMS_SG! Delete

- @ ND9541(192.168.4.157)

[l

[l
d)

ﬁe

Whenever you close the LiveClient or Playback programs and changes in screen layout have been
made, you will be prompted to save your current configuration.

é Layout has been changed. Are you sure you want to save the channels in the layout?

] ol |
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Scheduled Layout Rotation

In a configuration consisting of a large number of cameras, you can configure different layouts containing
view cells of different characteristics, e.g., a V view for a vertical, corridor scene, or a P view for
panoramic glimpse of the scene. With these layouts, you can configure an automated layout rotation.
Each layout will be displayed in turn, for a configurable dwell time.

10 sec 6 sec 6 sec
3 pages 2 pages 4 pages

1
|
1
IS i
A - TF>

A time frame can be configured for each layout rotation. For example, one rotation may take place during
the office hours, while another will take place during the off-office hours. Configuring a time frame for the
layout rotation is optional. If not preferred, you can select the "Always" time frame template.

L T T 7

To configure a Scheduled Layout Rotation,

1. The precondition is that you should have multiple layouts created for your application needs.
2. Click on Layout > Multi-layout > Settings.

| Configuration | Layout | Help )
Start Rotating Ctrl+0

Save To
Delete
Choose
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3. Click on the Add ® button to create a new scheduled layout rotation. Enter a name for the layout
rotation. Avoid using these non-alphanumeric characters: (<>&"). -.

'@ Multi-Layout Settings =]
Mult-Layout: :}
Time Frame List Click on the Edit # button to change the
Load Terpiate | [ Save as Tempite name of the configuration. Click on the
e fame e Delete & button to remove an existing

configuration.

The max. number of multi-layout

$ ; configurations is 128. Up to 256 individual

[ A | ear | ek Offcer ] v Down_| layouts can pair with a time frame.

Layout List (o [ concel |

Avalsble Byouts: Note that you can not edit a multi-layout
e Name | Dwel Time | Divsion | configuration while it is performing a rotation.

[ select al

4. Click on the Add button on the Time Frame pane to create a time frame. You can manually enter the
Start and End time, or drag the time frame for the span of time you prefer. When done, click on the
Add button to create the time frame.

You can use the Load Template button to select a pre-configured template, such as the Officehour,
OffOfficehourinWorkday, Weekend, or Workday template. Make adjustments to the span of time. You

can save your current time frame as a tempate for later use.

If necessary, select the days within a week, or the effective range for the time frame.

&4 Multi-Layout Settings [=]
Mutsavout: (ayoutromton_+] (@) Click Save to complete the time frame
Time Frame List configuration.

Time Frame Name:  Time frame for Layout Rotationl |

[ Load Template | [ Save as Template | [ save

Repeat Frequency: IWeeidy Setting (Day-based) 'I

‘Weekly Setting (Day-based)
Set time segments in a 24-hour day. Multiple segments are allowed.

Start Tme: 00 = 00 5

S

Repeat on: [C|Sunday [“IMonday [C]Tuesday [T]wednesday [T] Thursday [CJFriday [C]Saturday

Range
Start: 2017/ 9/ 8 - End: © 2017/ 9/ 8 ~

@ Never Stop

Repeat every TE Week(s)

Select all
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5. Select the layouts that will be included in the Layout Rotation.
When done, click on the Dwell Time and Division field to edit their appearance and behavior on the

live view.
9 Moblevost Settines =y
Time Frame List
ILoadTmphte] [Saveasi'ﬂ'rplate]
Time Frame Rule
timeframe Daily Setting
Time frame for Layout Rotationl Weekly Setting (Day-based)
< m | .
[ade | er ] ook
Layout List
Available youts: Added kyouts:
Layout Name ||)welrme| Division ‘
O officel Officel 4 x4
M Office2 offi
ced 3
T Officez office3 s i @
T Offeed officcs 5 v
1P+2 @
3V
2%2
4V
2V+3
145
1P+6
Select all 3x3
1P+48
1412
Cancel
5x5
1+31
B8x8

If necessary, use the Delte button to remove a layout. Use the move @ E] buttons to change
the display sequence of configured layouts.

6. You can start a Scheduled Rotation in many ways. Once configured, a Layout Rotation icon will appear
on the device list. You can double-click on it to start the rotation.

=-- BE¢ Recording Storage
P DefaultGroup

- [H 1/O Box

= B Layout

Layout-rotation
Officel X 2

]
EH
@ Office2
]
i

Office3
Officed

Stop Rotating Ctrl+O

Save To

Delete
Choose
Multi-Layout

- v v w

Layout-rotation
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A rotation automatically starts with pre-configured layouts if you configure the option in Configuration
> Client Settings > General Settings.

v =

System Settings
Automatically log in after logging in to operating system
[7] Automatically display in full screen after login

Auto add newly-inserted camera to video cell

Retrieve RTSP stream on specffied port: E

Connect substation streaming via refay
Keep detecting DI/DO status
[l Sort camera by name
Alarm Settings
Enable live alarm notification
Enable alert sound(s)
Enable E-Map popup window
Alrm window mode: @ Fixed
() Papup

(" Roration Settings
Enable rotation after login
E second(s) (3 ~ 999}

Rotate the page every 10
.

Display Settings
Maximum number of view cells

Enable auto stream size: | Quality first. -

Enable de-interlace function
Enable Instant Replay on video cel

Default replay length:

Local streaming buffer time: 0 E milisecond(s) (0 ~ 10000}

o [ G |

To stop a rotation, click on the Stop button on the tool bar. This button turns red when a rotation is

taking place.

You can also double-click on an

existing layout to stop the rotation.
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Maximize/Minimize the Live Video Monitoring Window

= Single View: to maxmize a video cell to the entire live video window

Double-click the video cell, or right-click the video cell and select Single View. The focused video will

occupy the entire playback window as shown below.

Single View Cerl+

Full Screen Ctrl+F

Enable PiP Ctrl+L

Hice Globsl View Ctrl+H
V| Enablelnstant Replay

| @ Stresm1(1280x720)
Stream 2 (1280x720)
Stream 3 (176x144)
Stream 4 (1920-1080)
Send to Talk Panel
SetDO
Qthers

Video Enhancement
Video Display Mode

SWC FPS Adjust Bar

Remove

Single View

Full Sereen
Enable PiP
Hice Globsl View

V| Enablelnstant Replay

©  Stream 1(1280x720)
Stream 2 (1280:720)
Stream 3 (176x144)
Stream 4 (1920:1080)
Send to Talk Panel
SetDO
Qthers

Wideo Enhancement

Video Display Mode

SWC FPS Adjust Bar
2 =

Ctrl+
Crl+F
Ctrl+]
Ctrl+H

To restore to the original layout, double-click the video cell or right-click the video cell and uncheck

Single View.

90 - User's Manual




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

® Full Screen: Maximize the live video monitoring window to the entire screen

Click Full Screen on the quick access bar or right-click the video cell and select Full Screen. In
addition, you can also click View > Full Screen on the menu bar to maximize the live video monitoring
window.

To restore to the original layout, you can right-click a video cell and uncheck Full Screen or click the
Esc button on the keyboard to exit full screen mode.

Mnﬁgumﬁon | Layout | H
N Eamara X

v Two'Way Audio Panel
Instant Playback Panel

v Alarm Window

Full Sereen Ctrl+F

Minimize

v Matrix Wiew

= Minimize: If you click View > Minimize on the menu bar, LiveClient will minimize to the Windows tool
bar.

View Live Video on Dual Monitors

VAST also supports live video viewing on dual monitors, allowing you to manage a maximum of
64 channels concurrently on two screens. Moreover, the layout of the video monitoring window
on different monitors can be set up individually.

Please follow the steps below to set up dual-screen mode:

a. Set up dual monitors for your local computer.
b. Launch VAST LiveClient on monitor 1.

c. Click System > Second View on monitor 1, then the live video monitoring window will be displayed in
monitor 2 as shown below.

Monitor 1 Monitor 2
(_system | Edit | View | Configuration |
Lock Ctl+L

ble Click On [mage
k
.1)

E-Map
Launch Playback

Logout
Exit

d. There are two ways to view live videos. One is to drag-and-drop the target device from the
hierarchical management tree window to the video cells. The other is to click any video cell on monitor
1 or monitor 2, then double-click the target device; the live video will be displayed in monitor 1 or 2 in
accordance with your selection.

e. If you click Switch Screen on the quick access bar, the live monitoring window on monitor 1 and
monitor 2 will swap.
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Simultaneously Viewing up to 128 Channels

If you select 1+31 layout on dual screens, you can view a maximum of 128 channels live video
simultaneously. In this case, each layout contains 32 channels on 1 video page.

Monitor 1 - 32 channel Monitor 2 - 32 channel

Using different layouts on each monitor

You can also select different layout for two monitors, simply click the Layout button [E] on the quick
access bar. Below is an example of the 2x2 layout with 8 video pages on monitor 1 and the 4x4 layout
with 2 video pages on monitor 2. You can click g and |2/ to switch among the video pages.

Monitor 1 - page 1

Monitor 2 - page 1

Monitor 2 - page 2
= B _. ——

Click 3] [

Monitor 1 - page 8
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View Live Video with Multiple Monitors

If you have multiple screens in your monitoring center, you can switch the VAST LiveClient
Window among these screens.

® |f you have two monitors, click Switch Screen on the menu bar; the LiveClient window on monitor
1 will switch to monitor 2.

Monitor 1 Monitor 2

m |f you have two monitors, a drop-down list will be displayed when you click Switch Screen on the
menu bar. The number of items on this list depends on the number of your screens. Select a desired
screen on the drop-down list and the LiveClient Window will switch to the specified screen.

&

User's Manual - 93




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

How to Manage Stations

The VAST Server allows you to construct a hierarchical management system by adding more
sub-stations to the root station. Under each sub-station, it can also insert sub-stations and
network cameras.

Relay Settings

Before adding a sub-station, please follow the instruction below to enable the sub-station's
Relay Settings first.

a. Login to the sub-station.
b. Select the station from the hierarchical management tree.

c. Click Configuration > Station Settings > Relay Settings on the menu bar (or right-click the station
on the hierarchical management tree and select Station Settings > Relay Settings).

System | Edit | View | Cenfiguration | Layout | Help)

Olg a0l

Camera Management 3
Station Management...
Logical Tree View Management...

= Bl Tk Stationi (1 1/O Box Management '
“: User Management...
6 iz 2o Association Mana
o Mega-F A "
= @M Mega-F o enegEme
. o Virtual Matrix Management L4
G . Recording S Failover Management 3
= B Defaul Search VivoCam Switches. .
w 2 l Station Settings ' 3 General Settings
: Client Settings » MNetwork Settings
=] . Lavout ideo Enhancement 3 Recording Storage Settings
. N | Recording Schedule Settings
ﬁ Iritial

Scheduled Backup Settings
Server Settings 3
l Relay Settings .

Live Wiew

| B station1(127.0.0.1)
E‘ Camera Management 3
E‘ Station Management...
e

Logical Tree View Management...

I/0 Box Management 3
User Management...

Assaciation Management...

Alarm Management...

Settings

<

Wirtual Matrix Management
e Bettings
Settings
Search VivoCam Switches... »

<

Failover Management

Station Settings 4 General Settings

Client Settings Netwark Settings

Recording Storage Settings
Recording Schedule Settings
Scheduled Backup Settings

Server Settings 3

d. The Relay Settings window will pop up. Check Allow Relay Connection and enter a Password.
Then click OK to enable the settings.

<

Wideo Enhancement 3

¥ Relay Settings |z|

Relay Authentication

Confirm Password: I:I

[ Ok ] [ Cancel J
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Insert Sub-stations

Please follow the steps below to add sub-stations:
a. Select a target station from the hierarchical management tree.

b. Click Configuration > Station Management on the menu bar (or right-click the target station, then
select Station Management).

c. The Station Management window will pop up. The hierarchical management tree managed by the
target station will be displayed on the left panel.

i e I
(_System | Edit | View | Configuration | Layout | Help ) o= Camera Management v
Camera Management » Station Management...
@ b Station Management... Iogllcaﬁree iew Management...
Ogicar Tiee VW Wianageie /O Box Management 3
[ ! WK Staton1(12 | e gy panagement 5 User Management.
“ @ vegap User Management... Association Management...
H @M Megap Association Management... Alarm Management._
@M Mega-P Alarm Management... Virtual Matrix Management »
Recording St Virtual Matrix Management 4 Failover Management 3
B Layout Failover Management e Search VivoCam Switches...
S B /0 Box Search VivaCam Switches...
E‘ “ﬁ ADAM-E Station Settings > S ’
Client Settings » Find...
T — , Qutput Streaming URL

Output Camera List

Station Tree for ¥Y¥TK_Stationl
Addrass:

N7 _stationi(127.0.0.1)

Pazsword:

Communication Part: 3454

List Substation Hierarchy | | Insert

Hierarchical management tree

Celete | | Update i[ Close l

d. Before inserting the sub-station, you can click List Sub-station Hierarchy button to know if there is
any sub-station under it.

e. Enter the sub-station's IP address and Password (defined in Relay Settings, not login password).

The default communication port is 3454.

m |f the sub-station is on the LAN, you can click the Search Station button to detect all ST7501 and
VAST on the LAN. A Station List window will pop up and show a list of detected cameras on
the LAN. On the top of Camera List window, you can select "List the stations which are not
inserted" or "List all stations". The items listed below will then change accordingly. You can click
Name, IP Address, Model, Http port to sort the items. Then select a device from the list to insert
to the station.
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f. When all settings are done, click Insert to add the sub-station to the target station. The sub-station will
be displayed under the left station tree.

g. To insert additional sub-stations to the target station, repeat the above steps.
h. When completed, click Close to exit the Station Management window.

¥ Station Management for ¥¥ TE_Stationl

Station Tree for ¥¥TK_Stationl adldrese: |1?2.16.4.23
Password: | |
Comrnunication Part:
Delete Lipdate Close
N —

g' &4 Search Stations

(@ List the stations which are nat inserted

(7 List all stations

Station List
Marne Address Model HTTP Part
WY TE _Stationl 192.168.6.224 WAST 3454
RO1_MEIL_S5235 192.168.6.207 WAST 12345
WY Tk, _Stationl 192,168.5.135 WAST 3454
" WY TE_Stationl 192,168.6.133 WAST 3454
|l

i. Back to the main window, you will find the newly-inserted stations displayed under the hierarchical
management tree.

........ - Layout
=
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=y

B You can add VAST or free standard ST7501 as the sub-stations. The number of sub-stations can be
added to the server depends on your key dongle. The VAST server will automatically detect the USB
dongle installed on your host PC. Following is an illustration for two-level hierarchical architecture:

ans cren —— SN
VAST- Central Control Room

H ! D site
WAST

B site
‘ C site

A site
5T7aM1 ST7A01 WAST
- ..
L i s i

ALAASS agsspis ASALS S

A L L i i A i i P P L L L i i

- - - - -
VIVOTEE IP Camera VIVOTEE IP Camera VIVOTEE IP Camera

VIVOTEE IP Camera

B Please note that the following cyclic relay is not allowed.
Server C

Server A
=y
J —=—
z
Add ser\‘wr\ Add server C
as substation as substation

=

&

Vel

Server B
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Delete Sub-stations

There are two ways to delete a sub-station:
Method 1. Select the sub-station on the hierarchical management tree, then right-click to delete.
E= . WY TK_Station1(127.0,0.1)

Camera Management 4
Station Management. ..

Tser Management. .

A mociation Mansgement. .
Event Management...

Yirtual Mateos Management *

Station Sethngs 4

Find ...
Cutput Streaming TRL

blic IP
Delets

Method 2. Delete the sub-station via the Station Management window:

a. Click the station on the hierarchical management tree, then click Configuration > Station Manage-
ment on the menu bar (or right-click the station, then select Station Management).

b. The Station Management window will pop up. The hierarchical management tree managed by the
station will be displayed in the left Station List window.

c. Select a station from the list you want to delete. Its related information will automatically be displayed
in the corresponding blanks in the Station Management window.

d. Click Delete to delete it.
e. To delete additional devices, repeat step c. and d.

f. When completed, click Close to exit the camera management window and return to the main window.
The deleted device will disappear from the hierarchical management tree.

¥ Station Management for ¥¥ TE_Stationl

Station Tree for ¥Y¥YTK_Stationl

Address: 172.16.4.23 |
Password: | |
Commurication Part; T

| List Sub-Station Hierarchy | | Insert | [ search... |

Hierarchical management tree

--------- WWTK_Station2(172.16.4.23)

e |(_gom I
—— A
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Update Stations

Please follow the steps below to update a station via Station Management window:
a. Right-click the target device on the hierarchical management tree and click Station Management.

b. The Station Management window will pop up. The hierarchical management tree managed by the
station will be displayed in the Station List window on the left.

c. Select a station from the list you want to delete. Its related information will automatically be displayed
in the corresponding blanks in the Station Management window.

d. When all settings are completed, click Update to enable the settings.
= Q Wy Tk _Station1(127,0.0.1)

¥ Station Management for ¥¥ TK_Stationl

Station Tree for YVTK_Stationl

Uaer Management...
Asociation Management. .
Event Management. ..

Virtnal Matrix Management *

Station Settings 4

Omtput Streaming TRL
Gret Public [P
Delete

Scldress: 172.16.4.23

Password: |

Comrnunication Port: 34354 :

[I=ist Sub-Station Hierarchy ] [ Insert ] [ Search... J

Hierarchical management tree

B vk _Station2(172.16.4,23)

ch Celete '

Undate

Close
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How to Manage User Accounts

VAST allows users to apply multiple user accounts to a station with five levels of user roles:
Administrator > Power User > User > Operator > Guest. Each role has different permissions
listed as shown below. Moreover, Administrators have the highest privileges, while Power Users

can only add/edit users as Power Users, Users, Operators, and Guests.

The Default User Roles and Permissions of User Accounts

Functions \ User Roles Administrator Power User

Station Management
User Management
Camera Management

Association
Management

Access Alarm
Management
Modify Alarm
Management
General Station
Settings

Station Network
Settings

Access Recording
Storage/

Recording Schedule
Settings

Modify Recording
Storage/

Recording Schedule
Settings

Manually Record

Scheduled Backup
Settings

Access Server Settings
Modify Server Settings

License Management

Relay Management

Client Settings

Video Enhancement
Settings
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Operator Guest

Description

Add sub-station under the
existing station

Manage user accounts

Insert and configure the
camera settings

Access and modify the
association settings

Access Alarm management

Modify Alarm management

Modify general station
settings

Modify network settings

Access the recording group
and recording schedule

Configure the recording
group and recording
schedule

Enable the recording
function manually

Configure backup schedule

Access server settings
Modify server settings

Allow user to manage
station licenses

Allow user to manage
station relaying settings

Configure the client
settings: snapshot, AVI,
etc.

Allow user to edit profile for
video enhancement and
assign profile to camera in
LiveClient
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Privileges \ User Roles Administrator Power User

Modify Directories

Delete Station

Delete Camera

PTZ Control

Device Control

Talk Control

Access Camera
Configuration

Modify E-map
Event Search

Log Viewer

Backup

Record/Export Media

Virtual Matrix
Management

Virtual Matrix Control

Playback Authority

v

v

v

v

Operator Guest

Description

Add, remove and rename
directories

Delete sub-station from a
(parent) station

Delete camera from the
station

PTZ control for PTZ
cameras and speed domes
in LiveClient

Control the digital output or
white light/IR illuminators of
the cameras

Two way audio function for
the cameras

Access the camera settings

Allow user to modify the
E-map

Use built-in search engine
to search specific events

Use built-in search engine
to search the log

Back up database manually

Record live stream or
export playback stream to
local files

Allow user to manage
virtual matrix

Allow user to control virtual
matrix

Allow user to access
Playback
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Manage a User Account

Add a New User Account - Basic Account
a. Select the station from the hierarchical management tree.

b. Click Configuration > User Management on the menu bar (or right-click the station, then select

User Management).

System | Edit | View | Configuration | Layout | Help)

QY EJ YR

2\ B Tk _station1i12

=

Camera Management

Station Management...

Logical Tree View Management...
1/O Box Management

w Mega-P
EN Mega-P
EN Mega-P
M recording St
- Layout
= B 170 Bax

H L

c. The User Management window will pop up. The user accounts under the station will be displayed
under the left User List tree. Up to 1,021 users can be created (not including the default Admin and two

User Management...

Association Management... D

Alarm Management...
Virtual Matrix Management
Failover Management

Search VivoCam Switches...

internal communication accounts).
d. Enter the User Name, Password, and specify the User Role of this user.

e. Click Add to add the user account to the station. It will be displayed under the User List.

User List

“Account Management

Camera Management

Station Management...

Logical Tree View Management...
I/O Box Management

' User Management... !

Alarm Management...

Virtual Matrix Management
Failover Management
Search VivoCam Switches...

Station Settings

Find...

Output Streaming URL
Qutput Camera List

E=r vvTK_Stationl
- BSy Administrator

L
el
.
Y
o,
(]
.
)
A,

adrnin

wiviotek, twhEric. L
wiviotek, twhFrank.chang
erictheqgreat 123, comer
ericthegreat 123, comb, L
erictheqgreat 123, corm’, A
erictheqgreat 123, comb L

Althentication:

Basic Account

Izer Mame:

guard post

Password: sese

Confirrn Passwaord:

lJser Ruie:

1 3

Pesmission | Accessible Cameras | Accessible & * [+

Functions

Station Managem...
zer Managerment

Association Mana..,
Access Event Ma..,
Maodify Event Ma...
General Station 5.
Station Metwork ...
Access Recording. ..
Modify Recarding. ..
Manualy Record

Camera Managem...

-

Description

Add substation ur j
Manage User acce
Thsert and configl—
Access and modif
Access event mar
Maodify event mar
Modify general st:
Modify network s
Arcess the recorc
Canfigure the rec

Enable the recorc ™
3

Lpdate ll _ Add

=10
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Account Management

User List

F= vvTK_Stationl
- B Administrator Authentication; Basic Account. ']

-------- % adrmin Ller s guard post

-------- o, iwObek, bW\ Eric.Lu

‘r'.'_ vivotek, twiFrank.chang Password: ssssssse

-------- ﬂﬂs ericthegreat123.com'eri
i eticthegreat 123, comyuse Confirm Password: eeeseses

. ericthegreat123,.comiad
. Sl S Lizer Role: Porwver User

- N OLiard st

Add a New User Account - Windows AD Account

In an established, enterprise network environment, the support for Windows AD (Active Directory)
infrastructure enables ease of integration using the credentials of existing users. Using the same AD
authentication methodologies, you can configure the clients or users in an established network to access
the VAST server configuration.

Note the following with Windows AD support:

1. The ST7501 software does not support Windows AD accounts. However, if you log in to a VAST server
which supports Windows AD accounts, the AD account will work for an ST7501 sub-station managed
by VAST.

2. If you install VAST server on a Windows XP machine with Postqre SQL server, the login using a
Windows AD account will not work.

3. The VAST server must reside in a domain managed by the AD server.

4. This function does not support the environment that spans across multiple AD domains.
5. A user account hosted by an AD server cannot be modified in VAST.

6. A User Group and its members configured in AD cannot be managed in VAST.

7. You cannot add an account having the same name as one you used to log in VAST.

8. There are 3 types of account for VAST: VIVOTEK account, AD single user, AD group.
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a. To configure a Windows AD user as a VAST user, enter the User Management window. Select

Windows AD Account, and click on the Search button.

\d User Me

o VvVOTek.Ew\Eric.Lu

ﬂ vivotek.tw\Frank.chang
b D vivotek.bw\ (T RIEE

User Name:

Password: | | 2
Confirm Password: | | |‘
User Role: | Administrator
Howyeon: [sme T

Accessible Device: @ Device tree

© Logical tree

b. A Select User or Group window will prompt. |
Click on the Object type button. Select = '
=
Group or User. :
=
Select User or Group 7| x | : H
Select this object type: =
|Usa.&m.p.orBLi-h security principal | | Object Types... | :
From this location: = ;
|3ﬂ0ﬁ’1€9'53123-m || Locations... | L Fe——T— E
T ————
Check MNames

ok || Ccancel |

Select the types of objects you want to find.

Object types:

[l * Built-in security principals
o

ouUps
[wi s Users

c. You can also click on the Location button to specify a search range on a location on the AD
hierarchical tree, e.g., a department in an organization.

Select the location you want to search.

Location:

EE Entire Directory
B2 vivotek tw
-2 Builtin
-- Computers
G727 Domain Controllers
[#-/5] Fomign3ecurityPrincipals
1| LostindFound
Managed Bervice Accounts
-- Meeting Room PC
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d. Enter a name for user or group that is known to the AD. Click on the Check Name button. The search
results will be listed.

Select User or Group ?| x
Select this object type:
|User.[-.‘mt.p.orﬂll-'n security principal | | Object Types... |
From this location:
|3ﬂ0ﬁ’169'53123-m || Locations... |
Enter the object name to select (zamples):
admin Check Names
o] e

More than one object matches the following object name: “"admin”. Select an
object from this list or, to reenter the name, click Cancel.

Matching names:
Mame Logon Mame {pr...  E-Mail Address Description In Folder
s Administrator Administrator Buitt-n account f...  ercthegreat123....
*Mminia‘.rators Administrators ercthegreat123....

e. Click to select a user, and then click OK to confirm your selection.

f. Users thus added will be listed on the left in the User List. These users or groups will be listed with
-~
their domain name listed in front of them and indicated by different icons s :‘.

g. Select a User Role for the AD user as Administrator, Power user, user, operator, or guest.

h. Select user's privileges in terms of the Permission, Accessible Cameras, and Accessible
Substations from the tabbed windows below.

i i s [—
i. Click the Add button to complete the process. g VAST LiveClient [m]
[¥ILog in local station
The next time you log in, you can select Windows
AD Account, enter User Name and Password to || Address: 127.0.0.1 -
access the VAST software. authentication: | Windows AD Account - |
i
Lser Marme: wivotek, twiEric. Lu
Note that you should specify the domain name in
" . " Password: LALLLLLL | |
front of the user name; "domain name\user name.
Port; 454 1
i
Proxy Settings ]
[ Lag in ] ’ Cancel ] ’ Hide <« i
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Permission of the User Account

Administrator is granted with all access privileges, while other user roles' permission is limited. If
you want to modify the permission, please login as the Administrator to configure the settings.

f. Select a User account from the User List tree.

g. If you want to set the limit of the permission
of the user, click Permission tab to check or
uncheck the items.

z Eric.Lu
o e, VNOTEkEWFrank.chang Passward: | |
v Do vivotel b TSR

Ccmﬁ'mﬂiﬂ;wmd:l | ”

User Role: | Adminiserator [=]
Dleopyprom:  [amn  [] !
@ e: (@ Device tree Logical tree |
Permissian ‘Cameras | Accessble f ' [ * |
Functions Description ‘ ||
E (.
. . . . ‘ 7
h. If you want to limit the devices accessible : '
by the user, click Accessible Cameras tab to :
select the desired devices. ‘ & ”
] .
=
7 Modfy | ng... - Configure tha rac ‘
F Enzble the recorc ™
1 r

i

| Permission | | Accessible Cameras | Accessible Substations

)l camneras

| Carneras
1_FDE161
2_IPg1a1

You can select either a basic user can access a device tree or a logical tree.
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i. If you want to configure the access limit of the sub-station accessible by the user, click Accessible
Substations tab to select the desired devices.

=
If you want to remove access permission mentioned above from the account, the user will not able to
operate some functions listed in the following warning dialog.

Unchecked sub-stations or cameras will have the following permissionds) removed from the account:
"Camera Management",

"Delete Catmera",
é "Maodify Recording Group/Recording Schedule Settings",

"Scheduled Backup Settings",
"Modify E-Map”,
"Miodify Event Managerment"

i K i [ Cancel J

j- When completed, click Update to enable the new settings.

| Permission | Accessible Caineas| Accessible Substations l

O all substations () Selected substations

Substations
Wi TK_Station?

=z | ] |
[Jselect al

Delete Lpdate | Add

Delete the User Account

k. Click Delete, a delete user dialog will pop up. Click OK to delete the user account.

é Are you sure you want to delete this user?

i oK i [ Cancel ]

§¢

If the Administrator modifies or deletes the User Account, that modified user might be kicked off from the station.
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Expiration

Click Expiration to configure the extension of time allowed for a user's access. For example, an
administrator may want some users to have access to the LiveClient during a specific period of time,
wh

ile they are forbidden to access when they are not on the duty.

=PUNAT St

Aocount Management:
BSr vMs station

- B Administrator Authentication: || FRSicSeroupty ST
Lo B vivakek twarics
- hobak,twifrank.chang

- B admn Passwiord: .
Confim Password: = Q
Liser Aoie: Bower Lser :

FltopyFom: z0mn =

Accessble Device: @ Devicetree ' Logicel tree ; 9

User Hama: test user |4 |

Time Frame Hame:  day shift-1

i Load Tempiate | | Save as Templte | | Sawe |

Repear Frequency: @&m_[w
Set time segments n a 24-houl ed,
L e O o

Start Time: 18 -5 20 3

EndTme; 20 % 35 5 [ adi | [Cosere ]
e Repeat on: ¥\Zhnday ¥ Monday o\ Tuesday [ Wednesday [V Thursday | Frday ) Saturday

Range
Sea: 2016/ 613 v End: O 2016/ 613 -

_oaid | [ ek | [odets ] M i

Log-in Limitation Repeateveny © . Weskls)

0 [ mes J sachtme

0[] mns /) sach ey

oo s

Note that if a new user has the Administrator previlege, no Expiration setting will apply to him.
The Expiration setting applies to Power User, User, Operator, or Guest.

1. To start the configuration, enter a user name, password, and then select a User Role.

2. Click to enter the Expiration tab window.

3. You can either Load a Template or click Add to manually configure an Expiration setting. You may
also configure a Log-in Limitation by configuring the extension of time a user can access for each
day or each login.

4. If creating a new template, enter a name for the template.

5. Drag your cursor across the timeline, or manually enter the Start and End time. Click the Add
button if you manually enter the time span. You can add multiple time spans to the timeline. The
time spans will display on screen as red bars.

To delete a time span, click to select a time span and click the Delete button.

When done with a manual template configuration, you can click the Save button to save the template
for later use.

Export: Click to export users' privilege, access list, as a CSV file. The information include Functions

Permission, Accessible Cameras, and Accessible Substations. The Logical Tree access information is
currently not included.
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How to Set up Association Management

VAST LiveClient supports association management which allows the user to configure relative
event trigger notifications of connected network devices. (E.g., DI/DO status on the hierarchical
management tree, motion detection windows appear in the video cell, the event list in the event
window)

Association Management
Please follow the steps below to configure assocation settings:

a. Select the station from the hierarchical management tree.
b. Click Configuration > Association Management on the menu bar (or right-click the station and

select Association Management). o I [ e— —
5 = Camera Management b
t System | Edit | View [ Configuration I}ayout | Help ) Station Management...
' ol V" - =t D Logical Tree View Management...
— b ! Seation Management.. /O Box Management »
Logical Tree View M nt...
12 S T s e User Management...
» ﬁ
e Association Management...
ENM Mega-P _U
[EM Mega P Virtual Matrix Management 2
Recording St Virtual Matrix Management 4 Failover Management 3
B Layout Failover Management 3 Search VivoCam Switc
= By 1O Box Search VivoCam Switches...
i - Station Settings 3
St ADAM Station Settings b ng
Client Settings 3 Find...
Video Enhancement » Qutput Streaming URL
b b P ek

c. The Association Management window will prompt. Select or deselect the items and click Save
to enable the settings. The items you've selected will also be displayed under the hierarchical
management tree.

For example: _
Y R —— = -2 ! Wy TK_Station1(127.0.0.1)
Check item to enable/disable the Digital Input or Digital Output. - h amera
o ! VMS_Station(127.0.0.1) = 1 PZ7131(192,168.3.247)
: = FE9391-EV(192.168.4.161) [ ]
FEOl0142(102.168.4.171) | & DO-1
3.192.168.4.124(192.168.4.124)
; SDO161-H(102.168.4.164) = EW 2_IPE161{172,16.200.40)
@ ND9S41(192.168.4.157) [} I OI-1
........ DL1 @ DOl
E = 3 _FD2161(192,168.5,105)
"""" DI4 Input for DI-3 3
........ DI-5 Sl i DI 1
........ DL6 | 0 Do-1
"""" D7 # - [ Recording Group
........ DL
........ DO-1 [ ok || cancel | w o [ Layout
........ DO-2
........ DO-3
........ DO4
. / I Digital input on / off
¥ / &P Digital output on / off

d. If you want to rename the DI device, select the DI item and click the Rename button. It will be very
convenient for you to recognize the target DI device.
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® 7o manually enable DI/DO settings, please right-click the video cell and select Set DO to enable (Trigger) or
disable (Normal) the digital output of the linked device.

1_IP8161 2010{01/27 AM 03:31:28

1 IP3161 7 2If!1 0f01/27 AM 03:31:28
Bemove -
Single View
Full Screen

Enable PiP
Hide Globel Tiew  Ctl+H

Bemove

Bingle View
Full Screen
Enahble PiP
Hide (Flobal Wiew Ctl+H

Stream 1

Steeaim 2

Stream 3

Steeaim 4

Send to Talk Panel
Set DO

Others

Stream 1

Steeaim 2

Stream 3

Steeaim 4

Send to Talk Panel
Set DO

Video Enhancement

¥ideo Enhancement

m Before you configure the DI/DO Settings for VAST, please enable DI/DO settings on your network device and set
up the camera correctly on the configuration page. You can right-click the device and click Camera Settings fo

open the configuration page. 5 B wwTK_Station1(127.0.0.1)
- B Camera

@ 20x Zogr s Bt o
-G8 Mega-Fi Delete
------ EM Mega-Fi Refresh

B Layout amera Management »
Output Streaming URL
Send to Talk Panel

Cww. viveTEN. Eom Home Client settings [eLL)[ITeLM Language
Applications > DI and DO

L — Digital input

Media Normal status: @ High (OLow

Network Current status: High

Security — Digital output

PTZ Normal status: (@ Open () Grounded
Current status: Open

Event

Applications I: Save

Motion detection

DI and DO
Tampering detection
Audio detection

Package management

Recording
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How to Set up Alarm Management

VAST LiveClient supports Alarm management which allows the server to display and respond to
particular situations (events).

Alarm Management

Please follow the steps below to configure Alarm management:
a. Select the station from the hierarchical management tree.

b. Click Configuration > Alarm Management on the menu bar (or right-click the station
Alarm Management).

Camera Management

Station Management...

Logical Tree View Management...
/O Box Management

[ (M Mega-P

User Management...

Association Management...
I Alarm Management... l

—

: m_ Camera Management

Station Management...

Logical Tree View Management...
I/O Box Management

User Management...

Association Management...

: Alarm Management...
P Recording St Wirtual Matrix Management 4 e »
t irtual IMiatrix Mianagemel
: Failover Management 2
B Layout K Failover Management 4
= Py 1/O Box Search VivoCam Switches..
& ‘,’ DA Search VivoCam Switches...
Station Settings 4
Client Settings » Station Settings »

and select

c. The Alarm Management window will prompt. Click New to configu}'el a new event. Enter a name and
description for the new alarm. When you finish the general settings, click Next to set up trigger source
settings. The Alarm name you specify here will be displayed on the Alarm panel in the Live view.

An alarm is associated to one or more interested events, YWhen one of them is triggered, General e Trigger . Action iy Schedule e Detail
the systern would raise an alarm.
Alarm List
) ) [¥1Enahle this larm
Enable  Mame Triggers Actions Schedule
° ADAME.. DL1(Trigger) ... TumnDO-3 (AD.. Always [7]Enable five notification
° IPE155... Motion-1 on Me... Start torecord ... Always MName:
Description: " l‘
—
Trigger Period; | 5 {secy O FD— 30
Detect next event after 5 s
’ - | =
Edt | | Femove | [Detals» Close I [ ek | mee J)[ e | e ] |
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d. Click Add to select the trigger source by Device or Trigger Type.

General == Trigger =» Action = Schedue -  Detal

4 Add Event |E| {il

add Event by: @ Device () Trigger Type

Category: [C_a_njera. Events ._v]

[ Remore
[Lmade J[ moe | [ Fren | [cancel ]

Note that the Motion detection windows are separately
configured using web consoles with each individual
cameras. Open a web console with the camera to configure
Motion detection windows.

The Storage Status includes: Storage connection status
and storage capacity status on NVR systems.

Each individual motion detection window can be used as a
triggering condition. The Line Crossing and Field Detection
packages running on cameras also apply as triggers.

7 [EM Mega-Fixel Network Camera(192.168.6.127)

v Mation-1
| & Matian-2 Wideo LossfRestore
Motion-3 PIF.

g DI-1 Tampering

[T & Tampering = Temperature
[ & Mega-Pixel Network Camera(192.168.6.217) IR
-7 C&P Mega-Pinel Metwork Camera(192,168.6,101) Iv & - Moving Object
[T S NDS321(192.168.6.208) v, - Loitering Detection

IV - Camera Tampering
P-PTZ

& g

\Field Cetection

If you connect your DI/DO devices via an 1/0 module (I/O box), please refer to page 307, Appendix E
Support for Digital /0O Modbus TCP Modules for details.
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There is a new event trigger type, P-PTZ. The P-PTZ refers to the occurrence of Auto Tracking action in
a Panoramic PTZ configuration.

m S J Auto Tracking is configured on the fisheye camera in a Panoramic PTZ

- configuration.

If you manually configure a detection area for the Auto Tracking function,
the P-PTZ event will not be triggered.

e. The Device List window will prompt. Select one or more devices and set the Notification Type.

Depending on the trigger source, the Notification Type will be different. Then click OK to close the
WIndOW. % Device List-Connection Status E3 i 2 . =5 [
Select the trigger(s) from the folowing list, Select the trigger(s) from the following list,

= WY TK_Station1(127.0.0.1) || =-F ! WVTK_Stationl 0.1}
w 1_FDE161(192, 2] -7 @M Mega-Picel Netwark Camera(192, 168.6,228)
-7 4 Motion
7 i DIl

[T & Tampering
i 20x zoom Mega-Pixel Speed Dome Metwork Camera(152,
@@ Mega-Pivel Metwork Camera(192, 168 .6,127)
-t Motion
[ i DL
F & 001
-V b Tampering
 w PPTZ
=] 20x Zoom 1080p Speed Dome Metwork Camera(192, 168,
[ (A Mega-Pixel Metwork Camera(192.1658.6.228)
O MDB401(192.168.6.128)

<

Trigger Period E (sec) O 07 20

Maotification Type I |

AN m_ ] +
() Connected (&) Lost |

(o ] [comet ||

f. The trigger source(s) will be listed on the window as shown below. If you want to add more Trigger
sources, click Add and repeat steps d. to e. Then click Next to assign action(s) to the trigger source(s).

g. Click Add to open the Action Settings window.

ew Alal

Gereral .. Trigger .. Action .. Schedue .. Detal | General

ww  Trigger ..  Action .. Schedule .. Detail

@| Remove |

| Back | [ Mext | | Frich | [ Caneml ] ||
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Note that if your camera is using Sony's SR-WM series cards, SD card status events can be used as a
trigger.

The event messages look like the following:

Normally Functioning The SD card is inserted and there is enough lifespan remaining.
Replacement Recommended |Has reached xx% of the SD card's lifespan.

Has Reached its Lifetime All the spare blocks have been consumed. The card is read-only.
Card Not Inserted No SD card is inserted.

Failed to Get Status Unexpected error has occurred.

-
4 Alarm Management EI@
An (RGTrggertet T e e,

the

Select the trigger(s) from the following list.

A

gy N s seton(127.0.0.1)
= [7 @D FED391-EV(192.168.4.161)

=[] igh Motion-1

-] igh Motion-2

-7 g Motion-3

-] igh Motion4

-] tglh Motion-5

[ it DL1

[ i DO-1

-] il Tampering

[V g Smart SD Card

-] i Audio Detection

- [ G@ FED1012(192.168.4.171)

- B 3_102.168.4.124(192.168.4.124)
w7 (@) SD9161-H(192.168.4.164)

w7 (&) FDO381-EHTV(192.168.4.124)
e[ . VMS5_5tation(192.168.4.156)

- [ @ NDIS41(192.168.4.157)

)

T E]]
[NewJ{Edrt]lRermveJ{Deﬁi>>] Close

The related event messages will prompt on the event list. On seeing the Smart SD events, you
should replace your SD card.

£| Instant Playback MName T Description Source T Event Type T Value Time T State T
o Alrm-3 FE9391-EV Smart SD Card Trigger 2017-09-07 16:19:43 New
O Alrm-3 FE9391-EV Smart SD Card Trigger 2017-09-07 16:10:19 New
é Alarm-3 FE9391-EV Smart SD Card Trigger 2017-09-07 16:09:43 New
a Alarm-3 FE9391-EV Smart SD Card Trigger 2017-09-07 16:06:58 New
Alarm-3 FD9381-EHTV Recording Status Stop 2017-09-07 16:01:04 MNew

The Tampering, Audio Detection, and Shock Detection are also available as a trigger source
with cameras that support these features. Shock Detection is available for cameras that come
with an acceleration sensor.

=
@ Triggerfist
‘Selact the trigger(s) from the following list.

=-r B
r 8132(172.18.204.43)
[C EN P8132(172.18.204.45)
[T &3> FEB180(172.18.204.49)
- & rp8162(172.18.204.38)
& rD8162(172.18.204.39)
[~ EM 188382-T(172.18.203.10)
" M CD8371-HNVF2(172.18.2.32)
[ g Motion-1
~-[7 g Motion-2
T &b Motion-2
™ &b Motion<4
T & Motion-5
[ & DI
[ & DO-1
"] i Tampering
[t Smart SD Card
~-[7 g Audio Detection
-7 4 Shock Detection

7.0.0.1)

oo

[T e e e
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There are several types of Action Settings.
® Email: The sever will send a notification via e-mail when a trigger is activated.

h. To enable this function, please set up the SMTP server first. Click SMTP Setting to open the window
and refer to page 165 for detailed information.

i. Enter the related informtaion. You can modify the mail content in the blank. If you want to modify the

content, click Insert Macro to select the parameter When completed, click OK on the bottom to

enable the setting.

Note that you can insert a snapshot
taken by the time of alarm occurence
of the recorded video. The snapshot
will be sent along with the notification
Email. The snapshot comes from
camer's stream 1.

triggered.

Content:

At $(EventTime), event type -

[$(Trigger Type)] occurred o
$(DeviceMame) - -

P

() Start to record on

I A=

j. Click Add Camera to select the target camera(s).
k. The selected camera(s) will be listed on the left wmdow below. When completed, click OK on the

bottom to enable the setting.

) Email o

(@ Start to recard on ]

) Move to preset location
) 5et DO
() 35M shart message

when an event is triggered.

Add Camera

Remave

NPT LT

D LR LAV e

m Start to record on: The sever will start to record video from selected camera(s) when an event is

:

Mega-Pixel Network Camera

Mega-Pixel Metwork Camera

= Move to preset location: The target camera(s) will move the shooting area to the preset location(s)

I. To enable this function, please configure some preset locations on the camera configuration page

first.

m. Click Add Location to select preset location(s).
n. The selected preset location(s) will be listed on the left window below. When completed, click OK on

the bottom to enable the setting.

@ Move to preset location

Add Location

7 5et DO
) G5M short message
D HTTP

Remove

&4 Action

=)

Select the preset location(s) fram the folowing list,

= B wyTk_Station1(127.0.0.1)
2 BDAM-6052(192, 1686, 136)
ena-Bixel Hietwark Camera( 169,254, 164,215)

loweer left
n corner

right

Lpper rlght

5 WOrK Camera(169.254,203,96)
- M Mega-Pixel Network Camera(192.168.6.218)

m
—

o
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m Set DO: Select this option to turn on external digital output device(s) when an event is triggered. For
more information about how to set DI/DO settings on the target camera, please refer to page109.
o. Click Add DO to select DO device(s) and select a DO status (Normal or Trigger).
p. The selected DO device(s) will be listed on the left window below. When completed, click OK to

enable the setting.

I () Start to record on
) Mowe to preset location
@ set DO

Turn DO-1 (Mega-Pixel Metwork Carmera) to

(Em)

< | m | r

) GSM short ressage

Remove

Select the Tirgger Period from the slide bar below.
The range is 0 to 30 seconds. The DO trigger
signal will return to normal after after this period of

time.

Note that the Trigger Period setting does not apply
to the camera DI/DO managed by substations.

Select the DO(s) from the following list.

= Bl wwTk_station1(127.0.0.1)
g ADAM-0S2(192, 168.6.136)

[ otk Cameral 169
Q' ega-Hixel Metwork Camneral169

-------- EM Mega-Pixel Metwork Cameral192

< m r

Notification Type
(1 Mormal
@ Trigger

Notification Type
) Normal
© Trigger

Trigger Period: 0  (sec) 0 [} 30

oK Cancel

m GSM Short Message: The sever will send a short message to a GSM cell phone when an event is

triggered.

g. Please enter the Phone Number and open GSM Settings window to set related information if
necessary. When completed, click OK to enable the setting.

|
L.

)

) Emall

(") Start to record on

) Move to preset location
)58t DO

@ G5M short message

Phone Murnber:

CIHTTR
7 Client MNatification

) GSM mai;‘ficatjo 1 - COM Por

GSM Settings

SIM PIM Murrber:
COM Port Mumber:  |COM1 - = |

Bits per second:

Data bits:

Parity;

Stop hits:

Flow contral:

Please enter the country code if you use overseas call.
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m HTTP: This function allows user to send a CGlI command to the linked network camera, such as pan/
tilt/zoom function or enable DO devices.

r. You can click Insert Macro to select the parameter. Please enter authentification information
if necessary. For example: http://192.168.3.66/cgi-bin/admin/setparam.cgi?system_
hostname=$(EventTime) $(CameraName)

If you want to use special characters such as $-_.+!*'()#%+$,@:;/?=&, please refer to the

following table to transfer the Code (Hex).

For example: http://192.168.3.66/cgi-bin/admin/setparam.cgi?system_hostname=123&456
--> http://192.168.3.66/cgi-bin/admin/setparam.cgi?system_hostname=123%26456

@ HTTP
LRL: In=ert Macro
ication: [T
Use authertication:

Character Code (Hex) Character Code (Hex)
! 21 , 2C
# 23 - 2D
$ 24 . 2E
% 25 / 2F
& 26 : 3A
' 27 ; 3B
( 28 = 3D

29 ? 3F

* 2A @ 40
+ 2B _ 5F
= TE

= Client Notification: On the occurence of an event, a pop-up window will display to show what is
triggering the current event. Select the window size, and select the display duration of the notification
window. If not selected, the notification window is manually closed.

Include the event triggering camera: You can select to
display the screens of other cameras (e.g., cameras
that are closely adjacent) when the notification
prompts.

) Emnail

) Start to record on

) Move to preset location
) 5et DO

@ G50 short message 20y Zoom 10807 Speed Dome Natwirk Cameta
EHTTP

| @ Client Notification

MNaotify me with Popup Window . Size:

=
[T Close it autornatically after I-_‘J seconds

[V11rclude the event-triggering camera

23S TR 008

Add Camera
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s. The action(s) will be listed in the window as shown below.
Then click Next to set up schedule(s) to the action(s).

For more information about Schedule Settings, please refer to Recording Schedule Settings on page
141. You can assign more than one time frame to one action.

General .. Trigger .. Action .. Schedue ..  Detal General ..  Trigger .. Action ..  Schedule ..  Detal

to Trigger Loaq.'[em;:g[ail:g:] ’.=5‘1V'5.’.‘?5..T!3ml3]a,t?. ]
0 Trigger = e

Time Frame

| add | | remove | [ add || Edt | Delete | [ W | Down |

i Back l Mext '| Finish |’ Cancel ] I . ’ Back ][ Mext ] | Finish |[ Cancel ] |

Time Frame Mame:;  Blways [

| Load Templste | | Save as Template | | save

Repeat Frequency: ’_‘,{y{egkl}_g; Setting (Day-based) vl

weekly Setting (Day-based)

Set time segments in a 24-hour day. Multiple segrments are allowed.

Start Time: oo E' oo E

End Tme: 00 (5] 00 5] [ add | [ Delete |

Repeat on: [VISunday  MIMonday [V Tuesday  [Viwednesday [V Thursday  [VIFriday V] Saturday

R.ange
Start: 2008/12f 8 = End: () 2095f 1/ 1 -

@ Mever Stop

Repeat every I_E Week(s)
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t. When you finish schedule settings, click Next to review the detailed information of the new event
settings.

| General .. Trigger .. Action .. Schedule .. Detal

| Load Template | | Save as Template |

Tirne Frame Rule _
Blways weekly Setting (Day-hased)
add || Edt || Deete | | U | pown |

| Firisk | ’ Cancel ]

u. Following is the detailed information of the new event setting. You can click Back to modify the event
setting or click Finish to close the window.

ew Ala

General ..  Trigger .. Action ., Schedue .., Detai

Bescription: -
Triggers:
* Motion-1 on Mega-Pixel Metwork Camera, Trigger Period © 5 (sec
* Motion-2 on Mega-Pixel Metwork Carmera, Trigger Petiod @ 5 (sec
* Motion-2 on Mega-Pixel Metwork Camera, Trigger Period @ 5 (sec
* Tampering on Mega-Pixel Network Carnera, Trigger Period @ 5 (s
Actions:
* Turn DO-1 (ADAM-6052) to Trigger
* Turn DO-2 (ADAM-6052) to Trigger
Schedule:
* Dhways

< I | »

i ([Come ) e | Comn ) o |

v. Following is an example of an enabled event. You can click New to set up more events or click Close
to exit the window. -

An alarm is associated to one or more interested events, When one of them is triggered,
the systern would raise an alarm,

Alarm List

Enable  MName Triggers Actions Schedule
()  fDaME.. DL1(Trigger) .. TumDO-3 (AD.. Always
° IP2155... Motion-1 on Me... Start torecord ... Always

alarm-2 Motion-1 on Me...  Send client noti...
° Alarm3 Motion-1 on Me.,.  Tumn DO-1 (A0, Always

Click to remove the event

Hew l[l Bt ([oemove g@au.eal

ﬁé Click to disable or modify the selected event

If your target station has sub-station(s), the trigger sources can be selected from the device(s) under
the sub-station(s); while the actions can only be performed on the device(s) under the target station.
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Alarm Notification Windows

With multiple alarms simultaneously triggered, the notification windows will appear consecutively at the
four corners of the screen. With more than 4 alarms, the latter notifications will appear on top of the old
ones at a slightly shifted position.

Alar Alarm notification

1 Alarm notification 2

Alarm notification Alarm notification

3 4

Fisheye Motion Windows

When fisheye cameras are configured with Motion Detection windows and their motion events are
triggered in the notification windows, they display in a more comprehensive dewarped, regional view.

If the Alarm triggering condition is configured as DI (digital inputs) or other inputs, you can configure the
Alarm Action as displaying Client Notification as well. You can select the "Include the event-triggering
camera," to display the pre-configured motion windows. The fisheye cameras' motion windows display in
the dewarped mode.

Select the camera(s) from the following list.

SRl B vus_station(127.0.0.1)
-7 @M 1B9381-HT(192.168.6.170)
-7 &@P FEB182(192.168.6.209)
[T & Default
Motion-1
Mation-2
Mation-3
Mation-4
7 g Motion-5
- €8P FEB191({192.168.6.177)
7 &) FDO381-EHTV(192.168.6.102)
-7 €&P FE9181-H(192.168.6.105)
i Motion-3
¥ Motion-4
“ Motion-5
-7 (M IP8166(192.168.6.160)
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Export All Logs

In the Playback utility, you can select the Log Viewer tab window, display the past events, and export all
event logs to a CSV file.

_System | Edit | Yiew | uration | Layout |

c

Log Viawar [

Index  Time Tie Zore Category Level  Type Resutt User Taiget Des
MS_Smtenl127.00.1) F 160613 14:42:95 +0E00 Operaton Log  Normel  Logn Success admn Lol (Y
z 2016-06-13 14:55:12 +0E00 Operston Log  Wormel Update Abm Manage.. Success admh Local sch
ES 20160013 14:36:52 +0E:00 Operston Log  Mormed  Update Al Manage...  Succass admin Logl =ch)
4 2016-08-13 14:37:15 0800 Operston Log  Mormad  Updata Ak Manage...  Succass adrmin Lol =ch)
5 2016-06-13 14:57:30 +0e00 Event Log Hih  Marm Trigger Success Local Ahar
6 2016-06-13 14:57:30 +0e00 Event Log High  Aarm Trigger Success Local Al
7 20160613 14:57:30 +0E:00 Event Log High  Alarm Trigger Succes Local Al
8 20160613 14:57246 +08:00 Event Log High  Alar Trigger Success Loal Alar
9 20160613 14:57:46 +0E:00 Event Log High  Alarm Trigger Buccess Lol Alar
i 2NE06T 14576 <0800 Event Log High Al Tiigger Success Lol LU -
11 20060613 145506 <000 Operation Log - Mormel  Loghn Success  adri Logl (¢t
Al £
|
‘EMT208:00 Baging, Chongging, Hong Kong, |«
2016 §13 - 135002 |
2016) G153~ ) 14502 |

| Traco Logn Actwiss
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How to Manage the Virtual Matrix

Virtual Matrix is a very useful tool for multiple monitor display and management. Based on the
whole surveillance system architecture, it efficiently helps user construct a real-time live video
wall in the control center. Under a large-scale hierarchical system, through VAST LiveClient
you can only simultaneously monitor up to 128-CH on dual monitors; while Virtual Matrix offers
fully extension for numerous channels and screens, thus making VAST a very powerful central
management system. Moreover, you can change the layout to 2x2 or 3x3 on each monitor
to enlarge the video size, then display the video pages on saperate monitor for close-up
monitoring.

VAST-64-CH on dual monitors

The architecture of VAST Matrix

As shown below, the surveillance system architecture is composed of VAST LiveClient, VAST Server with
two sub-stations, and VAST Matrix separately on individual hosts. Before constructing the Virtual Matrix,
please install and run VAST Matrix Program on Matrix Recipient connected with the video wall. Through
the Virtual Matrix connection, you can use LiveClient to log in the root server to remotely manage and
display all the live view onto the video wall by easily drag-and-drop. PTZ control is also available as on
the LiveClient.

VAST "l@ VAST Server | VAST Matrix i
LiveClient | - _L>O (Root Station) - Recipient1 — '_I’I_I“

: ~ 1 VAST Matrix :
VIVOTEK IP Camera .| Recipient 2 e

VAST/ST7501 Server
(Sub-station)

Video Wall

2288288

e i - -

VIVOTEK IP Camera

VIVOTEK IP Camera



Installing VAST Matrix Program

Please follow the steps below to install VAST Matrix Program:
a. Run VASTMatrix_setup.exe on another host (Matrix Recipient). Then click Next to start installation

wizard.

VASTMatriw_setop

Installer Language

@ Please select a language.

|English - |

|. Ok Cancel |

HF YAST Mairix Setup

=]
Welcome to the VAST Matrix Setup

Wizard

This wizard will guide you through the installation of YAST
Makrix.

It is recommended that vou close all other applications
before starting Setup. This will make it possible to update
relevant system files without having ko reboot ywour
carpuker,

Click Mext to continue,

Cancel
i

b. Carefully read to accept the End-User License Agreement for use. Click | Agree to the next step.

c. Choose the installing path as the destination folder, the required space and available space of the hard
disk will be shown below for reference. Click Next to the next step.

=

B TAST Matrix Setup

.4

=

B YAST Matrix Setup

S
-~

License Agreement
Please review the license terms before installing WAST Matrix.

i)

Press Page Down to see the rest of the agreement.

End-User License Agreement

PLEASE READ CAREFULLY: This End-User License Agreement ("EULA" iz a
legal agreement between VIVOTEK Inc. ("VIVOTEE") as lcensor, and you, as
licensee, for the VIVOTEK software that accompanies thiz EULA, which
includes the video management software VAST Matrix V1 and other applicable
software (the “Software™. YOU AGREE TO BE BOUND BY THE TERMS OF

SOFTWARE OR CTICKTHNG THE RIITTON R ARKED “T AGRFE” OR “YVES™

IF wou accept the terms of the agreement, click I Agree ko continue. You must accept the
agreement to install WAST Matrix.

THIZ EULA BY INSTALLING, COFYING OR OTHERWISE UZING THE =

l < Back. [ 1 Agree J [ Cancel

]

— Choose Install Location

'—JA‘) Choose the folder in which o install YAST Matrix,

Setup will install WAST Matrix in the following Falder. Toinstall in a different Folder, click
Browse and select anokher Folder. Click Mext ko continue,

Destination Folder

Browse. ..

C:\Program Files\WIVOTEK InciwAST Matrix|

Space required: 21,7MEB
Space available: 69.4GE

l < Back [ Mext = ] [ Cancel

]

d. Fill in the connection information with Port, Account & Password for VAST Server to connect to the

Matrix Recipient. B VAST Mot Setup

: &
1 J .
| ¥ A )
Part:
HTTPS Port:
Account:

Password:

Confirm Password:

Connection Information

Please enter your connection information.

3455

root

o] B /===

< Back Install | | Cancel




e. Click Finish to close the installation wizard, and you might want to run VAST Matrix immediately after
installation by selecting the option Run VAST Matrix.

i VAST Matrix Setap ==

Completing the VAST Matrix Setup
Wizard

WAST Matrix has been installed on your computer,

Click Finish to close this wizard,

Launching VAST Matrix

Please follow the steps below to install VAST Matrix Program:

a. Click the desktop icon to start VAST Matrix. When it's begun running, there will be a VAST Matrix tray
icon on the toolbar for the user to configure easily.

532 @l
VAST Mateix

b. The VAST Matrix live view window with multiple types of layout will be displayed. The following shows
32-channels layout.

c. Right-click on the live view window, a function menu will pop up. You may also open the menu by
right-click on the tray icon.

Configuration...
View Sethings. ..
Language 4

Display Client Information
A hont
Fwit




Configuration
m Connection: Enter the account, password and port information for the VAST Recipient.

= Monitor: It shows the monitor(s) connected to your host. You can select the monitor(s) you wish to
display as the video wall.

m Others

Auto launch at windows startup: Select this option if you want VAST Matrix to launch when windows
starts up in case to avoid the computer reboots by itself and accidentally shuts down VAST Matrix.

Display key frame only: Select this option to display live video with the key frame only in order to save
the bandwidth. It also lowers down the CPU loading and memory usage.

Enable de-interlace: Select this option if your linked device does not support de-interlace function. For
example: VS7100.

& Configuration ﬁ] & Configuration ﬁ] B8 Configuration l& ’
— _ . — . -_—
| Connection [ monitr | Others | | Connection | Moritar | Others | i | connection | Manitor | Others |

Part: 2455 = | Use only the checked manitars: [] Auto launch at windows startup

| :
HTTPS Port 444 : W Moritor 1
Account: root J
Paszword: sssssane

Confirm Password:  eeesssss

| oK | | Cancel | I [ o | | cancel

View Settings

Please refer to page 187 for detailed illustration.

About
This dialog that shows the version of VAST Matrix and the simple statement of the version copyright.
BE About WAST Matrix - h - &J
. =
H VAST Matrix 1.12.1.3
I A&l rights reserved. Copyright @ 2009-2016 WIWVOTEK INC.
hittp: ffnewewy vivotek. com
WINVOTEE iviewer
Please click QR code to purchase.
. Product Information

Exit

Click to close the VAST Matrix.

£ Available on the
[ ¢ App Store
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VAST Matrix Management

Once the VAST Matrix Program is setup completely, the next step is to connect the VAST Server with
VAST Matrix Recipient(s). Use LiveClient to log in VAST Server, then click Configuration > Virtual
Matrix Management to configure Matrix Management and Matrix View Settings.

System | Edit | Vi | Configuration | Layout | Help)

ént »
Station Management.__
Logical Tree View Management...

= ! VMS_Station(127. /O Box Management p HX View
- B camera
@ o381 User Management... :Esewer p’, Monto
Association Management...
oo ENEs182 S
arm Manageme:
- 5 FEB191 : !
w FDaa81 Virtual Matrix Management »

Matrix Management...
@@ FEorsy  SearchVivoCam Suitd B
- (B IPB166 Station Settings g
- [ Recording St Client Settings
- [ Layout

B o Box

Matrix Management Settings
Please follow the steps to set up VAST Matrix Recipient(s):

a. Click Configuration > Virtual Matrix Management > Matrix Management to open the Matrix
Management window.

b. Manually enter the Matrix Recipient Info as previous settings, or you click the search button to
search for the Matrix Recipient(s) on the LAN.

The Managed by menu allows you to let a LiveClient instance manage the Matrix configuration. In
normal uses, the configuration is managed by the VAST server. @

VAST_’* Matrix
Server

VAST

LiveClient

c. When the information of the target recipient is filled in, you can use the detect button E to confirm if
the filled information is correct.

d. Click Add, then the recipient will be displayed on the Matrix Recipients list window.

Matrix Recipients
a4 OList. the matrix recipients which are nat inserted -
Mame Address Port Type :
I — (@ List all ratrix recipients
(& Wetrixserver 102.168.6.143 3455  Server E [
- Matrix Recipient List
MALC | Addrass | Model | HTTP Port |
00-18-F3-E9-72-1F 192.168.4,.139 WMFS02 3435
Matrix ipient Info
Managed by: Server - @
Name:
Address:
Port: 3455 ] Bluse ssu
Server Address: |
Account:
Password:
n ¥
Model:

Edit display settings e
Update Close
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g;

When entering a server address, please avoid entering the XML-related characters: <, >, &, ', and ".

e. Click Edit display settings to set up the viewing interface for the monitors (video wall) connected to
the Matrix Recipient host.

The Matrix View display is capable of executing rotation. The
[“lEnable deinterlace default interval time is set at 10 seconds.

[ isplay key frame only

I oK I Cancel

Rotation Interval Time: 10 seconds(3~993)

f. If you want to set up more Martrix Recipients, repeat the above steps.

g. If you want to modify the Recipient Info, select it from the list to change settings, then click Update to
enable the new settings.

h. When all settings are done, click Close to exit the Matrix Management page.

=8
Due to the limitations imposed by the Windows UAC (User Account Control), you need to right-click on
the Matrix icon to display and "run as administrator," after you close and re-start the Matrix utility.
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Manage VAST Matrix through VAST LiveClient

Once the setup is complete in Virtual Matrix Management, you may go back to the main page of
LiveClient, the connection between VAST Server and VAST Matrix will be working successfully. Then
you can choose Matrix Recipient and the monitor from the drop-down list for the operation control. Some
buttons on the quick access bar will be disabled when you switch from the Live View Panel to Matrix
View Panel.

® Change the layout

As the following picture shows, you can click to change the layout and set new layout group on the
Matrix View Panel using the methods same on the use of the LiveClient. The layout on the monitor (video
wall) will also change synchronizely once you change the layout on Matrix View Panel.

| System | Edit View Configuration | Layout | Help )

= B wuTk_station1(192.1¢68.4.189) P Live View | [ Matiix View
= B Camera it
w - @& Outdoor Metwork Speed Dome (102,168.4
£ F 1
- B Hetwork Camera(192.168.4.208) Outdoor Network Speed Dome 2010{09/07 P -
& N Mega-Pixel Netwark Camera(192,168.4.122 A VI e WM w5
P recording Storage &

- Layout
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m Connection status

If the VAST Server is not able to connect to the Matrix Recipient, the status icon .’will become .0’
and show the reason of disconnecting when you slide the mouse to the connection status icon. The
"Connection Lost" string will be displayed on the Matrix View window as shown below.

o G| 1

| Matrk Racgiens: |Recpient_2 [z] @ woreae |1 _—|

Connection Lost!

m Rotation

VAST Matrix is capable of executing rotation by clicking @ You can even select another layout group
on the Matrix View window without stopping the rotation. If you want to adjust the rotation interval time,
please refer to Edit display settings on page 126 for adjusting.

m PTZ
VAST Matrix currently does not support PTZ control.

Eemaove
m Matrix View Menu

Right-click on the window to open the menu. * Stream 1
Remove: Remove the channel from VAST Matrix. Stream 2

Stream 1 ~ 4: Switch the camera stream between 1 ~ 4. stream 2
Streaim 4

® Remove All Connections
It's capable of removing all connections from VAST Matrix once by clicking on button.

Matrix View Settings

Click Configuration > Virtual Matrix Management > Matrix View Settings to open the window.

m Media Source

You can choose the path of media source from camera directly or the CMS server to display on Matrix
View.
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m Display Settings

Media Source
@ From camera
Using multicast
i2) From server
From substation
Display Settings
1 Full frame rate
@ Key frame only

| oK

To configure Multicast video streaming for Matrix,

Using Multicast configuration help preserve cameras' system resources while streaming video to a
Matrix machine. Before applying the Multicast settings, the related network settings should be properly
configured on the individual network cameras.

1. Open the web console with the individual network cameras.
2. Enter the Configuration > Network > Streaming protocols window.
3. Change the Multicast settings for Stream 1 on each camera.

Note that it is very important to configure a unique Multiple Group address for each camera.
Otherwise, images on the view cells will be overlapped, rendering the Matrix view useless. You can
also configure the unique Multicast video port into a unique number.

[P srwamng | w159 srvaming

Streaming protocols
DONS
s
SHME
Security
PIZ
Evont

Applications

Authentication:

Accags name for slieam 1

Accass name fr sieam 2

ALLasS NAMB for straam 3

AC02E8 NEME 10 Sir2Am 4

RTSP port:

RTP pori for videa:

RTCP port for wdeo:

RTF pon for metadata:

RTCP port for metadata

RTP port for sudic:

RTCP port for audio:

e Muihcast settngs for stream 1
1 Always mulicast
Muiticast group address:
Mhhcast video port:
Mutticast RTCF video port
Muticast metadata port:
Muiticast RTCP metadata port
Mutbrast aucho port
Iuticast RTCE audia part:
Musticast TTL [1~255]:

** hiultizast settinga far stream 2
[ Abways maticast
futicast group address
Mutticast video port.
Multicast RTCE video port.
Puiticast metadata part
Mutticast ATCR metadata port
PMuitcast auco port

230128 1.400
5554

e

E584

6505
5566

System
Media
Hetwork

General setiings
Str=aming protocols
DONS

Qo5

SNMP

Security
P
Event

Applications

TP streaming || RTSP streaming |

Autherscason: [basie _w|
Accass name: for straam 1 Iva.sdp
‘Access name for stream Z Ivez sap
Access name for straam 3 el sdp
Actess name for siream 4: _Ii_uz-isdp_
RTS# port: 564
RTF part for vioso: 5556
RTCF port for video: T
RTF pert fof metadata: e
g port for metadata sk
RTF port for g 5558
RTCF part for sudic: = |
“ Mullleast setlings far stream 1
] Aways mutticast
Multicast group acdrass: |ESEREREE
Muiticast videe part |ss78
Mudticast HTCP videa ot |ss7m
MuinCass MEREa por: ﬂﬂ
Multicast A TCP matadata port [ZE
Muiticast audio pert |ss82
Multicast RTCP audio port: Er

Multicast TTL [1-255]

“ Wullicast setfings for seam 2
[] Aways matkast
Multicast group acdress.
‘Multicast vides part:
Mulbcast ATCP video port
Mulhcast metadata port:
Wuibcast RTCP matadata ot
Multicast auia pert

Note that if you change the adress, the same address for stream #2, #3, and #4 will change

accordingly.
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The 239.0.0.0/8 address range is assigned by RFC 2365 for private use within an organization.
From the RFC, packets destined to administratively scoped IPv4 multicast addresses do not cross
administratively defined organizational boundaries, and administratively scoped IPv4 multicast
addresses are locally assigned and do not have to be globally unique.

When finished with configuration, you can use the Wireshark utility to test the presence of multicast
packets.

If you select the Always Multicast checkbox on the configuration page, multicast traffic will always be
detected whether or not the Matrix settings have been synchronized or started between server and the
Matrix machine.

File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help

Am e LERBRe==F sEQAQQR

(W] £00ly 2 display filter -+~ <Ctel-f> =0 -] Bxpression= | +

Filte: Expression Preferences-+ Label: Apply this filier Filtsr: Enter o display filler -~ [ ok || camae |

o T Sonis Destinatinn Protwol  Length  Inf -
1 0.000000 192.168.6.217 239.128.1.185 upp 1298 5576 » 5576 Len=1256

i Frame 1: 1298 bytes on wire (10384 bits), 1298 bytes captured (18384 bits) on interface @

i Ethernet II, Src: Vivotek_3e:1d:97 (80:02:d1:3e:1d:97), Dst: IPvAmcast_01:69 (81:80:5e:00:01:69)
& Internet Protocol Version 4, Src: 192.168.6.217, Dst: 239.128.1.1@5

» User Datagram Protocol, Src Port: 5576 (5576), Dst Port: 5576 (5576)

» Data (1256 bytes)

0000 91 99 Se 99 81 69 88 82 dl 3e 1d 97 @8 @@ 45 8@  .."..i.. .>....E. -

0010 85 B4 df a9 48 80 8f 11 ce d4 @ a8 86 d9 ef B0  ....@... ........ [

0020 81 69 15 c8 15 c8 84 f8 2c Be 90 e3 5d d@ 11 84  .i...... P P

0030 83 58 23 8e 1f 29 80 88 00 Oe 00 00 01 34 80 00  .X£..).. .....4..

0040 94 d4 68 32 36 35 18 8@ 22 15 @c 57 55 al b3 8@ ..h265.. "..WU... Il

@ 7 multicast stream date-1 || Packets: 27607 - Displayed: 27607 (100.0%) - Load time: 0.0.477 || Profile: Clossic ‘:il

You can choose the display frame rate in the Matrix view as full frame rate or key frame only.
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Search VIVOCam Switches

Use the serach managed switch function to locate and open a web console with the managed
switches. Double-click on the entry found to open a web console.

Camera Management 4
Station Management...
Logical Tree View Management...

I/O Box Management 3
- PRy Camera

& sooiel
@& FER191

User Management...

Association Management...

Alarm Management...
i w Mega-F
‘... [EM [BE33E Virtual Matrix Management 4
- [ Recording St Failover Management 3
e [ Layout Search VivaCam Switches
- B 1/0 Box Station Settings L4
Client Settings r
Video Enhancement »

VivoCam Switch List

MAC Address Model HTTP Part
00-02-D1-32-A0-D2 192.168.6.126 AW-GEV-2644-370 80
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How to Configure the Station General Settings

Select the target station from the hierarchical management tree, then click Configuration
> Station Settings > General Settings on the menu bar (or right-click the station on the
hierarchical management tree and select Station Settings > General Settings). The Station
General Settings window will pop up.

<8

LSyslem | Edit | View | Configuration | Layout | Help_}

Camera Management 3

(IJ E’l G | 4 I Station Management...

Logical Tree View Management...
e Bl vms_sttion(127. 1O Box Management ;
m User Management...
s II:Z?E‘:SBEI Association Management...
52 FES183 Alarm Management...
&8 resiod Virtual Matrix Management (|
; & rpo3s Failover Management »
2D re91s) Search VivoCam Switches...
=12 b Recording 5t > P —
& B Defaik ient Settings r Recording Storage Settings
g g Recording Schedule Settings
. RN FEGTEZ Scheduled Backup Settings
-G8 FES191 Server Settings [3
- K@ FDO3BI-EHTV Relay Settings

i ! VMS_Station(127,0.0. 1) [T
B S Carmers Camera Management
L GZP FEO3Y Station Management..
LG8 FEB1Y Logical Tree View Management...
_ og g
oo M 3_193 /O Box Management 3
Bl B Recording 5 User Management...
P 1o Box

Association Management...
Alarm Management...
Virtual Matrix Management

Failover Management

Search VivaCam Switches...
Station Settings General Settings
Find... : B, £

Recording Storage Settings
Recording Schedule Settings
Scheduled Backup Settings

Server Settings 3
Relay Settings

Output Streaming URL
Output Camera List
Get PublicIP

Server Settings

In this section, you can modify the Station Name.

Log Settings
In this section, you can set up Log Settings for the station.

The VAST server allows user to search for the recorded [tz BT
log through VAST Playback. For more information, Server Setting
please refer to How to Search Logs on page 263.

m | og level: Select High (only record high-level logs),
Normal (record high-level and normal-level logs), Low
(record all logs). For detailed information about log Log Settings

levels, please refer to page 264.

m Reserve Time: Enter the time interval that you want

to reserve the log record. The maximum value is 365 Resarve Time: _3 day(s)
days.

Station Mame: '|_|'"'|_|"T|‘=:: Stationl |

[ (8] 4 J[ Cancel J
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How to Configure Station Network Settings

Select the target station from the hierarchical management tree, then click Configuration
> Station Settings > Network Settings on the menu bar (or right-click the station on the
hierarchical management tree and select Station Settings > Network Settings). The Network
Settings window will pop up.

4 LiveClient

(__System | Edit | View | Configuration | Layout | Help )

Ol j=5060

Logical Tree View Management.

2 B vms_station(127.

- By Camera
(@ 189381
& roa3se
= Fem18z
@ Fes19]
- & FDO381
@ rE9181,
= BS Recording St
= B Defautt
o (BN T

+ i view|

Recording Schedule Settings
Scheduled Backup Settings
L@ resiol Server Settings

9
e
W v
FD9381-EHTY \ K RelaySettings - -

47@4 . = ' ¥ Network Settings

B Juws sttoni27.20 | st v =

o B s :
ation &
b

@D Feo3g Port Settings

@ FEo1g

{— EBE-

& [ Recording §
B yoBox
B Layout

Server port: 3454

RTSP port:  [554 e

PP Settings
[Enable UPAP port: forwarding

[CJEnable UPAP presentation Apply

4

Station Settings

Find
Output Streaming URL
Output Camera List

. - Proy Settings
POI’t Settlngs [CIEnable Proxy

m Server port: The default server port is set to 3454. If you change
the server port, please enter the new value while logging the
LiveClient next time. Fort:

m RTSP port: The RTSP (Real-Time Streaming Protocol) controls the | User Name:
delivery of streaming media. By default, the port number is set to

IP Address:

Passward:
4543,
U P n P Settl ngs Wb Access Settings
® Enable UPnP port forwarding: For client to access the VAST Server e Enetle e Access
from the Internet, select this option to allow the server to open ports

on the router automatically so the video streams can be sent out
from a LAN. To utilize of this feature, make sure that your router
supports UPnP™ and it is activated.

= Enable UPnP presentation: If you select this option, shortcuts to
VAST Server will be listed in My Network Places.

Proxy Settings

In this section, you can enable, modify, or cancel Proxy Settings for VAST Server if your network
devices are set up under a proxy.

Web Access Settings

User can access VAST LiveClient and Playback via Internet web browser
(http://IP address:3454). For local host --> http.//127.0.0.1:3454. See page 103 for
Windows AD account information.

Bask Account
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How to Edit Recording Groups

By default, all devices are assigned to the default recording group. You can manually remove
a device from the default recording group. However, only those devices which belong to a
recording group can produce recorded media files.

Another purpose of setting recording group is that you can divide all the managed devices into
several recording groups, and for each recording group, you can assign several hard-disks (with
recording paths) to store media data. The live media data will be stored in the first assigned
hard-disk initially, and when the available space of the first hard disk reaches the preset
reserved space limit, the media data will be stored in the second disk and so on. If the available
space of the last disk reaches the reserved space limit, the recorded files in the first disk will be
overwritten with the new media data. This procedure is called "Cyclic Recording".

Recording Storage Settings

Please follow the steps below to set up recording groups for a station:
a. Select the target station from the hierarchical management tree.

b. Click Configuration > Station Settings > Recording Storage Settings on the menu bar (or right-
click the station on the hierarchical management tree and select Station Settings > Recording
Storage Settings). You can also right-click DefaultGroup under the station and click Recording
Storage Settings since all devices are assigned to the Default Recording Group by default.

Camera Management
Station Management..

Logical Tree View Management .
=B vms_stabonuy. /O Box Management ol =

User Management

Assodiation Management...

Alarm Management...

Virtual Matrix Management

Failover Management

Ussal
Search VivoCam Switches|
a

tation settings
Client Settings

Video Enhancement

scordn e —
Scheduled Backup Settings
Server Settings

= B wwTK Station1(127.0.0.1)
w - [ Camera
= B Recording Storage

- m iﬂecnrdingsmmge&tﬁngs

Camera Management

Station Management...

Logical Tree Wiew Management...
/O Box Management [3

! User Management...
B 10 Box Association Management...

Alarm Management ...

Virtual Matrix Management 2
Failover Management 3 :

Search VivoCam Switches...
—

General Settings
Metwark Settings '

[ Iieoo!cj(ng S‘pched.u\e S"yeﬂl'ngs
Scheduled Backup Settings

Station Settings

Find...

Qutput Streaming URL
Qutput Camera List
Get PublicIP

c. The Recording Storage Settings window will pop up.

™~
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Default Storage Group Settings

The following example shows the default storage group settings. You can click Rename to modify the

group name or click | % | Delete to remove the default settings.

Storage Group: |Defau|tGrc-up El

Paths in Storage Group

Recovery Storage Path

C:\Record

Storage Information

Total: 916.156 GBytes
Reserved: 91.00 GBytes
Free: T05.73 GBytes

d. The default recording path is D:\Recording. The total space and free space of the disk is shown on
the right for reference.

e. Add Local Path: Click to add another recording path on your local computer. A Select Path dialog
will pop up as shown below. When all settings are complete, click OK to enable the settings, or click
Cancel to discard the settings. The default reserved space is 10% of the disk volume.

f. Add Network Path: Click to add a networked storage for recorded data. Please refer to page 164
for detailed information about how to add a new network storage server. Then double-click the Path to

assign a specific folder as a new recording path.

&4 Select Local Path

folder under D:\

imibrowser
H-2011-11-07

- AITEMP

G CAMERA

[ Cormputex_2-13
[+ Digi-Carn

- Directy

[+~ Eric

| i | 3

F-Etic_desktap ¥

1 Add... ][ Celete ][Rename... ]]

Path:  Ei

Type: @ Storage Path () Recowery Path
Storage Irformation
Total: 488,29 GBytes Free: 131.66 GBytes

Reserved: 43 E GBytes

Click those buttons to moaify the file

gg

Note that the reserved space is the comparatively
small amount of storage space saved for data
transaction during recording cycles. The reserved
space is not the storage space configured for

video recording.
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g. To modify the settings of a path, select the path from the list, then click Change settings to modify.

h. To delete a path, select the path from the list and click Delete path. A warning dialog box will pop
up as shown below.

é harging the address ssttings may temporar iy pauss recording and scheduled backup o spply the rew settngs. Are you sure you want bo cortinue?

i. By default, all devices are assigned to the Default Recording Group in the window on the right. You
can select device(s) from the list and click <- to delete device(s) (or right-click the device under
DefaultGroup tree to delete it). Note that a Delete Camera dialog box will pop up. Click Yes to delete
the device along with the recorded data; click No to delete the device but retain the recorded data;
click Cancel to cancel the delete action. Please note that only those designated devices can record
videos.

j- Click -> to add devices to the DefaultGroup.

@ Delete recorded data older than |7 E‘ day(s)

Cameras in Storage Group

Available Cameras: Added Cameras (6/256):

1B9381-HT

Group MName Address FDE36E EHTV

W 1B9381-HT 192.168.6.170 FEB182

& FD236B-EHTV 192.168.6.233 FE8151
FDO381-EHTV

L4 FEB182 192.168.6.209 FE9181-H

& FEB191 192.168.6.177

Ly FD9381-EHTV 192.168.6.109 ||

W FEG181-H 192.168.6.105

U o

E| ------ F= Recording Storage
- P DefaultGroup

‘ é Are you sure you want to delete this camera from the recording group along with the recorded data?

Manually Begin Recording

[ ves |[ mo || cancel

k. Delete recorded data older than the duration: If you only want to retain recorded data for a duration,
check this item and enter a number of day(s). In addition, since VAST Server will do "cyclic recording”
automatically, the oldest file will be overwritten by the latest one when the maximum capacity is
reached.

I. When completed, click Apply to confirm and save your settings. If you want to cancel all of your
editing, click Restore to return to the previous settings or click close to discard the settings.
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Add New Recording Group(s)

If you want to add a new recording group, click Add to give a name to the new recording group,
which will be displayed on the drop-down list.

The following is an example of recording group list.

| ol

Storage Group: |yl |©| |f ‘ |@|

Paths in Storage
IR

Recovery Storage Path

Recording Group 1

Group Mame:

ok | [ cancel |

D:\recording Total: 916.15 GBytes
Reserved: 91.00 GBytes
Free: 44934 GDBytes

Delete recorded data older than El day(s)

Cameras in Storage Group

Available Cameras: Added Cameras (6/256):
1B9381-HT
Group Mame Address = BEHTV
L 4 1B9381-HT 192.168.6.170 FEB182
"4 FDB36B-EHTV 192.168.6.233 FE8191
FDQ381-EHTV
L4 FEB182 192.168.6.209 FEO181-H
L4 FEB191 192.168.6.177
L 4 FD9381-EHTV 192.168.6.109
L 4 FE9181-H 192.168.6.105

Please refer to the following limits when you set up recording group(s):
® The maximum number of devices in a recording group is 64-CH. Please refer to the system requirements of the
software.

® One recording group can be assigned with several recording paths and perform cylic recording; while one
recording path should only be assigned to one recording group.
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Multiple Stream Recording

Since software revision 1.12, a camera's stream can be recorded to different storage paths, e.g., the
server's internal storage and a Network Attached Storage. If hardware should fail (such as H.D.D. failure)
on the VAST server, video can still be retrieved from other storage devices. This feature provides fault-
tolerant redundancy for stream recording.

Functional Requirements:

1. Each camera can be configured into multiple Recording Storage Groups, and has individual
configurations in each storage group.

2. Separate recording schedules can be configured for each camera in different storage groups.

3. Schedule Backup Settings:
As shown below, when configuring a Schedule Backup, each camera in different storage groups will
be listed as individula entries. You can select to back up only one of the recording streams.

'\; e
[¥] Enable schedule backup
Select Backup Source

) AllCameras @ Selected cameras

189381-HT (DefaultGroup)

I Add Gl = -
ame ress g 1B9381-HT (Recording Group 1)
FDO381-EHTV 192.168.6.109  DefaultGr
FE2181-H 192.168.6.105 DefaulGr
P8166 192.168.6.160 DefaultG
IBO381-HT 192.168.6.170  Recording _
aF— T o
Backup Schedule
=
Backup time : 12 [5]: 00 [£]
-—<_

Select Backup Target

Path: E:\recording Browise
M

Delete old backup data if space i insufficient

Other Options
Back up events only  Pre-event time: E second(s) (2 ~ 20}
Post-event time: El second(s) (2 ~ 20}

o) (o]

4. By default, every camera is recruited into the Default Storage Group. You can select a camera from
the device tree, right-click to select Camera Management > Update camera.

8 Live View r_\i Matrix View

5 By Camera
(EM 1B9381-HT(192.168.6.170)
I FEB182(19: Delete
@@ FeEs101(192 Refresh
& FD93BLEH|  CameraSettings

S FEO181H(1 Camera Maméemerrt 3
& P8166(192 -
Bt D Recording Storag QOutput Streaming URL
o [ DefaultGrou Send to Talk Panel

- - Recording Group 1

Insert Camera...
Update Camera...
Delete Cameras...

Camera Configuration...

You can configure different video streams for different storage groups.
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In here, you can configure the recording parameters for different storage groups. Note that you should
only enable Seamless Recording or Active Adaptive Stream in one of the storage group. Applying
these two functions on multiple streams can over-stress the camera.

v ]

Camera List
-
=~ B WMS_Station(127.0.0.1)

© - (D 1B9381-HT(192.168.6.170]  Camera Name: 1B9381-HT

FES182(192.168.6.209) [

FEB101(192.168.6.177) et 1921686170 | [&f]
- @) FDO3BL-EHTV(192.168.6.1  model Name:
@) FED181-H(102.168.6.105)
L. [ 1PB166(192.168.6.160) MAC Address:

nmecon st

| Connection Settings | Recarding Setmgs

Storage Group: |DefaultGroup

Basic
Recording Stream: 1 E' Enable seamless recording

etting
Pre-event Time: 10 % seconds(3-15)
Post-event Time: 10 El seconds(10-60)
Acﬁvem

NS

5. When performing Instant Replay or Instant Playback, the system will poll the first available storage
group only. If video is not available in the first storage group, playback will fail.

Note that Multiple Stream Recording is not supported when access is made via a web console. From
a web console, playback displays the stream that last joined the recording storage group.

When the stream recording takes place on any of the camera's streams, the red indicator will light on
on the camera's view cell.
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How to Edit Recording Schedules

After editing recording storage settings, you can begin to edit recording schedules for the
devices in a recording group. By default, all devices are assigned to the default recording
schedule (Please refer to the default time frame settings on page 145). Therefore, once you
insert a device to the station, the VAST Server will begin to record live video according to the
default recording schedule. You can also manually remove a device from the default recording
schedule. Please note that you cannot assign recording schedules to those devices which
have been deleted from a recording group.

The following is an illustration of a set of recording schedules, which are composed of several
time frames. Each time frame has its own time segments, period of time, repeat interval, and
recording mode. You can create different recording schedules with simple or complex time
frames based on your needs.

Devices in Recording Group

’ o— —o° Time Frame a
g ’ o— —o Time Frame b

— Recording Schedule 1 —|

o— —o

.
o— L— Time Frame n
.

L]
L]
& ° Time Frame y

Recording Schedule N

R

Time Frame z

In addition, you can arrange the priority of each time frame according to its importance. The
recording schedule with the highest priority will be applied first. This capability is very useful
because you can specify a new time frame with the highest priority temporarily without modifying

the other time frames.

Features of the recording schedules:

m Each device can be assigned to only one recording schedule.

m Each recording schedule may contain many time frames.

m Each time frame has its own repeat frequency and recording mode.

To save time editing recording schedules and time-frames, we also provide a useful template
function to save your time on schedules/time-frames settings. That is, you can save a specified
schedule and download it as a template for future use or upload a well-arranged schedule
template designed by others.

Please note that after you save the recording settings in the server, the recording schedule will
begin automatically according to your settings.
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Edit Schedule List

Please follow the steps below to set up the recording schedules:
a. Select the target station from the hierarchical management tree.

b. Click Configuration > Station Settings > Recording Schedule Settings on the menu bar (or right-
click the station and select Station Settings > Recording Schedule Settings).

N LiveClient.
(_System | Edit | View | Configuration | Layout | Help )
PR . Management - —  ——
RER DR 5 [>])
»

Logical Trez View Management..
=B vms_station(127.

1/0 Box Management
User

@ Bozst
Assodiation Management...
@ rosaet

i FeB1s: Alarm Management...
@ Fenio Virtual Matrix Management

Failover Management

8182

\ S
Camera Managemeant
@ FE3g Station Managerant.
& FE1g Logical Tree View Management
107 /0 Box Management v i

User Management

VO Bax Association Management...
Alarm Managernent.
Virtual Matrix Managament

Failover Management
Search VivoCam Switches. .

Station Settings 3

Find... r
Dutput Streaming URL

Outpust Camera List

Srhacilad Rark i Sathna.

c. The Recording Schedule Settings window will pop up. By default, all cameras under the station are
assigned to Default Schedule, Default Time Frame, and Default Camera List.

Add Schedules

d. To add a new recording schedule, click Add to enter a name in the Schedule Name dialog box for the
new schedule. Click OK to confirm the settings or Cancel to discard the settings. The new recording
schedule will be displayed on the schedule drop-down list.

Rename Schedules

e. To rename an existing schedule, select the schedule from the schedule drop-down list and click
Rename. A Schedule Name dialog will pop up for you to fill in a name for the new schedule. Click OK
to confirm the settings or Cancel to discard the settings. The new recording schedule will be displayed
on the schedule drop-down list.

Delete Schedules

f. To delete an existing schedule, select the schedule from the schedule drop-down list and click Delete.
A Remove Schedule dialog box will pop up. Click OK to confirm or Cancel to discard the settings.

[ A I.&E;namel Delete | Load Template || Save as Termplats | ‘

@ Confirm X

’a 'Recordmedufe S’eﬁhgs’ fc;r

Schedule List: |Defau|t Schiedule
T

é Are you sure you want to delete the schedule GateCamera?

E o' i [ Cancel J
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Load/Save Schedule Templates

g. If you have a schedule template with time frame settings, you can upload it to simplify the editing of
the schedule. Click Load Template, and a Load File dialog box will pop up. Select the template file

and click Open to load.

h. If you want to save a schedule as a template for future use, select the schedule from the schedule
drop-down list and click Save as Template. A Save File dialog box will pop up for you to save the

template file.

.w:Recordmduie Msf(s_r T

tionl

Schedule List: |Defau|t Schedule [

Add

][ Rename

Load file

My Fecent
Documents

&

0] esktop

My Documents

My Conputer

My Mtk
Places

Look. in: IE My Documents

@ My Music

Iy Pictures

File narne: I j Open I
Filez of type: I TimeT able template( tc) j

Cancel |
|

Sawe file

ty Recent
Diocuments

€]

Desktop

dy Document_s

ty Computer

<

tdy Metwark,
Flaces

Savein: IE 4y Dacuments

x| = @® ek EE-
@My Music
My Pictures
File hame: | j Save I
Save as lype: ITimeTabIe template(”.tc] ;I Cancel |
4 |
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Edit Camera List

Please follow the steps below to assign a device to a recording schedule:
a. Select a recording schedule on the schedule drop-down list.
b. By default, all devices under the station are assigned to the Default Schedule.

c. Click << to remove devices from the Default Schedule. Click >> to add devices to the Default
Schedule.

d. Click Apply to confirm or Close to discard the settings.

T Fecordng Schedle ot for W Seion] | 2=l
Schedule List: |Defau|t Schedule |—v][ Add ” Rename ” Delete ][ Load Temnplate ][ Save as Template ]

I Time Frame List

Recording Settings
Time Frame Rule _
Recording Mode:
Always wieekly Setting (Day-based)
Triggers
Motion PIR Tarmpering
[¥IP-PTZ  [¥Line Crossing V] Field Detection
Digital Input
| () Traditional Recording
[ Trigger State [ IMarmal State
[ add ” Edit ” Delete ] [ Up ][ BT ] @ Recording fram DI activated to OI normal

() Recording from DI normal to DI activated

Camera List E
Mamne address Group Scheduls Miaga-Pixel Matwnrk Camers

wireless camera

Mega-Pixel Metwork Camera
Meqga-Pixel Network Camera
Meqga-Pixel Network Camera

Mega-Pixel Me... 192.168.4.121  DefaultGroup YEs
Wireless camera  192,168.6.143  DefaultGroup Yes
Mega-Pixel Ne.., 192,168.0,127  DefaultGroup Yes
Mega-Pixel MNe... 192.168.6.217  DefaultGroupn Yes
Mega-Pixel Ne.., 192.168.6.101  DefaultGroup Yes

4 (LI} 3

0 Apply Close

b e J

=
If you add a Network Device that does not belong to any Recording Group, a warning dialog will pop up as shown

below. For more information about how to set up Recording Group(s), please refer to Recording Group Settings on
page 135.

Camera List

MNarme | address Group Scheduled 1 PZ7151
1 PZ7131 192.168.3.247 | DefaultGroup | Yes
2_1P8161  172.16.200.40 Mo

8 The carmera is not in recording group.

[ Apply ][ Close ]
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Edit Time Frame List

Default Time Frame: Weekly (Day-based), Mon.~Sun., 24-hour, continuous recording

(R Recording Schedsle S50 for VUK ot D & &)
—
| Schedule List; |Defau|t Schedule B[ Add ” Rename ” Delete ][ Load Template ” Save as Template ]

I Time Frame List

Recording Settings
Time Frame Rule _
- Recording Mode:

Blweays wieekly Setting (Day-based)
Triggers
Motion PIR Tampering
[¥1p-PTz  [¥Line Crossing  [¥IField Detection
Digital Input

| () Traditional Recording
DTrigger State [ |Mormal State
[ add " it [ Delete ] [ Upn " Dt ] @ Recarding from DI activated to Ol normal

Click Edit to open the Default Time Frame settings page as shown below.

P
Time Frams —— -m

Time Frame Mame:  Always [
Load Template ] [ Save as Template ] [ Save ]

Repeat Frequency: [Weekly Setting (Day-based) -

Weekly Setting (Day-based)

Set time segments it a 24-hour day, Multiple segments are allowed,
|
PSRN e

Start Tme: 00 5| 00 [

End Time: 23 E 33 E [ Add ] [ Delete ]
|
Repeat on: [[|Sunday  [CIMonday  [C]Tuesday  [|wednesday [ Thursday  [ClFriday  [T]Saturday
b
Range i
Start: End: O 2013/ 710 -
@ Mever Stop
Repeat every l_E Wieeki(s)
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Add New Time Frames

Please follow the steps below to add new time frames to a schedule:

a. Select a recording schedule from the drop-down list.
b. Click Add to open the Time Frame Settings window.
a Remrdi%ﬁedule%sform -—— - @J

H [ Add ” Remarme ” Delete ” Load Termplate ” Save as Termnplate ]

I Time Frame List

Schedule List:

Recording Settings

Tirme Frame Rule )
- Recording Made:
Blweays wWieakly Setting (Day-based)
Triggers
Mation PIR. Tampering

[¥1p-pTZ  [V|Line Crossing  [V|Field Detection

Digital Input

() Traditional Recarding
[“ITrigger State [ |Mormal State

ﬂ add m Edit " Delete l | Up ” Dzt | @ Recarding fram DI activated ta DI normal

c. Enter a name for the new time frame.

d. If you have a time-frame template, you can upload it to simplify the editing of the schedule. Click Load
Template and the Load File dialog box will pop up. Select the template file to load.

e. To edit the new time frame, select a Repeat Frequency from the drop-down list and edit the time
segments, applicable days, applicable period of time, and repeat time interval. For the detailed settings
of each repeat frequency, please refer to The Concept of Repeat Frequency on page 149.

f. When completed, click Save to enable the settings.

g. If you want to save this time frame as a template for future use, click Save as Template. A Save file
dialog will pop up for you to save the template.

Time Frame Mame |Time Frame 2 Load Template Save as Template . Save
e Repeat Frequency |Weeklv Setting (Periods in a week) V|

Weekly Setting (Periods in a week)

Set time seagments in a week, Multiple segments are allowed.

Start Time - v
End Tirme : : [ add | [ Delete J

Range:

Start 2010/ 1/27 ~|  End O 2010/ 1/2F v

(&) Mewer Stop

Repeat every > weekis)

146 - User's Manual




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

h. If you want to add additional time frames to the schedule, repeat the steps above.
i. Close the window when you finish the time frame settings.

j. Back to the Recording Schedule Settings window, the new time frame will be displayed on the Time
Frame List.

k. If you want to edit an existing time frame, select if from the Time Frame List and click Edit to set up.
l. If you want to delete an existing time frame, select if from the Time Frame List and click Delete.

m. If you want to change the priority of a time frame, select it from the Time Frame List and click Up or
Down to shift its position. The time frame on the top of the list has the highest priority.

fg Recordi:éaedufe Se?r‘lgs for VWTK_Stationl - - @
Scheduls List: |Default Schedule E“ Add ][ Renarmne " Delete ][ Load Ternplate " Save as Template l

i Time Frame List

Recording Settings

Time Frame Rule )
- Recording Mode:
0 Alweays Weekly Setting (Day-hased)
Motion PIR Tampering

WIpFTZ  [VLine Crossing  [¥]Field Detection

Digital Input

() Traditional Recording
I 0 [ Trigger State [ IMarmal State

@ Recarding from DI activated to DI narmal

l Add I‘ Edit l Delete ]] | Up ” Do () Recording from DI normal to DI activated
|
|| Camera List
[l -
Marme Address Group Schedule Mega-Pixel Matwork Camera
| Wireless camera
(| | MegaPixel Me... 192.168.4.121 DefaultGroup Yes Mega-Pixel Metwarl Camera
|| | Wireless camera 192.168.6,143  DefaultGroup Yies Mega-Pixel Netwark Camera
Mega-Piuel Me... 192.168.6.127 DefaltGroup  Yes Mega-Pixel Network Camera
Mega-Pixel Me,,, 192.168.6.217  DefaultGroup Yies
Mega-Pixel Me,.. 192,168.6.101  DefaultGroup s

Apply ][ Close

-

Recording Settings

n. Select one of the following Recording Modes for the time frame:
= None: No recording action.

® Continuous: 24-hours continuous recording. If you want to enable Activity Adaptive Streaming,
please refer to page 138 for detailed illutration.

m Event: The server will start to record only when an event is triggered. The recording time length
depends on the settings in Recording Storage Settings. The default time length is 20 seconds (10s
pre-event time plus 10s post-event time). Please refer to page 137 for more information. For more
information about event catagories, please refer to page 257 for detailed information.

0. Select Trigger Source(s): Motion Detection, Line Crossing, Field Detection, PIR, Tampering Detection,
and P-PTZ (Auto Tracking).

p. Digital Input: See next page for more information.
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The Digital Input signal triggers can be configured as follows:

1. Traditional Recording: can be triggered when the DI enters the Trigger State or the Normal
State. If thus configured, the recording task will end when the post-event recording time is
reached.

2. The recording starts when Dl is triggered, and will end when the DI signal returns to Normal.
3. The recording starts when DI is Normal, and will end when the DI signal returns to Triggered.

4. The DI-triggered recordings also include the appended lengths of pre- and post-event recordings
(default is 10 seconds). Therefore, the length of DI-triggered recording is as follows:

DI triggered DI returns to Normal state

Pre-recording Post-recording

An example for the configuration can be: the recording starts when a door is opened (DI triggered),
and the recording stops when the door is closed (DI returns to normal).

=
When connected, a camera's Digital input signal is automatically detected as pulled-high or pulled-low.

Users should then designate the current state as Normal or Trigger. The configuration page is found in
Configuration > Application > Digital Input on a web console.

Applications > Digital input

Digital input
Mormal status: @ High ) Low
Current status: High

g. Click Apply to confirm the settings. Then close the window when you finish the recording schedule
settings.
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=
The following diagrams show the frame rate variation of two recording modes:
1. Continuous recording + Activity adaptive recording (helps save bandwidth and storage)

A—H—%

> Time
| frame ---> Full frame rate ---> | frame
Continuous Recording
2. Event recording

Bandwidth : :
1 1
1 1
i |
1 1
1 1
1 1
1 1
. ' > Time

No recording data ---> Full frame rate ---> No recording data
Event Recording

The Concept of Repeat Frequency

VAST offers the following types of repeat frequency. The definition of each type is listed in the
following table:

Repeat Frequency Discription

® Specify arbitrary time segments within a day,

BHilSeting m Repeat the segments every N days in the specified period of time.

m Specify arbitrary time segments within a day,
® Apply only on selected days of a week,
® Repeat the segments every N weeks during the specified period of time.

Weekly Setting (Day-based)
(Default Time Frame)

® Specify arbitrary time segments within a week,

UL ST (RO U0 QT ® Repeat the segments every N weeks during the specified period of time.

m Specify arbitrary time segments within a day,
Monthly Setting (Day-based) ® Apply only on selected days of a month,
® Repeat the segments every N months during the specified period of time.

® Specify arbitrary time segments within a day,
Yearly Setting (Day-based) ® Apply only on selected days of a year,
® Repeat the segments every N years during the specified period of time.
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Repeat Frequency: Daily Setting

To set up daily repeat frequency, please configure the following items: Daily time segments, applicable
period of time, and repeat time interval.

Time Frame |X|
Time Frame Marne | | [ Load Ternplate ] [ Sawve as Template ] [ Save J
Repeat Frequency | |BEN==10yE
Daily Setting
Set time segments in a 24-hour day, Multiple segments are allowed, Daily time segments
1500 [ 720 1730 e s (76T [0 [ e (1) [ (920 (31 1) 8] (160 17 [181 9] 200 210 220231 | "You can drag the daily
Daily timeline control bar timeline bar for more
Stait Thne % % than one time segment
per day.
End Time E E | add | [ Deete |
Range:
Start End O Applicable period of
(& MNewer Stop time
r h | H H
(Repeat every Il_[ o~ Dayis) ) | Repeat time interval

Set up daily time segments

You can specify several time segments within a day. The numbers 0~23 on the hourly timeline control
bar (the purple rectangles) represent the 24 hours in a day.

There are two ways to define time segments: one is to use the computer mouse to manipulate the
timeline control bars; the other is to fill in the precise start and end time values in the corresponding
fields.

Add time segments: Choose either step 1 or step 2 to set up
1. Use the mouse to drag the timeline bars:
a. Left-click the daily timeline control bar (the purple rectangles) and drag the mouse.

b. The corresponding time segment will also appear in the Start Time and End Time fields. Click Add,
then the red timeline bars representing new time segments will appear as shown below. You can
drag multiple time segments within a day.

In the following illustration, the yellow arrows show the dragging direction of the mouse. You can
drag from left to right or the opposite.

Start Time 2 :
End Time ¥, E, Coadd Delete
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2. Fill in the precise Start Time and End Time:
a. Directly enter the value in the Start Time and End Time fields, then click Add.
b. The corresponding red timeline bar will automatically appear as shown below.

e ™

Start Time 2 :
ErdTme [19]% (00|32 T add | [ Deete |

Delete time segments: Choose either step 1 or step 2 to set up

1. Use the mouse to erase the timeline bar: Right-click on an existing red timeline bar and drag the

mouse. A green timeline bar representing the deleted part of the time segment will erase the red bar as
shown below.

In the following illustration, the green arrows show the dragging direction of the mouse. You can drag it
from left to right or the opposite.

-------w-----

Start Time ; - %
End Time ¥, 3

Start Tirme E; 3
EndTime |14|% 0|32 |_add | [ Delete |

2. Use the delete button to remove the entire timeline bar:

a. Click an existing red timeline bar or left-click the daily timeline control bar (the purple rectangles)
and drag the mouse.

b. The corresponding time segment will appear in the Start Time and End Time fields.
c. Click Delete, and the selected timeline bar will disappear.

tart Time E; 2
End Tirne: E; E Add
--------“------------

Start Time £ :
End Time : i | add | [ Dekete |

| Add i[ Delete ]
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Set up applicable period of time

For repeat frequencies, you can set up the applicable date and period of time for the time frame.
a. Specify the start date and time in the Start field. A calendar date selector will appear when you click
on the drop-down list of date. Click € or * to select the month, then pick a desired day in the

b. Specify the end date and time in the End field if you have an end time for applying this time frame. If
you do not have a terminating time for this time frame, select Never Stop.

1jz6/2010  » |

wer Stop

January, 2010

Sun Mon Tue WethJhu B 5ak

Repeat| -7 = = =0 - 1\
3 4 5 & 7 )
10 11 12 13 14 15

17 15 19 20 21 22 23
24 o5 [ER 27 28 29 30 . )
e Click to select a month from the drop-down list

[ ITeday:1/26/2010 ———— Click here to move the focus to the current date

AN

N

Click to select a year

Set up repeat time interval

The repeat time intervals is "every N day(s)" as shown below. Repeat every 1 day means the time frame
would apply for every day within the period of time.

Repeat ewery |1 : Daw{s]l'
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Repeat Frequency: Weekly Setting (Day-based)

To set up Weekly (Day-based) repeat frequency, please configure the following items: Daily time
segments, applicable days within a week, applicable period of time, and repeat time interval.

Time Frame |z|

Time Frame Marme | | [Load Template J [Save as Template ] [ Save ]

Repeat Frequency || =R g piREE e =)

S

Weekly Setting (Day-based)

Set time searments in a 24-hour day, Multiple segrments are alowed,

{707 [0 720 190 0 [7sT 6T N (e a0 [l [ (2] 31 [a) s) e A e 9] 200 210 220 1230 Daily Time segments

Daily timeline control bar (24h) *You can drag more
Start Time (00] 3 [00] 3 than one time segment
End Tirne .3 .: [ Add ] [ Delete ] per day'

[Repeat on [Isunday [CMonday [Tuesday [Cwednesday [Thursday [CIFriday  [C]Saturday ]—— Appl_lcable days
within a week

Range:
Start End O Applicable period of
&) MNever Stop time
| Repeat every |1 |3 Wesk(s) —+ Repeat time interval

Set up daily time segments

Please refer to page 150 for detailed instructions.

Set up applicable days within a week

For repeat frequency--"Weekly (day based)", you can apply the time segments only on selected days of
the week.

Repeat on [JSunday [IMonday [Tuesday [Iwednesday [Thursday [Friday [ Saturday

Set up applicable period of time

Please refer to page 152 for detailed instructions.

Set up repeat time interval

The repeat time intervals is "every N week(s)" as shown below. Repeat every 1 week means the time
frame would apply for every week within the period of time.

Repeat every : Wieek(s)
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Repeat Frequency: Weekly Setting (Periods in a week)

To set up Weekly (Periods in a week) repeat frequency, please configure the following items: Time
segments within a week, applicable period of time, and repeat time interval.

Time Frame |z|
Tirne Frame Mame | | [Lclad Template ] [Save as Template ] [ Save J
Repeat Frequancy | EEHIREE =R
Weekly Setting (Periods in a week)
Set time segrnents in a week. Multinle segments are allowed.
Weekly timeline control bar Time segments within
O 0 (2 1530 ) 1S 8 ) 21 (31 (1) s ) ) (19 20 2 (221 2w | | @ week
Daily timeline control bar (24hr) thYOU can t‘_j"ag more .
! = “ an one time segmen
Start Time - v
per week.
End Time s £ [ Add ] [ Delete J
Range: ) )
Applicable period of
et © e
&) Mever Stop
[Repeat EVEry S Wieek(s) } Repeat time interval

Set up time segments within a week

You can specify several time segments within a week. The weekly timeline contol bar represents the
7 days of a week, and the daily timeline contol bar represents the 24 hours in a day. The daily timeline
control bar is only valid when one of the days on the weekly timeline control bar has been selected.

There are two ways to set up time segments: one is to use the computer mouse to draw the timeline
control bars; the other is to fill in the precise start and end time value in the corresponding fields.

Add time segments: Choose either step 1 or step 2 to set up

1. Use the mouse to drag the timeline bars:
a. Click on a day on the weekly timeline control bar. The selected bar will turn green.
b. Left-click the daily timeline control bar and drag the mouse.

c. The corresponding time segment will also appear in the Start Time and End Time fields. Click Add,
then the red timeline bars representing new time segments will appear as shown below. You can
drag multiple time segments within a day and a week.

In the following illustration, the yellow arrows show the dragging direction of the mouse. You can
drag from left to right or the opposite.

Start Time | Monday v F 3 G
End Tirme s s P Aadd Delete
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2. Fill in a precise Start Time and End Time:
a. Directly select a day and enter the value in the Start Time and End Time fields, then click Add.
b. The corresponding red timeline bars will automatically appear as shown below.
The following is an example of an extended time segment from Mon. 8:00 to Fri. 19:00.

e Start Time  |Monday Il'; .

End Tirme  |Friday Qf} .

A I [ Delete J

Delete time segments: Please refer to page 151 for detailed instructions.

Set up applicable period of time

Please refer to page 152 for detailed instructions.

Set up repeat time interval

Please refer to page 152 for detailed instructions.
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Repeat Frequency: Monthly Setting (Day-based)

To set up Monthly (Day-based) repeat frequency, please configure the following items: Daily time
segments, applicable date(s) of a month/ day(s) of a week, applicable period of time, and repeat time

interval.
Time Frame |z|
Time Frame Marme | | [ Load Template ] [ Sawve as Template ] [ Save ]
Repeat Frequency | iegime = e p i = ) ."l,
Monthly Setting (Day-based)
Set time segments in a 24-hour day. Multiple segments are allowed.
01 5 21 531 51 56 7 0 0121 131 0 7w s 20 2w 2 8| | o
Timeline control bar (24hr) "
_ . _ You can drag more
Start Time 00 [00] & than one time segment
EndTime (00 % [m0|% | add || Deete | per day.
Repeat on |Date {of a month) ,V;| Appllcable date(s) of
_.V; _: Repeat on the folowing date(s) of a month: a month/ day(s) ofa
week
1 =z
24 5 6 F 8 9 Delete
1o 11 12 13 14 15 16
17 18 19 20 21 22 =23
24 25 26 27 H§ 29 0
a1
Range:
Start End O Applicable period of
&) Mewer Stop time
[Repestevery 1 |3 Monthis) — Repeat time interval

Set up daily time segments

Please refer to page 150 for detailed instructions.

Set up applicable date(s) of a month/ day(s) of a week

For repeat frequency--"monthly (day-based)", you can apply the time segments only on selected days of
a month. There are two types of repeat frequencies: Date(s) of a month and Day(s) of a week.
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Repeat by date(s) of a month:

Select date(s) from the calendar, and it will be displayed on the right blank as shown below.
The following example refers to the 1°'~5" day of a month.

Repeat on | Date (of a month) l._] '

-[_:] Repeat on the folowing datels) of a month:

i o 02
3 4 8 6 7 8 9 |03 | Delete |
10 11 12 13 14 15 16 22 [ poete ]
17 18 19 20 21 22 23
o4 25 26 27 20 29 a0
21

Repeat by day(s) of a week:
Select day(s) from the calendar, and it will be displayed on the right blank as shown below.
The following example refers to the 1% ~ 5" Friday of a month.

Repeat on |Daﬁ,r (of a week) l.f] '

_E‘;' Repeat on the folowing day(s) of a month:

1st Friclay
i 2 EHJJ Frlijlay
2rd Frida
so403 s 78 o mEy
Sth Friclay
17 18 19 20 21 22 23
24 25 26 27 2B a0
21

Set up applicable period of time

Please refer to page 152 for detailed instructions.

Set up repeat time interval

The repeat time intervals is "every N month(s)" as shown below. Repeat every 1 month means the time
frame would apply for every month within the period of time.

Repeat every E:j Monthis]
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Repeat Frequency: Yearly Setting (Day-based)

To set up Yearly (Day-based) repeat frequency, please configure the following items: Daily time
segments, applicable date(s) of a year/ day(s) of a week, applicable period of time, and repeat time

interval.
Tame Frame |z|
Time Frame Name | | [Load Template ] [Save as Template ] [ Save ]
Repeat Frequency | SR me = =R S aE ==l ) ,v;

Yearly Setting {Day-based)

Set time segments in a 24-hour dax. Multiele segments are allowed,

1707 [T 720 1730 e ST (76 1 [he ey [ [ 20 (93] e [1S) 6] A (e 19 [200 (210 )220 1231 iy i
Timeline control bar (24hr) PYac::Jy ct:r?zrzzgrr: Oerrelts

Start Time (00| 3 |00 |3 than one time segment
End Time : : [ Add ] [ Delete J per day
Repeat on  Date (of ayear) v | Applicable date(s)
_3 Repeat on the folowing dateis) of a year: of a yearl day(s) of a
[Sun Mo Tue Wed Thu FriSat week
102
2 4 5 & 7 8 0

10 11 12 13 14 15 16
17 18 19 20 21 22 =3
24 25 26 27 5 29 =0
31

Range;

Start Erd O Applicable period of
&1 Mewer Stop time

|Repestevery |1 | T Year(s) — Repeat time interval

Set up daily time segments

Please refer to page 150 for detailed instructions.

Set up applicable date(s) of a year/ day(s) of a week

For repeat frequency--"yearly (day-based)", you can apply the time segments only on selected days of a
year. There are two types of repeat frequencies: Date(s) of a year and Day(s) of a week.
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Repeat by date(s) of a year:

Select date(s) from the calendar, and it will be displayed on the right blank as shown below.
The following example refers to the 1°'~5" day of a year.

Repeat on  |Date (of a year) I:]

January Il"] -E: Repeat on the follwing datels) of a year:

01/01
i =z o1foz
EEEEERN:
10 11 12 13 14 15 16 0105
17 18 19 20 21 22 23
24 25 26 27 28 29 40
3l

Repeat by day(s) of a week:
Select day(s) from the calendar, and it will be displayed on the right blank as shown below.
The following example refers to the January 1* ~ 5" Friday of a year.

Repeat on |Day (of a week) v

Repeat on the folowing day(s) of a year:

Janiary b |

January 1st Friday
January 2nd Friday

Janary 3rd Fricay

3 4 3 G 7 a8 =

0 011 12 13 14 15 16 Janary gtk Fricay
17 18 19 20 21 22 =3 January Sth Friday
24 25 25 27 2B an
31

Set up applicable period of time

Please refer to page 152 for detailed instructions.

Set up repeat time interval

The repeat time intervals is "every N year(s)" as shown below. Repeat every 1 year means the time
frame would apply for every year within the period of time.

—

Repeat every |1 Year(s]

| s
(5.4
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How to Manually Begin /Stop Recording

By default, all devices are assigned to the default recording storage and default recording
schedule. Therefore, once you insert a device onto the station, the VAST Server will begin
to record live video according to the default recording schedule. Please refer to How to Edit
Recording Schedules on page 141.

However, if you have changed the default schedule, you can manually click Manually Begin
Recording to enable a device without setting up a recording schedule. Please follow the
instructions below to manually begin recording.

Select the device from the hierarchical management tree under Default Group, then click Edit
> Manually Begin Recording on the menu bar (or right-click the device and select Manually
Begin Recording). The string on the menu bar will turn into Manually Stop Recording as
shown below and the VAST Server will start to record video from the target camera. Please
note that its priority will be higher than the recording schedule, so it will continue unless you
click Manually Stop Recording. After you click Manually Stop Recording, the device will then
follow the preset recording schedule.

(System Edit | View | Configuration | Layo CSyrsiem Edit | View | Configuration | Layoi

r
Snapshot Cicl+d Snapshot Cl+d E
Puint » Brint r
Record to EXE Record to EXE
Enapshot Zoomed Tmage Snapshot Zoomed Image
I Print Zoomed Image | Print Foomed Tmage
| |
Find... Find...
I-ﬁ- = =T L b =
= B Recording Storage = E& recording Group
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How to Edit Scheduled Backup Settings

VAST LiveClient supports scheduled backup which allows the user to back up the recorded data
to another disk.
Please follow the steps below to enable scheduled backup settings:

a. Select the target station from the hierarchical management tree.

b. Click Configuration > Station Settings > Scheduled Backup Settings on the menu bar (or right-
click the station and select Station Settings > Scheduled Backup Settings).

System | Edit | View | Configuration | Layout | Help

— ’ Camera Management
OlEleoll e
Ll L

=

Logical Tree View Management...
I/0 Box Management b i

User Management...

------ [N 1Bo381 o
@ ~ Associstion Management ..
i Alarm Management..

...... @ FEBLY. Virtual Matrix Management 3
& s Failover Management ’

...... @ reots Search VivoCam Switches...

T |

=} Defaulty
= Client Settings »

General Settings
Netwerk Settings
Recording Storage Settings

Video Enhancement g
hediled Backop Settings

-G FEB191 SIS
& Fpo381-EHTY Relay Settings

Camera Management

Station Management...
Logical Tree View Management...
/O Box Management 3

- [ Recording § User Management...

-~ [ 710 8ox Association Management...
- B Layout Alarm Management...

Virtual Matrix Management 3
Failover Management 3

Search VivoCam Switches...

Station Settings 3
Find...

QOutput Streaming URL

Qutput Camera List
Get PublicIP

Relay Settings

c. The Scheduled backup settings window displays.

Select Backup Source

d. Select the Enable scheduled backup checkbox.

e. Select the data source you want to backup. If you check Selected cameras, you can click >> or << to
choose the data source that you want to backup.

Schedule Backup Status : Standby

Enable schedule backup

Select Backup Source

@ Al cameras () Selected cameras

Marne Address Group Backup

FEQ391-EV 192.168.4.161 DefaultGroup Yes

FE9191-v2 192.168.4.171 DefaultGroup Yes

3.192.168.4.... 192.168.4.124 DefaultGroup Yes

SD9161-H 192.168.4.164 DefaultGroup Yes
FDO381-EHTV 192.168.4.124  DefaultGroup Yes
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Setup Backup Schedule
f. Click the Edit button to enter the configuration screen. Please note that the backup time interval must
not be shorter than 1 hour. For example, 23:40 and 00:15 are not allowed to exist simultaneously.

In the following example, the server will backup the recorded data at 12:00 PM and 23:00 PM everyday
once you save the settings.

Backup Schedule
Time Frame Rule
Off duty Weekly Setting (Periods in a week)

gi

The following diagram shows the backup schedule and backup data:

1st backup 2nd backup 3rd backup 4nd backup
data data data data

Server T T T T

start 12:00 23:00 12:00 23:00 e o o o o o
2010/01/24  2010/01/24 2010/01/25  2010/01/25

Select Backup Target

g. Click Browse... to select a path (local path or network storage) to store the backup data. Please
note that the disk for backup data should be different from the original recording path, or a warning

message will pop up as shown below. For more information about how to set up recording path, please
refer to page 136.

h. Select Delete old backups if space is insufficient if you want to do cylic backup due to the limited
size of the hard disk.

i. Select the backup speed. The speed range start from 0 to 100MB/s. "0" stands for no limitation. If
bandwidth or system resource is of the concern, you can tune down the backup speed.

I ULy VVEERY JELLIY (FEIUUD 1 d WEER)

@ Select Backup Target
Path: Browse

m ' Delete old backup data if space is insufficient ' Local

Metwark

Clear
Backup Throughput

0 30 100
Max Throughput: MB (0 for unlimited)

The backup destination folder should look like this "2016-07-06_164500 > DISC_001." A scheduled
backup error log will be available for users to examine the backup history.

@]

[ ok | [ cancel |

Since the scheduled backup is a file-based process, if the backup involves an unfinished video file
(currently being recorded), the backup process will skip the file.

162 - User's Manual




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

How to Configure Station Server Settings

VAST LiveClient supports Server Settings including DDNS Settings, Network Storage Settings,
and SMTP Settings.

Select the station from the hierarchical management tree and click Configuration > Station
Settings > Server Settings to open the page (or right-click the station and select Station
Settings > Server Settings).

Configuration | Layout | Help

Camera Management 4
Station Management. . H
Msex Management. .. = E 6 +
Asociation Management. .. _
Event Management. .. 3 U ﬁ Matrix View
Wirtual Matrix Management ¥
General Sethngs
Client Settings 4 Wetwork Settings
Recording Storage Sethings
Recording Schedule Settings
Scheduled Backup Settings
DDNE Settings
Eelay Settings Wetwork Storage Settings
SMTF Bettings

WWTEK _Stationl1{127.0.0.1)
He Camera Management
E| ..... Station Management. ..
B User Management...
Asmociation Mansgement...

0 Live Wiew ﬁ Matris Wi

Ewent Management...
Virtual Matriw Management *

General Sethings

Hetwork Settings
= Recording Storags Settings
Ovutput Streaming URL SFCOTMAE wiarge SE
Gret Public 1P Eecording Schedule Sethings
SLn Scheduled Backup Settings

DDNE Settings
Wetwork Storage Settings
EM TP Settings

Relay Settings

DDNS Settings

Since the public IP of VAST Server may be a dynamic IP address, DDNS service will give it a

fixed domain name.
Select a DDNS provider from the provider drop-down list. VIVOTEK offers 2bthere.net (Safe100.
net), a free dynamic domain name service, to VIVOTEK customers. Please refer to the user's

manual of VIVOTEK's network camera for detailed DDNS settings.
¥ DDHS Settings X

DOMS: Dynarnic domain narme service

[[JEnable DOMS

Provider: | iz, org(Dynarnic )
Host name: | |
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Network Storage Server Settings

The VAST Server allows user to set up network storage path(s) for recorded files. Please follow
the steps below to add a new network storage path.

a. Click Add to open the Network Host Window.

b. Fill in the related information for the network host. Then click OK to save the new settings.

¥ Network Storage Server Settings

Starage Server List; acldress: || ‘
Address Dormair Account
Domain Mame: |H|:|st Iv"
User MNarme: |guest ‘
Password: |***** ‘
l (04 | Cancel

¥ Network Storage Server Setfings

Starage Server List:

Address Domain Account
192.168.5,122  VIVOTEE ritali

[ add... i[ Edit. .. J[ Remove J

Close |
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SMTP Settings

VAST Server allows user to set up SMTP Server to send mail alert when event triggers. For

more information about how to set up event management, please refer to page 111.

Please follow the steps below to configure the SMTP Server:

a. Click Add to open the SMTP Settings page.

b. Enter the related information of your mail server. If your SMTP server requires a secure connection
(SSL), check Use SSL.

c. Click OK to enable the settings.
d. Then the new information will appear on the SMTP Settings window as shown below.

¥ SMTP Settings

SErver b
Address Authentication S5L -
Address: |M5.kutek.tw |
LAl [ :
G Logir
@ Use authentication :
User name: |ritali |
Add J Edit Remoye
Password: |******** |
G ' Ok ][ Cancel J

¥ SMTP Settings

Address Authentication S5L

@ (M=, vivatek, tw V'S Mo

If you have more than
one SMTP server, you
can click to arrange the
priority.

= =)

i Add i Edit [ﬁemmfe ]

Close
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How to Use the Talk Panel

VAST LiveClient supports the two way audio function which allows the user to communicate with
people around the network camera. Please enable the two way audio function on the camera
side.

The following is an illustration of the two way audio function:

Audio transmitted from network camera

Y

Network Camera with internal
or external microphone

4

Audio transmitted from operators

L]
£

Add a Camera to the Talk Panel

B There are several ways to add a Network Camera to the Talk Panel:

Drag-and-drop a camera from the video cell or from the hierarchical management tree to the talk panel
as shown below. You can also right-click the target camera or the video cell, then click Send to Talk
Panel on the popup menu.

a VYTK Station1 (127,0.0.1) (1 Pz7131 200971 1116 PM 02:32:27 = B wi station1(127.0.0.1) = Q WWTK_Station1(127.0.0.1)
& By camera =T > ee
RS- 31 r77121152.100.5.247) RN e i - T ey o I B
- @M 2_IPE161(172,16.200, . :
E - Recording Group S | = Delete
B Layout i
Refresh
Carmera Settings
Camera Management 3
Output Streaming URL
Send to TalkPanel '
Open Recording Folder
PTZ | Two Way Audo | Tnstant D 4 ftant Playback

Remove

Single Wiew Crl+v
Full Sereen Ctrl+F
Enable PiP Cirl+1
Hide Global Wiew Ctrl+H

¥ Enablelnstant Replay

@ Stream 1(1920«1080)
Stream 2 (1280x720)
Stream 3 (176:144)
Stream 4 (19201 080)
Set DO 3
=0 commamresmor e (5] Oter »
IIDIDIEDID- \ N Video Enhancement 3

Video Display Mode

SWC FPS Adjust Bar
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B An icon with the camera name will be displayed in the Talk Panel.
PTZ | Two Way Audio | Instant Playback

2
PZ7131

Click to play sound from the camera
Remove all cameras
from the Talk Panel

Click to talk . .
(!t ]

Select sound from the
file list

Click to play the selected
sound on the client side

C:'\Program FilesWiwotek Inc'S1 rl. I!

§¢ Click to adjust volume

m Please note that you cannot Talk and Play Sound at the same time.
m When you are talking or playing sound, you cannot add other cameras to the Talk Panel. If you want to add more

cameras to the Talk Panel, please Stop Talking and Stop Playing first.

PTZ | Two Way Audio | Instant Playback PTZ | Twio Way Audio | Instant Playback

1_PZ7131

1_PZ7131

Click to stop playing

C:'\Program FilesWivotek Inc\/ ' I

C:Program Files\Wivotek IncV| (B D

(CTTTTTTTTTTTT I—
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Remove a Camera from the Talk Panel

B Remove a camera

Drag a camera from the Talk Panel and drop to the hierarchical management tree window as shown
below. The camera icon will disappear.

= PE Camera
i w 20x Zoom Mega-Pixel Speed D
@& Mega-Pixel Metwork Camera( 1t
EM Mega-Pixel Metwork Cameral 1t
i Mega-Pixel Metwork Carneral 19
=5 - Recording Storage
E| ------ F=r DefaultGroup
w 20 Zoom Mega-Pixel Spe
0 Mega-Pixel Metwork Carm
- @M Mega-Pixel Metwork Carm
v Mega-Pixel Metwork Carm
- [ Layout

Audio

Instant Playback

B Remove all cameras
Click , all cameras in the Talk Panel will be removed.
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How to Configure E-map Settings

VAST LiveClient supports intuitive E-map function which allows users to upload E-maps for
overall devices management.

Click System > E-map to open E-map Settings Page:

( System | Edit | \ [
Lock

Enable Click Omn Image
Leangvage

Second View

Lawnch Playback

Logout
Exit

Upload an E-map

Click to search for E-map(s) to upload.
Upload New Maps @@
Lok, jr: |Bmaps ?| Q & M-

Iy Recent
Documents =] Map#.jpg

€]

Desktop

7
My Documents
My Computer
File name:; |"Map3.ipg" "Mapl.jpg" "Map2 FHG" b | L Open i
My Metwork | Files of tupe: |AII image filez ﬂﬁl [ Cancel ]

The uploaded E-maps will be listed under the E-map list tree.

ge

If the uploading procedure fails, please compress the image size of your map (equal or smaller than 2MB) and try
again.
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User Interface of E-map Settings Page (View Mode)

B Double-click an E-map on the tree, it will be displayed on the E-map window as shown
below. There are two operation modes of E-map settings page: "View Mode" and "Edit Mode".
The following is the "View Mode" illustration.

A D E

@ E-Map

B =) ) ) L
5 WUTH_Staanl{127.0.0.1) C B

El
"

A. Menu bar B. Quick access bar C. E-map list tree D. E-map window E. Status panel

m Right-click the E-map, then you can Edit, Rename, or Delete the E-map.
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m Right-click an E-map on the tree and click Edit or click [Zl] on the Quick Access Bar, it will
switch to edit mode.

= B wwTk_Station1(127.0.0.1)

Quick Access Bar

I
— -

Function Description

Zoom in Zoom in the E-map

Zoom out Zoom out the E-map

Default size Adjust the E-map to default size

Upload Upload E-map to the login station

View Mode Click to switch to view mode

Full Screen Extend the E-map settings page to full screen
Save Save E-map settings

Status Panel

User Name

Station Name (IP Address)

Login Time (yyyy-mm-dd hh:mm:ss)
Current Time (yyyy-mm-dd hh:mm:ss)
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User Interface of E-map Settings Page (Edit Mode)

TAIWAN

A. Menu bar B. Quick access bar C. E-map list tree D. Device tree
E. Map preview F. E-map window G. Status panel

m Right-click the E-map, you can Edit, Rename, or Delete the E-map.

Rename

Delete
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Device Management

Please follow the steps below to edit an uploaded E-map.

a. Double-click the E-map you want to edit, it will be displayed on the E-map window.

b. Use Quick Access Bar to adjust the size of the E-map. In edit mode, you can also use your mouse to
drag the position of the E-map and zoom in or zoom out the E-map.

c. Drag-and-drop the connected devices to the E-map according to your deployment.

e |
|-d‘i ] ra BTl

d. Right-click the device icon on E-map, you can rotate the direction or delete the device. The device
can be rotated in 8 derections as shown below.

TOEOEIDG

e. You can also drag the DI/DO device under the connected device onto the E-map. If you want to
change the status of the DO device, double click the DO icon on E-map.

For more information about DI/DO settings, please refer to . / . Digital input on / off
Association Management on page 109.

-/ i Digital output on / off
f. Click on the Quick Access Bar to save the new settings.

gé

The red frame twinkling around the device means there is event trigger(s) going on.
Meanwhile, a live view dialog will pop up beside the model.

2I]I]9.f11.f1ﬁ PM 05:20:12|

— e
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Live View Dialog Settings

Click Configuration > E-map Settings to open the E-map Settings dialog, then you can
choose to Open Live View Dialog or to Send to Single View when you double-click the device
deployed on the E-map.

Open Live View Dialog

Select Open Live View Dialog: When you double-click the device icon on the E-map or when an event
triggers, a live view dialog will pop up beside it. It is the default setting in E-map Settings window.

¥ E-Map Settings

Double Click Carmera on E-Map _F'Z!?IBI
[ Configuration :J & Hpen Live view Dialog

E-Map Settings.. ) 5end to Single View

[ (] 4 ] [ Cancel

Send to Single View

Select Send to Single View: When you double-click the device icon on the E-map, it will open a single
view on the VAST LiveClient.

¥ E-Map Settings §|
Double Click Carmera an E-Map
( Configuration ::I () 0pen Live View Dialog

E-Map Settings. . @ Eend to_Sindle View!

[ (0] ] [ Cancel ]

If you have set up dual monitor, it will be automatically sent a single view to the second monitor.
Monitor 1 Monitor 2

1_PZ7131
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The live view dialog also supports click on image, PTZ, and e-PTZ as long as the linked device supports and
enables those functions. To enable those function on E-map, please check the item "Enable click on image" on the

menu bar of LiveClient as shown below. Then an icon will appear in the live view dialog for you to control the
cameras.

[ System | Edit | View | C

Lock CiltL
Enable Click O [mage
Language 4

Second Wiew
E-Map
Launch Plavback

Logoug
Exit

E-map Link

After completing device deployment on your E-map, you can link an E-map to another E-map.
Please follow the steps below to configure E-map link:
a. Select a map you want to edit and enter Edit Mode.

= B2 WWTEK_Stationl1i127.0.0.1)

=i ' E-Map

b. Drag-and-drop another E-map onto current E-map. A blue frame will appear as shown below.
For example: Link Map1 to Map2 by dargging Map2 onto Map1

-3 H WATE _Stationl [127.0.0.1]

c. Use F1= to move the position of the blue frame.
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Click Resize, some nodes will appear around the blue frame. Then You can drag the nodes to move
the position, rotate the direction, adjust the size, and change the shape.

P, - (lihpan = P WSt

rotate the direction

resize change the shape

move the position

e. Click on the Quick Access Bar to save the new settings.

f. If you want to set additional map links, please repeat steps a. ~ e.
For example: Link Map2 to Map3 by dargging Map3 onto Map2

-8 E WWTK_Station1(127.0.0.1)
= B e
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h. Test the web links. Click on the Quick Access Bar to switch to view mode.
Double-click the blue frame on Map1, it will automatically switch to map2. Then double-click the blue
frame on Map2, it will automatically switch to map3.

@ Fobep

Map 1

Configuration

Map 2

| Map 3
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Since VAST revision 1.13, you can also click and drag camera or NVR's DI/DO devices to an E-map.
See page 57 for how to enable NVR DI/DO options.

] e

| o SR FEROIIGR 18R 4 7L

| 3100684024152 168

| = R sps161-H192.108.4.104)

|~ yoem

i Bl s smbociszasease) o

| — I EMap

|~ men

B o

1 - A4 1192 168415 |
= B oo

3o
@ o2

o2

See page 191 for how to enable popup video windows on E-Map. y
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How to Configure Client Settings

In Client Settings, you can configure Snapshot Settings, Recording Settings, View Settings,

General Settings, Joystick Settings, Proxy Settings, a

Camera Management L
Station Management...

Logical Tree View Management...

1/O Box Management 3
User Management...

Association Management...

Alarm Management...

Virtual Matrix Management r
Failover Management 3

Search VivoCam Switches...

Station Settings 3

Video Enhanceme

Snapshot Settings

nd PiP Settings.

Snapshot Settings

Recording Settings
View Settings

General -E'..eﬁir.tgs

' Joystick Settings

Proxy Settings

PiP Settings

Please follow the steps below to configure snapshot settings:
a. Click Configuration > Client Settings > Snapshot Settings on the menu bar to open the Snapshot

Settings window.

b. By default, camera name and current time will be printed on the snapshots taken.

c. Select a picture format for snapshots (BMP or JPEG). If you select JPEG format, you can adjust the
recompression quality (from 1 to 100). Note that a higher value would generate higher picture quality

but lower compression rate.

d. Fill in a filename prefix for the snapshots.

e. The default storage path for snapshots is C:\Users\Public\Documents\VIVOTEKInc\VAST\Client\
LiveClient. If you want to change the storage path, click Browse _-- | to select another folder.

[ Generate a file name automatically. (YYYYMMDD_HHMMSS) ]
_

Overlay camera name and time on snapshot.

)

P Co—
Recompression Quality: El

C:\ProgramData\WVIVOTEK Inc\VAST\Client

Lok | [ concel ]

ge

The recompression quality is only enabled
in MPEG-4 streaming. If your stream source
is MJPEG, the system will directly save the
JPEG image without recompression.

f. If you check Generate a file name automatically, VAST will directly save snapshots with the following
filename format to the storage folder.

!

l

File name prefix Date and time

(YYYYMMDD_hhmniss)

~

4 Snapshot_20100125_173015_01.jpg

!

Picture format

Serial number of snapshots
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If you uncheck Generate a file name automatically, the Save file dialog box will pop up when you
take a snapshot. The file name prefix will automatically be displayed in the Save File dialog box.

Save file EI[X]

Save ir: IEi Snapshat LI « @ 5k B

My Recent
Documents

My Computer
M_l,l Metwark  File name: Snapshot_| i Save I
P|aces M _I
Save as type: IJPEG files [*.jpg) LI Cancel |
i |

Take a Snapshot

Please follow the steps below to take a snapshot of the live video stream:
a. Select the video cell of which you want to take a snapshot.

b. Click Snapshot on the quick access bar, or right-click the video cell and select Others >
Snapshot from the popup menu. You also can click Edit > Snapshot to take a snapshot.

'. ‘E||"E| Edit | View | Configuratior

- Start Mannal Becord ing
(127.0.0.1) 08 Live View | [ Matrix View Spanshot Chled
DE161(192.168.5.111) 1_FDalhl ‘ ,52,1 2"“9"'“2 PM "*”ﬁ, Primnt b
] Storage E— Fecord to EXE
gingle View Chrl+Y .
Full Screen Ctel+F Em'd

Enable PiP
Hide Glabal View

Ctrl+1
Ctrl+H

EnableInstant Replay

Stream 1 (19201 080)
Stream 2 (1280<720)
Stream 3 (176x144)
Stream 4 (10201 080)
Send to Talk Panel
SetDO »

Others 7

‘ideo Enhal t
Wideo Displ Brint
SWC FPS Adjust

c. The snapshots will be found in the preset storage folder on your local computer.

Ctrl+8

Snapshot Zoomed Image

Print Zoamed Image

Nute Ctrl+M
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Recording Settings

The VAST Server allows you to record the live video in EXE, 3GP, or AVI format to your storage
folder.

Type 1: Record to EXE

Record video as an EXE file. The EXE is not only a media file but also a built-in media player. When
user execute the EXE, the media file will be played automatically. There is no need to install any other
program. For more information about how to use the EXE player, please refer to page 185.

Please follow the steps below to configure EXE record settings:

a. Click Configuration > Client Settings > Recording Settings on the menu bar to open the Recording
Settings window.

b. Select EXE as the Record Type.

c. The default storage path is C:\Users\Public\Documents\VIVOTEK Inc\VAST\Client\LiveClient\Record.
If you want to change the storage path, click Browse - | to select another folder.

d. Select the Length of each file-- Maximum Size (11~2000MB) or Maximum Time Interval (1~150
min).

Record video in EXE format, includes a built-in media
player along with the media file, Executing the file
Record Typer 03GP (g its i automatic playback, eliminating the need to
A install a separate playback program.

C Save to; C\ProgramDatalDocurnents\WIVOTEK InciWAST Client\Liveclie | ., ]

d‘" Length of Each File

(@ Maximurm Size () Maxirmum Time Interval

11 1500 2000
(MB)

-
W

[ ik ] ’ Cancel

e. Click OK to enable the settings.

Type 2: Record to 3GP

Record video as a 3GP file. 3GP file is a standard MP4 format compatible with players such as VLC
player. Choose this type if you has already installed one of these players.

Please follow the steps below to configure 3GP record settings:

a. Click Configuration > Client Settings > Recording Settings on the menu bar to open the Recording
Settings window.

b. Select 3GP as the Record Type.

c. The default storage path is C:\Users\Public\Documents\VIVOTEK Inc\VAST\Client\LiveClient\Record.
If you want to change the storage path, click Browse _.- | to select another folder.

d. Select the Length of each file-- Maximum Size (1~2000MB) or Maximum Time Interval (1~150 min).
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N Recordigg Seting =

b (EXE  Record video as a 3GP file, a standard MP4 format

compatible with players such as YLC, QuickTime, ar
Record Type:| @ 3GP || pealdne, Choose this format if vou have aready installed

iy One of these players,

Save tor  CiiProgramDataiDocuments\WIVOTEK IncivASTiClentiLivecls E

Length of Each File
@ Maximum Size () Maximum Time Interval

1 1500 2000
{ME)

-
W

3GP Settings

|"_|Record with only standard codec l

| Ok | Cancel

e. If you check "Record with only standard codec", the video from old models (VIVOTEK 6000-series
products) using H.263 codec will not be recorded.

f. Click OK to enable the settings.

Type 3: Record to AVI

Record video as an AVI file, which uses the popular codecs pre-installed in the Windows OS. Please
note that the speed may be slower due to the need of decoding the video/audio and re-encoding both
into a compatible codec.

Please follow the steps below to configure AVI record settings:

a. Click Configuration > Client Settings > Recording Settings on the menu bar to open the Recording
Settings window.

b. Select AVI as the Record Type.

c. The default storage path is C:\Users\Public\Documents\VIVOTEK Inc\VAST\Client\LiveClient\Record.
If you want to change the storage path, click Browse _.- | to select another folder.

d. Select the Length of each file-- Maximum Size (1~2000MB) or Maximum Time Interval (1~150 min).

b 1 exg  Record wideo as an AV file, which uses the popular
codecs pre-installed in the Windows 0S5, Please note
Record Type: () 2GP  that the speed may be slower due to the need to
decode the video/audio and re-encode into a

@ AVI rormpatible codec,

v

Due to the AVI file has a limitation on
the maximum file size of 2G bytes, if
the setting “time length” generates data
larger than 2G bytes, several files will
be created.

Length of Each File

1@ Maxirnurm Size () Maxirmurm Time Interval

1

1500 2000

(ME)

-
7

AVI Settings

-
AWT Frame Rate: 15

S (130 ]
m]@

Wideo Cormpression Setting

[ O ] [ Cancel
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e. Select the frame rate/ per second.

f. To modify the video compression settings, click Video Compression Setting to open the AVI Video
Compression Setting window. Select the desired video compression algorithm, compression
quality, key frame intervals, and data rate in the corresponding fields.

Video Compression Setting 1)
Compressor: E K. i
| Cinepak Codec by Radius &8 |
Compreszzion Quali, 100 l
Canfigure. .. ‘

< | )

About...
Key Frame Every frames ‘

Data Rate KB/sec

If you do not choose to compress the video, the
generated AVI will be very large in file size.

= To modify the settings of the compression algorithm: Click Configure, then a dialog box will pop
up for you to modify the settings. The dialog box will be different according to the compressor you

Se|eCt Cinepak for Windows 32 |X|

radus

Wersion 1.10.0.11
Copyright & 1332-1995 Radius Inc., &l Rights Reserved

(%) Compress to Color
() Compress ta Black & White

® To read the information of a compression algorithm (its version for instance): Click About, and a
dialog box will pop up showing the related information. The dialog box will be different according to
the compressor you select.

Cinepak for Windows 32

radus

Cinepakf Codec
YWersion 1.10.0.11
Copyright & 1992-1995 Radius Inc., Al Rights Reserved

g. To modify the audio compression settings, click Audio Compression Setting to open the AVI
Audio Compression Setting window. Select the desired audio quality, format, and attributes in the
corresponding fields.

Audio Compression Setting

RE=S

[untitled] | | Save As.. Remove
Formnat: | PCH e |
Aftibutes: | 44.100 kHz, 16 Bit, Stereo 172kbisec v |

E Ok, i Cancel
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Record an EXE/3GP/AVI File

Please follow the steps below to record an EXE/3GP/AVI file of a live video stream:

a. Select a video cell or a device from the heirarchical management tree which you want to record to
media file.
b. Click Record to EXE/3GP/AVI B on the quick access bar, or right-click the video cell and click

Record to EXE/3GP/AVI. You can also click Edit > Record to EXE/3GP/AVI on the menu bar. (The Ul
string will change according to your Recording Settings.)

2ofa] @I eafE|E <[>

n1(127.0.0.1) 0 Live View | Pf Matric view | Edit | View | Configuratior
] | LRt Ve ]

_FDB161(192.168.5.111)
ing Storage

1_FD8161 2010/09{02 PM 04:47:2

Snapshot Cl+d
Print 4
Record to EXE

Remove

Ctrl+V
Ctrl+F
Crl+l
Crl+H

Single View
Full Screen
Enable PiP
Hide Global View
EnsblaTnstsnt Replay

Stream 1 {1920<1080)
Stream 2 (1280<720)
Stresm 3 (176x144)
Stresm 4 (1920<1080)
Send to Talk Panel
St DO
Others

Video Enhancement

Video Displey Mode

Shapshot Ctrl+8
Record to EXE
Print

c. For recording a high-resolution video (1600 x 1200) in AVI type, a dialog box will pop up as shown
below to remind you that the CPU loading will increase. Click OK to continue the process.

@ Information

Converting high resolution video size may significantly increase the CPU loading,
leading to the possibility of strearing disconnection or reduced systern performance.

d. The icon E] will then change to Recording EXE/3GP/AVI B and a red text string (EXE/3GP/AVI)
will appear at the bottom right of the video cell. Note that only one video channel can be recorded at a

time. e —

&l « 1@< beaf | < [ )
0N Live View |ﬁ Matrix View ﬁé
1_FD8161 i 2010/09/02 PM 04:56:31

If you save your video via a LiveClient installed
on another computer, the videos will be placed in
where you installed the LiveClient utility: e.g., C:ll
VASTIClient|LiveClientlRecord. On Windows XP:
C:|Documents and Settings|All Users|Documents|
VIVOTEK IncI\VASTIClient\LiveClientIRecord

32,168.3.81)
92.168.3.59)
92,168.3.102)

e. When you want to terminate the AVI Recording, click the icon E on the Quick Access Bar. The export
process will then terminate and the button will change from @ The recorded media files will be
found in the preset storage folder on your local computer as shown below.

Below is the file name format for AVI files:

20100125 _173015.avi AT e 20091118, 195800 3ap
L L M MediaPlayer Application % ggsngnm
Pate and fime Video format G T a0
(YYYYMMDD_hhmmss) | TBERmE

1,191 KB

| :




Built-in Media Player--EXE

Below is the icon of footages saved as EXE files. Double-click on it, the recorded video will be played
automatically as shown below. You may also open the built-in Media Player in the default location:
C:\Program Files\VIVOTEK Inc\VAST\Client\LiveClient. On Windows XP: C:\Documents and Settings\All
Users\Documents\VIVOTEK Inc\VAST\Client\LiveClient\Record.

20091118 113743 exe
Video Title bediaPlayer £ pplication

2013-04-01 |U Timeline Slider 2013-04-01

0g:49:13

Nr 2013/04/01(32 === )
IE."J._I‘ & @ o 08:49:15 17 Playing

| Total length of the histogram
Control Buttons

The playing rate can be 1/8, 1/4, 1/2, 1X, 2X,
4X.

Current time of the video clip

Ilcon Function Description

E Pause Pause playback of the focused video clip
E| Play Start playback of the focused video clip

E| Next Frame Go to the next video frame of the focused video clip

f?-| Slow Down  Slow down the playback rate

@ Speed Up  Speed up the playback rate
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The function menu of the built-in media player are displayed as shown below:

Bdit View Edit N
Crpen 3GF File .. Snapshot (BMP) Full Screen
save az BHE .. snapshot JPED)
Bave az 3GF File .. Comvert to AY]
Print
Exit

® The built-in player is able to playback 3GP and EXE files.

® The built-in player is able to save 3GP files as EXE files.

® The built-in player is able to save EXE files as 3GP files.

® The built-in player is able to convert EXE and 3GP files into AVI files.
® The built-in player also supports snapshot and print functions.

=Y
Below are special notices related to video recording with the fisheye cameras:

m For recorded videos from the fisheye cameras, only the built-in Media Player can playback the
Regional or Panoramic views. If you access the recorded videos using other playback software, you
will end up seeing the circular-shape Original view.

m \When recording videos from fisheye cameras, Regional and Panoramic views can only be preserved in
the EXE and 3GP format. If you save the dewarped views, i.e., Regional and Panoramic, as AVls, only
the circular Original view will be preserved.

= Currently the video playback on the Emap window displays the Original view only.

m To display a Regional or Panoramic view, right-click on the Media Player window.

[File Edit View
il

186 - User's Manual



VIVOTEK - A Leading Provider of Multimedia Communication Solutions

View Settings

This section allows you to set the display mode of a video cell, including Display Location,
Date and time Format, Video Display Mode, and Font Settings. When you change the
settings, the sample window will change accordingly for you to preview the settings.

(W Viewsettings T =

Display Location

Camera Name 2016/6/24 | 06:07:23
Doy Ava 1: | E TN ECEE
Display Area 2: | Server Date & Time El
This is a sample screen.
Display Area 3: | Video Title El
Display Area 4: | No Display El
Date and Time Format Font Settings
@ Same as Local Computer Font: ’ Systam .]
() Specify Color: | El
Date Format: | YYYY/MM/DD <] sie:
Time Format: Default Time Format -]
Video Display Mode

@ Hide borders () Keep top/down borders ) Keep the aspect ratio
[¥] Show motion windows when triggered

Display the connecting message when video is lost

The screen goes blank when video is lost

VCA
Show VCA rules

VCA extra information:

[ ok | [ cancal
Display Location . ;
Pay Display Area 1 Display Area 2
Display Location
Camera Name CUTBIEHZA A UBIUSIES
Disloy Avea 1: XY - | e
Display Area 2: ‘ Server Date & Time |Z|
This is a sample screen.
Display Area 3: ‘ Video Title |Z|
Display Area 4: ‘ Mo Display El

Yideo Title

. . ) Display Area 3 ) Display Area 4
As the illustration shows, there are 4 display areas for you to input information about the live video. Each

drop-down list includes many options for you to select: No display, Camera Name, Video Title, Camera
Date & Time, Camera DateTime, Server Date & Time, Codec & Resolution, Address, and Network
throughput & FPS.
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Date and Time Format

Date and Time Format

@ Same as Local Computer
Specify
Date Format: | YYYY/MM/DD

Time Format: | Default Time Format

m Same as local computer: Select this option and then the date and time format will synchronize with the
local computer.

m Specify: Select a desired format for the date and time from the drop-down list.
Date format: Select YYYY/MM/DD or MM/DD/YY.
Time format: Select the default time format (synchronize with the local computer), 12h AM/PM, or 24h.

Video Display Mode

Video Display Mode
@ Hide borders Keep top/down borders Keep the aspect ratio

v| Show motion windows when triggered

Camera Name 201040129 PM 02:12:11

m Keep the aspect ratio: In the default settings, the size of
the video window will change according to the layout of This is a sample screen.
the live view window you choose. However, the frame
size may be distorted.

m Keep top/down borders: the camera name, video title, _ _
and time will be displayed on the black borders instead LRI

of displaying floating text on the screen.

m Keep the aspect ratio: If you select Keep the aspect ratio, the video window will be adjusted to the
same frame size as the preview window. This function is disabled as default.

®m Show motion window when triggered: If you select this option, the red frame of the motion detection
window will appear in the video window when motion is triggered. This function is enabled as default.

m Display the connecting message when video is lost:indow will appear in the video window when motion
is triggered. This function is enabled as default.

m Show VCA rules: VCA rules refer to the Line Crossing and Field Detection lines drawn on individual
video screens. These VCA functions are configured on the web consoles with cameras, not on the
VAST LiveClient.

The Display options can also be accessed by a right-click on the view cell.

For detailed information about how to set up the layout of the live view window, please refer to How to
Change Video Viewing Mode on page 81.
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Font Settings
This function allows you to change the font on the video cell.
m Font: Automatically lists all fonts installed on your operating system. Select the desired type.

m Color: Select a desired font color (white, red, green, blue).
m Size: Select a desired font size (8, 10, 12, 14).

Remove

Single Wiew Crl+4

Font Settings Full Screen Ctrl+F

Enable Instant Replay

(o] [=]

Font: [sy-stem v]

Stream 1 3727kbs, 15ips
Strearn 2

cobr. ‘ E Strearn 3
Send to Talk Panel

SetDO »
Sige: |10 - Others ,

Wideo Enhancement 3

| Wideo Display Mode 3 ‘7‘ Hide Borders

S T e N Keep Top/Down Borders

Keep the Aspect Ratio

SVC FPS Adjust Bar
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General Settings

This section allows you to configure the System Settings and Rotation Settings.

System Settings

Autormatically log in after logging in to operating system
Autornatically display in full screen after login

[¥] auto add nesly-inserted camera to video cel

[¥|Retrieve RTSP stream on spedified part; 554 E
[] Connect substation streaming via relay

[V keep detecting camera DIJDO status

SyStem Settlngs ["]5art camera by name

m Auto login after logging in to operating system: If you check this option, VAST LiveClient will
automatically login after you login to Windows without filling in the user name and password. This
function is disabled as default.

m Automatically display in full screen after login: If you check this option, the video cells will be displayed
in full screen without showing the menu bar or the control panels.

= Auto add newly-inserted camera to video cell: If you check this option, VAST LiveClient will
automatically add the newly-inserted device to a video cell. This function is enabled as default.

m Retrieve RTSP streaming on specific port: The default port for RTSP streaming is 4543. If you want to
change this port, please check this item and fill in a desired port number.

m Setup substation streaming via relay: This option is not checked by default. As the following diagram
shows, VAST Client might directly connect to the streaming under VAST Server 3-2 without requesting
the connection via VAST Server 1 and Server 2-1. If you want to get streaming through relaying,

please check this option.
VAST VAST
Client &= Server 1

manages 2 sub-stations
VAST VAST
Server 2-1 Server 2-2
| 12
Il ST7501 VAST ST7501 ST7501
Server 3-1 Server 3-2 llServer 3-3 IlServer 3-4

22288

e
-
VIVOTEK IP Camera

i i
- -
VIVOTEK IP Camera

‘ £

i i i
- - - -
VIVOTEK IP Camera VIVOTEK IP Camera

VIVOTEK IP Camera

um [fthe VAST Server 3-2 is set up behind a firewall, the VAST Client will not be able to access the VAST Server 3-2
directly. You have to get the connetion by relaying.
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m Keep detecting camera DI/DO status: The default for this option is enabled. This option enables the
VAST server to monitor the DI/DO status from the configured cameras. You may also disable this
option.

m Sort camera by name: The positions of cameras on the device tree will be sorted by their camera
names.
[ GeneralSetings |

System Settings
[7] Automatically log in 2fter logging in to operating system
[] Automatically display in full screen after login

[¥] Auto add newly-inserted camera to video cel

Retrieve RTSP stream on specified port: | 4343 E

["] Connect substation streaming via relay
Keep detecting DI/DO status

[ Sort camera by name
Alarm Settings
Enable live alarm notification
Enable alert sound(s)
Enable E-Map popup window
Alarm window mode: @ Fixed
© Popup
Rotation Settings
Enable rotation after login
Rotate the page every 1[]75 second(s) (3 ~ 999)

Display Settings
Maximurm number of view cells
Enable auto stream size:

Enable de-interlace function
Enable Instant Replay on video cell

Default replay length:

Local streaming buffer time: 0 El millisecond(s) (0 ~ 10000)
o ]

Alarm Settings

= Enable live alarm notification: Select this option to activate real-time event notification. For example:
the event notification of DI/O status on the hierarchical management tree, the event list in the event
window, motion detection windows in video window, or the event notification on E-map settings page,
etc. This function is enabled as default.

m Enable alert sound(s): If you enable this option, you will hear alert sound on the client side when the
event is triggered.

m Enable E-Map popup window: When enabled, a popup window appears on an E-map displaying the
current video when a camera-related event occurs.

Note the following with the E-Map popup window:

The camera that triggers an alarm must be placed on the E-map to have its live video displayed in
the popup window.

When an event occurs, and the related camera is configured into multiple E-maps, the popup
window appears on the first available E-map.

When many popup windows appear, many map views will consecutively appear until all popup
windows properly display.

This feature supports popup windows for cameras under VAST substations or NVR.

Popup windows only appear when the E-Map is opened; however, the windows will still appear on
a live view.

If a DI/DO trigger is not associated with a specific camera, no popup video window will appear
when triggered.

Fisheye dewarp is also available on the E-map popup windows.
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* Please also configure the Client Notification options in the Alarm Management window.

N4 Alarm Management E@@

An alarm is associsted to one or more interested events. When one of them is triggered,
the system would raise an alarm.

Alarm List

Q Mew Alarm @
- =S eque ., Dewi
) Email

() Start to record on

() Move to preset location
) 5et DO

() GSM short message
DHTTP

@ Client Notification

Motify me with Popup Window. Size:

[¥] Close it automatically after E seconds

i) (oo )

[¥l Include the event-triggering camera inish
Add Camera
[ o] —
- —

m Alarm window mode: Select Fixed or Popup mode for the event window. For more information about
event window, please refer to page 39.

Rotation Settings

m Enable rotation after login: If you check this option, the video cells will start to rotate after you login to
the VAST LiveClient. The default setting of this function is disabled.

m Rotate the page every ] second(s): Fill in a desired interval time for video page rotation. The
maximum value is 99 seconds. The default value is set at 6 seconds.

For detailed information about how to set up the layout of the monitoring window and rotation functions,
please refer to How to Change Video Viewing Mode on page 81.
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Display Settings Display Settings

Maximum number of view cells |64 v|

| Enable auto stream slze:|QuaI'rty first v|

Enable de-interface function

| Enable Instant Replay on video cell

Default replay length: |30 seconds v|

Local streaming buffer time: 0 = milisecond(s) (0 ~ 10000)

® Maximum number of view cells: This determines the number of view cell on window, and also takes
effect with the number of layout pages. For example, if there are 320 channels using the 1+31 layout,
there will be 10 layout pages in the LiveClient window. The configuration changes take effect after the
LiveClient is re-started.

® Enable auto stream size: The Auto Stream Size feature dynamically adjusts the stream sizes of video
feeds from network cameras in order to reduce CPU load and bandwidth consumption.

It is often the case that in surveillance deployments the physical dimensions of monitors, the
effectiveness of visual stimulus, and the operators' regions of interest can all be very limited.
Streaming large-size videos at all times will be a waste of bandwidth and system computing power.
CIF and VGA size videos are usually sufficient for the operators watching surveillance screens.

When enabled, your LiveClient station automatically requests smaller-size streams as video feeds (any
from streams #1 ~ #4) from the network cameras. For example, the frame size of video stream #4 will
be reduced to 320x240 (CIF). Depending on the actual size of view cells on the LiveClient monitoring
screen, the VAST server automatically requests different video streams.

When the size of view cells is manually expanded, a VAST server requests a different stream. This is
called Stream Jump. Shown below are the details of the corresponding stream jumps.

View cell size Stream jump to...
4:3 resolutions
<= 320x240 stream #4 (CIF)
> 320x240 or 640x480 stream #1
16:9 resolutions
<= 384x216 stream #4 (CIF)
> 384x216 or 640x360 stream #1
1:1 (fisheye cameras)
<= 384x384 stream #4 (CIF)
> 384x384 or 640x640 stream #1

Facts about Auto Stream Size:
e The Auto Stream Size takes effect when,
1. The size of view cell is changed.
2. Inserting a new camera, or when the "Auto add newly-inserted camera" feature is applied.
3. Double-click or click-and-drag cameras into view cells.
4. When Auto Stream Size feature is enabled (the configuration on this window).
5. Through the layout change.

+ The LiveClient utility automatically adjusts stream selection according to the size of view cells, no
user's configuration is required.



* The frame size of stream #1 is user-configurable. The VAST server only resizes stream #4.

« |If a user disables the Auto Stream Size function later, the frame size of stream #4 will not be
restored to the previous configuration. Stream jump takes place on the display of all connected
cameras once the function is enabled.

» The Auto Stream Size function does not apply to the Matrix view.

» If users configured a region of interest before the Auto Stream Size function is applied, e.g., via
the ePTZ control, the view cell might display a different live view.

* Below is the general rule for stream selection:

stream # configured into VGA stream # configured into CIF
4 streams cameras Stream 2 Stream 4
3 streams cameras Stream 2 Stream 3
2 streams cameras none Stream 2

*  When a smaller stream is selected, the video quality is set to fixed quality as Good.
*  The Maximum frame rate is not configured.

* The VAST server automatically selects a video resolution of a specific aspect ratio that best fits
the current view cell, and places the video into the view cell.

Limitations:
* For older, single-stream cameras, the Auto Stream Size feature does not take effect.

*  When the Auto Stream Size feature is enabled, the NR and ND series NVR configured under the
VAST server will be considered as substations. The stream configuration of cameras managed by
these NVR substations will not be changed. Only the video codec, bit rate, and frame rate of the
video feeds directed through these NVR substations will be changed into a more economic setting.

+ For the NR8401 NVR, the Auto Stream Size function may not fully apply. For cameras managed
by the NR8401, the following will apply:
Large view cell: default viewing stream.
Medium view cell: stream #2.
Small view cell: the last stream.

e a user disables the Auto Stream Size function later, the frame size of stream #4 will not be
restored to the previous configuration.

®m Enable de-interlace function: Select this option if your connected device does not support de-interlace
function. For example: VS7100.

m Enable Instant Replay on video cell: Here you can change the duration of a playback that happened
immediately before a user utilizes the instant playback function.

m | ocal streaming buffer time: Video frames can be temporarily stored on the cache memory of the
VAST server for a short, configurable period of time before they are displayed on the Liveview. If the
networking condition is less than ideal, this can help delivering a smooth video stream. Note that this
feature is not available on a Matrix view and the web console.



Joystick Settings

This section explains how to remote control connected network devices with a USB joystick. It's
easy to install and configure via the USB interface.

Enable Joystick

Connect to the USB plug of the joystick to a USB port on your computer. Supported by the plug-in in the
main page (Microsoft’'s DirectX), once the plug-in in the main page is loaded, it will automatically detect if
there is any joystick on the computer. The joystick should work properly without installing any other driver
or software.

Then you can begin to configure the joystick settings of connected devices. Please follow the instruction
below to enable joystick settings.

a. Select the target device from the hierarchical management tree.

b. Click Configuration > Client Settings > Joystick Settings on the menu bar to open the Joystick
Settings window. If your joystick is working properly, it will be displayed on the drop-down list.

c. Select the joystick you want to configure. Check Enable Joystick, then click Configure Buttons to
open Buttons configuration window.

(System | Edit | W [b) | | Configuration | Layout | Help:I

Camnera banagement r
| Station Management. .. o =
O]z &)< fn : rea|| ) < [

/ ser Management... A -
A zsociation Management. .. ! T

= L} i - I i | ;i i

W TK_Stationi(12 Event Monagement,.. e Wiew I'_\i Matrix View |

[ h Zamera Virtual Matrix Management * 8161

201040903 PM 01:21:42

&) & 1 roa =

w2 Recording St SRten Setines . -~ 2
13 Client & Snapshot Settings
#- [ Layout 2 . .
] , Eeconding Settings
Yideo Enhancenent Visw Sett

Creneral Settings
Jowstick Settings
Prowor Settings
PiP Bettings

[\‘ Joystick Settings - I\ﬁ

Joystick Settings Assigned Actions
..r; Enable JDYStiCk Actions Buttons - Assigned Actions
@ s -~ Home - Buttonl - Record to EXE
|| Remverse direction of zoom control W EuttonZ - Zoom In
- ..2o0m Out Button3 - Zoom Cut
. : 1 Buttong - Single Wiew
Selected joystick: | |CH PRODUCTS IP DESKTOP COMTR: <+ - Focus = Buttons - Pan
- i Button6 - Stop
; ~Pan | Button? - Patrol
I Calibrate l [ Configure Buttons | [ Configure Keypad l - Stop BUttong - Home
- Patrol ButtonS - Ful Screen
[+ Preset Buttoni0 - Snapshot Auto Maming
Buttonll - Presetl
--Page Up
| OK ] [ Cancel l - i Do Buttoni2 - Preset2
e -~ Page Home
- Page End -
T
Assign Clear Selected

QK ] ‘ Cancel
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Reverse direction of zoom control

Due to different designs in joystick zoom wheel, you can select this checkbox to reverse the zoom in/out
directions.

Buttons Configuration

In Button Configuration window, the left column shows the actions you can assign, and the right column
shows the functional buttons and assigned actions. The number of buttons may differ from different
joysticks.
Please follow the steps below to configure your joystick buttons:
a. Choosing one of the actions and click Assign will pop up a dialog. Then you can assign this action to
a button by pressing the joystick button or select it from the drop-down list.
For example: Assign Home (move to home position) to Button 1.

¥ Buttons Configuration |§|
Assigned Actions
|ﬂu:ti|:|r'|5 | |Eluttc|r'|s |ﬂ~55igned Actions |
( Harne ' ad Buttonl
-~ Zoom In B Lo
- Zoorn Out v
[+ FoCus
[+ Iris
- Pan Prass the joystick button to assign to "Home" ar
- 5top select the button from the list below:,
- Patral
[+ Preset v
- Page Up :
- Page Down ELttornz
- Record to &I Button3
- Shapshot Auto Marming Buttons
e ButtonS
Assign ' Clear Selected SEEEQ?
Buttons Ok ] [ Cancel ]
|_|Buttong
Buttonlo K | | Cancel
Buttonll
Buttonls
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b. Click OK to confirm the configuration.
< Buttons Configuration |z|

Assigned Actions

- Zoom In
-~ Zoom Out)  Press the joystick button to assign to "Hormme” or
[+ Focus select the button from the list below,
[+ Iris
P | T
~Patral
= Presat Click "Ok" to assign "" to buttonl
Prezet]
- Presetd
- Preset;
21
ErESEF, Ok, Cancel
[ Assigh J Clear Selected J

[ ok J [ Cancel J

c. The Assigned Action will appear beside Button 1 in the right column as shown in the following diagram.
Note that a button can only be assigned with an action. If you want to modify the settings, select the
action on the list and click Clear Selected.

¥ Buttons Configuration

Azsigned Actions
Actions | |Eluttun5 |ﬂ«55igned Actions |
- Home A Euttonl Horme )
- Zoom In Buttﬂﬂé
Litton
Zoorn Cut Biuttond
- Facus ELthonS
Iz Buttons
~Pan = |Button?
-~ Stop Button2
- Patral Buttons
[+ Preset EUEDH ﬁ
F‘EIQE UD LITTaN
- Page Down —| |Buttonlz
-~ Record to AT
- Snapshot Auto Marming |
» &ssugn Clear Selected
[ [0]4 J [ Cancel J
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d. If you want to assign additional actions, repeat step a.~c. When all settings are complete, click OK
to save the settings or click Cancel to discard the settings. You may also assign buttons to jump around
matrix screens.

utton Co =

Assighed Actions

AcCtions | |Elutt|:|n5 - Assigned Actions
- Stop Alert - Buttonl - Record to EXE
- gudio Mute Buttonz - Zoom In

Button2 - Zoom Cut
- Rotate - -
- Record to EXE oond - gg‘#'e Vi
- Snapshot Auto Naming Button - Stop
[+ Print Button? - Patrol
- Lock Buttong - Home
- Full Screen Button® - Full Screen
- Gingle View ButtonlD - Snapshot Auto Maming
: ; Buttonll - Presetl
- Prewious Matrix
Pt Matrix Buttonlz - Presetz
- Previous Monitor
- Mext Monitar E

Azsign ] [ Clear Selected ]

(0] 4 Cancel

e. Click OK to save the settings or click Cancel to discard the settings.

¥ Joystick Settings |z|

Jovystick Settings
i

Selected Joystick! | cH PRODUCTS IP DESKTOR COM v |

[ Calibrate J [Cunﬁgure Euttons]

QK [ Cancel ]
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m /f you want to assign Preset actions to your joystick, the preset locations should be set up in advance.

m /f your joystick is not working properly, it may need to be calibrated. Click Calibrate to open the Game Controllers
window located in the MS Windows control panel and follow the instructions for trouble shooting. For more

information, please refer to the MS Windows help files for details.
¥ Joystick Settings |X|

Joystick Settings

Selected joystick! | (H PRODUCTS IP DESKTOP COF |

l Calibrate ' Configure Buttons

[ oK ] [ Cancel J

m The joystick will appear in the Game Controllers list in the Windows Control Panel on your computer. If you want
to check out your device, go to the following page: Open Start > Control Panel > Game Controllers.

Game Controllers

These settings help you configure the game controllers installed on
% your cormputer.

Installed qame controllers

Cantroller | Status |

CH PRODUCTS IP DESKTOP COMNTROLLER

[ Add... ] [ Remove J [ Properties J

[ Advanced... J[ Troubleshoat. . J
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Configure keypad

For joysticks that come with a keypad, you can use the combination of a number assigned to a camera
and the Enter key on keypad to quickly move to the camera’s current view. The current view will be
displayed in a single view. To configure the number representative of each camera, double-click to open
a configuration window. The number used for quick switch must be mapped to an existing channel.

Also note the following:

1. The keypad key representative can be a 4-digit numeric combination.

2. If a number key is pressed without pressing the Enter key within 3 seconds, the command is cancelled.
3. You should have at least ONE EMPTY view cell.

4. A Rotation operation will be halted when using the keypad quick switch function.

5. This quick switch function does not take effect on the cameras managed by VAST substations.

Set Key Mumber .- [ =
Camera Mame ey Mumber |— -
FEB191-shepherd test 1 E“g;;fg‘r" ﬁlﬁiﬁtﬁ?ﬁﬁlﬂf 1‘r<:|-n'£1’l glzmistutotﬁm to
Mega-Pixel Network Carmera 2 Mega-Pixel Network Camera.
IB3335-H 3 11 m
SDE161 4

| swe || doe l
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Joystick Settings - Using VIVOTEK's AJ-001 & AJ-002

The AJ-001 and AJ-002 joysticks come with some defaults working with a VAST server.

* Channel quick switch: Enter 1 to 4 numbers and press “Enter” on the keypad to bring the channel
into a full view. For example, enter 0010 and press Enter, CH 10 camera view will prompt on screen.
Note that the number keys and Enter must be pressed within 3 seconds.

» Currently, this function does not apply to cameras managed by sub-stations.

Following are the conditions for making the connection:

1. The joystick can either be powered by a DC 12V adaptor or via the USB. If powered by USB, plug the
USB cable twice to the USB port to enable USB power.

2. Connect the included USB cable between the USB ports on the joystick and a VAST server.

VAST

Below is the keypad numbering sequence:

< e

() &) &)
el (P i

9 1011
12 13 14 2122237 8 1 2
15 16 17 24 2526 27 28 3 4
18 19 20 5 6
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Since VAST rev. 1.13, the following keypad functions will be available as the defaults for the joystick.

1 |Pan 9 |#1 17 |#9 25 |Pause

2 |Patrol 10 |#2 18 |Cancel/Clear/Esc|26 |Play

3 |Stop 11 |#3 19 |#0 27 |Speed Up

4 [Home 12 |#4 20 |Enter 28 |Speed Down
5 |Zoomin 13 |#5 21 |Full Screen

6 |Zoom out 14 |#6 22 |Manual recording

7 |Snapshot 15 |#7 23 |Change Layout

8 |Preset 16 |#8 24  |Rewind

Use the combination of "Preset Move Combo" (button 8) + number keys + Enter.
For example button 8 + 1 + 0 + Enter -> Preset #10.

1d Pressing the layout button changes the current view cell layout. Press to change the layout
v from top to bottom as shown on the left.
1P+2
3V
232
4y
a3 You can see the default definitions for the keypad in the Joystick configuration windows.
1+5 3
1P+6 Joystick Settings
33 [¥] Enable Joystick
Reverse direction of zoom control
1P-8 Selected joystick: (3D Joystick Keyboard x)
1+12
it | Calbrate | [ Configure Buttons | | Configure Keypad |
306 Lok | [ cancel |
1+31
8x8

|~ 5top Al mmm.?:nmnwmp

Rotate Buttonl8 - Escape
Record Button19 - Keypad Number 0
i ;"'z:f Button20 - Keypad Enter
W bt Button21 - Ful Screen
et N Button2 - Record to EXE
Privious Montor Button23 - Change Layout
Hext Monkor Button2d -
- Keypad Button2s - Pause
L Button26 - Ply
' Preset Move Combo an:s"““’
- Instant Reply Buttonao
i3 Playhack
& Common

[ox J [ gnce |
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If you should need to change the mapping table, use the Keypad Mapping function.

30x Zoom Mega-Pixel Speed ..
Hetwork hi Camera

Mega-Man Network Camera

Mega-Man Network Camera
Meaga-Man Network Camera
Maga-Man Network Camera
Mega-Pieel Network Camera
Mega-Piell Natwork Camera
Mega-Man Hetwork Camera
Mega-Man Hetwork Camera
Mega-Man Network Camera

WO s A B W R

Lol
L=}

| Enter numberic characters starting from "0" to
"0999" or select the number from the list to map to
| Mega-Man Network Camera.

I g

[

D08~ O

[ =

The below message shows a mapping table ID conflict.

Enter numberic characters starting from "0" to
"9999" or select the number from the list to map to

Mega-Man Metwork Camera.
n =
The number is already in use by Mega-Man
Metwork Camera.
Press the OK button to replace it or press
Cancel to cancel.

[ o ][ oncel |
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PTZ/ E-PTZ Function

In addition to using the PTZ control panel, you may also control the rotation handle of the joystick to
remote control a PTZ/ E-PTZ network camera with ease.

Pan/Tilt: Move the rotation handle of the joystick; you can pan the camera to the desire position. There
will be blue line displaying the moving direction in the center of the video image as the diagram 1 below.

Zoom in/Zoom out: Shift the rotation handle clockwise to zoom in the camera on an image or go
counterclockwise to zoom out the camera on an image. There will be a circle and four vectors in the
center of the video image as the diagram 2, 3 below.

FD8161 EPEHL]

Pan/Tilt Zoom in Zoom out
(Move the rotating handle back and forth) (Turn the rotating handle clockwise) (Turn the rotating handle counter-clockwise)
Proxy Settings

In this section, you can enable, modify, or cancel Proxy Settings for client if your VAST Server
is under a proxy. If you change the proxy settings, please fill in the new value next time you login
the LiveClient next time.

h.@ ﬁro@ g;'mngs m N4 VAST LiveClient (=]
Log in local station
| [1Enable Prosxy
Address: 102.168.6.117 -
| &ddress: | |
- Authentication: |Basic Account -
: ==t
2" I_?"l User Mame: admin
Llser Mame:; | | S .
Password: | | Port: 3443 2] [Mluse ssL
l | ok || cancel |
- [ Log in I[Ca'lcei]’Hided.{l

User's Manual - 205




How to Use PiP (Picture-in-Picture)

PiP (Picture-in-Picture) is an intuitive function for user to simultaneously view a Global View and
ROI (Region of Interest) for live monitoring. The digital zoom in function can only focus on the
interested area and represent the details of megapixel video. Moreover, the multi-touch mode is
a very user-friendly interface for digital zoom in.

Enable PiP

Right-click the video cell and select Enable PiP. If you want to disable PiP, click the option again to
uncheck it. After you enable the PiP function, a movable global view window and a ROI frame will be
displayed as shown below.

2010/6{29 PM 09:24:24

Ctr+I
Hude Global Yiew Ll

Stream 1

Btream 2

Stream 3

Btream 4

Fend to Talk Panel
Het DO

Orthers

Global View - 4 Fiden Enhancement

Region of Interest
(ROI)

Global View

The global view is the original view with the size scaled down to 160x120. It is movable and you can drag
it anywhere in the live view window. If you want to hide the global view, right-click the video cell and
select Hide Global View from the menu. An icon ‘*_ will appear on top of the live view window.

1_FD8161

r
(]
o

.lr"'l

Remove
eingle View
Full Screen

< v Enzhl: PiP Ctiltl [
Hide Global Tiew  CtlH || 2]

& Stream 1
Btreag 2
Btream 3
Atresgm 4
Zend to Talk Panel
Zet DO »
Others *

Video Enhancement L4
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ROI (Region of Interest)

The ROI frame is capable of being resized and dragged in any direction upon the global view window as
e-PTZ function.

Digital Zoom In

Through digital zoom in, the live view window will be filled with the zoomed in ROl image. The maximum
magnification of the ROI frame is 16x zooming. The zoomed in area will change as the ROI frame is
dragged and resized. You can also easily zoom in and zoom out the ROI frame by rolling the mouse back
and force.

Edit | View | Configuration |

Manmally Begin Eeconding
Snapshot & Print Zoomed In Image Snspshot Chlsd
. I i 3
You can snapshot and print the zoomed in image. Erint
Fecord to EXE

Snapshot Zoomed Tmage

Frint £oomed Image

PiP Settings _

The PiP Settings is for you to adjust the initial position of the global view window.

Click Configuration > Client Settings > PiP Settings to open the window. On top of it, you may choose

the horizontal position with left / middle / right side of the live view window, or you can customize the
percentage of space distance from the border of the live view window as an option. It is also fully applied
for vertical position with top / middle / bottom side of the live view window. When it's done, you may click
on Apply to existing windows to enable the settings.

Configuration || Layout | Help )

Camera Management r
atation Management. ..

-~ Iritial Position for Global Yiew: Window
X
EI % away from left border

wertical: |E=|:|tt|:|rr| Aligned

EI %% away from top border

| &pply to existing windows |

Horizontal: - Gight Afigned

ser Management...
A zzociation Management. ..

Event Management...
Wirtnal Mateix Management ¥

Station Sethngs

Snapshot Bethngs
Becording Settings
View Sethings -

Video Enhancement k

CGreneral Settings OK [ E‘E'r.:!':el. J
Jowstick Settings
Broxor Bettings

=
& [f the position of ROl and global view will be saved and applied for the next open. It will be removed when the live

view cell is removed.
® The PIP function is also applied in VAST Playback.
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Multi-touch Mode

VAST also supports advanced multi-touch mode for PiP. You can easily zoom in or zoom out the image
by touching the multi-touch monitor with two fingers.




How to Configure Video Enhancement

The LiveClient allows you to enable post-image enhancement and defog for video live view.

Basic Image Adjustment

This function allows you to configure basic image adjustment including Brightness, Contrast,

Saturation, and Hue.

Please follow the steps below to set a profile for post-image adjustment settings:

a. Select the target video cell.

b. Click Configuration > Video Enhancement > Basic Image Adjustment > Settings on the menu
bar to open the Profile Settings window. (Or you can right-click the video cell and select Video
Enhancement > Basic Image Adjustment > Settings from the popup menu.)

9

Configuration || Layout | Helpj

<))

| Camera Management 3
' i m

l Statinn Management... |““ E “

0 Der Management... | -

' Asociation Management. .. P

| Event Wama gement. . e Wiew ﬁ Matrix Wiew

Virtual Matcix Managentent ¥ [RTRI

Station Sethngs
Client Settings

Video Enhancement

1_FD8161
Remove
Single View
Full Bereen Ctl+F
Enable PP

Stream 1
Stream 2
Stream 3
Stream 4
Hend to Talk Panel
et D0

Video Enhancermen

Dizble &1 Cameraz
Enable Al Cameras

Crriginal
e

c. Adjust the values of Brightness, Contrast, Satura-
tion, and Hue. You can preview the image from the
window on the right. A “VE (Video Enhancement)”
text string will appear at the bottom right of the
preview window.

d. When completed, click Save as Profile and enter
a name for the new profile.

e. The new profile will be displayed on the drop-down
list. This profile can be applied to all video cells.

f. If you decide to apply the selected profile to the
target video cell immediately, click the OK button.
Otherwise, click Cancel to close the window.



¥ Basic Image Adjustment - for 1_FD8161

Current Profie: e v S

Profie Settings

fo | Frintress: 128 - 1 128 |27 |3 1_FD8161_2010/05/03 PM 04:09:01
Cantrast: o ) 128 a0 |3
Saturation: o —F 122 20 |3
Hue: 10— 10 0 |2

dl | Save as Profile... | | Update Profle | | Delete Profie | | ok | [ cancal |

g. Back to the main page, a “VE” text string will also appear at the bottom right of the video cell and the
new profile will also appear and be selected on the popup menu as shown below.

Configuration || Layout | Help_:l

Camera Management

Station Management... I““ E“”"‘_‘Il-)” SH ‘

Teer Management...

Aszsnciation Management. .

ve View | [ Matrix View Click to create a new profile, edit

Event Management... . g
or delete a customized profile

Virtual Matrix Management * BT 2n1nmsma PM 04:16:10
Sation Settings 4 < |
Clisnt Settings ; ; — Click to disable VE on all linked
Videa Enhancemen mage Adjnstmen Setti o devices
Disable A1l Cameras Click to enable VE on all linked
Ensble 411 Camerss— devices

Dissbled ————— Click to enable/disable VE on the
Original target video cell

v Indoor

Remove

Single View
Full Bcreen
Enable PiP

Stream 1
Stream 2
Stream F
Stream 4
Send to Talk Panel

Click to create a new profile, edit or delete a

profile

Click to enable/disable VE on the target video

cell
| v Indoor



Defog

This function allows you to configure post-image defog.

Apply a Preset Defog Profile
Please follow the steps below to set post-image defog settings:
a. Select the target video cell.

b. Click Configuration > Video Enhancement > Defog or right-click the video cell and select Video
Enhancement > Defog.

c. There are some preset profiles for you to apply to the target video cell. You can select one from the list
accoding to the environment.

E@ [ Configuration | Layout | Help)

I_amera Managemeint 4

Statinn Management. e -

Stfion banagemen wa|| B < [>R
Taer Management... 4 f T - —
Azsociation Management. .. i T \

Event Management... e Ve | ﬁ Matrix Vigw |

Virtoal Matri: Managemfat ¥ BRI

Slation Betbings L4
Client Bettings

Yideo Enhancement B 9

Settings

Disable 811 Cameras
Enable &1 Cameras

Mormal
Fog

Rainy
Snowey
FirefSmoke

1_FD&161 2010{09/03 PM 05:07:06

—

Single View Cil+¥
Full Screen Cul+F ‘
Enable FiF Cil+]

® Stream | Ib)

Btream 2
Btream 3
Stream 4
Bend to Talk Panel
Fet DO




d. The string of the selected profile will be selected as shown below. A “VE” text string will also appear at
the bottom right of the video cell.

Configuration | Layout | Help)

Camera Management L4 :
Atation Management. .. |““ E” | q;_... I|+ Im_
User Management. . : z —
Association M t. e 3 : . :
Eii‘?:{ 5 :zf:mn ve View | £ Matrix view]| | —————— Click to create a new profile, edit or
SHEIL EANAZEMEL... e delete a customized profile
Wirtual Matrix Management + EREY 2010/09/03 PM 05:35:08

| Tr— ———y
Client Settings » Ba I

B
ssic Image Adjustment » || A [ |
Sethings
Digable &1 Carmneras

Enable All Camerss —— Click to enable VE on all linked devices
Disahl:d — Click to enable/disable VE on the target

v Hormal video cell

¥ideo Enhancemen

Click to disable VE on all linked devices

Fog
Fadnr
Snower

1_FD8161 . 2010{/09/03 PM 05:56:42

Eemove

Single View Cl+¥
Full Bcreen Chl+F
Enable BiF Cirl+]

® Stream 1
Strean 2
Stream 3
Strean 4
Send to Talk Panel

Zet DO | Click to create a new profile,

edit or delete a profile

— 11— Click to enable/disable VE
on the target video cell

Create a New Defog Profile
e. Click Settings on the popup menu to open the Profile Settings window.
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¥ Defog Settings - for 1_FDB161

'Current Profile; |iEkdslyyikE)

Profie Settings Fog

Rairy
, Fire/Smoke PO (1 FD3161 2010/09/03 PM 06:07:45)|
Block Size: M5 3= 2 ~ymy — ey
0 ock Size EN S W) B =

Strength: 1 —a— 5 ”;;

Threshold: 0 —l]— 255 .;,

g [update Profile J [Qelete Profile J Il ok i Cancel

. Adjust the values of Block Size, Strength, and Threshold. You can preview the image from the right

window. A “VE (Video Enhancement)” text string will also appear at the bottom right of the preview
window.

Block Size: Brush diameter from thick to thin (Value 1~5)
Strength: Brush stroke from soft to strong (Value 1~5)
Threshold: Brush pixel from loose to dense (Value 0~225)
g. When completed, click Save as Profile and enter a name for the new profile.
h. The new profile will be displayed on the drop-down list. This profile can be applied to all video cells.

i. If you decide to apply the selected profile to the target video cell immediately, click the OK button. Oth-
erwise, click Cancel to close the window.
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How to Search for a Device on the Hierarchical Management Tree

This function allows you to conveniently search for an inserted device, which is useful when
many devices have been inserted.

Please follow the steps below to find a device on the camera list:
a. Click the station on the hierarchical management tree.
b. Click Edit > Find on the menu bar (or right-click the station and click Find).

s{|0) ! Edit | View | Configuratior © =

= -
Camera Management 3

W T

Station Management..

tart Manual Recording Logical Trae View Management.. Find what: |TP&161
E’: Snapshat i+l I/O Box Management »
Print 4 User Management... String Options Search in =
o. ﬁ o 1o EXE Assaciation Management... fipdliiezy
N €C0 £. [IMatch case () Station only
: Alarm Management...
f— | Find a Virtual Matrix Management » [[]Makch entire word () Camera only

Failover Management »

(%) Camera and Station
Search VivoCam Switches...

Direction
Station Settings v
() search up

&treaming URL (%) Search down

Output Camera List
Get PublicIP

c. The Find window will pop up for you to set your search criteria.

® Find what: Enter a string in the blank. The string can be the full or partial name of the device you want
to search for.

= String Options: Match case represents that the search results should be identical to the string in
lower-case or upper-case letters, the string can be part of a word. Match whole word means that
the search results should be identical to the string for every character, and that the string should be a
complete word or phrase. If you select both options, the search results should conform to all criteria

listed above.
m Direction: Select search up or search down. NS BTk Station1(127.0.0.1)
m Search in: Select search in station or camera. & ESy Camera

SR h Recording Graup
Search dowp & [ DefaltGroup Search up

= [ Lavout

d. Click Find Next, the seaching result will be marked as shown below.

= B wk station1(127.0.0.1) @ Find X)
= By Camera =
- 1 P77131(192,1A8,3,247 ) Find what:

: EM 2 IPE161(172.16,200.40 . . A
Search results = ( 3 String Options Search in -
 Ee 3 FDB161(192.168.5,105) - o
- Matkch case Stakion only
= P& Recording Group
Dmetamorst | | oo
: [ - DefaultGroup Match entire war Zamera only
- [ Layout (%) Camera and Station
Direction
() Search up
(%) Search down

e. If there is nothing found in the camera list, a message will pop up as shown below:

¥ Information
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How to Print a Video Image

There are two ways to print out an image of live video:

1. Select a video cell, then click Print on the quick access bar, or right-click the video cell and select
Print from the popup menu. A Print window will pop up for you to choose the printer.

(sl « @) fER[<[>)R)

(127.0.0.1)
1_FD8161
)8161(192.168.5.111) =
Storage

Remove

SetDO
Others

0 Live View ﬁ Matrix iews

Single View
Full Screen
Enable PiP
Hide Global iew
EnsblaTnstsnt Replay

Stream 1 {1920<1080)
Stresm 2 (1280x720)
Stream 3 (176x144)
Stream 4 (1920<1080)
Send to Talk Panel

Video Enhancernent
Video Display Mode

SWC FPS Adjust Bar

Ctrl+v
Ctl+F |
Ctrl+1 |
Ctrl+H

Snapshot
Record to EXE

Snapshot Zoomed Image

Ctrl+s ||

2. You can also click Edit > Print to print out an image from a video.
m Focus Cell: Print out an image of the target video.
m All Cells: Print out an image with all video cells in the monitoring window.

Edit]View | Configuration | Layout | F

Manvally Begin Becording

Snapszhot

Recond to EXE

Ctel+3

Focuz Cell
Al Cells

Snapshot Zoomed Inage
Print Zoomed Image

1_FD8

How to Lock LiveClient for Security Concerns

If you are away from your computer, for security reasons, we suggest you lock the program.
When LiveClient is locked, the user must fill in the correct password to unlock and access the

program again.

m To lock LiveClient, click Unlock @ on the quick access bar or click System > Lock on the system

menu. The Unlock [ icon will then turn into Lock .
® To unlock LiveClient, fill in the correct password in the popup window.

[ System | Edit | View |
Chbl

Enable Click On Image
Language 4

Second View
E-Map

v Input

X

The application is locked. Please enter the password for STAdmin,

Lavnch Plavback

Logout
Exit
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How to Log out from the VAST Server

To logout from the current server, click Logout on the quick access bar or click System >
Logout on the menu bar. A confirmation window will pop up. Click OK to confirm or Cancel to
return to the VAST LiveClient window.

( System | Edit | View |

Lock Ctl+L é This will terminate the current connection. Are you sure you want 1o continue?
Enable Click On Image

Language r i [a]4 i [ Cancel

Hecond View
E-Map
Lawnch Plavback

Exit

How to Exit VAST LiveClient

To exit VAST LiveClient, click Exit on the quick access bar or click System > Exit on the
menu bar. A confirmation window will pop up. Click OK to confirm or Cancel to return to the
VAST LiveClient window. When you exit the program, your user account will be automatically
logged out from the current server.

( System | Edit | View |

Lock Ci+L é Are you sure you swant to exit the prograrm?
Enable Click On Image

Language + | o i [ Cancel

Zecond View
E-Map
Lawnch Plavback

Logout
Exit
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How to Configure a Logical Tree

A Logical Tree view is available since rev. 1.10 for both LiveClient and Playback. The Logical
Tree view allows you to re-define the logical relationships between the real-world deployment
and the physical devices (cameras). For example, according to your deployments, you can
designate several cameras to be listed under a logical sub-directory named as "Building A," and
the other cameras into "Building B." In this way, you can re-arrange your cameras and devices
on a tree view that is geographically accurate.

In addition to this, the logical folders can also be used to create privilege groups for users with
different access rights. This enables an administrator to easily and flexibly align user privileges
with his camera deployments.

VAST CMS Server
(Root station)

& (Admin: all areas)

o

(Logical folders)

i
|

(Power users:
work area #1)

i
|

(Power users:
main building regions)

i
|

(Users:
Front door and drive lanes)

|
bo[cjeje[ofefe[ole[o
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To configure a Logical Tree, either right-click on the Device list root entry (VVTK_Station1), or
visit the top menus through Configuration > Logical Tree View management.

|| M Live Viey
Loglcal Tree View Managetment. .

Refresh
Connect All
Find...

You will then enter the Logical Tree View management window. Left click on the root directory,
and then right-click to display the Add command.

nuiwlh = Lol Tres

e Bl T sttt 100,168 5.208) B B WK Stationd.
=1 [l v Stehon 10152, 16590, 341 = F B (TSNS
P R 10840 124) 9 Comera wEzL
7 W Mege-Proe! Hetwerk Camen 152,162 4052} F @ oot
& F e 1 a0 7 i veban o @
P Camers 1.FEEIE0[190. 160 41,113 B sy
P B Carnar 2 - CCREON 1960, 166 400 ACE) @ Moga el Metwork Camera
P W Camara 340E00L (160168 40. 1630 P camera LFERIED
FF BN Camers 4-{PELTLIISE 168 41 151) 7 [ Cmers 2 - 0530
B Camern TVDSR0L(152 108 40, 163 7 W08 Camers 30CH2IL
B Camera 04182108 40.124) ¥ 008 Camers 4-FE1TL
F @ Camers 7F0A130152. 102 4085 F @ comers 7eEL
e B vk _tationa(102 168 4078 - B ountaicn 2
B bocd usars
[

A Logical tree can also display and include the cameras from VAST substations. To enable
connection with substations, make sure the Relay Settings is enabled both on the VAST Root
and substations.

LiveClient pes— p— — i i — - — i %4

| System | Edit | Vlewl Conhguratmn | La\mut | Help

I L

Camera Management

Station Management...

Logical Tree View Management...

:K _Station1{19 1/O Box Management b pix View
D Camer; User Management... 201511424 J-_-_;F_ 09:0
: F‘;Dr Infg E;tl Association Management...
s Default
B L £ Alarm Management...
AyoLl
B 10 Box Virtual Matrix Management 3
! WWTK_Statial Failover Management »
- [ Camera Search VivaCam Switches... EE—
= P}ECDrdI Station Settings 3 Netwaork Settings
IfO Box - :
o NDB3Z: ik Recordl-ng Storage SeﬁerQS
! WWTK S Output Streaming URL Recarding Schedule Settings
Output Camera List Scheduled Backup Settings
Get PublicIP Sy 4
T Relay Settings
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[¥] Al CMS connection

Relay Authentication

Passyworc]

Confirm Passwaord: «l

To create a logical folder, enter a name for the sub-directory. The name can be a geographical
indicator or whatever name your prefer; such as Building A, Site 1, etc. Add a short description.

"

&4 Add New Folder

MHame; |

Description:

Lok ][ cocal |

Y

You can also create logical folders under sub-directories, e.g., a "Corridor" under "Building A."
Do this by selecting a sub-directory with a left-click and then right-click on it.

Logical Tree

3 ...... rEsiel
e @ spatst
......... r M
| Add
Edit

Note that the root directory can not be edit.
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You may also left-click to select a sub-directory, and use the Add, Edit, and Delete buttons to
create, edit, or remove sub-directories. Use the arrow buttons to change the positions of sub-
directories or devices on the logical tree.

BN @

When done, click the OK button at the low right corner of the window.
Configuration changes will be preserved.

You should then insert cameras to a preferred directory:
1. Open the device tree to select camera. Left-click to select the checkboxes in

220

front of cameras.

2. Select the checkbox of a preferred sub-directory. Make sure the checkbox is
selected and the directory is highlighted.

3. Click the Move button in the middle of the screen.
Cameras will be listed under the target sub-directories.

Logical Tres View Management

Device List

-1 Bl wwTk_Station1(192.160.6.205)
-1 B wwTi_Station1(192.168.40,34)
[ &3P FEQ391-V(102.160.40.124)
- & Megay work Camera(192,168,40,62)

-V & NDS .1 1]
Carmera 1 02, 168.41.111)
= Carnera 2 - (192.168,40.108)

[EM Camera 3-VCE201(192,168,40.159)

[EM Camera 4-1PB151(192,168.41,151)

¥ @ Camera 5-vC8201(192.168.40.169)

¥ @@ Camera 6(192.158.40,124)

@ Camers 7-FDE196(192,168,90,83)

e B wTK_Station1(192.168.40.78)
o) Viden Server (192, 168.40.168)

Logical Tree
ionl
2 on

-7 G&P Camera &
- |:|= Wideo Server
-7 G8P FEEBILY
- ' Mega-Pixel Network Camera
-~ T71G@P Camera 1-FES180
I B Camnera 2 - Comamn

I @M Camera 3-vCE201
™ @M Camera 4-1P8151
-7 @ Camera 7-FDB138
-7 [ substation 2
w7 [ local users

= O

Update “ &cid ]

Close |

Use the Sort and Find functions on the Device List on the left panel if it is hard to locate a

device.
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When done with the configuration, click the OK button, and select from the top menus View
> Logical Tree View. The Logical Tree View will become the standard display for your VAST
configuration.

Ol

=

Device Tree View

ur" FTZ Panel
= P VVTK Sti—

El ______ = Sital v Two \Way Audio Panel
i g Instant Playback Panel
o i \f Alarm Window

...... Full Screen
...... Minimize

........ P Layout G intatieiian

Ctrl+F
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When done with the creation of logical folders, you can move to the User Management
window. You can then define users' access rights using the logical folders you created. For
example, you may let a user access a specific logical folder while forbidding him from the

others.

1. When you assign Accessible Devices for a user, select the Logical tree button on the

lower right.

2. Select the "Selected logical tree nodes" button. You can then select or deselect logical
folders to confine the accessible devices for a user.

Note that an administrator has access to all devices, and hence the selection is not

available for an administrator.

W4 User Management for VWTK Stationl

User List

B vvTK_Stationl
B - Administrator

& wivotek. twheric.lu
& wivobek, twjeff.huang
& wivobek, tw frank.chang
£ wivohek, twikate wang
1 admin
= Py Power User

: Test

3. Click the Add button on the lower right.

Close |
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Account Management

Authentication: [Ea5|c Account v]
User Name: Testl
Password: .

Confiern Passward: ®

[T Capy From: Test

Accesshle Device: ) Device tree @ Lnglca\ tree

Permission | £ccessible Logical Tree |

) Al logical tree @ Selected Iogi nodes
=17 By wwTK_Station1
- B substation 1

@@ Camera 5-vCB201
[T G@P Camera 6
-7 ({Eag) videa Server
- [ G@P FES301Y
-] ' Mega-Pixel Network Camera
[T €GP Camera 1-FEB120
[ (@M Camera 2 - CC8370
[ (@M Camera 3-VC8201
[T @M Camera 4-[PB151
& camera 7-F0B136
B substation 2
5[ GG Camera 1-FES180
i @ Camera 7-FD8136
]= Wideo Server
¢ [ local users

&g - 8- E--E

m
B
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4. The User account information will prompt. Click OK to proceed.

i X
4 Confirm -

Unchecked substations or cameras will have the following permission(s) removed from the account:
"Camera Management”,
"Delete Camera”,

; l "Modify Recording Storage/Recording Schedule Settings",

"Scheduled Backup Settings",
"Modify E-Map",

"Modify alarm Management",
"Yiew Device Tree"

[ OK ] ’ Cancel ]

5. You can repeat the above steps to create more user accounts using the limited access
configuration via the use of logical folders.

&

* The Refresh, Camera Settings, Output Streaming URL, Send to Talk Panel commands are
available for cameras listed in the Logical Tree View.

+ The DI/DO, Recording Storage, and 1/0 Box are not available on a Logical Tree View.

» The root directory (default VVTK_Station1) can not edited or removed.

« A camera can be added to different sub-directories; however, it can not be added twice into
the same sub-directory.

* A camera managed by a sub-station can be added into the Logical Tree.
* The Logical Tree View can not be edited through a web console with the VAST server.

+ Cameras added to the VAST configuration will not be automatically added to the Logical Tree
View.

* By default, only the administrator and power user are authorized to configure the Logical
Tree View.
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VAST Playback Configuration

Activating VAST Playback and Logging in to a Server

VAST Playback allows you to search and playback recorded media data from VAST Server.

Once you insert a device into the hierarchical management tree of VAST LiveClient, it will
automatically be displayed on the hierarchical management tree of VAST Playback. You can
then begin to use VAST Playback to view recorded or backup video clips.

After installing the VAST Playback program, please follow the steps below to activate VAST

Playback:

1. Run the VAST Playback program. If you have already run VAST LiveClient, you can also click System
> Launch Playback to activate VAST Playback.

2. A Login window will pop up. Fill in the information as shown below:

m |f you want to login to a remote VAST Server, enter the IP address, user name, password and
communication port of the server. Click Log in to login the target server or Cancel to exit the
system.

® |[f you want to login to your local host which is running VAST Server, check the Login local
station checkbox, and the local IP Address will be displayed automatically. Enter the User Name,
Password, and Communication Port of the local server to log in. Click Login to log in to the target
server or Cancel to exit the system.

&) VAST Playback TS &) VAST Playback =
4
[TLog in local station [V]Logn local station
Address: N
ress: 192,166.6,135 - l127.0.0.1 -]
Authentication:  [gacic account - Authentication: [Basic Account -]
Lser Marne: 3dmin User Marne: admmin
Passwaord: . Password: .
[ Log in ] ’ Cancel ] [More = ] [ Log in ] [ Cancel ] [ More ==

3. The VAST Playback main window will be displayed.

=3
m /f your network environment need to set up proxy, click More >> to extend the login window, then click Proxy
Setting to open the dialog. Then enter related information to link to your proxy server.

— T — T P
%) VAST Playback %) Proxy Settings - L@J E

[(ILog in local station Eriablel Proy
Address: -

Address:
Authentication: | pasic account -

Port: a0 2
User Mame: El

User Mame:
Password:

Password:
Port: 54 7

OK Cancel

[ Proxy Settings ]l working Offline... ] [ — ] ’ EERGE)

| [ Log in ][ Cancel ][Hide<< ]

m Available functions of the VAST Playback program will be enabled according to the role of your login account. For
more details about the privileges of the user account, please refer to How to Manage User Accounts on page
100.
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VAST Playback User Interface D
A_{snmeunm | Layeut hw1
B— Z imz:mw oz i -
CT [iEEEc
=
N Mg Pl Patwork Camer:
a ln;d WOSAZL 182, 1658 208
E
[T R oioonn
. =
I [ [ () (e —F
:‘”‘ mmmku.. xmezn&q:.m ;:;.m-xm:am I::::“‘ f‘:?:‘mnm
—T1TG

A. Menu bar B. Quick access bar C. Query panel (Browsing / Time search / Bookmark search /
Event search / Alarm search / Log viewer) D. Status panel E. Recorded video playback window
F. Playback control panel

G. Video clips list

Menu Bar

(:S'grstem | Edit | View | Configuration | Layout | Help_}

Menu Item Drop-down Options
System Lock / Language / Launch LiveClient / Logout / Exit
Edit Snapshot / Print / Snapshot zoomed image / Print zoomed image / Find

Logical Tree View / Device Tree View / Backup Status /Exporting Status /
View Browsing / Time Search / Event Search / Bookmark search / Alarm search /
Log Viewer / Full Screen / Minimize / Query Panel / Video Clips List

Client Settings (Snapshot Settings / Export Settings / View Settings / Proxy

e Settings / General Settings / PiP Settings)

Layout Change Layout
Help About

Status Panel
User Name

Station Name (IP Address)
Login Time (yyyy-mm-dd hh:mm:ss)
Current Time (yyyy-mm-dd hh:mm:ss)

CPU and memory usage in percentage
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Quick Access Bar

0|2 &[]0 &)[F|al B2

— T

Icon Function Description

Exit Exit the system
Logout Logout from the current station
Lock Click to Lock the system for security concerns ( Unclock the system)
Volume Adjust the audio volume of the target video ( Mute)
Snapshot Capture the picture of the target video
Print Print out the picture of the target video
SVC Level Exert SVC control of video playback frame rate
@ Remove All Connection Remove all live videos from the live video monitoring window
Layout Change the layout of video monitoring window

<]l Full Screen Maximize the live video monitoring window

Switch Screen Switch to another screen

Synchronous Playback Click to enable synchronous playback for multiple channels

g;

Some buttons will be disabled if the selected device does not support those functions.

Recorded Video Playback Window

The "VIVOTEK" logo indicates that no camera has been assigned to the video cell.

The red frame (|:| ) represents the focused cell.

Video Cell
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Language Selection

VAST current supports user interfaces in multiple languages; and language options are availabe
in: English, Deutsch, Espafiol, i+, Frangais, Italiano, HZ:E, Portugués, Pycckun. A3,
and % %87 < User Defined If you want to select another language for the interface, please click
System > Language on the menu bar to select a desired language. Please note that if you want
to change the language option, a message will remind you to restart the system.

W Playback
/)
( System | Edit | View | Configu
e

o Gesty If you want to use "User Defined" language, please prepare images and
Lewneh LiveClient Deutsch / trings, and upload the files to the following folders:
m v English anguage s gs, P g .
Exit Espafiol
ohs e ...\VASTI\Client|\Playbackllanguage\zz_UD (language string)
(. 8 Local DB Frangais . |VAST| C/[enth/aybaCkllmage (Images)
Ttaliano
B
Portugués
Pyccrkmil
P
REP
User Defined

Query Panel-- Browsing Page

' Browsing ' ime Search | Event Search | Bookmark Search | Log* * | *
1

=28 a Managed Stations
AALSSE e, — - Root Station Name (IP address)

e . Cameras
L_.| """ EW 1 P71

2005-11-24 __l Dates with recorded
B T video clips
Devices listed = W 2_IPe1A1
under the root -~ [EE 2009-11-24
station . [EE 2009-11-25
= @M 3_FDE151

- 3 2009-11-24
-~ 3 2009-11-25

= FS Cameras |
= [N 1 IP7138
[ 2009-11-22
A 2009-11-23
o @ 2_P7121
Devices listed A zo09-1122
under the sub- 2009-11-23
station = @M 3 PZ7151
A 2009-11-23

Sub-station Name (IP address)

Q Local DB Local Database

You can hide this panel in order to maximize the single playback view from the View menu.
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Station list including server and local database

! A station (a computer that has installed VAST Server)
A station (a computer that has installed ST7501 Server)

The camera that exists on the hierarchical management tree of LiveClient.

The camera that has been removed from the hierarchical management tree of
LiveClient (off-line). However, its recorded video (if any) is still accessible from
the server.

Dates with recorded video clips.

Local database for backup data. For more information about how to upload
backup data to the list, please refer to page 250.

See page 217 for how to configure a Logical Tree View.
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Query Panel--Time Search Page

Select station(s)/ device(s) that
you want to search for recorded
files

= . "u'"'u"TK _Station1{127.0.0.1)
El v (Cameras

E| I:l F‘aul Kuul{l?E 16.4.38)
[T Camneras
w7 Owen(172.16.4.23)

GMT+08:00 Beijing, Chonaging, Hong kﬂ

Er R e
o

— Specify search period of time

aoosjijzs v Joasons | 2

Click to start to search, the
results will be shown on the
video clips list

You can hide this panel in order to maximize the single playback view from the View menu.

ﬁ;

The Time Zone setting is automatically synchronized with that on your client computer.
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Query Panel--Event Search Page

=~ Wy TK_Station1{127.0.0.1)

Select station(s)/ device(s) that

=~ Carneras
: 20x Zoom Mega-Pixel Speed Dome Metwork C
Mega-Pixel Metwork Carmera

Mega-Pixel Metwork Carmmera
Mega-Pixel Metwork Carmera

Motion - Window 2
Motion - Window 3
Motion - Window 4
Motion - Window S

I - Maoving Object

IwA - Loitering Detection

you want to search for recorded
files

Select an Event Category

Click to add search criteria

Click to remove search criteria

GMT+08:00 Bejing, Chongging, Hong Kot E

— Specify search period of time

il

Click to start to search, the
results will be shown on the
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Query Panel--Bookmark Search Page

Select station(s) that you want
to search for bookmarks

=T WTK_Station1(127.0.0.1)
=T Cameras
i [ Mega-Pixel Network Camera
[T Mega-Pinel Network Camera
- Maga-Pixel Network Camera
i--[] Mega-Pixel Network Camera
-7 Mega-Pixel Hetwork Camera

Select a name to serach for

Select a time zone

__ Specify search period of time

Click to start to search, the
results will be listed on the
video clips list
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Query Panel--Alarm Search Page

_System | Edit | View | Configuration | Layout | Help

QO

/|

/|

2016/ 7/ 5 ~ 10:53:32

-h | Alarm Search
- Bl vyms_station(127.0.0.1)

Index Mame Description
1 Alarm
Z ARrm
3 Alrm
4 Alarm

| Fiter |

GMT+08:00 Befing, Chongging, Hong Kong, Kuala Lu|~

Select station(s) that you want
to search for bookmarks

Click to configure the search conditions

Select a time zone

2016/ 6/ 1 ~ 08:59:32
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Click to export a log files for
the occurrences of alarms

Click to start to search, the
results will be listed on the
video clips list
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Query Panel--Log Viewer Page

&l Local Logs

GMT-+08:00 Esijing, Changaging, Hong k i

aoosfrsjes v oesos |
o

eoosjusjs | osous ]

Select station(s) that you want
to search for recorded logs

Select a Log Category

Select a User Account

Select a Result Type
Select a Log Type

Select a Log Level

__ Specify search period of time

Click to start to search, the
results will be listed on the
video clips list
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Video Clips List Window

If you select an option “date”, the video clips will be displayed in the video clips list window. An

\_(_Symm | Edit | View | C

(& Mega-Pual Natvork
W winskss camera
Mega-Biel hetvork

M8 zuisnszz

I LB roeamifiee.teas.20g)
B Loios

B
I ([ el | [ o) [ e
| Index Camera Stat End Time Tong Diescrption
- 1 Mega-Pnal Metvork Ca,., 2014-04-22 B2:47:10 2014-04-22 11:36:23 +0=2:00 2 hours 49 mins 13 secs

You can hide this panel in order to maximize the single playback view from the View menu.
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Playback Control Panel

When you double-click a video clip to play, the playback control panel will be enabled for you to

use. Playback Histogram

Playback Timeline Slider (Displays the period of time of the
video clip being played back)

@Eéa%g;? ,l zn}f-nm
[ __— .

A | <[l [ lof|u,m.u-_=;
| |

Playback Status Panel  Playback Control Buttons

Icon Function Description

Add Bookmark L\:Ioarr:]uaarlll3‘/9 ;csi:iinz Il?:golir;i:;k to pinpoint and extract a 20-second video clip

LY Histogram Zoom In  Zoom in on the displayed period of time of the histogram

@ Histogram Zoom Out Zoom out of the displayed period of time of the histogram

m Marker | If you wgnt to exportl partlof the recordeq video clip, click to set_marker I
on the histogram, which will be the start time of the exported media

@ Marker [I If you w_ant to export.part .of the recorde_d video clip, click to set.marker Il
on the histogram, which will be the end time of the exported media

@ Export Media Click to export the selected section of video clip

E Last Time Interval Go to the previous video clip on the video clips list

E Pause Pause playback the selected video clip

E Play Start to playback the selected video clip

E Rewind Reversely plays back the current video

E Next Frame Go to the next video frame of the selected video clip

E Previous Frame Displays the previous frame

E Next Time Interval Go to the next video clip on the video clips list

Repeat Mode Playback the selected video clip repeatly

Slow Down Slow down the playback rate

Speed Up Speed up the playback rate

Current time of the video clip
Total length of the histogram

The playback status

i (Stop/Playing)
The playing rate can be 1/8, 1/4, 1/2, 1X, 2X, 4X, 8X, 16X, 32X, and 64X.
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Rewind

The Rewind function enables users to reversely playback from a specific point in time on a video
playback window. Once the occurrence of an event is ensured, this function can facilitate the
process of finding the evidences that appeared before the occurrence.

The Rewind function also applies to the Synchronous Playback mode. The following also apply:
1. The maximum playback speed is 64x. (I-frame only when speed is higher than 16x)

2. When you pull the time slider during the Rewind playback, short interruptions may occur.
3. When switching from the playback mode to the Rewind playback, the playback speed remains
the same. The same applies when switching from Rewind to the playback mode.

Limitations:

1. Short delays may occur when switching from playback to rewind, due to limitations by the
hard disk access speed and network speed.

2. When doing the forward playback, the previous frame function is not available. When doing
the rewind playback, the next frame function is not available.

3. The Rewind playback on multiple streams requires system performance resources.
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How to Playback Recorded Video
Select a Recorded Video Clip

Please follow the steps below to select a video clip:
1. On the Bowsing page, click the plus sign (+) to expand the hierarchical management tree.

Time Search | Event Search | Bookmark Search | Log viewer |

—_—

= Managed Stations
; MOS4010192, 1684, 135)

2. Right-click a station, device, or option “date” on the hierarchical management tree and click Refresh
to display the recorded video clips.

Browsing | Time Search | Event Search | Bookmark Search | Log Viewer

| I:Ié Marnaqed Statcims
B UL I dee, L)
é---- b’ FRURnE Logout
Bg-,t [ Mega-Fivel
Lo H 2012.07-30
-l 2071
i ‘. [T 2012-08-01
é. . B Mega-Pixel Netwaork Camera
R 201207-30
E = Mega-Pinel Network Camera
: o[B8 201207-30
: _H 200207-31
= @ Mega-Pixel Netwerk Camera
e 20120731

= P

If a camera is configured with Multiple Stream recording, all its recording group configurations will be
listed on the device tree.

F _ System | Edit | View | Configuration | Layout | Help )

o [5) [ BT[]
ol 2] [Heea] E]ET[0)
Browsing &
| =] 6 Managed Stations
= B wms_station(127.0.0.1)
= . Cameras
&M 1B9381-HT (DefaultGroup)
&M FEB182 (DefaultGroup)
@M FER191 (DefaultGroup)
@M FDO381-EHTV (DefaultGroup)
@M FE9181-H (DefaultGroup)
@M 1B9381-HT (Recording Group 1)
(&M FER182 (Recording Group 1)
@M 1P2166 (DefauttGroup)
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3. There are two ways to view the video clips of a date

= View all video clips of a date:

a. Select an option “date” from the hierarchical management tree

b. Double-click the option “date” or right-click the option “date” and click play, and it will start to

Browsing | Time Search [ Event Search | Bookmark Search | Log Viewer

m Maraged Stations

D

401192, 1684, 135

Esl B Mega-Pixel Network Camera

E E n Mega-Pixel Network Camera

El ‘Mena-ﬁmmmfkcuwa
: —Ef w1200
- ER o1z07-31

a -lnmﬂmnmmd:amra
8 201207-31

—
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play in an available video cell. (You can also directly drag-and-drop the option “date” to a desired
video cell in the recorded video playback window. The video clip will start to play.)

B npa4n1(192.166.4.135)
E- .‘ Cameras
i N Maga-Pixel Network Camera
EJ n Mega-Pinel Network Camera

E| - (BN Mega-Pivel Network Camera
P ﬁ 20120730
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= View only one of the video clips of a date:

a. Click on a “date” on the hierarchical management tree. The corresponding video clips will be listed
in the video clip list window.

b. Select a video clip from the video clip list window.

c. Double-click the video clip, then it will start to play in an available video cell. (You can also directly
drag-and-drop the video clip to a desired video cell in the recorded video playback window. The
video clip will start to play.)

) .: J
5 |
e e

L& B v sseniarong

{ £ Bl Caverss
- M Maga-Perl Network Camers
£ N Mg Hel et Conera

'-‘;._i_ﬂ’ )

A T RN Cwee—,

@ B e 2 020 Tries 14 om
1 Mega fioel el Cormers. 20130730 132888 DILONM 120 +tast 2hoers 4 e Formcn

5 MegaPivel Meboors Comera 20120730 154257 BI0TW LTI +08:00 24mre s

4. Then you can make use of the playback control panel to playback the selected video clip. Please refer
to Playback Control Panel on page 235.
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Remove Recorded Video Clips from Video Cells

There are two ways to remove a recorded video clip from the video cell:
1. Right-click the video cell and select Remove.

_m | Time Search J E‘l‘e“tf"'ﬁ“fc"Iﬁ"“"“"“""‘5""“""'F"’ﬁ \-'EHHJ Mega Pixel Network Camera . 2012/07/31PM
E| ----- 6 Managed Stations - . . .
= ! MO2401(192,162.4,135)
- Py Cameras LA
i W Mega-Pixel Network Camera . Al e cul-y %,
'7’ N Maga-Pixel Netwrark Camera i :,.::::: i‘:‘m:
! — 8 m Hide Global View CuleH SRS
-8 201207-31 3 - [ Others Biie s

i - [FH 2012-08-01 1 Vide Enhancement
|3 n Mega-Pixel Network Camera SVC fps acjust bar
; - [ 2012:07-30
EJ - (@ Mega-Pixel Netwark Camera

2. Drag-and drop the live view from the video ceII to the hierarchical management tree window.
lh‘msrrg [Time Search | E«mtseudnhodmﬂ search | Log viewer |

Mega Pixel Network Ca 2012/07/31PM

E--- h’ Cameras

li--~ M Msga-Pixel Natwork Camera

(£ (M Mega-Pixel Natwork Camera
o [FH 2012-08-01

nl Mega-Pixel Metwork Camera

i o [ 2012-07-30

E.I - [N Mega-Pivel Metwork Camera

ﬁe

If you want to remove all live videos from the video cells, please click on the menu bar.

Timeline Slider Bar and Histogram

The red part of the histogram shows the period of time of a video clip. The timeline slider bar will move
forward as the video is on playback. You can manually move forward/backward the Timeline Slider Bar
to the desired position as shown below.

Start time of the histogram End time of the hisitogram

2014-04-22
18:00:00

2014-04-22 I
0f&:00:00

-

v

E3E1[EY R Y 2 )| Dj{ e

The current time of the video clip will be displayed on the status panel. It will change according to the
current position of the timeline slider bar.
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Zoom in / out of the Histogram
Histogram zoom out

2014-04-22 D
06:00:00

T
EETEER (> | - (<[ =)o) [ ]o] [1,)i,=

2014-04-22 2014-04-22
15:00:00

o N &

Q@@@@@@m@

Total time length

Histogram zoomed in

As the second picture shows, by clicking Histogram Zoom In, the total time of the histogram will shorten
to half of the original period of time, while the red part of the histogram that shows the period of time of
the video clip will extend to twice the original time span.

In addition to clicking and to zoom in/ out of the histogram, you can use the mouse directly to
drag the histogram to zoom in part of the focused video clip.
For example:
a. Drag a section of the histogram. You can drag it to either direction.
I "}

2014-04-22 1 2014-04-22

08:26:48 v 11:41:52
o e ——
|

B

LR o) G

b. The section will be extended as shown below.

2014-04-22 U 2014-04-22
09:31:45 02:58:00

e
T < (<= o] [

gi

For more functions of the playback control buttons, please refer to page 235 for detailed description.
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Synchronous Playback

VIVOTEK VAST Playback supports synchronous playback, which allows you to review up to
16-channel video clips simultaneously during the specific time point.
Please follow the steps below to enable synchronous playback:

a. Drag-and- drop the option “date’s to the video cells.

Browsing | Time Search | Event Search Search \ﬁl:wurl 1_PZ7i 2012/07/31 11:02:03P | 2012/07/31 11:02:03PM
-Gl Managed Stations \ : 1 .
2-- B WK station1(127.0.0.1)
& By Cameras
- [N Maga-Pixel Network Camera
- (BN Mega-Pixel Network Camera
o [ER2012.07-30
B anaza7-3 e [ -|
- [EE 20120801
E B Meja-Pixel Network Camera] = = =}
FE wzo7-:
r - (M Mega-Pixel Network Camera
-~ [B8 201207-3:0
P e FE o731 S
= M Mega-Pixel Network Camera & 5
8 20120731 *~|

2012/07/31 11:02:03PM

B tocans

b. Drag the Timeline Slider Bar to the specific time point.

c. Click the synchronous playback button . on the quick access bar. The selected channel will start to
sychronously playback as shown below.

[ Systom | Edif | View | Gonfigurason | Layowt | Halp ]

BEEOCEDEERNCH

Dw-nz mmlbnswdn 5mut5eud-|lwm

I pe—
VTR Smaten (127001

2012/07/31 11:02:03PM

2014-04-23

000000 2 00500

r eeeee———— N e e
L R e e O 1 ST




d. You can move forward/backward the Timeline Slider Bar to another time point, and all of the time
stamps on the video cells will change accordingly.

e. If you want to stop synchronous playback, click the non-synchronous playback button _ again.

gi

The following illustration shows that during the specific time, there is no recorded video on the camera.

[ Systam | Edit | View | Configuraton | Layout | Help

2012/07/31 11:02:03PM 2012/07/31 11:02:03PM

|

2014-4-22 ] 2014-04-23
000000 ' 00:00e00

[

x [«J(n]l=ll=] [ml=o] (5
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Audio Control
QEEDEDEEEEER

N
The audio function will be enabled if the device is equipped with an internal or external
microphone. Please follow the steps below to adjust the volume or turn on/off the audio of the
focused video:
® To turn off the audio (Mute Mode)

a. Click Audio On on the quick access bar and check Mute. Or you can right-click on the video
cell to open the popup menu, then click Others > Mute. The mute option in the popup menu will then
be selected.

b. If you want to turn off the audio of all live video, select Apply all.
c. The Audio icon will then change from to .

@ [ola] B|E

b [Taemly Al ] ootmark Sescch | Log Viewer EY Y s &
i Others > Snapshot ‘ T
[ (Phael Metwork Camera Video Enhancement | Snapshot Zoomed Image
2012-08-01 SVC fps adjust bar Mute S
2012-08-02 ST ; M bute
2012408-03
m EM Mega-Pixel Metwork Camera : ;
i (B Mega-Pixel Metwork Camera : oy ; I‘D E_J
- (@M Mega-Pixel Network Camera I apply &l
i (M Mega-Pixel Network Camera

= To adjust the audio volume [
I
a. Click Audio On on the quick access bar. il
b. Drag-and-drop the slider bar. Slide to a higher position for louder volume. @ I

® To turn on the audio

a. Click Mute on the quick access bar and uncheck Mute. Or you can right-click on the video cell
to open the popup menu, then click Others > Mute. The mute option in the popup menu will then be
unchecked.

b. If you want to turn on the audio of all live video, select Apply all.
c. The Audio icon will then change from . to

Video Enhancement »
mm-ﬂl SVC fps adjust bar 4
20802 Fﬁh!y!D'SPI-yMnd ¥ T
2012-08-03 ] : ’
@ &M Mega-Pixel Netwark Camera “ A
v M Mega-Pixel Netuwark Camera [ Mute
v M Mega-Pixel Netwark Camera
e (BN Mega-Pixel Netwark Camera
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How to Change the Playback Layout

Changing the Layout of the Recorded Video Playback Window

VIVOTEK VAST Playback supports up to 16-CH simultaneous recorded video playback on a
single monitor and allows you to change the layout of the recorded live video playback window
based on the number of inserted devices.

Switch Video Channels

Drag-and-drop a video channel to another empty video window.

w

—
=

[ Sy

To switch two channels, drag-and drop one view to the other, then the two channels will switch
positions. Tt o " :

Configure Layout Mode

Click the Layout button [E1] on the quick access bar or click Layout > Change Layout on the menu bar.
Select a desired layout mode and the layout window will change accordingly. Below we illustrate 6 types
of layout modes:

B EIE DR R EE

Layout mode Description

(_System | Edit | View | Configuratin | Layout || Help |
1x1 L]
I i (o | L | 2V
Olg)| SIS 2 2v 1]
Time Search | Event Search | Bookmark Search | £ 22
E-[F VMS5_Station(127.0.0.1) Vo 3v D:D
=-[# Cameras V+3
¥ FE9181-H (DefaultGroup) .

I FDO381-EHTV (DefauftGroup) * 2x2 EE

™ outdoor Network Speed Dome Ca 3x3

I Outdoor Network Speed Dome Ca 1412

™ 1B9381-HT (DefaultGroup)

I PB166 (DefaukGroun) o 4V D:[I:I
2V+3 1E
1+5 =
3x3 FF
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Maximize/Minimize the Recorded Video Playback Window

® Single View: to maxmize a video cell to the entire video playback window

Double-click the video cell, or right-click the video cell and selec Single View. The focused video will
occupy the entire Playback window as shown below.

Single View
Full Sereen
Enahble FiF

Cithers

Video Enhancement

Remove

v Bingle View
Full Sereen
Enable PiP

Orthers
Video Enhancement

To restore to the original layout, double-click the video cell or right-click the video cell and uncheck
Single View.
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= Full Screen: to maxmize the video playback window to the entire screen

Click Full Screen on the quick access bar or right-click the video cell and select Full Screen.
In addition, you can also C|ICk V|ew > Full Screen on the menu bar to maximize the recorded video
playback window. J Playback

‘ System | Edit | View | Configuration | Layout | Help)
y Log\calTee\ﬁew

Backup Status
Exporting Status

v Time Search

V| EventSearch

v BookmarkSearch

7 ItGroup)
Al Search
v Alarm Searcl torun)

&~ Cameras

v | Log Viewer

v QueryPanel
v Video Clip List

To restore to the original layout, right-click the video cell and uncheck Full Screen. You also can press
the Esc button on the keyboard to leave the full screen mode.

= Minimize: If you click View > Minimize on the menu bar, the Playback window will minimize
to the Windows tool bar.
View Recorded Video with Multiple Monitors

If you have multiple screens in your control center, you can switch the VAST Playback Window
among these screens.

m |f you have two monitors, click Switch Screen on the menu bar, the Playback window of monitor 1
will switch to monitgn@nitor 1 Monitor 2

m |[f you have three or more monitors, a drop-down list will be displayed when you click Switch Screen
on the menu bar. The number of options on this list depends on the number of your screens. Select
a desired screen from the drop-down list and the Playback Window will then switch to the specified

screen. ﬁ

Monitor 1
Monitor 2
Monitor 3
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How to Backup Recorded Video

In addition to the Schedule Backup function of VAST LiveClient introduced on page 61, the
VAST Playback also features to backup recorded video clips from the local database. Please
open the Browsing page and follow the steps below to backup recorded video:

a. Select the target files.

® To backup all recorded video of a selected device: Right-click the device and click Backup.
;_ﬁ Playback - = .L

Brawsng | Time Search | Event Search | ever |

- managed stabses
= Bl nDeM01(102.162.1.135)

1 Pdeh -
- Balip J ®
mmmg =

- (M Mega-Pixel Metwark Camera
(EM Mega-Pixel Hetwork Camera

M MegarPixel Nebwark Camera
(EDw Mega Pixel Hetnork Camera
~ & wam

OOCC-Oo03 COJ0-00-00
p.acod 00ooco

Index Camera Start End Time Zone Description
1 MNetwork Camera 2011-05-24 08:25:55 2011-05-24 11:09:01 +08:00 2 hours 43 mins 6 se|

® To backup all recorded video of the day: Right-click the option “date” and click Backup (or select the
date and click the Backup button below).

Browsing | Time Search | Event Search | Log Viewer| (S aR ] 2011/05/23 T - 04:46:12

qﬁ Managed Stations

MDS401(192,165.4.135) )

B cameras

i W Network Camera i
m— Play

2011-0f  Refresh

- (M Mega-Pixel NE{ Backup

(- (M Network Camerd

- (@A Video Server

[ (M Mega-Pixel Network Ci

- (M Metwork Camera

[+ &M Network Camera

-------- & NVR(60.251.25.60)

....... g Local DB

Q-0 Nr-T7H0
Co:00co 0o 20:co

Index Camera Start End Time Zone Description
1 2011-05-24 08:25:55 2011-05-24 11:09:01 +08:00

2 hours 43 mins 6 se

Metwork Camera
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®m To backup part of the recorded video of the day: Select the date and choose the video clip(s)
from video clip window. Then right-click the selected option(s) and click Backup. Note: Use the
combination of the Shift key and left mouse click to select multiple video clips.

{ System | Edit | View | C

Eh'uwslnu Tire sean: Event ich | Log Wiewer

=] smanagad Statiors
=] WTE _Statinl(127,0.0.1)
I:.- B camerzs
= Ew 1 PI71EL
B 2oeuns

M 2001125

[ =ooe s

M 21127

= @M 30916l

[ e 115

[ 20001125

~ [ 20001127

& B patkin(i7z.16.4.35)

=

. LtL'zlLJl:_IL"JlCJEJIIrMQJ =

Time Zoa D iptior

1 hor 12 s 49 sacs

b. A Backup Settings window will pop up. Spetify the time span and select a storage path, then click
Backup. The system will start to backup and popup a window showing the backup status.

Mega-Fixel Metwork Camera

Start Time: 2013-01-16 00:00:00 ~2013-01-16 23:58:59

1/16/2013 =  00:00:00 % Backup Mega-Pixel Network Camera has completed,

End Time: [
116/2013 v 235959 [

Save to:

E:'\Recording\2013-01-163 E

{Badwp | | cancel

If you close the status window, you can also open it again by clicking View > Backup Status.

System | Edit | ".!"lew | Conﬁgumtm | Layout | Hﬂlp_)

) Exporting Status
' Time Search

/ Event Search
Bookmark Search
Log Viewer

Full Screen Ctrl+F

d. When the backup is complete, you will see an information dialog. The recorded data will be restored in
the specific folder.

User's Manual - 249




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

How to View Backup Files

The VAST Playback also allows users to playback backup files, including Schedule Backup by
VAST LiveClient and Recorded Data Backup by VAST Playback.

Please follow the steps below to view backup files:

a. Right-click Local DB and click Add.
b. A Load Backup File window will pop up as shown below. Select the *.dif file to upload.

System | Edit | View | Configuration | Layout | Help ]

VVTK_Station1(127.0.0.1)
£ P Cameras

-~ [N Mega-Pivel Network Camera
-FH 20120801

(D Mega-Pixel Network Camera
@ Mega-Pixel Network Camera

eeal Path

418 Cornputer ‘
¥ e Lol Disk (C)
gz Local Dk (D)
# g Local Dk (B
4 ) BackupE|
1 Mega-Pinel Hetwork Camera S0NS0L L3175
© [l Mrga-Povel Hetwork Camers 21120801 13175
& L4 Mega:Parel Hetwark Camera 21123803 00001
bk Recording

0000000
00:00:00

®]

—

Index  Camera Start End Time Zone Description
1 Mega-Picel Metwork Camera  2012-08-05 00:00:00 2012-08-03 08:40:15 +08:00 &hours 40 ming 15 sece

c. The following is an example of uploaded file, and you can double-click it or drag-and-drop it to a
video cell to playback

| 20140423

]

X[ [l [l o) [
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If you want to playback the backup files from the local database, you can also click Working Offline in the Login
Window without the account information. The VAST Playback will launch as shown below.

&) VAST Playback L! s |
[¥] Log in local station
Address: 1127.0.0.1 |
Authentication: |Basic Account -
UserName: 1

-

ipom 451 2] Elusesst

| [ roxy Settings || Working Ofine.. | |
| togn | [ gencel | [fide<<]

L

No user account information required

m = = . %ﬁg&
L jooooneelneeimes

g find HetvarkComers 20134122 BN W2 Bs2 000 2w 572mcs
Plaga ol Habrcrk Carars 301341131 B:08:30 D301 M om0 hour T3rwe T
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Model-specific Functions (FE Series Fisheye)

The VAST Playback program offers model-specific functions through a right-click menu. For
example, if you playback a video clip made from an FE8171V fisheye camera, a right-click on
the playback screen will bring up the Display mode options. You can even exert mouse control
while playing a recorded video. You can zoom in, zoom out, and change the view angle as if you
are investigating a 3D scenario kept in a recorded point in time.

Note that ePTZ functions via the mouse control only takes place in a Regional view, e.g., the 1R

or 103R mode.

[The D splay mode options and mouse control methodologies are identical to those described on pagg
74 and the following pages. |

VVTK_Station1(127.0.0.1)
- Bl Cameras
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Remove

e 0 ! H i’i’i] | v singleview

Full Screen
1 "'f"‘ r._, r‘pq\
Others
' Video Enhancement

SVC fps adjust bar

Fld\e_y: DispEy Mode

Ty
i

Index  Camera Start End
1 Mega-Pixel Network Camera  2012-08-03 00:00:00 2012.08-03 08:40:15 +08:00 & hours 40 mins 15 secs
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To configure the SVC-related feature:
1. Right-click on the playback window of an SVC-enabled camera. Select SVC fps adjust bar.

Femove

¥ Single View Ctrl+W
Full Screen Ctrl+F

Others *
Fisheye Settings 3

SVC fps adjust bar |

2. A slide bar will appear above the view cell. Click and drag the slide bar. A numeric indicator will display
the current selection. See below for the frame rates represented by the numeric indicator.

to page 52 for the introduction of this feature. [Changing the SVC vaule takes immediate effect on the
number of frames per second shown with the video being played.

Indicator Frame rate per second (fps)
Maximum 30

7 26

6 22

5 18

4 12

3 8

2 4

1 1
Minimum 1/4
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How to Search for a Video Clip in a Specific Period of time

Please follow the steps below to use Time Search function:
a. Open the Time Search page.

0.

| 20140423
o000

I
B () () (o) Gl

2 Maga gl hobeore Cangra 20 120802 02eatss BRI ahoura I

e pp—— | ( a

: ®
- —d

b. Select the target station(s)/device(s) that you want to search for video clips.

c. Specify the time span. You can choose to set up the start time only, the end time only, or both the
start time and end time. The search results will only include the video clips within the time span. If you
uncheck both the start time and end time, the search results will include all video clips recorded by the
selected device(s).

v Skart Time:

You can manually enter a specific time.

ez37me =
October, 2008

Sun Mon Tue Wsd Thu B Sat

28 29 30 1 3\
g 9 11

5 6 7
1z 15 14 15 18 17

1wER s 22 23 24 .
26 27 25 29 a0 a1 . Click to select a year

2 3 4 5 & 7 B Click to select a month from the drop-down list
[ IToday: 10/20,2008 — Click here to move the focus to the current date

d. Click Search to start time search.
e. View the retrieved video clips.

- —

Search

o |
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How to Add a Bookmark

Bookmark is a convenient tagging function that allow your to pinpoint and extract a 20-second video
clip from out of a video recording. When you see somehting of your interest while browsing through a
recorded video

1. Click on the E Bookmark button,

2. Enter a name for the bookmark, such as "thief spotted."

3. You may enter a short description in the Description field. You may also search for the bookmarks you
created later on.

A bookmark comprises a video clip starting from 10 seconds of before and ends at 10 seconds after the
point in time you selected.

321 1 B = 2 B EY D AR

Index  Camera Start End Time Zone Description
1 Mega-Pixel Network Camera  2012-08-01 13:17:59.253 201208-01 23:59:59.999 +03:00 10 hours 42 mins

Please refer to page 231 for how to search for bookmarks.
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How to Search for Events

The VAST Playback program offers users an intuitive event search engine for retrieving video
clips from the database of recorded videos based on different search criteria such as motion,
IVA, or DI events.

Please follow the steps below to search for recorded events:
a. Open the Event Search page.

7] #hoga Mo Mamath Camvira
I MegePiue bistwoek Comers.
7] Magau Mtmsek Camira

2014-04-23
00:00:00

2014-04-2
00:00:00

@

@@@ﬂ\@@m@

dee  Cavera Tire Tir Zone
Megn Fteel Netnork Comers  2003-08-01 116144 om0
Mg Bhecl Notwark Canvara 20130801 134030 1080
Mega-Fleel Netvork Camers 20L2-08-01 134457 +0810
Meca el Netrort Carrara  20L1.08.07 134501 480
Megn-fteel Nemwork Covera  2012-08-01 134736 +08:0
Maga Ptuel Network Cavara 3003.08.01 1348538 +omcn
Megn-Freel Newwnrk Covern 2012-06-01 13148144 -+

Mega Pixel Hetwork Camera 2003-03-01 1305053 80

i
o

1 Mega Finel Netverk Covera 20000801 13:51:43
" MagaFreel Hetrors Cavars 30030801 15:53:30
B Mega-Fixed Hetwork Comers 2003-08-01 1354411
Megn-Freed Network Camers  2012-08-01 135747

[
#

L
i Ui,

FEE

@ repeat mode

b. Select the target station(s)/device(s) that you want to search for events.

c. Specify the Event Category. For detailed information, please refer to Select Event Category on the
following page.

d. Specify the time span for event search. You can choose to set up the start time only, the end time
only, or both the start time and end time. The search results will only include the events within the time
span. If you uncheck both the start time and end time, the search results will include all events from
the selected device(s). Please refer to step c. on the previous page for detailed information.

e. Start event search. Please refer to page 260 for detailed information.

f. View the retrieved video clips. Double-click on it or drag-and-drop it to the video cell. It will playback
in repeat mode.

Note: The length of each video clip will depend on your settings of pre-event time & post-event time for
the recording storage. The default setting is 20 seconds. For more infromation, please refer to page
137 for detailed information.

256 - User's Manual




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

Select Event Category

The following introduces the event search categories: All Events, All Motion Events, All
IVA events, All DI Events, Named DI Events, PIR, Tampering, Tamperature, Video Loss/
Restore, IR Trigger/Normal, and P-PTZ. You can also add or remove customized events from
the list.

Event Category- All Events

If you select the All Events category, all of the events including motion detection, digital input, and
intelligent video analysis, PIR, tamper detection, and tamperature alarm will be listed in the search
results. You can click Add or Remove to change the search criteria options.

All Events v

Al Everts

Motion - Window 1 I IS
Mation - Window 2 | a)l 1vA Events
Motion - Window 3 | all DI Events

IVA - Moving Objeciiamed DI Events

I'V& - Loitering Detection
I - Camera Tampering
Iva - Others

Search Categories:

[ Add J [ Remove ]

Event Category- All Motion Events

If you select the All Motion Events category, all detected motion events will be included in the search.
You can click Add or Remove to change the search criteria options.

Search Categaories: NS EEN="

Mation - Window 1
Mation - Window 2
Motion - Window 3

Event Type: | Al Motion Events -

Search Criteria

Window 1 Window2 Window3 Window4 Windows

(o J[ coca ]

[ Add ] [ Rermove ]

The parameters of the motion detection windows, such as motion percentage and the time of occurrence
are also recorded in the database of the server. If you wish to change the parameters of the motion
detection windows such as the position, size, detection sensibility, and motion percentage, please link to
the camera's Configuration page to modify the values.

Enable motion detection

Video(TCP-AV)
; YWindow Narme

|1
Sensitivity
— |_ 802
Fercentage
0%
R[=1 Save
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Event Category- All IVA events

If you select the All IVA events category, all detected IVA events will be included in the search. Cameras
with embedded intelligent video content analysis are capable of detecting IVA events such as moving
objects, loitering, and tamper detection.

The embedded video content analysis, superior to the conventional motion detection function, is capable
of distinguishing between creature’s motions, static backgrounds or natural movements such as swaying
trees, waves or sunsets to prevent false alarms from environmental noises.

With camera tamper detection, it can detect incidents such as camera redirection, blocking or defocusing
of cameras, or even spray-paint. Additionally, a suspicious object in the pre-defined detection region will
trigger alarms once the dwell time of the object is longer than the given time.

You can click Add or Remove to change the search criteria items.

Search Categories: |} its L SUNENRPSEI——— 0

Event Type: | &l Iva Events -

- LD|ter| Detection
WA - Camera Tampering

Iwa - Others Search Criteria
[CImMoving Ohject [ Loitering  [Z] Tampering  [C] Others
i Add i [ Remave J

If you want to change the parameters of IVA, such as the detection region, loitering duration, etc, please
link to the camera's Configuration page to modify the values.

Trigger name: |Trigger1 |
[ Enable this trigger
. Detection type

& Moving object detection
O Loitering detection - duration: seconds [1~90]
O Camera tampering detection

Detection region
(TCP-AV)

B, ’ Deletel
(Sve] (e

Event Category- All DI Events

If you select All DI Events category, all triggered DI signals will be included in the search. The DI events
signify that there is a Digital-Input signal detected by the camera; its corresponding information such
as DI-Trigger or DI-Normal signal and the time of occurrence are also transmitted and recorded in the
database of the server.

You can click Add or Remove to change Search Categories: |GliREins
the search criteria options. DI - Trigger

DI - Morrnal

Event Type: | &I DI Events

Search Criteria
Trigger Hormal

For more information about DI/DO settings on the connected devices, please refer to page 109 for
detailed illustration.

[ Add ] [ Remave J
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Event Category- Named DI Events

This category allows you to select only Named DI Events--the DI device which you have renamed in
the LiveClient. Please refer to Association Management on page 109 for more information about how to
rename DI device.

Click OK and fill in the name you want to search on the left window.

MNamed DI Events

Event Type: &)l DI Everits

| Search Criteria

Trigger Normal
Remove L&J _ Cancel

The new search criteria will be displayed in the search categories column as shown below.
You can click Add or Remove to change the search criteria options.

Marned DI Events ﬂ

Entrance (DI - Trigger )
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Start Event Search

After you specify all of the search criteria mentioned above, check/uncheck Display in new result list
and click Search to begin event search.

= |f Display in new result list

is unchecked, all search results will be displayed on the original event list

window as shown below.

Search Categories: | All Motion Events  »

IMotion - Window 1
Motion - Window 2
Motion - Window 3

Add ] [ Remave

Time Zone: |GMT+DEI:DD Beijing, Chongging, Ha v|

AR
00 C0.C0

TUC-THON
C0; 00,00

P . (-
pe—

Start Time:

Index  Camera Time Time Zone Type Description
|2DUQ}11{30 V| |09=26=43 [C 1 Mega-Pixel Netwark Ca...  2014-09-25 14:01:20 +08:00 Motion - Window 1 19%
CJend Time: 2 Mega-Pixel Metwork Ca...  2014-09-25 14:02:39 +08:00 Maotion - Window 1 43%
3 Mega-Pixel Metwork Ca... 2014-09-25 14:15:03 +02:00 Motion - Window 1 38%
| [ | 4 Mega-Fixel Network Ca.. 2014-09-25 14:17:37 +08:00 Motion - Windaw 1 7%
5 Mega-Pixel Metwork Ca...  2014-09-25 14:15:03 +08:00 Maotion - Window 1 35%
[¥] Dispilay in Mew Result List ‘ ‘ ¢ Mega-Pixel Metwork Ca...  2014-09-25 14:18:16 +0E:00 Mation - Windaw 1 28%
= Mega-Pixel Metwork Ca...  2014-09-25 14:18:32 +02:00 Mation - Window 1 29%

Unchecked

Only one page

m |n the above picture, The Type field in the search result page shows the event category, and the
Description field displays the motion percentage of the detection window. Please refer to page 257
for more information about Motion Events.

m |f you select Display in new result list and click Search, the search results will be displayed on a
new page as shown below. This allows you to place the search results of each search category on an
individual page. You can set up to 5 pages in the event list window.

Search Categaries: | &l Events v

DI - Trigger ~
DI - Morrnal |
FIR

Tarnpering

Temperature - Trigger

Temperature - Morrmal —

Add ] [ Remove

Time Zone: |GMT+DEI:DD Beijing, Chongging, Ho v|

Start Time:

l2009/11/30 v | 092643 [ 4

[C]End Time:
| || |

[+ Display in Mew Result List
1

| Search |

2023-2340 0000-00-0C
00:00:00 (CO100
Index  Camera Time Time Zone Type Diescription -
1 3_FDE161 2009-11-30 09:44:54 +08:00 PIR Trigger T
2 3_FDE161 2009-11-30 09:44:54 +08:00 PIR Trigger
3 3_FDE161 2009-11-30 09:44:55 +08:00 PIR Trigger
4 3_FDE161 2009-11-30 09:44:55 +08:00 PIR Trigger

5 3_FDE161 2009-11-30 09:44:56 +08:00 PIR Trigger

6 3_FDE161 2009-11-30 09:44:56 +08:00 PIR Trigger v

| Pag=2 || Page1 J‘

Chlecked

gg

You can set up to 5 pages.

The P-PTZ event type refers to those triggered by the Auto Tracking actions.
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Backup the Event Videos

Please follow the steps below to backup the evnet videos on the results list:

a. Select the video clips you want to backup. You can select more than one video clip.
b. Right-click the selected video clips and click Backup.

Index  Camera | Time

| Time Zore | Description
0

Tricger
Trigger
Trigger |
+03:00 PIR Trigger el

Show Millizeconds

i Page 2 i[ Page 1

c. A Backup Settings window will pop up. For more information about how to set up the Backup
Settings, please refer to page 248. For more information about how to view backup files, please refer

to page 250 for detailed illustration.
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How to Search for a Bookmark

Please follow the steps below to use Bookmark Search function:

a. Click on the tabbed menu to open the Bookmark Search page.
b. Select the cameras which have video clips you have placed bookmarks on.

| 1 2014-08-11
Q00 000300

=
fndex  Carera Time Te fore HName Decrpmon Saahrs
Mega-Freel Network Camers  2012-08-03 00:00:00. 155 a0 MyBoakark
puerhl

o
80 ekl o
o
o

15 020 MhiBoamark2
+Em MyBeakmarkd

e firat | GHT +08:00 Bagn, Chorgong, Heng Ferg, Kuda 1= |

8 YD v eds

c. Enter the name of bookmark.

d. Specify a range of time during which the video streams were recorded and its points in time were
bookmarked.

Click search. You can then click on a bookmark to display the short video clip extracted from
within the recorded video.

To remove an existing bookmark, left-click to select an entry, and then right-click to display the
Delete button. Bookmarks will be indicated as "Invalid" if the videos where the bookmarks were
appended were erased, e.g., when the original recording was erased by cyclic recording.

2014-03-10 U
00:00:00

o |

i r— <)

Index  Camera Time Time Zone Mame Description Status
1 20% Zoom Mega-Pixel ...  2013-07-04 09:29:30 ~+08:00 MyBookmark [a]4
2 20% Zoom Mega-Pixel .. 2013-07-04 10:40:41 +08:00
Delete
3 . 2013-07-04 10:44:33 +03:00 IMyBookma Ok
Clesr All Results
Backup

Show Milliseconds
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How to Search Logs

The VAST Playback program offers a convenient log engine for searching all local logs based
on different search criteria such as log category, log type, and log level. The search results will
be displayed in the log viewer window along with the detailed log history.

Please follow the steps below to search logs:

a. Open the Log Viewer page.

b. Select the target station where you want to search logs.

c. Specify the Log Category. For detailed information, please refer to Select Log Category on page 264.
d

. Specify the User Account. If you have added other user accounts to the station, you can select one to
search its login history. For detailed information about user account, please refer to How to Manage
User Accounts on page 100.

e. Specify the Search Result. Select All to display all search results; select Success to display successful
log activities only; select Fail to display failed log activities only.

f. Specify the Log Type. For detailed information, please refer to Select Log Type on page 264.
g. Specify the Log Level. For detailed information, please refer to Select Log Level on page 264.

h. Specify the search time span. You can check the start time only, the end time only, or both the start
time and end time. The search will only include the events within the time span. If you uncheck both
the start time and end time, the search will include all events saved by the server. Please refer to page
254 for detailed information.

i. Start the log search and the results will be displayed on the log list window.

Erovsing | Time Saarch | Evant Smarch | Log Viswer Index | Time Tima Zone Category Level | Trpa Rezdt Usar 4 Cescription
1 2010-01-18 10:55:05 +02:00 System Log Hoh Sarver Stat Suiccess Servioz Name=wasT Recorcng
- 2 2010-01-18 10:56:05 +02:00 System Log Hon  Ssrver Stat Suacess Servics Mame=VAST Query Ser
El 2010-01-18 10:56:16 Rt =Hili] System Log High Setuer Stat SLces Service Mame=VasT Backip Se.
4 2010-01-18 10:56:18 Rt =Hili] System Log High Setuer Stat SLces Service Hame=wAST Event Sar...
5 20100118 10:55:21 020 System Log Hgh  Setuer Stat Sircess Serca Mame=VasT configrat...
[ 2010-01-18 11:26:30 +02:00 Operation Log Mormd Logia SLrres STadin [Uuecient) L=t Accourit=STA..
7 2010-01-18 131122 +0=:00 Operation Log Mormal i SLreass STadmin .

: Lo

11424 +02:00 Event Log Hgh Camera Comrected to ., Succes

114525 +0E:00 Operation Loz Mormdl - [rsert Camera SLreass STadmin
CareraRecordng Stop Success

Camnera Recordng Stat

Target Carera Mame=1_IPE3:0
Target Camera Name=1_IFE33..,
[Plavbad:] User Account=STAd,.
Target LMS Marne=Default Map,..
[Luechent) Lssr Accaut=5TA..
[Lvecient) Lssr Accourit
[Luecient ) Lksst Accourt
e Marme=\AST fLery Ser, .
Ferviza Mame=VAST Recordig ..

Service Mame=VAST Config.rat, .
Target Carera Mame=1_IFE320

Camera Canrected to ..
Catmgorr: |AI Local Logs 2 Camera Recordng Stat

LuEClent) Lssr ACHaLE= STA...
[Uvechent] Lissr Accolrit=5T)
[Luecient) L=t Accourit=5T A

Usa: |

. e Usst Name=Usert, New R
=l |M [Flaykack] Lser Accoont=:
Log Type: | l
Log Level: |.al

Tnchide upeer kv Service Mame=VasT Recoeding ..

Servio Mame=VasT Configrat. .
Target Camera Name=1_IFE320
Target Cavera Hame=1_TFEI2..,
Target Carera Hame=1_IFA30

System Log
System Log
Evant Lag Canera Canrected to ..

Time Zone: | GHT-+0R0 Eefing, Chorgoing, Hang Forg, Kudla Lupur, |

Ewent Log Canera Recording Stat

[ start Time: Event Lag Carera Recording Stop

REREEEEEERRRERRERERRARRETAREARRERRRRAARRRERES

. - Ewent Log Canera Deconnected F. Taget Carera Mame=1_TPaa0
api0f 1 2 ¢ | omanz 2 5 g : Event Lig Camera Recording Start Target Cavera Hame=1_TFAI2...
M l— E g Event Log Camera Comrected to ..,
[=1End Time: B 2 i g:aagm Il:u:; Login
x g peration Log
noEtE | s 20100122 145 : : )

2010-01-22
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Select Log Category/Log Type/Log Level

The following table shows the breakdown of log category, level, and type. The search results will
be different according to your selections.

Log Categories Log Levels Log Types

Login / Logout
Insert User
Update User Name
Update User Password
Update User Privilege
Delete User
Insert Station
Update Station Information
Update Station Name
Delete Station
Insert Camera
Update Camera Information
Delete Camera
Set Recording Group
Insert Recording Schedule / Update Recording Schedule / Delete Recording
Schedule
Insert Event Management / Update Event Management / Delete Event
Management
Insert Recording Group / Update Recording Group / Delete Recording Group
Insert Recording Path / Update Recording Path / Delete Recording Path
Insert Camera to the Recording Group
Normal Update Camera information in the Recording Group
Delete Camera from the Recording Group
Move Recording Path
Operation Log Move Camera to another Recording Group
Insert Layout / Update Layout / Delete Layout
Set Digital Output
Update Scheduled Backup
Update Server Port
Set Proxy Server
Set UPNP
Set DDNS Server
Create Directory / Rename Directory / Delete Directory
Insert SMTP Server / Update SMTP Server / Delete SMTP Server
Insert Network Storage Device / Update Network Storage Device / Delete Network
Storage Device
Set GSM Modem
Set DI/DO Rename
Set Relay Settings
Update License Information
Update Web Access Information
Insert Matrix Recipient / Insert Matrix Recipient Information / Delete Matrix
Recipient

Manually Begin Recording

il Manually Stop Recording

Camera PTZ, Iris, Focus, Pan, Patrol Control
Low Click on Image
Select Preset Location

Server Start / Server Stop
Trial Expired

System Log High Key Dongle Lost
Virtual Memory Low
Network Lost / Storage lost



Log Categories Log Levels Log Types

Camera Disconnected from the Server / Camera Connected to the Server
Parent Station Connection Lost / Parent Station Connection Restore
Sub-station Disconnected / Sub-station Connected

Event Lo High . :
9 9 Camera Recording Start / Camera Recording Stop
Start Scheduled Backup / Stop Scheduled Backup
Event Trigger
Log Category
Log Level
Log Type

Index  Time Time Zane Cateqgary Level  Type Result Lser Target  Description ‘5
1 2009-12-09 09:50:54 +08:00 Systemn Log High Server Stop Success Loecal Service Mame=4AST Backup ...
2 2009-12-09 09:50:54 +08:00 System Log High Server Stop Success Local Service Mame=%AST Event S...
3 2009-12-09 09:50:55 +08:00 System Log High Server Stop Success Local Service Mame=%AST Query 5...
4 2009-12-09 09:50:55 +08:00 Systemn Log High Server Stop Success Local Service Name=%AST Recordi...
=1 2009-12-09 09:50:55 +08:00 System Log High Server Stop Success Local Service Mame=YAST Configur...
G 2009-12-09 09:50:56 +08:00 Event Log High Camera Disconnecte...  Success Local Target Camera Mame=1_PZ7...
7 2009-12-09 09:50:56 +08:00 Event Log High Camnera Disconnecte...  Success Local Target Camera Mame=2_IP3...
g 2009-12-09 09:51:42 +08:00 Systemn Log High Server Start Success Loecal Service Mame=4AST Recordi...
Q 2009-12-09 09:51:44 +08:00 System Log High Server Start Success Local Service Mame=%AST Query S...

10 2009-12-09 09:51:47 +08:00 System Log High Server Start Success Local Service Mame=%AST Event 5...

11 2009-12-09 09:51:48 +08:00 Systemn Log High Server Start Success Local Service Mame=4AST Backup ...

12 2009-12-09 09:51:50 +08:00 System Log High Server Start Success Local Service Mame=YAST Configur...

13 2009-12-09 09:51:51 +08:00 Event Log High Camnera Connected t...  Success Local Target Camera Mame=2_IP3...

14 2009-12-09 09:51:51 +08:00 Event Log High Camera Connected ... Success Local Target Camera Name=1_PZ7...

15 2009-12-09 09:51:52 +08:00 Event Log High Camera Recording Stop  Success Local Target Camera Name=3_FD&... «
Clear &l Results ] [ Trace Login Activities ] [ Export Al Logs ] [ Local Logs ][Login Histary ][Lngin Activities

Click to export all search results from the list
Click to remove all search results from the list

Select Login History from the log category field and click the Search button below, the search results,
including all login logs, will be displayed on the Login History page.

Browsing | Time Search | Event Search | Log Viewer Index | User Login Time Login Result Logout Time Logout Result Time Zone Description
= 1 STAdmIN 2010-02-01 09:41:28 Success 2010-02-01 11:48:52 Success +02:00 Playback
VVTK_Stationl(192,168.5.122) E STadmin  2010-02.01 110553 Success 2010-02-01 20:18:21 Success +0%00 LiveClient

3 STAdmIN 2010-02-01 11:48:55 Success 2010-02-01 20:16:15 SuCCess +02:00 Playback
4 STAdmin 2010-02-02 09:31:04 Success +0e:00 LiveCient

Category: Login Histary v
User: v
Result: Al ~
Log Type:
Log Level:

Time Zone: | GMT-+08:00 Beiing, Chongging, Hong Kong, +
[]Start Time:

2010/ 2/ 1 v| DBAL21 |2

[“]End Time:

2010 2f 2 v | D9:31:21 | O

Clear All Results Export &l Logs [ Local Logs — Login History | Login Activities




This function allows you to search the operations the user performed during the login period of time. You
can search for login activities on the Local Logs or Login History page.

m Search Login Activities on the Local Logs page:
a. Click on the Local Logs page.
b. Select a login/logout option from the list.
c. Click Trace Login Activities (or you can right-click the selected login/logout option on the list, then

click Trace Login Activities).

Index  Time Time Zone Category Level  Type Result Lser Target Description e’
1 2010-01-18 10:56:05 +05:00 System Log High Server Start SuCCess Local Service Name=wAST Recording ...

2 2010-01-18 10:56:05 +08:00 System Log High Sarver Start Success Local Service Mame=Ya5T Query Ser...

3 2010-01-18 10:56:16 +08:00 Systermn Log High II@ wer Start Success Local Service Mame=YAST Backup Se...

4 2010-01-18 10:56:18 +08:00 Systermn Log High: wer Start Success Local Service Marme=YAST Event Ser...

5 2010-01-18 10:56:21 +08:00 System Log High ~oricr Ctart Success Local Service Mame=YAST Confi ti.,

; 2010-01-18 1 i Cperation Log  Mormal S STAdmin LiveClient) oun

- ) .
STadmin Local (Playback) User Account=S5TaAd...

7 2010-01-18 13:11:22 +08:00 Operation Log al LOON  Clear Al Results (=13

g8 2010-01-18 16:14:24 +08:00 Ewvent Log Zame ;race Login Activitiss Local Target Cameta Mame=1_IP8330
Q 2010-01-18 16:14:25 +08:00 Operation Log | Inser e @ STadmin Local Mew Carnera Mame=1_1P8330, ...
10 2010-01-18 16:14:25 +08:00 Event Lag Came  Show Millissconds Local Target Camera Mame=1_IP8330
11 2010-01-18 16:14:27 +08:00 Event Lag Camera rerorrgrorare——oueC 255 Local Target Camera Mame=1_IPE33...
1z 2010-01-18 19:58:22 +08:00 Operation Log ~ Mormal  Logout SuCCess STAdmin Local (Playback) User Account=STad...
13 2010-01-18 19:52:41 +05:00 Operation Log  Mormal  Update Layout SUCCESS STadmin Local Target LMS Mame=Default Map,...
14 2010-01-18 19:52:41 +05:00 Operation Log ~ Mormal  Logout SUCCESS STadmin Local (Liveclient) User Account=STA...
15 2010-01-18 19:59:12 +05:00 Operation Log ~ Mormal  Login SUCCESS STadmin Local (Liveclient) User Account=STA...
16 2010-01-18 20:07:24 08:00 Operation Log  Mormal  Logout SuCCess STAdmin Local (LiveClient) User Account=5TA...
17 2010-01-19 09:33:42 as:00 Systermn Log High Server Start Success Laaal Seridce MNarme=YAST Query Ser...

[ Clear &l Results ] Trace Login Activities ] [ Export & Logs ] @ [ Local Logs ] Login Histary ][Login Activities ]

d. The search results of the login activities will be displayed on the Login Activities page as shown below.

Index | Time Time Zone Cateqgory Level | Type Result User Target Description

1 2010-01-18 11:26:30 +05:00 Operation Log  Mormal  Login Success STadrmin Local (LiveClient) User Account=STA...
2 2010-01-18 16:14:25 +08:00 Operation Log  Mormal  Insert Camera Success STAdmin Local Mews Camera Mame=1_IP8320, ...
3 2010-01-18 19:58:41 +05:00 Operation Log  Mormal  Update Layout Success STadrmin Local Target LMS Marne=Default Map,...
4 2010-01-18 19:58:41 +05:00 Operation Log ~ Mormal  Logout Success STadrmin Local (LiveClient) User Account=STA...

[ Local Logs ][Login History || Login Activities

Clear All Results Export All Logs

m Search Login Activities on the Login History page:
a. Click on the Login History page.
b. Select a login/logout option from the list.

c. Click Trace Login Activities (or you can right-click the selected login/logout item on the list and
click Trace Login Activities).

User Time Zone

Adrnin

Index Logout Result Diescription

SLUCCE

2 STAdmin  2010-02-01 11:05:53 Closr All Results 1116:21 :

3 STAdmin 2010-02-01 11:48:55 Succe (™7 : . 5 Success +05:00 Playback
Trace Login Activitie

4 STAdmin  2010-02-02 09:31:04 Lrce e EE SOER ACRNIES @ +02:00 LiveClient

Show Millisconds

al

[Local Logs © Login History - Login Activities

Clear Al Results ] Trace Login Activities Export All Logs

©
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d. The search results of the login activities will be displayed on the Login Activities page as shown below.

Index | Time | Time Zone | Category | Level | Type | Result | User | Target | Description |
1 2010-02-01 11:05:53 +05:00 Operation Log ~ Mormal  Login SuCcess STAdMmin Local (LiveClient) User Account=STA...
2 2010-02-01 20:16:21 +02:00 Operation Log  Mormal  Logout Success STadrmin Local (LiveClient) User Account=STA...

Clear &l Results | Trace Login Activities | Export Al Logs Local Logs || Login History | Login Activities

=
When you select All in the Log Level field, the search results will include all log levels. If you select Low in the
Log Level field and select Including above level as shown in the picture on the left below, the search results

will include all levels of logs. But if you select Normal in the Log Level field and select Including above level as
shown in the picture on the right below, the search results will only include Normal-level and High-level logs.

Al £ Law ]
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How to Configure Client Settings

On Client Settings, you can configure Snapshot Settings, Export Settings, View Settings, Proxy
Settings, and General Settings. It allows you to save snapshots and media files on the local
computer.

Configuration | Layout | Help)

Cliemnt Se Snapshot Bethings
Export Sethings
¥ideo Enhancement * _@D E.
. View Jethngs
- Prosor Settings
it Search | Log Wienwer General Settings
27.0.0.1) FiF Settings

Snapshot Settings

When you play a recorded video, VAST Playback also allows you to take snapshots. For
detailed information about Snapshot Settings, please refer to page 179.

Export Settings

When you playback a recorded video, the VAST server allows you to export part of the recorded
video in EXE, 3GP, or AVI format to your local computer. Before exporting a media file, please
set up Export Settings first. For detailed information about how to set up EXE, 3GP, and AVI
Export Settings, please refer to Record Settings on page 181.

The default exporting path is: C:\ProgramData\VIVOTEK Inc\VAST\Client\PlayBack\Export

Limitations

1. The size of exported footage depends on the file size limitation. When the limitation is
reached, files will be concluded regardless of the length of your selection.

2. The Export button will not be available when there is another exporting task.

3. If the time settings on camera and VAST server are inconsistent, the export task will generate
files of unexpected length.

4. The minimum export length is 1 minute. The maximum is 150 minutes. However, due to the
embedded limitation, the approximate max. file size is 3.7GB.
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Export an EXE/3GP/AVI File

Please follow the steps below to convert part of an EXE/3GP/AVI file of recorded video:
a. Playback a video clip from which you want to export a media file.

b. Set a period of time. Move the timeline slider bar to the desired start time and click Marker | @ Move
the timeline slider bar to the desired end time and click Marker I @

=Y
Currently exporting video files from the NVR series is not supported.

(0 Fayech

( System | Edi | View | Configueation | Layout | Heip |

Errwerg [ Tima Saach | Event Sazech | Bogk
= G Manened Stations

2- B vk Stetondit=r00.)
= - B Camaras i
= N MegarPieel Netwerk || [T
M zoumanr
B 20140310
~ P8 140408
BH 20140409 N
=~ W Wrokss camara — 4 L] Mo Diata
B aie0e21 :

™ aoeodez
= M MagaPteel Netwar k

e R RN Y

P 00422
- BN MegerPiael Metwerk
5% roesaLezeEe20) | ([

B e

@ 014.04-22 140432

05:00:00 o 18:00000

=]

R < <l (o) [ e

c. Click Export EXE/3GP/AVI @ the server will start to export the data and popup a window showing
the exporting status. If you close the status window, you can also open it again by clicking View >
Exporting Status.

d. When the export is complete, you will see an information dialog. The exported data will be restored in

the preset storage folder on your local computer (C:\ProgramData\Documents\VIVOTEK Inc\VAST\
Client\PlayBack\Export).

e I =i

( System | Edit | View | Configuration
Mega-Fixel Network Camera [
20130116_105023 ~20130116_105218
Exporting media for Mega-Pixel Network Camera from 20130116_105023 to 201301161052 -
. ™ Close | (I) E’: G EXPDrhm_?: sStafus
w Time Zearch

- w Event Bearch
Browsing | Time Seal , Log Viewer

= @ Manager Full Sereen CthF

5 B
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View Settings

This section allows you to set up the display mode of video cell. For detailed information about
View Settings, please refer to page 187.

Proxy Settings

Please refer to page 205 for detailed illustration.

General Settings

System Settings
Please refer to page 190 for detailed information.

Display Settings

m Enable de-interlace function: Select this option if your connected device does not support de-interlace
function. For example: VS7100.

P General Settings

System Settings

[IRetrieve RTSP stream on snecified port: (554

[JConnect substation streaming via relay

Display Settings

[JEnable de-interlace function

i (04 i [ Cancel J

How to Configure Video Enhancement

The Playback also allows you to enable post-image enhancement and defog for video viewing.
Please refer to page 209 for detailed information.

How to Search for a Device on the Hierarchical Management Tree

The Playback also allows you to conveniently search for an inserted device. Please refer to
page 214 for detailed information.

How to Print a Video Image

The Playback also allows you print out an image of live video. Please refer to page 215 for
detailed information.
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How to Lock VAST Playback for Security Concerns

If you happen to be away from your computer, for security reasons, we suggest you lock the
program. When VAST Playback is locked, the user must enter the correct password to unlock

and access the program again.

m To lock Playback, click Unlock on the quick access bar or click System > Lock on the system
menu. The Unlock [ icon will then turn into Lock .

® To unlock Playback, click and enter the correct pasword in the popup window.

.f,.Sjrsmm.lEdit | View | Configurati

The application is locked. Please enter the password for admin.

Chel+L
] |

Launch LiveClient
Launch System Manager

Logout
Exit

ok ][ canest | |

How to Log out from the VAST Server

To log out from the current server, click the station and click Logout on the quick access
bar or click System > Logout on the menu bar. You can also right-click the station and click
Logout. A confirmation window will pop up. Click OK to confirm or Cancel to return to the VAST

Playback window.

Lock Chrl+L 5 .
‘ Browsing | Time Search | Event Search | Bookmark Search | Log Viewer| % €07
. ¥ ] T é This will terminate the current connection. Are you sure you want to continue?

Launch LiveClient
Launch System Manager ‘

Coe) ‘

Exit

How to Exit VAST Playback

To exit VAST Playback, click Exit on the quick access bar or click System > Exit on the
menu bar. A confirmation window will pop up. Click OK to confirm or Cancel to return to the
VAST Playback window. When you exit the program, your user account will be automatically
logged out from the current server.

ufS',rxtam | Edit | View | Configurati é Are you sure you want to exit the program?
Lock Ctel+L
Launch LiveClient _ ok || concel
Launch System Manager
out
Exit
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Import and Export Utility

VAST supports import and export utility for user to keep record of all server settings. You can
use the export file to copy the configuration on another host.

Export Utility
Please follow the steps below to export the server settings:
a. Under Microsoft Windows, choose "Start > All Programs > VIVOTEK Inc > VAST > Tools > Import-
export Utility." =
G Tools 3 I Y Tmport-Export Tty

b. The Import/Export Utility window will pop up. Click Export and select a target folder. The system will
start to export a .bin file.

[ 1 Import/Exgort Utility l = | ' J -n ImportfExport Mility
Ophions

Export current settings 1 5 Start morvice.

0 Import previous settings
| @ Resor [7] Copy settings 1 13:44:00

Import Utility

Please follow the steps below to import the server settings:
a. Under Microsoft Windows, choose "Start > All Programs > VIVOTEK Inc > VAST > Tools > Import-
export Utility."

b. The Import/Export Utility window will pop up. Click Import and select the export file. The system will
start to import the file.

You should then select the Restore or Copy settings options.

Restore: If this is selected, the VAST server GUID will also be restored. This option applies when
you need to restore as crashed server.

Copy Settings: This applies you use the exported profile to duplicate your configuration to mul-
tiple computers. A new server GUID will be generated.



! The svsterm will still recycle the video files in the original paths when the new sttings with new paths is imported.

i Tmport will drop all current settings in the station.
L Would you like to continue?

oK | [ Cancel

! Import/Export Utility =] | ]

Options
" Export current settings

@ Import previous settings
I || Restore Copy sitings
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VAST Service Control Tool

VAST service control tool is a tool for server control and for user to be aware of the VAST Server status.
It starts up as Windows OS startup.

Under Microsoft Windows, choose "Start > All Programs > VIVOTEK Inc > VAST > Tools >

VMServiceControl."
] VIVOTEK Inc
j Installation Wizard 2

J VAST
&4 LiveClient
& Playback
&7 Uninstall
. Toals
Import-Export Utili
&} VMSSeniceCantrol -

You may also find it in the system tray icon of the tool bar, which indicates that the service is running:
It shows a disconnection icon when the service is stopped: m

A menu for the service control tool will pop up when you right-click on the icon:

Open VAST Senice Control  ——|———[RJ VAST Service Cantrol | =] =1 [l
Start Service Service Status

Stop Service Wersion: 1.12.1.4

Restart Service Status: Running

Exit | Start | | Stop | | Restart |

Here you can manually start, stop and restart the service.
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Appendix A Failover Server Configuration

VAST servers can be configured into two groups: Active and Redundant. The Active group
performs daily recording and monitoring tasks, while the Redundant group acts as the standby
servers. In the event of server failures, the Redundant group becomes active, and takes over
the recording task.

The Redundant server group configuration consists of the following:

1. One VAST server designated as the CMS (Central Management server) VAST central

management server.
2. At least one VAST server in the Active group.

3. At least one VAST server in the Redundant group.

4. Gb/s network or higher-speed connection among the servers. All Active and Redundant
groups can reside in different subnets, provided that static IPs are configured for these
servers.

IMPORTANT:

For a Redundant server configuration, you must first enlist VAST servers in the Sites
configuration page before configuring the Redundant server groups. See the Sites
configuration page.

CMS VAST

External storage /

Network Cameras NAS

Active Group Redundant Group

Active VAST servers Redundant VAST servers

Node 1 Node 1

Node 2

Node 3

~ e e —
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Below are the definitions of server roles:

1. CMS VAST server: The main access portal for the configuration.

1-1. |CMS server is where the Failover configuration takes place.

1-2. |CMS continuously polls to check the hearbeats to monitor the statuses of all Active
and Redundant servers.

CMS regularly backs up the configurations on Active servers.

CMS assigns redundant server(s) to the takeover of a failed Active server.

In a Redundant server configuration, the CMS is supposed to be up and running at
all time. If the CMS server fails, the server failover and failback operation will not
take place. It is therefore preferrable to install the CMS server at a high up-time
environment, such as on a VMWare configuration.

—_— ]| -
1
Sl Bl i

2. Active servers: Active VAST servers are the work horses that perform recording and
monitoring tasks.

3. Redundant servers: The Redundant servers are actually active-standbys. They participate
to continue video recording in the event of active server failures. It is recommended for the
Redundant server to have an equivalent or higher processing power than the Active servers.
The same applies for the storage volume and write performance.

Note that you cannot configure a Redundant server by opening a local console.
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The conditions during the failover are illustrated below:
Multiple Active and Redundant groups can be created.

CMS VAST

External storage /

Network Cameras NAS

(- - -T--- - -=-=-=-=-TT-"qr--"-~"-"-"-"-=-==-=-= r - - - -T - T - T-= == ---"r--""-"=""="="="7="="=7=
Active Group Redundant Group Active Group Redundant Group
Active VAST servers Redundant VAST servers Active VAST servers Redundant VAST servers
Node 1 Node 1 Node 1 Node 1

Node 2 Node 2 Node 2

Node 3

Server Group 1 Server Group 2

Each Redundant server can serve as the backup for ONE Active server. Depending on

the number of the Active and Redundant servers, if the number of failed servers exceeds
the number of Redundant servers, the failover will be abandoned. For example, if 2 Active
servers failed, and there is only 1 Redundant server available, the second Active server that
failed will be abandoned.
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In the event of a server failover, a VAST server in the Redundant group takes over the recording
task. Note that depending on the network environment, the takeover can take up to 5 minutes.

= Recording

Active Group Redundant Group

Active VAST servers Redundant VAST servers

Node 1

Node 1

Node 2

Node 3
Server Group

Node 2
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Once the server in the Active group is restored to normal operation, and a CMS server requests
for the recordings and data occurred during the time the active server failed, the requests will
be fulfilled by a shared volume on the redundant server. Due to the concerns with network
bandwidth and processing power, the restored active server does not synchronize its recording
pool with that on the redundant server.

= Recording
~@—= Playback & Search

Active Group Redundant Group

Active VAST servers Redundant VAST servers

Node 1

rd
Recovered! <

Node 2 Node 2

Node 3

Server Group

— e e e e e e o o e e e o o o e e o e e e e = = = =

The recovery path should be available in the network neighborhood, with a name that looks like
the following: ActiveServer1_91AAF3D06B6C47 \RecGroup1.

If an Active server has 3 recording groups, then each Redundant server will have 3 recording
paths accordingly.
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In terms of network failure, the VAST2 configuration supports Seamless Recording. For cameras
equipped with an SD card, video is recorded to the SD cards in the event of network failure. Of
course, the camera must be powered by a secondary power source, such as a DC 12V input. In
cases such as the only PoE switch or POE mid-span fails, power is lost.

CMS VAST

== Recording

External storage /

NAS
Network Cameras

Network
Failure

Node 3

Server Group 1

-]-1- 1 F \
- — Active Group Redundant Group |
|
| Active VAST servers Redundant VAST servers :
| I
| Node 1 Node 1 |
| I
| I
| I
| I
| I
| I
: Node 2 Node 2 |
1
| |
| I
| |
| I
| I
| I
| I
| I
| I
| I
| I
\
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Once the network connection is restored, the VAST2 servers resume the recording task and also
retreive video segments from the SD cards. The video segments recorded during the network
failure will be stitched up with those occurred before and after the network failure. The retrieval
speed varies depending on the available network bandwidth and CPU resources.

CMS VAST

= Recording
=== Retrieval

External storage /

NAS
Network Cameras

i i
%
> > Pl - - - - - - - —HHd = = = - - e e D - - - = =

Redundant Group

Active VAST servers Redundant VAST servers

I
|
1
|
| Node 1
|
1
|
|
|
|
! Nodegg Node 2
|
I
|
I
|
|
|
I
|
I
|
1
|
\

Node 1

Node 3
Server Group 1

—_—— e e e e e - — =
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To enable Seamless recording, find the associated option in Configuration > Camera
Management > Camera Update, and select the Seamless recording checkboxes. Camera

models that support the Seamless recording option will have it listed.

v

Camera List

------- B 3_102.168.4.124(102.168.4.124)
------- & SD9161-H(192.168.4.164)

Brand: VIVOTEK |~ |
Camera Name: FE9191-v2
Address: 192.168.4.171

Model Name:  FES191-v2
MAC Address: | 0002D15AD1BF

Connection Settings | Recording Settings

Storage Group: |DefaultGroup -
Basic Settings

Recording Stream: 1

S

Pre-event Time: 10 E seconds(3-15)

Post-event Time: 10 E seconds(10-60)

Active

Enable seamless recording

Update ][ Close
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Failover Configuration Process

Before Failover configuration, you need to add other servers to your Failover configuration.
+ If you are adding a Redundant server, enter the "Redundant Server Management" screen.

* When adding a Redundant server, you can provide a Windows account 802.1x domain user
name and password. A Redundant server requires this because a full access to the recorded
data is required during the failover and failback process.

To configure Redundant servers,

1. Install VAST server on a server chosen as the active standby.

2. On the server chosen as the VAST CMS server, open Configuration > Failover
Management > Redundant Server Management.

@y_stem | Edit | View | Configuration | Layout | Help}

Camera Management

Station Management...
Logical Tree View Management...
= Bl yms_station(127. 10 Box Management
B camera User Management... 2017197 4 10:46:35

P™ Recording St

P 1o Box
: Alarm Management...
- [ Layout

Association Management...

Virtual Matrix Management %

 Failover IManagement 7 Redundant Server Management... \
Search VivoCam Switches... Redundancy Group Settings... g

Station Settings
Client Settings

Note that it is a must for the Redundant server to be installed differently by selecting a
"Redundant server" checkbox during the installation process.

(") gtandard Server

(@) Free version: 32 channels (WIVOTEE onky)

Trial wersion: 256 channels (60 days)

@ Redundart Server

YAST vl 131,2  <Back || Mext» |
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3. Enter the IP address and Windows AD credentials for access to the Redundant server. Click
the Add button when done, and click the Done button to leave this page.

v |

Redundant Server List

Iame Address Port
£ WMS_Station 192.168.4.156 3454
Redundant Server Info
Address:
Port: 3454 [£] Fluse sst
Wir A (optional)

Input Windows account information to access recordings

Dormain Name: Host

User Name: guest

Password:  eesssses

i) (i ) (o]

An Active server must have a CMS password configured for the hierarchical configuration.

Note that on the Active servers, you should configure them as the subordinates to your CMS
VAST server. On a web console with these servers, open the Site management page, and select
"Allow CMS connection." Create a common password for the CMS hierarchy.

Allow CMS connection

Relay Authentication

Passwoord:

Corfitrn Passwiord;: | cssnssns |

| ok || cancel |
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Two agents will be running on the Active and Redundant servers, "stunnel" and
"VMSWebServer." Make sure they are not blocked out by your firewall. These agents can be
found in the default folders below:

C:\Program Files (x86)\VIVOTEK Inc\sTunnel\stunnel.exe
C:\Program Files (x86)\VIVOTEK Inc\VAST\Server\VMSWebServer.exe

WP Alloveed apps - - a8 s
4 @ > Contol Pangl » Systenand Securty » Windows Firewall o Miowed apps. w @ Search Corrol Panel el
File Edit ‘ew Tocls

Allow apps to communicate through Windows Firewall
To add, change, o remove dlowed apps and perts, dick Change settings.
it are the risks of allowing # ape 1o commusiicate?

Allowsd apps and featuras

hzene Private  Public
ISHELD Streaming NyStreamer TCP Excepbion c.] c]
[ SHELD Streaming NvStreamer UDP Eeceptinn [l cal
[¥ SHELD Streaming 5543 UDP Exception =) i}
| MJSHELD Streaming 5540 UDP Exception =] ]
[@ SmanSoreen =] =
CISNMP Trap o m]
[ Ssh Server c] =
& Stare =] = =
[¥] Stare Purchase Apg =) o]
stunnel - TLS offlnading and Ioad-balancing proxy [ B
& SHURTR [=] =
@ Takea Tost 2= v
Al ancther app.- |
ok [ cancel

4. Enter Configuration > Failover Management > Redundant Group Settings. Enter the

Group name, Description, and click on the Edit button .

v (|
Group List Group Information
= . VMS_Station MName:
B Groups Failover group
B unused Servers
Description:
Failover server sitel: CMS server -~

192.168.4.165; bctive server 192.168.4.167;
redundant server 192.168.4.157

Mermbers:

- [ Active Server

P Redundant Server

Network Interrupt Settings
Reply threshold: 30 El seconds (5~3600)
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5. Select the Active and Redundant servers and move them to the list of Selected servers. The
Active and Redundant servers you enlisted should all be listed below. Select the members of

the Redundant group, and click OK to complete.

Availabe Selected
g ._ B= Unused Servers g ._ B Members @
|:| P Active Server |:| B Active Server
E = i [ Redundant Server @

H— VMS_Station

2] [#]

0K Cancel

The default for the network disconnection timeout is 30 seconds. It is not recommended to
configure a very short timeout, e.g., 5 seconds, because if doing so, a temporary network
disorder can make servers consider the Active server(s) have failed.
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Using the failover function requires Failover license. On the CMS server, you can check the
number of channels in Help > Failover license. Below are the requirements for running a failover
configuration:
1. In a Redundant server group, the number of licensed channels = No. of Active server
channels x No. of Redundant server(s).
For example,
There are 3 Activer servers with 100, 125, and 165 channels.
There are 2 Redundant server.
The number of failover license channels are: 165 x 2 = 330.

= =

Faillover |Local
Purchased Used Unused
Poiover s o e |
[l’rpnrtlj:ense][‘“ te License Update Req "][ Close ]

2. Error prompts will display if there are not sufficient failover channels when you create a
Redundant server group.

e number allowed by the license. Please contact our sales representatives to upgrade.

*=Camera Number

6 The following features exceed the number allowed by the license. Please contact our sales representatives to upgrade.
*Failover Number
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Appendix B Panoramic PTZ (P-PTZ) Configuration

Enable Panoramic PTZ on VAST

The process of configuring two cameras (1 fisheye and 1 speed dome) into the Panoramic
PTZ configuration takes place on a PC using the calibration tool. The Auto Tracking feature is
configured using a web console with the fisheye camera. A Panoramic PTZ package should
comprise two cameras running specific firmware for this application and a software CD
containing all necessary utilities. For configuration details, please refer to the Panoramic PTZ

Installation Guide.

360°
All round view

o ref.point10
. ref. point 11

. refpointi2

To exert Panoramic PTZ control on VAST:

.
. ref. point 11
.

o refponti2

1. Once these two cameras are configured into an interactive pair, insert these cameras into
your VAST configuration.

2. Select a preferred layout using the Layout

H

button. The 1P+2, 1P+6, and 1P+8 layouts

are specifically designed for the Panoramic PTZ configuration.

3. Taking the 1P+2 layout as an example, once they are listed on the device list, click and drag
the fisheye camera to the upper left and the bottom view cells. Place the speed dome in the

upper right view cell.

Fisheye 10

Speed Dome

Fisheye 1P
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4. Right-click on the fisheye's view cell to change its Display mode either into the 10 (Original)
or the 1P (Panoramic) mode. Note that the Panoramic PTZ control does not take effects on
the "R" (Regional) mode and the combinations of other display modes.

5. There are two different ways to quickly exert Panoramic PTZ control. The pan, tilt, and zoom
actions are made from the fisheye's 360° hemispheric overview:

5-1. Click on a spot on the fisheye's Original or Panoramic view where you detected a
condition of your interest. The speed dome will aim its lens at the corresponding position
to cover that field of view.

5-2. Click and drag a region of interest either on the Original or on the Panoramic view. The
speed dome will move to that region and zoom in to fill the same proportion of view into its
view cell.

* On the Original view, click-and-drag creates a circular region of interest.

* On the Panoramic view, a square region.

» If you draw a small region, the speed dome will zoom in on the scene. The smaller the
region, the larger the zoom-in ratio. A large region makes the speed dome to zoom out.

a- ! WTK_Stationl 192 166.6,118)
- By Camera

@ - @ 204 Z0om 10500 Seead
ot~ 8 Mega Do abwork Camarals

100 Liva Ve | o Ma e |
Mege- C

Object

Click to move

Z013/03z9 B4 na:40:59

= : of your interest

il i ] e
M " - L
E \ Click and drag
. y L ) Fary
e = | [nstant Flavbeck  Soume Tma TmaZona  Twe Descristian
mﬂ | 2 Foom 10800 Cocad. 0120320 1534:50.576 0200 Rocarding Status Start

The speed dome camera automatically performs optical zoom in/out to best fit the selected
field of view until the maximum and minimum zoom ratio is reached.

-¢)- Tips: Object
1. When drawing a region of interest, click and drag from of your interest
the center of your interest over a diagonal line to the

bottom right. It is not like drawing a diagonal line from
corner to corner.

2. To swipe the Panoramic view left or right, press and
hold down the Ctrl. key and the left mouse button.
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g;

1. The fisheye and the speed dome are made into an interactive pair using the calibration tool. The VAST
software provides the control interface only. If the cameras have not been properly configured, the
Panoramic PTZ function will not take effect.

2. If the password of the speed dome camera has been changed, you will need to open a web console
with the fisheye camera to change the coordinate password.

3. You may need to reset the fisheye camera if the speed dome camera is powered on after you started
the VAST software.

4. The precision level of the interactive positions between the view cells of the fisheye and the speed
dome is determined by the mapping table. Make sure you have inserted a sufficient number of

reference points and make good association of these points using the calibration tool.

5. Currently the associated event trigger by Auto Tracking is not supported on VAST. The associated
event triggering is configured through a web console with the fisheye camera:

Applications > Panoramic PTZ

| General settings | | Import/Export files |
— L

[#] Enable Panoramic PT2

Enable Auto tracking

Auxiliary camera information
IP address: 172.16.90.172
HTTF port; 80
Conirofler camera account
User name:
Password:
Associate the auto tracking event with the auxiliary camera’s manual trigger [7]1 [T]2 713

5-1. You should then create an event setting using the manual triggers as triggering sources.
5-2. When Auto Tracking takes place, the pre-configured event settings on the speed dome camera
can take associated actions, e.g., taking a snapshot, recording to SD, or triggering the DO pins.

6. The Panoramic PTZ function is currently not available on the Matrix or web console mode in VAST.

7. If the interactive camera pairs (Panoramic PTZ cameras) are managed under VAST substations, then
all of the VAST instances, such as the primary VAST server, the substations, and the client side must
be running the revision that supports P-PTZ.
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Panoramic PTZ - Event Trigger

The P-PTZ-related event types include: "triggered" and "returned to normal" when Auto Tracking
takes place. Below are the configurable options with the event configuration:

1. When configuring a recording schedule, the Auto Tracking actions can be selected as one of the event
triggers. The configuration is found in Configuration > Station Settings > Recording Schedule

Settings.

Schedule List: | Default Schedule : [

Add

) Rerame || Detets || Load Templats | Save as Templats

Time Frame List

Recording Settings
Time Frame Rule
Always Wieekly Setting (Day-based) Recording Mode:
PRTZ wigekly Setting (Day-based) .
Triggers
[¥Imotion & PIR
[V Tampering P-PTZ
Digital Input
[¥] Trigger State  [ZINormal State
[ eod [ Ear ][ peete
Camera List
Mega-Pixel Netwark Camera
DS hcidess ) i Bl 20% Zoom Mega-Pivel Speed Dome MNetwork Camera
Mega-Pixel Ne... 192.168.6.228  DefaultGroup s Mega-Piel Network Camera
20% Zoom Me... 192.168.6.101  DefaultGroup Yes 20x Zoom 1080p Speed Dome Network Camera
I Mega-Piel Ne... 192.168.6.127  DefaultGroup Yes
20% Zoom 108... 192.168.6.130 DefaultGroup Yes

2. When Auto Tracking is enabled, its actions are considered as one of the system event types.
In Configuration > Event Management, P-PTZ is configurable as a Trigger Type in Event
Management > New Event > Trigger. This event trigger can be associated with different actions,
such as Email, recording, moving to a preset location, GSM message, HTTP, Client notification, etc.

An event is a combination of triggers, actions, and schedule. You can add a new event or

edit an existing one.

Event List

General .

Enable

Mame Trig:

Event 1

Event 3

gers

DI-2 (Trigger) ...
P-PTZ (Trigger}..,
P-PTZ (Trigger)...

Actions

Send client noti,..
Start to record ...

Send client nati...

Trigger ==  Action == Schedule == Detail

Schedule

Ahways

Alwrays

&dd Event by: () Device @ Trigger Type

4 Add Event

-]
Moton

Categary: [Cam_era_E.\"Emts

Type:

J |

[ mew Edt

| [ remove | [ Detai>>

Motion
DI
J

013
D14
oIS
L6

Bap 7

LG

L=

DLz
—_—

Do-3
DO-4

0o-1
Do-2

—

Tirme Zane

D05

DO-6

DO-7

Do-g

Wideo Loss/Restare
PIR

‘Tampering
‘Temperature

IR

WA - Maving Chject
IWA - Loitering Detection

TWA - Camera Tamﬁerini
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Auto Tracking can also function as a Device type in the Event Management configuration.

Once triggered, the P-PTZ Trigger and
P-PTZ Normal events will create two

DA Mega-Fivel Metwork Camera(192,166.6.228) short videos for a length of 30 seconds.
[T &gd Mation

[ &b DI-1 _ Note that the P-PTZ event is not
[T &g Tampering

- [~ B 20% Zoam Mega-Pixel Speed Dome Network Camera(192, trigge.red by Pe.m.orar_nic PTZ control on

=¥ @D Mega-Pixel Network Camera{192. 166.6.127) the view cells, it is triggered by Auto
o[V Motion Tracking. Auto Tracking takes place

™ b DI-1 when a moving object enters the pre-

el configured region of interest. Please

[¥ & Tampering . .

¥ & PPTZ refer to the Panoramic PTZ Installation

20x Zoom 1020p Speed Dome Metwork Cameral(192,168, Guide.
e Mega-Pixel Metwork Cameral 192, 168.6.228)
-7 B NDB401(192.168.6.128)

m
o
i@

| i | r

ok | [ cancel |

w SFe172 2013-06-19 15:41:47.087  +08:00
P7160 2013-06-19 03:41:43.821  +08:00
P7160 2013-06-19 03:41:40.488 +08:00
P7160 2013-06-19 03:41:37.156  +08:00 -
w SF8172 2013-06-19 15:41:36.844  +08:00 P-RPTZ Trigger

4. As the result, in Playback > Event Search panel, Auto Tracking (P-PTZ Trigger/Normal) is also a
search condition.

Search Categories: | Al Events -

Wideo - Loss -
Video - Restore

IR - Mormal

IR - Trigger

P-PTZ - Trigger m
P-PTZ - Mormal

4

Add ] ’ Remove

Time Zone: |GMT+DS:DD Beijing, Chongging, Hong Kong, kuala El

Start: Time:

2013 7f 3 v 135205 5

["1End Time:
2013} 7f 9~ (145205 |5
[ I Display in Mew Result List

292 - User's Manual




VIVOTEK - A Leading Provider of Multimedia Communication Solutions

Enable or Disable the Panoramic PTZ Functions

You can manually enable or disable the Panoramic PTZ function in Configuration > Camera
Management > Camera Configuration:

...... ED DEFEte
...... Q ME
Refresh
i Bk n o= . -
""" P recordic il il
L - Layout | Camera Wa ﬁﬂgf-‘mem ,. R T
Output Streaming URL Update Camera...
Send to Talk Panel Delete Cameras...
I Camera Configuration...

1. Select the fisheye camera by a single click, and then open the panoramic PTZ panel from the tabbed
menu.

2. You can enable or disable the panoramic PTZ or the Auto Tracking functionality using the checkboxes.

3. Click the Save button, and the saving progress window will prompt.

Camera

Video | pudio | Remote Focus | NTP Settings || Panaramic PT

a8 l VWTK_Station 1(122.0.0. 1) || vidan stream:
S G8P Mega-Pixel Network

L GED Mega-Pixel Network Maximum frame rate:

Video qualty: [constantbitrate ~| [4Mbps  ~]

4. Click Close to end the configuration process.
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Appendix C  ONVIF Support

ONVIF is supported in an environment where the VAST server can detect and record video
streams from the cameras made by other manufacturers.

The following are supported.

1. ONVIF camera icons on the device tree.
Brand name selection is also available on the configuration window.

Camera List
Brand:

= B wyTk Station1(127.0.0.1) R
w 20x Zoom Mega-Pixel Spe Module: OMWIF

Mega-Pixel Network Carne

i (M Mega-Pixel Network Came camers Hame: ’:I Plauto
‘o (@ Megs-Piel Network Came|  aodrass: 192 168.6.219
Model Mame; | IPE352

MAC Address: 000201192002

Connection Test

Connection Settings Lﬂg@ldﬂg S_B_Etlng§,|

User Mame: Passward:

Configuration Protocol:  |HTTR - Configuration Port: 80 EI
Streaming Protocal: TCR ax Channel: E

Initial Wiewing Stream: 1 E

[¥] automatically add camera into recording starage | DefaultGroup
: T :
fl

2. Insert/update/delete camera from the device tree.
2-1. Detect ONVIF cameras.
2-2. Connection test.
2-3. camera password authentication.
2-4. Supports HTTP and HTTPS streaming protocol.
2-5. Supports multiple streaming.

3. Live view/recording/playback.
3-1. Audio G.711 support.

4. Mechanical PTZ support with the exception of Focus, Iris, Pan, Patrol, and preset location
operation.
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Limitations:

The following limitations apply to ONVIF cameras made by other manufacturers. Some features
may be implemented in later releases of software.

1.

Users should ensure that your other brand cameras support ONVIF.
. The connection statuses of the other brand cameras will not be displayed on the device tree.

. For mechanical PTZ cameras, the Focus, Iris, Pan, Patrol, and preset locations functions will
not be supported. The associated buttons and control elements on the Ul screen will not be
disabled.

. Does not support the Batch Insert Camera function.
. Does not support Camera Configuration.
. Does not support Active Adaptive Stream (AAS) function.

. Does not support Event related functions, including event recording, event management,
instant playback, event search, etc.

. Does not support camera DI/DO.
. Does not support Two Way Audio.

10. Does not support Auto Stream Size.

1

1. The ONVIF user authentication (account and password) may not comply with those
configured via a web console.

12. The number of multiple profiles can vary.

1

3. The number of accessible profile can vary. Some might have only one profile to be
connected.

14. Does not support Click on Image.
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Appendix D VCA Report

The VCA Report utility is started from System menu > Launch VCA Report. The VCA Report
utility provides comprehensive graphs and line charts for quick access to the data collected
through VIVOTEK's People Counting modules, such as the SC8131 stereo camera. Statistical
results is refreshed by hour or minutes, and you can compare the results acquired through
different time periods or among different surveillance areas. These data help figuring the
customer flow in retails so that shop owners can optimize the arrangement of store layout, or
mange queues more efficiently.

Time selector and function
panel

_ Chart panel
Add, Select, Edit
Areas
o SRR - | |

Area Al vt Dy g v (M Mg, st vty P e e (B8
Area data | FlowPathCounting! 132 & 9267 mins 0900
Tatal 139

ﬁe

The configuration of detection methods in People Counting still occur on a web console with individual
cameras. It is not configurable through the VAST LiveClient.

Prerequisites:
The prerequisites for using the VCA Report are:

1. Cameras running the VCA utilities have been configured and added into the VAST
deployment. The instances of available VCA rules will be listed in the Area panel.

2. The life expectancy of VCA records is 5 years.
3. Currently the utility supports Windows XP, 7, and 8.

4. The latest revision v.1.12 supports Seamless Recording, in order to retrieve collected data
and recording during Ethernet disconnection. Provided that an SD card is installed on
the SC8131 camera, the VAST station gradually retrieves data from the SD card after the
connection is restored.
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To begin using the VCA report:

Create Areas

1. Click on the Add button in the Area panel. Cameras running the VCA utilities will be
listed. Click to select cameras. Those running multiple detection rules will be displayed on
screen. Data collected for these rules is kept in camera's flash memory.

2. Click to select one or more cameras.
3. Enter a name for the area, and then click the Create button.
4. The Areas thus added will be listed on the Area panel on the left side of the screen.

If you have multiple detection rules on cameras, you can manually remove some of them from
the list by mouse-overing the rules. After you configured an area, you can still right-click on an
area to configure its parameters.

If only one camera is selected, its name
will apply as the Area name. If not, enter
a name for the area.




5. Click to select one or multiple areas. Those selected will be highlighted in a different color.

=+

Floor 1
Floor 2
Floor 3

Site 1 counting

Select Date & Time

6. By default, the time displayed on the calendar is the current system time on the client

computer running the utility. Select from the Date selector on top.
7. Select a date or span of time from the calendar or use the and Time selector to select a
span of time.

> Single-click to select a date or click and drag to select multiple dates.

> You can select a month or a year using a single click. If you select a month, the timeline unit
will be days within the month. If you select a year, the timeline units will be the months in a
year.

> In the Month or Year panel, single click to select the entire month or an entire year. Double-
click to select sub-units, e.g., days within a month. If you double-click on a Month panel, you
will enter the Day panel.

-+ May 06 - 22, 2014

Floor 1

Day Month
Floor 2

Floor 3 May, 2014




You can select a different month in the Month or Year panels. The Calendar panel
disappears if left unattended for 2 seconds.

On a Month panel, double-click to select a month, and the Day panel for that particular
month will display.

May, 2014 B

Month

Select a month

g;

« When a date is selected, the Date and Time panel will not automatically close, and the
configuration changes will not take effect until it is closed. You can click on the outside of the
panel to leave the panel.

* You can select multiple days to form a span of time. Select one date with a single click and
select multiple dates by draging your cursor across the screen to a preferred end date.

» To select a year, click to open the Year panel. Single click to select a year. Multiple years can
be selected using the click and drag method.



8. Select the hours to be included in the statistical poll using multiple clicks on the chart.

Single-click to select an hour or click and drag to select multiple hours.

Jan 31 - Feb 09, 2015

Note that you can only compare the counting results
from two spans of time if you select only one Area. If you
selected multiple Areas, you can not compare the results
from multiple time spans.

9. Click outside the Calendar panel. The statistical results will display. The default display is the
bar chart. Below is a sample screen showing the results polled from 3 areas. Up to 8 areas
can be selected in one view.

R

o

60 60
54 54
48 48 48 48
o ERES
35 33 33
29 29
""""""""""""""" o 0 B = ' | = B | it (i Sl el e e i
6 6
! 4 - - I
ol @ W0 W0 00 0000 0 ey .uoououoonu_uo
Areas Al visits / Day Avg. visits 7 1h Aug: duration of stay / Person Peak period (1)
FlowPathcount1 369 15 1190.4 mins 16:00
I Counting1 369 15 1190.4 mins 16:00

otal 738
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Select different display modes using the Bar “ Line , or Pie n chart buttons.

Line chart.

Jun 17, 2016

View report from:

In Ot

{Remaining people/People)

0 i} a a o o o [ L] 0 0
TR0 1R300 1300 1330 1406 1430 150 15300 160 1§30 1700 1780 18000 1830 1900 1930 000 X030 2100 B0 2200 EX30 2300 2330

(Period/30m)
i | 4 ]

| countiner 1126.5 mins

Pie chart.

View report from:

1230 1300 1330 1400  14:30

1500 1530 1600 7630 1700 1730 £ 05
1800 1830 1900 1930 2000 2030

2100 2130 2200 22530 2300 2330

| comme 11265 mins
| Fowpatncounc 11265 mins

Note that the timeline units can vary depending on the span of time you selected on the
Calendar panel. If a date was selected, hourly data will display in chart. If a year was selected,
monthly data will display in chart.
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Use the following functional buttons to change the display parameters

Show data on chart E: Displays the collected numbers on chart.

Average : Displays the average number per time span unit (e.g., per hour). If the interval

is changed to 30 mins, the average number will be halved comparing to the number acquired
by every hour.

Report Interval : Configure the intervals for polling data from the camera. The default for
displaying results is by every hour. If you enter 30 minutes as the display interval, all data will

be listed on the basis of the 30 minutes time span. The configurable range is 1 to 1440 mins.

11

t
1

| FlowPathcount] ] 0 15881.8 mins 0830
Total 2

I
Use the Refresh button to poll the latest data from camera.

[ >

Use the time selector on the View Report from pane to select the start time of your statistics
view window. Data collected before that time will not be displayed.

Jun 20, 2016

View report from:

Countingl

]

(Qut/People)

10

A number is displayed when you mouse over an
area on the chart. Move your cursor to an area on
chart, and the number is displayed.

1330 14:00 14:30 15:00 1530 16:00 1630

(Period/30m)
i |
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=
If you selected only one area, you can use the Shift key to select multiple areas (or two spans of
time). You can select multiple dates in the Calendar panel.

Data on a time line will be generated. To close the window, use the close button on the second
date information. Equivalent spans of time can also be used for comparison. For example, you
can compare the data in a span of 4 days against another span of 4 days.

Note that the Compare function only applies when you select to display only one area on
screen.

“ Qut Remaining people

(In/People)

Tho 10,270

B.546
5250 7,892
5500
3,203
2750
425
i SR R R U e R R O R O R AR D SR R T-6D DPTTTOTTTOT VT DTG 0 g0 a FRTEHGTT 0BT
o —m —
oo o1 0z 03 04 05 oe o7 08 08 10 1" 12 13 14 15 16 17 18 19 2 al

o
Feb 09, 2015 E

In a comparison result displayed in a line chart, mouse over to the peak value to display the
percentage of an increase or decrease rate.

e Bt Mt i+ mintie /A1
n 22 5
[Period/Hoor)

Feb 09, 2015
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See below for the functions of buttons on screen.

No. of people who No. of people who No. of people who

entered the area left the area remain in the area
Show an average
number

m <Change the time interval

Click to display or Show data on chart
hide the results for an area

In addition to the charts, a summary of displayed data will be listed below showing the areas
involved, visits/Day or Month, Average visits / Hours / Days, Average duration of stay / person,
and the Peak hour.

Floor 3 490,870 122,718 106.3 mins 12/04
I Floor 2 959,482 239,870 105.9 mins 12/02
site 2 3,873,510 968,378 108.0 mins 12/01
5,323,862
10. When done with displaying the results, you can use the Export button to produce an

image file to preserve the current results. Both a spreadsheet and a graphic chart will be
produced.

Export

Raw data (CSV file)

Save to

C:/ProgramData/Documents/VIVOT -

Open folder after export




11. Click the Reports Subscription button to configure the regular report sent to your Email
account or a specific location on the server itself. Select the report chart image in JPEG or
PNG, and CSV data files. Slide the email button to enable the Email notification.

Select the time to deliver your mail notification. Enter valid Email addresses as the sender
and receiver addresses and make sure the SMTP mail server configuration has been
properly configured on your VAST server. This VCA mail notification utilizes the mail service
on VAST for regular notification. You can then receive Email notification every day on your
Email account. You can enter up to 5 recipient addresses.

Reports

crore [T

Raw data (CSV file)

Sentat | 00 : 00 : 00

Subscribe by email .

B v sewp Live Cllent > Configuratio

Subscribe by sending to server .

Locatic C:/Users/Public/Documents/VIVOTE '

Note that the notification contents is your current field of view, including a Bar, Line, and
Pie chart combined into one image file. The In/Out/Remaining results will be generated into
3 charts. Each Area will generate one CSV file, and each CSV data file will contain In/Out/
Remaining/Summary information.

Peak period (30m)

The generated file names will look like this: 20160226 _test02_Remain.jpg for charts and
20160226_Summary.csv for CSV files. The Email subject will be "VCA Daily Report -
2016/02/26."

Note that if you manually export a report, the default is sending the data collected until one
hour before the manual export. For example, if you generate the report at 14:07, the report
will only cover the data collected until 13:59. You may use the Refresh button to manually



immediate data inputs (those occurred between 14:00 and 14:07).

Below are the messages with the Email test function.

ée

@ swresewp ' ! ' :

SMTP Setup

Failed to send emsail sending to server

If changes have been made to the VCA People Counting configuration through a web
console, Refresh the connection with a network camera from the Device Tree. You can left-
click to select a camera and right-click to display the Refresh command.

The object height information detected by cameras is displayed on screen. You can select to
display such information in centimeters or inches in Configuration > Client Settings > View
Settings.

4 View Settings @
Display Location

Camera Name 2016/6/14 £ 09:19:03

Display Area 1: | Camera Name

Display Area 2: | Server Date & Time
This is a sample screen.
Display Area 3: | Video Title

1 [ B [E]

Display Area 4: | Mo Display

Date and Time Format Font Settings

@ Samne as Local Computer Font: [S\Pfgtem v]

© Specify Color: E|
Date Format: | YYYY/MM/DD Sge: |10 -

Time Format; | Default Time Format

Video Display Mode

@ Hide borders () Keep top/down borders () Keep the aspect ratio
Show motion windows when triggered

[] Display the connecting message when video is lost

[7] The screen goes blank when video is lost

VCA
Show WCA rules

VCA extra information:

none
cm
inch [ 0K ] l Cancel
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Appendix E  Support for Digital I/O Modbus TCP
Modules

This revision, rev. 1.9, supports Advantech's I/O Modbus TCP Modules 6000 series. The VAST
server can receive digital inputs and trigger digital outputs via the I/O modules.

The Advantech 1/0 modules come with configuration utilities, such as the Adam/Apax.NET.
Connect the DI/DO wires to the module and the Ethernet wire from the module to the local
network.

Proceed with the following to configure the 1/0 module:
1. Use the Search function to locate the I1/O module on the network.

File | Tools | Setup  Help
) E” Search Device |

Add Devices to Group

Group Configuration fting I

Terminal for Command Testing

Wetwork setting:
Print Screen Apply change |

Monitor Strearn/Event Dats MAC address: IUU-DU—CQ-FU-EF—SB

= Manitor Peer to Peer

_____ Maonitor GCLIO Data Message [F address: Il?Q.lS.lDD.QQ
é..g Maniter APAX

I Subnet address: |255.255.n 0
Eé Wireless Sensor Networks

o COM1 Default gateway: |1?2.15.n.1

2. It is recommended to configure a static IP for the I/O module.
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3. You may then test the DI/DO device connectivity using the software utility.

File Teools Setup Help

SEH "7 5»a|

28] Secil ADAM-6052 16-ch sowrce typs DIO module
i comt
-4} Ethemet Chasnel ssting | bodbus |

i 16925418720
160254 45.127
| B 1921686138

= 192.168.6.136-[ADAMED5T)
= FE
.3+ 6052 GCL
- 192 1686135

- @ Others
Favorite Group
-4 ADAMA500_55108eries
i comt
Bl 6 Wireless Sensor Networks

- comM1

The Fail Safe Value (FV) of conumnication WDT.
Each DO will switch to its FSV if the module's WDT iz enabled and it zets trizzered.

FEV checked -- Logic High State, FEV unchecked -- Logic Low State Apply SV |

I Commnuication WDT [ P2RGCL WDT

4. To configure the 1/0 modules in VAST, open the Configuration > I/O Box Management >
Insert 1/0 Box Device window.

| System | Edit | View | Configuration | Layout | Help |

Camera Management k

Station Managerment...

. If':j é.oi.lf\ﬂ.as.lnagemen‘é ] P |

.lir%ser‘t.:LfD Bom De«.fice...
Update [/0 Box Device...
Delete /0 Box Devices...

User Management. ..

= B Camera
i Mega-F
- [EM Mega-P

Association Management...

Alarm Management...

Wirtual Matrix Management

- (A Mega-P
- [ Recording St Station Settings
- [ Lavout Client Settings

. IID Bo

Video Enhancement

5. Select the Module model name, enter IP address, User Name, Password, and then click the
Insert button.

1/0 Box List

........ ! WVTK_Station1(127,0.0.1) Brand: Advantech »

Module:

Device Mame: ADAM-6052

address: 192.168.6.138 Pati s[5
User Name: adrnin
Password: LLLLLLE | |

—

Mumber of DO

Murnber of DI DI Marne: l:a
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6. Click Close to close the window. The 1/0 module and its DI/DO entries should be listed on the
device tree under the 1/0 box sub-directory. As shown below, once a DI is triggered from the
I/O module, the associated DI icon will be lighted. Audible notification can also be heard from
the VAST server.

([ System | Edit_| View |_Configuration | Layout | Help )

o6 ofa] - @) @I

i+ N Mega-Puel Natwork Camera(16t »

@ [ Racording Storage

- [ Lavout

= B 1o Box

Ea " ADAM-6052(192.166.6.136)

— @ o
(— il o2

013

Dl-4

OIS

0l-6

-7

MEeqa-Pixel Network'Camera

ag
®
m

358

3

:ét&éi;-ﬁ-

¢
g

7. You can also double-click on a DO icon to manually trigger the digital output. Double-click
again to cancel the trigger.

(_System | Edit | View | Configuration | Lay

[ Mega-Pixel Metwiork Camera(16t
- Recording Storage
- Layout
= ES 1j0 Box
Clggt ! ADAM-E052(192, 168.6,136)
DI-1

DI-2

D1-3

DI-4

DI-5

DI-6

D1-7

DI-3 X2
Do-1

Dio-2

S

Do-3

{
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8. You can also implement the digital inputs and outputs from the I/O module in your alarm
setting. For example, a DI can be wired to an intrusion detector; and when the DI is triggered,
an associated DO can be used to sound an alarm.

To configure the Alarm setting, enter the Configuration > Alarm management window.
Configure a new alarm. On the Trigger window, select the Trigger Category as External
Device Events.

i
i

General .. Trigger .. Acton .. Schedue .. Detal

&4 Add Event

Add Event by: @ Device (0 Trigger Type

) FT T T e ——

‘Carnera Events
Camera Status

Substation Connection Status
‘Storage Status

‘Station Status }
External Device Events

! [Bxk ][ met | [ Fmeh | [Lconcal ]

9. The DIs and DOs on the I1/0O module will be listed. You can then select one or more Dls as the
triggers.

Select the trigger(s) from the following list,

........ E “ DI-1
........ D “ nl-2
........ E “ nl-3
........ E‘ “ OI-4
........ D “ 0I5
........ D “ Dl-6
........ D “ OI-7
........ D “ D8 r
........ D . Oio-1
........ D . 0o-2
........ D . 0o-3
........ D . Oio-4
........ D . 005
........ D . Do-5
........ D ' Do-7 i
........ E “ Do-2 *
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10. On the Action panel, you can select to trigger DOs, for example, as the reacting actions

Note that once a DO is triggered, you should manually disable the DO.

é@

Select the DO(s) from the follawing list,
General .. Trigget .. Action .. Schedue .. Detal
Email Notification T |
oA = B vk Staton1(127.0.0.1) =[N eenee
) Start to record on C ) ADAM-E052(192.168.6,136) (1 Normal [
) Maove to preset location © po1 E © Trigger
@ 56t DO [ po2
T po-4
7 pos
e
™~ po7 -
(71 GEM short message 4 n 3
Removs_| (OHTTR
) Client Motification
| Lo ] (o) | oo | [conm | —
Concel |

If an 1/0 module is started later than the VAST server, you may not be able to access the 1/0 module.
You should then re-start the VAST service.

W VAST Service Contrel -*l. | =] 2 J
L — -

Service Status
Wersion: 1.9.0.2
Status:  Running

| star | [ stop | | Restar |

=

& Mo

B o8B
&5 9 4

T4 01:12
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Appendix F  Database Merge Function

The Database Merge function applies in the following scenario:
1. A VAST server A failed or was intentionally depleted. The precondition is that the disk drives

containing the recordings remain intact.

VAST Server A
o
e
< DB
O
Network Cameras
Recorded
videos
VAST server B

DB
b Recovery path

Recorded
videos (default path)

2. The VAST server B is used to continue video recording. The previous recordings on server A

é&

can be retrieved by attaching the hard disk(s) to server B or manually copying to a storage
device on server B. You can then designate the location of these files as the "Recovery
path" from server B. An administrator can then use the VAST Playback to access the past
recordings.

Note that you can also configure a separate recycle policy for that Recovery path.

It is IMPORTANT to move or copy the entire storage group folder, e.g., D:/recording/2016-
06-17/1-FE9181-H..., which is a root directory configured by VAST server as the recording
folder. The default recording folder contains file folder structure, video files, and database
metadata. If you copy the video files only, the database data will not be synchronized, and
you will not be able to access the recordings using the VAST Playback utility.

The video streams received from cameras will not be recorded on to the Recovery path
folder. It is designed to maintain previous recordings. The Recovery path folder becomes
static.
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- D:/Record

|
RN
e D PP

2016-06-17 2016-06-18 2016-06-19 2016-06-20 2016-06-21 2016-06-22

2016-06-17 . . . . . . T

1-FE9181-H 2-FD9381 3-Outdoor  4-Outdor  5-1B9381  6-1IP8166
Speed Dome Speed Dome

L

L

« It is also a good habit to export and preserve your VAST system configuration to prevent
losses in the event of system failure. In case you want to migrate or upgrade your VAST
server, you can use the Import-Export utility to duplicate your VAST configuration to
another server. Copy the configuration file and import the configuration from another VAST
server.

| VIVOTEKInc
| Installation Wizard 2

. VAST
&g LiveClient
) Playback
&7 Uninstall
|l Toals

[ R4 Import-Export Utility

& VMSServiceContral -

M Import/Export Utility

| Options

@ Export current settings
Confignration settngs

() Import previons settings
Eestore [] Copy settings

B e R | ]

| Hext ]I Cancel ]
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When the file folder is ready for server B, designate the location of recovered files from
another VAST server, go to Configuration > Station Settings > Recording Storage Settings.

Select the recording folder that contains the recordings from the counterpart VAST server.
Select the Recovery Path check circle and click OK.

u m"g Storage Settings EVMS_SIaﬁon
- g
PMroup
Sel Ls
- recording2_2014 o
- Recording_backup
Recovery Storage Path - Reference
C:\Record-1 [#- Releases_FW ites
- Root-192.168.4.105_28x Zoom Speed Dome MNetwork Camera_
& shared_Rita ==
k- Spanish_UM 1tes
- storage_export
[#- System Volume Information
[ temp
B-themes
Delete recorded data older than B Transiated_
- Translation Folder Mame: a2
« 3
Cameras in Storage Group ‘ —
recovery_path
Available Cameras: e -
y 4
Group Name
path: E\
v B [oc ][ concel hera
L4 FD9381-EHTV Type: () Storage Path Recovery Path nera
L4 Outdoor Network S Storage Information
: Outdoor Network Sy Total 1862.89  GBytes : 1193.32  GBytes
IB9381-HT FEa
Reserved: 186 GBytes
L 4 PB166 jeen:
L4 5C8131
(o J[ cncel ]

Click the Apply and Close button.

———
g

[; 5% |
Storage Group:  DefaultGroup ﬂ
Paths in Storage Group
=
Recovery Storage Path Storage Information
C:\Record-1 Total: 1862.89 GBytes
E:\recovery_path Reserved: 186.00 GBytes
Free: 1193.32 GBytes
Delete recorded data older than E day(s)
Cameras in Storage Group
Available Cameras: Added Cameras (7/256):
FE2181-H
Group MName Address T
« FE9181-H 192.168.6.105 Outdoor Network Speed Dome Camera
K Qutdoor Metwork Speed Dome Camera
L4 FDO381-EHTV 192.168.6.109 BO3BLHT
L4 Outdoor Network Spe...  192.168.6.169 P8166
L4 Outdoor Network Spe...  192.168.6.169 5C8131
& 1B9381-HT 192.168.6.170
4 1PB166 192.168.6.160
L4 5C8131 192.168.40.1...
Restore ] [ Apply I [ Close
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If you are running the Playback utility, close and re-start the Playback utility. Open the device
tree, and you should be able to see previous recordings listed under each camera. This
indicates previous recordings can be accessed from the recovery path and the databases on
the two VAST instances have been synchronized.

| System | Edit | View | Configuration | Layout | Help

PEARDEDE B ZE D

Brawsing | Time Search | Event Search | Bookmark § * | * | [RSCEEIRG]

=] s Managed Stations
= B0 wms_Station(127.0.0.1)
=2 h‘ Cameras
)~ (@M FE181-H (DefaultGroup)
A 2013-03-29
A 2013-04-01
FA 2016-06-17
- [FH 2016-06-20
- [ 2016-06-30
- [ 2016-07-01
- M FDI381-EHTY (DefaultGray
A 2013-03-29
-~ [FH 2013-04-01
- [ 2016-06-17
- [ 2016-06-20
& 2016-06-30
A 2016-07-01
. M Outdoor Network Speed D
- (M Qutdoor Metwark Speed D
o (M [BO3B1-HT (DefaultGroup)
(&M [PE166 (DefaultGroup)
- M 508131 (DefaultGroup)
[ B oniie-0F-17

i [P 2016-06-20

=& Laca 0B
e Q E:\export path
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In addition to the use of Recovery path, if you need to access the recordings made by a
different VAST server, you can also manually copy the entire storage group folder, such as
D:/recording, to a hard drive or a network share, and then avail the recordings on the new
server.

Different from the use of Recovery Path (Database Merge), this scenario applies to two VAST

servers with different configurations.
VAST Server A

Network Cameras
Recorded

videos

VAST server B HDD Network share

(Entire folder)

DB

Recorded
videos

On the Playback window, right-click the Local DB icon to display the Add command. Select
the folder where the recordings reside. The recordings should be listed under each of the
cameras.

Bromwesing Event Search | Bookmark EEIIl

Ela Managed Stations
o B yMs_station(127.0.0.1)
& BEy Cameras
‘... @M FE918L-H (DefaultGroup)
- &M FDO381-BEHTY (DefaultGrol

: Outgmf “EtWDrE SDEESD Note that as the folder structure remains intact, you
Outdoor Metwiork Speed D . . .

- EN BOEELHT (Defaultaroun) cgn_su.ll manually remove some of the video files
o BN [PB186 (DefaultGroup) within, if they are not of your interest.

Lo @M 5CH131 (DefaultGroup)

o[ Local DB
S B EjRecord-1

H|
- (M FO9381-EHTY

- M Cutdoor Network Speed Dome
- M Outdoor Network Speed Dome
- (M IB9381-HT

= M IPE166

[ 2016-06-17

- [ 2016-06-20

[ W 5C8131
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The Export Storage is another backup function.

To export video recordings to a specific target folder, enter Configuration > Station Settings >
Recording Storage Settings. Click the Browse button to select a target folder.

Select the default storage group, click on the Export button %], Select all cameras (default)
or manually select specific cameras from the list. If you want to select individual cameras, use
the arrow buttons to move cameras to the right column. Select the time span of the export
using the selectors below. The minimum span is one day. Click OK to proceed.

Note that the videos thus exported can not be indexed in the Playback utility's device list.
Each video clip should be watched individually.

Nd Recording Storage Settings for VMS_Station P

Storage Group: | DefauftGroup E @ ‘Z| @|

Paths in Storage Group

Recovery  Storage Path Storage Information
C:\Record-1 Total 916.15 GBytes

& E:\recovery_path 4 Export Storage ==l
W E:\storage_export ‘Output Folder

Destination Path:

Select Export Source

Delete recorded data older than 7 @ Al Cameras Selected Cameras

Cameras in Storage Group Name Address Group

5C8131 192.168.40.1... DefaultGroup
1P8166 192.168.6.160  DefaultGroup
1B9381-HT 192.168.6.170  DefaultGroup
Outdoor Netw... 192.168.6.169 DefaultGroup
Outdoor Netw... 192.168.6.169 DefaultGroup
FD2381-EHTV  192.168.6.109 DefaultGroup
FE9181-H 192.168.6.105  DefaultGroup

‘ m 3

Available Cameras:

Group Name
L 4 FEQ181-H
FD9381-EHTV

Outdoor Network Spe...
Qutdoor Network Spe...
1B9381-HT

1P8166

5C8131

Select Time Period

e e e e e e

Start Time: 2016/ 6/30 = End Time: 2016/ 6/30 =

| oK H Cancel ‘

| i ‘ | il ‘ ‘ st -

Depending on the length of time span and the number of selected cameras, the export
process may take several minutes or longer to complete.

9

% Information (&2
Exporting Success
| ook

ge

+ If the members of the original VAST configuration (cameras) have been changed, the VAST
server will not be able to locate the original MAC addresses, and may not be able to retrieve
past recordings.

+ The Export Storage function only takes effect on the VAST server local console. It is not
available on a web console.
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Appendix G Other Parameters

Disable background decode:

Administrators can choose to disable the background decode for other view cells when entering
a single view of a specific camera. This can help reduce the CPU load on a server short of
system resources.

This function can be evaluated in two aspects:

1. For a server with abundant system resources, there is less stress when disabling and
enabling background decode. When a user leaves a single view and enters a multi-cell
view, the background decode starts again, and a powerful server handles this process more
smoothly.

2. For a server with less resources, this feature can reduce CPU load. However, latency can
occur during the process when returning from a single view back to a multi-cell view.

This feature is enabled by editing the ClientSetting.ini file in C:\ProgramData\VIVOTEK Inc\
VAST\Client\LiveClient.

64 [H[Generalsetting]

a5 AutoFullScreen=0

66 AutolddCam=1

&7 S5E=1

&8 EnableRTSP=0

69 RISPPort=4543

70 StreamingRelay=1

71 SubscribeCamera=0

T2 SortCamera=0

3 LiveEvent=1

74 Localhlert=0

TS EventWindowIype=0

T& Rotatelec=10

77 AutoRotate=0

78 DeInterlace=0

R SynchudioVideo=0

80 AutoStreamSize=1

81 AutoStreamSizeMode=0
82 InstantReplay=1

83 DefaultPlaybackLength=1
84 BufferTime=0

85 GDICnly=0

86 GPUDecode=0

87 GFUDecodeMaxNumber=0
88 MinPTSpeed=-1

85 MaxPTSpeed=-1

S0 LDisableBackgroundDe co-de=]4
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